
Dell™ C3765dnf Multifunction
Color Laser Printer

User's Guide

Regulatory Model: C3765dnf





Template Last Updated - 2/7/2007 Contents 1

Contents

Before Beginning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

A Notes, Cautions, and Warnings . . . . . . . . . . . . . . . . . . . . . . 23

As for RSA BSAFE  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

1 Dell™ C3765dnf Multifunction Color Laser Printer User's 
Guide  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   25

Conventions.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  25

2 Finding Information  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   27

3 Product Features  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   31

4 About the Printer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   33

Front and Rear View  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33

Front View .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  33

Rear View  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  34

Duplex Automatic Document Feeder (DADF)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35

Space Requirements .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  35

Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

Additional Components.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

Optional Accessories .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

Non-bundled Items  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  36

Securing the Printer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  37

Ordering Supplies  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  37



2 Contents Template Last Updated - 2/7/2007

Setting up the Printer (Printer Setup)  . . . . . . . . . . . . . . 39

5 Preparing Printer Hardware .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  41

Removing Tape  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  41

6 Installing Optional Accessories .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  43

Installing the Optional Memory Module .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  43

Updating Your Driver to Detect Memory Module .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  45

Installing the Optional 550-Sheet Feeder.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  48

Updating Your Driver to Detect 550-Sheet Feeder.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  50

Installing the Optional Wireless Adapter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  53

Verifying the Contents of the Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  54

Installing the Wireless Adapter Using Video Instructions (Recommended)  .  .  54

Installing the Optional Wireless Adapter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  55

Determining the Wireless Network Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  56

Configuring the Optional Wireless Adapter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  57

Using Wizard Setup to Configure a Wireless Adapter  .  .  .  .  .  .  .  .  .  .  .  .  .  57

Using Advanced Setup to Configure a Wireless Adapter .  .  .  .  .  .  .  .  .  .  .  .  59

Reconfiguring the Wireless Setting  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  63

Installing the Optional Hard Disk.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  64

Updating Your Driver to Detect Hard Disk .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  67

7 Connecting Your Printer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  71

Connecting Printer to Computer or Network .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  72

Direct Connection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  72

Network Connection .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  73

Connecting the Telephone Line.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  73

Turning on the Printer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75

Setting Initial Settings on the Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  75

8 Setting the IP Address .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  83

Assigning an IP Address  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  83

When Using the Easy Setup Navigator  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  83

When Using the Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  83



Template Last Updated - 2/7/2007 Contents 3

When Using the Tool Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  84

Verifying the IP Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  85

Verifying the Settings Using Operator Panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  85

Verifying the Settings Using System Settings Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  85

Verifying the Settings Using Ping Command  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  85

9 Loading Paper  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   87

10 Installing Printer Drivers on Windows® Computers  .  .  .  .  .   91

Identifying Printer Driver Pre-install Status .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  91

Changing the firewall settings before installing your printer .  .  .  .  .  .  .  .  .  .  91

Inserting the Software and Documentation Disc  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  91

Direct Connection Setup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  92

Network Connection Setup  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  95

Network Printer Setup on a Local Network .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  95

Network Printer Setup on a Remote Network  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  99

Setting Up for Shared Printing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   104

Specifying the Shared Settings of the Printer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   104

Point and Print .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   105

Peer-to-Peer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   108

11 Installing Printer Drivers on Macintosh Computers  .  .  .  .   111

Installing the Drivers and Software .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   111

Adding a Printer on Mac OS X 10.5, 10.6, 10.7, or 10.8  .  .  .  .  .  .  .  .  .  .  .  .   111

Adding a Printer on Mac OS X 10.4.11  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   112

Adding a Printer on Mac OS X 10.3.9  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   113

Configuring Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   115

12 Installing Printer Drivers on Linux Computers (CUPS)  .  .   117

Operation on Red Hat Enterprise Linux 5/6 Desktop .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   117

Setup Overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   117

Installing the Printer Driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   117

Setting Up the Queue  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   117

Setting the Default Queue .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   118

Specifying the Printing Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   119

Uninstalling the Printer Driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   119



4 Contents Template Last Updated - 2/7/2007

Operation on SUSE Linux Enterprise Desktop 10.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  120

Setup Overview  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  120

Installing the Printer Driver  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  120

Setting Up the Queue  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  120

Setting the Default Queue .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  121

Specifying the Printing Options  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  121

Setting the Password for Authority as the Printer Administrator .  .  .  .  .  .  .  122

Uninstalling the Printer Driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  122

Operation on SUSE Linux Enterprise Desktop 11.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  122

Setup Overview  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  122

Installing the Printer Driver  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  123

Setting Up the Queue  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  123

Setting the Default Queue .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  124

Specifying the Printing Options  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  124

Setting the Password for Authority as the Printer Administrator .  .  .  .  .  .  .  125

Uninstalling the Printer Driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  125

Using Your Printer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

13 Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   129

About the Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  129

About the Main Home Screen  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  130

Message Field .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  130

Toner Status Icon  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  130

Wireless LAN Connection Status Icon  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  130

Data Status Icon .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  130

Function Buttons .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  131

Using the Keyboard Displayed on the Touch Panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  131

Using the Number Pad  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  132

Number Pad Numbers .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  132

Changing Numbers or Names .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  132

Inserting a Pause  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133

Printing a Panel Settings Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133

Changing the Language .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133

When Using the Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133

When Using the Tool Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133

Setting the Power Saver Timer Option .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  133



Template Last Updated - 2/7/2007 Contents 5

About the Concurrent Jobs Feature  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   134

14 Dell™ Printer Configuration Web Tool .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   135

Overview .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   135

Setting Up the Dell Printer Configuration Web Tool .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   136

Setting Up From Web Browser  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   136

Setting Up From Operator Panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   137

Starting the Dell Printer Configuration Web Tool .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   138

Overview of the Menu Items .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   138

Printer Status  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   138

Printer Jobs .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   138

Printer Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   138

Print Server Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   138

Copy Printer Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Print Volume .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Address Book .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Printer Information  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Tray Management .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

E-Mail Alert  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Set Password  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Online Help  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Order Supplies at: .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Contact Dell Support at: .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   139

Page Display Format .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   140

Top Frame .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   140

Left Frame .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   141

Right Frame  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   141

Changing the Settings of the Menu Items .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   142

Details of the Menu Items .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   142

Printer Status  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   145

Printer Jobs .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   146

Printer Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   147

Print Server Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   170

Copy Printer Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   193

Print Volume .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   193

Address Book .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   194

Tray Management .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   201



6 Contents Template Last Updated - 2/7/2007

15 Understanding the Tool Box Menus .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   203

Starting the Tool Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  203

Printer Setting Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  203

Printer Information .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  203

Menu Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  204

Reports .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  206

TCP/IP Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  206

Tray Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  207

Default Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  207

Fax Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  209

Panel Language  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  210

Printer Maintenance  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  211

System Settings - General .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  211

System Settings - Timers  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  213

System Settings - Output Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  214

Service Tools .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  215

Tray Management .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  216

Panel Language  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  219

TCP/IP Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  219

Network Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  220

Copy Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  220

Scan Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  223

Fax Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  224

USB Direct Print Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  225

Fax Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  226

Diagnosis .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  228

Chart Print .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  228

Environment Sensor Info  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  229

Resetting Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  229

When Using the Tool Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  229

16 Understanding the Printer Menus  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   231

Report / List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

System Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

Panel Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

PCL Fonts List  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

PCL Macros List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

PS Fonts List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

PDF Fonts List  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231

Job History .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  231



Template Last Updated - 2/7/2007 Contents 7

Error History .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Print Meter  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Color Test Page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Protocol Monitor  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Speed Dial .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Address Book .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Server Address  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Fax Activity  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Fax Pending .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Stored Documents.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   232

Printing a Report/List Using the Operator Panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233

Printing a Report/List Using the Tool Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233

Admin Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233

Phone Book  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233

PCL.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   233

PostScript .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   240

PDF  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   240

Network .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   242

Fax Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   247

System Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   255

Maintenance  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   264

Secure Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   269

USB Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   272

Default Settings.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   273

Copy Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   273

Scan Defaults .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   274

Fax Defaults .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   275

USB Direct Print Defaults .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   275

Tray Management.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   275

Tray Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   275

Panel Language.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   280

Print Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   280

Private Mailbox  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   280

Public Mailbox .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   281

Proof Print .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   281

Secure Print .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   281

Secure Fax Receive .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   282

Copy Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   282

Copy Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   282

Quality Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   285

Output Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   286



8 Contents Template Last Updated - 2/7/2007

Scan Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  288

Network  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  288

Application .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  288

USB  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  289

Scan Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  289

WSD Scan .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  292

E-mail .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  293

Fax Menu  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  293

Fax Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  293

Options Tab  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295

Polling Receive  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295

Fax Cover Page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295

USB Direct Print Menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295

Select File to Print .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295

USB Direct Print Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  295

Options Tab  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  298

ID Card Copy  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  298

ID Card Copy Tab.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  298

Quality Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  298

Panel Lock  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  299

Enabling the Panel Lock .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  299

Disabling the Panel Lock  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  299

Resetting Defaults  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  299

When Using the Operator Panel .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  300

17 Print Media Guidelines .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   301

Paper  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  301

Paper Characteristics .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  301

Recommended Paper  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  302

Unacceptable Paper .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  302

Selecting Paper  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  302

Selecting Pre-Printed Media and Letterheads  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  303

Selecting Pre-Punched Paper .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  303

Envelopes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  303

Labels .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  304

Storing Print Media .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  305

Identifying Print Media and Specifications  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  305



Template Last Updated - 2/7/2007 Contents 9

Supported Paper Sizes  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   305

Supported Paper Types .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   306

Paper Type Specifications  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   306

18 Loading Print Media .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   307

Capacity.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   307

Print Media Dimensions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   307

Loading Print Media in Tray1 and the Optional 550-Sheet Feeder  .  .  .  .  .  .  .  .   307

Loading Letterhead (Pre-Printed and Pre-Punched Paper)  .  .  .  .  .  .  .  .  .   307

Loading Print Media in the MPF .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   308

Loading an Envelope in the MPF  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   310

Envelope #10, Monarch, or DL  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   311

C5  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   311

Using the MPF  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   312

Linking Trays .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   312

Printing, Copying, Scanning, and Faxing  . . . . . . . . . . 313

19 Printing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315

Tips for Successful Printing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315

Tips on Storing Print Media .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315

Avoiding Paper Jams  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315

Sending a Job to Print  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   315

Canceling a Print Job.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   316

Canceling a Job From the Operator Panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   316

Canceling a Job From a Computer Running Windows  .  .  .  .  .  .  .  .  .  .  .  .   316

Duplex Printing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   317

Duplex Printing With Duplex Unit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   317

Using Booklet Print  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   317

Using the Stored Print Feature .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   318

Overview.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   319

Procedures for Printing Stored Print  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   320

Printing from USB Memory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   321

Supported File Formats  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   322



10 Contents Template Last Updated - 2/7/2007

Inserting and Removing a USB Memory  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  322

Printing a File in a USB Memory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  322

Printing With Web Services on Devices (WSD) .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  323

Adding Roles of Printer Services  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  323

Printer Setup .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  323

Installing a Printer Driver Using the Add Printer Wizard  .  .  .  .  .  .  .  .  .  .  .  324

Printing With AirPrint .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  325

Setting Up AirPrint on Your Printer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  325

Printing via AirPrint  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  325

Printing With Google Cloud Print™  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  325

Preparing to Use the Printer with Google Cloud Print .  .  .  .  .  .  .  .  .  .  .  .  .  325

Registering the Printer to Your Google Account  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  326

Printing via Google Cloud Print  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  326

Printing a Report Page  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  327

Printer Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  327

Using the Operator Panel to Change the Printer Settings.  .  .  .  .  .  .  .  .  .  .  327

Using the Dell Printer Configuration Web Tool to Change the Printer Settings  327

20 Copying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   329

Loading Paper for Copying .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  329

Selecting Paper Tray  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  329

Preparing a Document  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  329

Making Copies From the Document Glass .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  330

Making Copies From the DADF .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  331

Setting Copy Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  332

Output Color .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  332

Select Tray .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  332

Darken / Lighten .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  333

2 Sided Copying  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  333

Original Type .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  334

Sharpness .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  334

Color Saturation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  334

Auto Exposure .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  334

Collation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  335

Reduce / Enlarge.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  335

Original Size .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  336

2-Up  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  337



Template Last Updated - 2/7/2007 Contents 11

Margin .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   338

Using the ID Card Copy .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   338

Changing the Default Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   339

21 Scanning  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   341

Scanning Overview.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   341

Scanning - With scanner driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   341

Scanning - Without scanner driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   341

Scanning From the Operator Panel - Scan to Application.  .  .  .  .  .  .  .  .  .  .  .  .   343

Scanning from the Operator Panel - WSD Scan .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   344

Printer Setup for WSD Scan  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   344

Procedures for WSD Scan  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   345

Scanning Using the TWAIN Driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   345

Scan Settings Tool  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   347

IP Address Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   347

Password Setting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   348

Scanning Using the Windows Image Acquisition (WIA) Driver.  .  .  .  .  .  .  .  .  .   349

Scanning to a PC or Server via SMB/FTP  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   351

Overview.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   351

Procedures  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   352

Setting a Login Name and a Password (SMB Only)  .  .  .  .  .  .  .  .  .  .  .  .  .   353

Creating a Shared Folder (SMB Only) .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   354

Setting a Destination Using an Address Book  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   359

Sending the Scanned File on the Network  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   364

Scanning to a USB Memory  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   364

Types of a USB Memory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   364

Procedures  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   365

Specifying a Folder to Save the Scanned Image .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   365

Sending an E-Mail With the Scanned Image  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   366

Setting an E-Mail Alert  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   366

Registering a New E-Mail Address .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   367

Sending an E-mail With the Scanned File .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   367

22 Faxing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   369

Specifying the Fax Initial Settings Using the Easy Setup Navigator  .  .  .  .  .  .  .   369



12 Contents Template Last Updated - 2/7/2007

Setting Your Country  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  370

Setting the Printer ID .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  370

Setting the Time and Date  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  370

Changing the Clock Mode  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  371

Setting Sounds  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  371

Speaker Volume .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  371

Ringer Volume .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  371

Specifying the Fax Settings Options .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  372

Changing the Fax Settings Options  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  372

Available Fax Settings Options  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  372

Advanced Fax Settings  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  376

Sending a Fax .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  377

Loading an Original Document  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  377

Adjusting the Document Resolution .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  378

Adjusting the Document Contrast .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  379

Sending a Fax From Memory  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  379

Sending a Fax Manually .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  380

Confirming Transmissions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  381

Automatic Redialing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  381

Sending a Delayed Fax .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  381

Sending a Fax from the Driver (Direct Fax).  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  382

Example  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  382

Receiving a Fax .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  386

About Receiving Modes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  386

Loading Paper for Receiving Faxes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  386

Receiving a Fax Automatically in the Fax Mode.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  386

Receiving a Fax Manually in the Telephone Mode  .  .  .  .  .  .  .  .  .  .  .  .  .  .  387

Receiving a Fax Automatically in the Telephone / Fax or Ans Machine/Fax  .  387

Receiving a Fax Manually Using an External Telephone (Remote Receive)  .  387

Receiving Faxes Using the DRPD  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  388

Receiving Faxes in the Memory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  388

Polling Receive  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  388

Automatic Dialing.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  388

Speed Dialing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  388

Setting Speed Dial .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  389

Sending a Fax Using Speed Dial .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  389

Group Dialing  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  390

Setting Group Dial .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  390

Editing Group Dial  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  390



Template Last Updated - 2/7/2007 Contents 13

Sending a Fax Using Group Dial (Multi-address Transmission)  .  .  .  .  .  .  .   391

Printing a Speed Dial List .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   391

Phone Book .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   391

Other Ways to Fax  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   392

Using the Secure Receiving Mode  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   392

Using an Answering Machine.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   393

Using a Computer Modem.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   393

Printing a Report .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   394

Changing Setting Options  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   394

Know Your Printer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 395

23 Understanding Your Printer Software  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   397

Printer Utility Software.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   398

Status Window  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Tool Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Updater  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Troubleshooting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Address Book Editor.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

ScanButton Manager .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Dell ScanCenter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Address Books .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Types of Address Books .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   399

Adding and Editing Entries to the Address Books  .  .  .  .  .  .  .  .  .  .  .  .  .  .   400

Status Monitor Widget for Macintosh .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   403

Status Monitor Widget Feature .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   403

Before Installing the Status Monitor Widget .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   403

Installing the Status Monitor Widget .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   403

Opening and Closing the Status Monitor Widget .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   403

Printer Status Window  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   404

Order Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   405

Preferences .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   406

Status Monitor Console for Linux  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   407

Status Monitor Console Feature  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   407

Before Installing the Status Monitor Console.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   407

Installing the Status Monitor Console.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   407

Starting the Status Monitor Console  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   408

Printer Selection Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   408



14 Contents Template Last Updated - 2/7/2007

Printer Status Window.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  409

Dell Supplies Management System Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  410

Service Tag Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  411

Settings Window .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  411

24 Printing Using ColorTrack (External Authentication) .  .  .  .   413

ColorTrack Settings .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  413

Dell ColorTrack .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  413

Authentication System.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  414

Kerberos Server .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  415

LDAP Server .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  416

LDAP Authentication.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  417

Setting the Printer Driver .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  418

Dell ColorTrack Mode  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  418

Specify Group Name .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  418

Specify Job Owner.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  419

Job Owner Name  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  419

Password  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  419

25 Using the Server Address Book and Server Phone Book   421

Setting Server Address Book and Server Phone Book  .  .  .  .  .  .  .  .  .  .  .  .  .  .  421

26 Using Digital Certificates .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   423

Managing Certificates  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  423

Preparing to Manage Certificates .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  423

Importing a Digital Certificate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  425

Setting a Digital Certificate  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  426

Confirming the Settings of a Digital Certificate  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  426

Deleting a Digital Certificate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  427

Exporting a Digital Certificate .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  427

Setting the Features.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  428

Setting the Certificate in the IPsec Digital Signature Mode  .  .  .  .  .  .  .  .  .  428

Setting the SSL-use Server Certificate (HTTP/IPP) .  .  .  .  .  .  .  .  .  .  .  .  .  .  429

Setting LDAP-SSL/TLS Communication .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  429

Setting Server Certificate Verification for LDAP-SSL/TLS Communication .  .  429

Setting Client Certificate for LDAP-SSL/TLS Communication .  .  .  .  .  .  .  .  .  430

Setting for Wireless LAN WPA-Enterprise (EAP-TLS).  .  .  .  .  .  .  .  .  .  .  .  .  430

Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, 
EAP-TTLS CHAP) .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  431

Setting Client Certificate for IEEE 802.1x (EAP-TLS) .  .  .  .  .  .  .  .  .  .  .  .  .  .  433



Template Last Updated - 2/7/2007 Contents 15

27 Understanding Fonts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   435

Typefaces and Fonts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   435

Weight and Style  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   435

Pitch and Point Size .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   435

Bitmapped and Scalable Fonts.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   436

Resident Fonts  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   437

Symbol Sets.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   441

Symbol Sets for PCL 5/PCL 6  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   441

28 Understanding Printer Messages  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   443

Error Codes .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   443

Error Messages .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   451

29 Specifications  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   455

Operating System Compatibility .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   455

Power Supply .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   455

Dimensions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   455

Memory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   455

Page Description Language (PDL)/Emulation, Operating System, and Interface .   455

MIB Compatibility .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Environment.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Operation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Print Quality Guarantee .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Storage  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Altitude  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Cables.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   456

Copier Specifications  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   457

Scanner Specifications  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   458

Facsimile Specifications .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   458

Optional Wireless Adapter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   459



16 Contents Template Last Updated - 2/7/2007

Maintaining Your Printer  . . . . . . . . . . . . . . . . . . . . . . . 461

30 Maintaining Your Printer  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   463

Determining the Status of Supplies  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  463

Conserving Supplies  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  463

Ordering Supplies.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  463

Storing Print Media .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  464

Storing Consumables .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  464

Replacing the Toner Cartridges.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  465

Removing the Toner Cartridge .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  465

Installing a Toner Cartridge  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  466

Replacing the Drum Cartridges .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  467

Removing the Drum Cartridge .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  467

Installing a Drum Cartridge  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  469

Replacing the Fusing Unit  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  473

Removing the Fusing Unit  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  473

Installing a Fusing Unit.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  474

Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd BTR), and the Retard 
Roller  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  475

Removing the Transfer Belt Unit .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  475

Installing a Transfer Belt Unit  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  478

Removing the 2nd BTR .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  481

Installing a 2nd BTR .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  481

Removing the Retard Roller in Tray1.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  482

Installing a Retard Roller in Tray1 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  483

Replacing the Waste Toner Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  484

Removing the Waste Toner Box .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  484

Installing a Waste Toner Box  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  485

Cleaning Inside the Printer .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  487

Cleaning the CTD Sensor  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  487

Cleaning the Raster Optical Scanner (ROS) Window .  .  .  .  .  .  .  .  .  .  .  .  .  492

Cleaning the Scanner .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  496

Cleaning the DADF Feed Roller .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  498

Adjusting Color Registration .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  498

Printing the Color Registration Chart  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  498



Template Last Updated - 2/7/2007 Contents 17

Determining Values .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   499

Entering Values  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   501

31 Removing Options  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   503

Removing the Optional Memory Module.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   503

Removing the Optional 550-Sheet Feeder .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   506

Removing the Optional Wireless Adapter .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   509

Removing the Optional Hard Disk  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   511

32 Clearing Jams  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   513

Avoiding Jams  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   513

Identifying the Location of Paper Jams  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   514

Clearing Paper Jams From the DADF  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   515

Clearing Paper Jams From the MPF .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   517

If error code: 050-112 appears:  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   517

If error code: 050-129 appears:  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   519

Clearing Paper Jams From Tray1 .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   520

Clearing Paper Jams From the Fusing Unit  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   521

If error code: 050-111 appears:  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   521

If error code: 050-129 appears:  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   523

Clearing Paper Jams From the Optional 550-Sheet Feeder .  .  .  .  .  .  .  .  .  .  .  .   527

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 529

33 Troubleshooting Guide .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   531

Basic Printer Problems.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   531

Display Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   531

Printing Problems  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   531

Print Quality Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   532

The output is too light .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   533

Toner smears or print comes off  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   534

Random spots/Blurred images  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   535



18 Contents Template Last Updated - 2/7/2007

The entire output is blank  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  536

Streaks appear on the output  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  537

Part or the entire output is black  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  537

Pitched color dots .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  538

Vertical blanks .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  539

Ghosting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  540

Light-induced fatigue  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  540

Fog .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  541

Bead-Carry-Out (BCO) .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  541

Jagged characters.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  542

Banding  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  543

Auger mark.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  544

Wrinkled/Stained paper .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  544

Damage on the leading edge of paper  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  545

Jam/Alignment Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  545

The top and side margins are incorrect .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  545

Color registration is out of alignment  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  546

Images are skewed  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  547

Tray1/Optional 550-Sheet Feeder Misfeed Jam .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  547

MPF Misfeed Jam .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  548

Regi Jam (Exit Sensor On JAM) .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  549

Exit Jam (Exit Sensor Off JAM)  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  550

Tray1/Optional 550-Sheet Feeder Multi-feed Jam .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  550

MPF Multi-feed Jam .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  551

Noise  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  551

Copy Problem .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  552

Fax Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  552

Scanning Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  554

Digital Certificate Problem .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  556

Problems With Installed Optional Accessories .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  558

Scanner Driver/Printer Utility Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  558

Other Problems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  559

Contacting Service .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  559



Template Last Updated - 2/7/2007 Contents 19

Appendix  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 561

B Appendix  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 563

Dell™ Technical Support Policy .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   563

Online Services  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   563

Warranty and Return Policy  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   564

Recycling Information .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   564

Contacting Dell .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .   564

Index  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  565



20 Contents Template Last Updated - 2/7/2007



21

Before Beginning

Notes, Cautions, and Warnings ..................................................... 23

1 Dell™ C3765dnf Multifunction Color Laser Printer User's Guide....25

2 Finding Information..................................................................... 27

3 Product Features......................................................................... 31

4 About the Printer ......................................................................... 33



22



Notes, Cautions, and Warnings 23

Notes, Cautions, and Warnings
 NOTE: A NOTE indicates important information that helps you make better use of your printer.

 CAUTION: A CAUTION indicates potential damage to hardware or loss of data if instructions are not followed.

 WARNING: A WARNING indicates a potential for property damage, personal injury, or death.

Information in this document is subject to change without notice.

© 2012 Dell Inc. All rights reserved.

Reproduction of these materials in any manner whatsoever without the written permission of Dell Inc. is strictly forbidden.

Trademarks used in this text: Dell and the DELL logo are trademarks of Dell Inc.; Microsoft, Windows, Windows Server, Windows Vista, and 
Active Directory are either trademarks or registered trademarks of Microsoft Corporation in the United States and/or other countries; Apple, 
Bonjour, iPad, iPhone, iPod touch, Macintosh, Mac OS, and TrueType are trademarks of Apple Inc., registered in the U.S. and other countries. 
AirPrint and the AirPrint logo are trademarks of Apple Inc.; Android, Google Chrome, Gmail, Google, Google Cloud Print, and Google Drive are 
either registered trademarks or trademarks of Google Inc.; Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries; Wi-Fi is a registered trademark of the Wi-Fi Alliance; Wi-Fi Protected Setup, WPA, and 
WPA2 are trademarks of the Wi-Fi Alliance; Red Hat and Red Hat Enterprise Linux are registered trademarks of Red Hat. Inc. in the U.S. and 
other countries; SUSE is a registered trademark of Novell, Inc., in the United States and other countries.

XML Paper Specification (XPS): This product may incorporate intellectual property owned by Microsoft Corporation. The terms and conditions 
upon which Microsoft is licensing such intellectual property may be found at http://go.microsoft.com/fwlink/?LinkId=52369; DES: This product 
includes software developed by Eric Young (eay@mincom.oz.au); AES: Copyright (c) 2003, Dr Brian Gladman, Worcester, UK. All rights 
reserved. This product uses published AES software provided by Dr Brian Gladman under BSD licensing terms; TIFF (libtiff): Copyright (c) 
1988-1997 Sam Leffler and Copyright (c) 1991-1997 Silicon Graphics, Inc.; ICC Profile (Little cms): Copyright (c) 1998-2004 Marti Maria.
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1
Dell™ C3765dnf Multifunction Color Laser Printer 
User's Guide
Click the links to the left for information on the features, options, and operation of your Dell C3765dnf 
Multifunction Color Laser Printer. For information on other documentation included with your Dell C3765dnf 
Multifunction Color Laser Printer, see "Finding Information."

 NOTE: In this manual, Dell C3765dnf Multifunction Color Laser Printer is referred to as the "printer."

Conventions
The following describe the meaning of the symbols and fonts used in this manual:

Bold texts : • Names of hardware button on the operator panel.

• Screen and tab names on the touch panel.

• Menus, commands, windows, or dialog boxes displayed on the computer screen.

Texts in Courier New font : • Menus and messages displayed on the touch panel.

• Characters entered from the computer.

• Directory paths.

< > : • Key on the keyboard of the computer.

→ : • Indicates a path to a certain item within a procedure on a computer.

" " : • Cross references in this manual.

• Characters entered from the operator panel.

• Messages displayed on the computer screen.
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2
Finding Information
What are you looking for? Find it here

• Drivers for my printer

• My User's Guide

Software and Documentation disc

The Software and Documentation disc contains setup video, documentation, 
and drivers for your printer. You can use the Software and Documentation disc to 
install drivers or access your setup video and documentation.

Readme files may be included on your Software and Documentation disc to 
provide last-minute updates about technical changes to your printer or advanced 
technical reference material for experienced users or technicians.

• How to use my printer Quick Reference Guide

 NOTE: Quick Reference Guide may not be included in the package for some 
regions.

Quick Reference Guide

About Your Printer

1

2

4

311

12

Service Tag  Express Service Code
xxxxxxx 000 000 000 00

111 2 3 4 5 6 7 8 9 10

61 51 41 213191 7 81 6 712022 12

Service Tag
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• Safety information

• Warranty information

Product Information Guide

 WARNING: Read and follow all safety instructions in the Product 
Information Guide prior to setting up and operating your printer.

• How to set up my printer Setup diagram

• Express Service Code and Service Tag

The Express Service Code and Service Tag are located inside the front cover of 
your printer.

• Latest drivers for my printer

• Documentation for my printer

Go to support.dell.com.

What are you looking for? Find it here

Setting Up Your Printer

54
a1

a2

b

1 2 3

Service Tag Express Service Code
xxxxxxx 000 000 000 00

http://support.dell.com
http://support.dell.com
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• Answers to technical service and support 
questions

support.dell.com provides several online tools, including:

• Solutions — Troubleshooting hints and tips, articles from technicians, and 
online courses 

• Upgrades — Upgrade information for components, such as the printer drivers

• Customer Care — Contact information, order status, warranty, and repair 
information 

• Downloads — Drivers 

• Manuals— Printer documentation and product specifications

Go to support.dell.com. Select your region, and fill in the requested details to 
access help tools and information.

What are you looking for? Find it here

http://support.dell.com
http://support.dell.com
http://support.dell.com
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3
Product Features
This chapter describes the product features and indicates their links.

Printing from USB Memory (USB Direct Print)

The USB Direct Print feature enables you to print files 
directly from a USB memory without requiring you to start 
your computer and an application.

Using the ID Card Copy (ID Card Copy)

You can copy both sides of an ID card on one side of a 
single sheet of paper in its original size by selecting ID 
Card Copy on the touch panel. This feature helps to 
show both sides of an ID card in one page in its original 
size.

Sending an E-Mail With the Scanned Image (Scan to E-mail)

When you want to send scanned data by e-mail, use the 
Scan to E-mail feature. You can directly send the data 
scanned as an e-mail attachment. You can choose 
destination e-mail addresses from the address book on the 
printer or server. Or, you can enter the address from the 
touch panel on the printer's operator panel.

Scanning to a PC or Server via SMB/FTP (Scan to Network)

You can transfer data scanned to a PC or a server via SMB 
or FTP without service software. Although prior 
registration of the destination FTP server or PC on the 
address book is required, it helps save your time.

Scanning to a USB Memory (Scan to USB Memory)

With the Scan to USB Memory feature, you don't need a 
PC to connect a USB memory. You can specify the USB 
memory inserted into the printer's port as a data saving 
location when you scan data.

Making Copies From the Document Glass (Scan From 
Document Glass)

You can scan the pages of a book or a brochure from the 
document glass. When you scan documents using the 
document glass, place them facing down.
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Making Copies From the DADF (Scan From DADF)

You can scan pieces of unbound paper using the duplex 
automatic document feeder (DADF). When you scan 
documents using the DADF, load them facing up.
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4
About the Printer
This chapter provides an overview of your Dell™ C3765dnf Multifunction Color Laser Printer.

Front and Rear View

Front View

1 Duplex Automatic Document Feeder (DADF) 9 Multipurpose Feeder (MPF)

2 Transfer Belt Unit 10 Toner Cartridges

3 Drum Cartridges 11 Front Cover

4 Waste Toner Box 12 Front USB Port

5 Right Side Cover 13 Output Tray Extension

6 Power Switch 14 Operator Panel

7 Tray1 15 Top Cover

8 Optional 550-Sheet Feeder (Tray2)

115

2

3

4

5

6
78

9

10

11 12

14
13
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Rear View

1 Control Board 8 "Blue" Plug

2 Left Side Cover 9 Duplex Unit

3 Ethernet Port 10 2nd Belt Transfer Roller (2nd BTR)

4 USB Port 11 Fusing Unit

5 Wireless Adapter Socket 12 Power Connector

6 Phone Connector 13 Rear Cover 

7 Wall Jack Connector

1

2

3

4

5

6

7

89

10

11

12

13
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Duplex Automatic Document Feeder (DADF)

Space Requirements
Provide enough room to open the printer trays, covers, and optional accessories, and for proper ventilation.

1 DADF Cover 4 Document Feeder Tray

2 Document Guides 5 DADF Feed Roller

3 Document Glass

1
2

3

4

5

320 mm/
12.60 inches

558 mm/
21.97 inches

400 mm/15.75 inches

530 mm/20.87 inches

600 mm/23.62 inches

400 mm/15.75 inches

530 mm/20.87 inches

400 mm/15.75 inches
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Operator Panel

For more information on the operator panel, see "About the Operator Panel."

Additional Components

Optional Accessories
The following optional accessories are available for the printer.

 NOTE: Each accessory can be purchased separately except for the wireless adapter and the hard disk, which can only be 
purchased together as a bundled kit.

• Wireless adapter

• 512MB memory module

• Hard disk

• Optional 550-sheet feeder

Non-bundled Items
The following items are required for connecting the printer to a computer or a network. Please purchase them as 
needed.

• USB cable

• Ethernet cable
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Securing the Printer
To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot on your printer.

For details, see the operating instructions supplied with the Kensington lock.

Ordering Supplies
You can order consumables from Dell online when using a networked printer. Enter the IP address of your printer in 
your web browser, launch the Dell Printer Configuration Web Tool, and click the web address under Order Supplies 
at: to order toner or supplies for your printer.

You can also order replacement toner cartridges or supplies from Dell by using the Dell Supplies Management 
System:

 NOTE: For Macintosh, start the Status Monitor Widget, and then select Order Supplies button to open Order window.

1 Double-click the icon on your desktop.

If you cannot find the icon on your desktop:

a Right-click DLRMM.EXE under x:\abc\Dell Printers\Additional Color Laser 
Software\Reorder, where x:\abc is the location where the printer software is installed.

b Choose Send To from the drop-down menu, and then click Desktop (create shortcut) on the submenu. 

The Dell Supplies Management System window appears.

You can also launch the Dell Supplies Management System by clicking Start → All Programs → Dell Printers → 
Additional Color Laser Software → Dell Supplies Management System.

2 Click the Visit Dell printer supplies ordering web site link (www.dell.com/supplies), or order Dell printer supplies 
by phone.

To ensure that you get the best service, have your Dell printer’s Service Tag ready.

For information regarding locating your Service Tag, see "Express Service Code and Service Tag."

Security Slot

Security Slot

http://www.dell.com/supplies
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Setting up the Printer (Printer 
Setup)

5 Preparing Printer Hardware...................................................... 41

6 Installing Optional Accessories................................................ 43

7 Connecting Your Printer ............................................................. 71

8 Setting the IP Address ............................................................... 83

9 Loading Paper.............................................................................. 87

10 Installing Printer Drivers on Windows® Computers ............. 91

11 Installing Printer Drivers on Macintosh Computers............ 111

12 Installing Printer Drivers on Linux Computers (CUPS) ...........117
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5
Preparing Printer Hardware

Removing Tape
1 Remove tapes and the protective sheet from the printer.
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6
Installing Optional Accessories
You can make the printer more functional by installing the optional accessories. This chapter describes how to install 
the printer's options such as the 512 MB memory module, optional 550-sheet feeder (tray2), wireless adapter, and 
hard disk.

Installing the Optional Memory Module
1 Ensure that the printer is turned off.

2 Turn the screw on the left side cover counterclockwise.

3 Slide the left side cover towards the back of the printer.

4 Open the left side cover completely.
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5 Hold the edge of the memory module and face its connector toward the slot with the notch on the connector 
positioned on left.

6 Align the connector of the memory module with the slot and insert the memory module into the slot.

7 Push the memory module firmly into the slot.

 NOTE: Ensure that the memory module is firmly fixed in the slot and does not move easily.

notch
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8 Close the left side cover, and then slide it towards the front of the printer.

9 Turn the screw clockwise.

10 Turn on the printer.

11 Print the system settings report to confirm that the newly installed memory is detected by the printer.

For details about how to print a system settings report, see "Report / List."

12 Confirm the amount of Memory Capacity listed in the system settings report under General.

If the memory capacity has not increased, turn off the printer, unplug the power cable, and re-install the memory 
module.

13 If you installed the optional memory module after installing the printer driver, update your driver by following the 
instructions for the operating system you are using. If the printer is on a network, update the driver for each client.

Updating Your Driver to Detect Memory Module

 NOTE: When you use XPS driver, driver updating is not required.

When Using PCL Driver

Microsoft® Windows® 8/
Windows 8 x64/
Windows Server® 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell™ C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.
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If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps:

1 Click the Options tab, and then select Memory Capacity in the Items list box.

2 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu in Change 
Setting for.

3 Click Apply, and then click OK.

4 Close the Printers and Faxes(Printers, or Devices and Printers) dialog box.

When Using PS Driver

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell™ C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.

Windows Vista®/Vista x64 1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows Server 2008/
Server 2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows XP/XP x64/
Server 2003/
Server 2003 x64

1 Click start → Printers and Faxes.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers and Faxes dialog box.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Devices and Printers dialog box.
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If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Memory Capacity in the Items list box.

3 Select the total amount of the installed printer memory in the Memory Capacity drop-down menu under Setting 
for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes (Printers, or Devices and Printers) dialog box.

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Devices and Printers dialog box.

Windows Vista/Vista x64 1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers dialog box.

Windows Server 2008/
Server 2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers dialog box.

Windows XP/XP x64/
Server 2003/
Server 2003 x64

1 Click Start → Printers and Faxes.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers and Faxes dialog box.

Mac OS® X 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences.
2 Select the printer in Printers list, and click Options & Supplies.
3 Select Driver, select the options that have been installed on the printers, and then click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.
2 Select the printer in Printers list, and click Options & Supplies.
3 Select Driver, select the options that have been installed on the printers, and then click OK.
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Installing the Optional 550-Sheet Feeder
 WARNING: If you install the optional 550-sheet feeder after setting up the printer, be sure to turn off the printer, unplug the 

power cable, and disconnect all cables from the back of the printer before starting this task.

1 Ensure that the printer is turned off, and then disconnect all cables from the back of the printer.

2 Remove the tape and the bag holding the screws.

 NOTE: Do not lose the screws because you will need them later.

3 Place the optional 550-sheet feeder in the same location that the printer is located.

4 Pull tray1 out of the printer about 200 mm. 

5 Hold tray1 with both hands, and remove it from the printer.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup Utility).
2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show 

Info.
3 Select Installable Options, and select the options that have been installed on the printer, 

and then click Apply Changes.
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6 Lift the printer and align the five guide pins of the optional 550-sheet feeder with the holes at the bottom of the 
printer. Gently lower the printer onto the optional 550-sheet feeder.

 WARNING: Two people are required to lift the printer. 

 WARNING: Be careful not to pinch your fingers when lowering the printer onto the optional 550-sheet feeder. 

7 Secure the optional 550-sheet feeder to the printer by tightening the two screws provided with the feeder, using a 
coin or similar object.
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8 Insert tray1 into the printer, and push until it stops.

9 Re-connect all cables into the back of the printer, and turn on the printer.

 NOTE: The printer will automatically detect the attached tray but will not detect the paper type.

10 Print the system settings report to confirm that the optional 550-sheet feeder is installed correctly.

For details about how to print a system settings report, see "Report / List."

11 Confirm Tray2 (550 Sheet Feeder) is listed in the system settings report under Printer Options.

If the feeder is not listed, turn off the printer, unplug the power cable, and re-install the optional 550-sheet feeder.

12 After loading paper in the optional 550-sheet feeder, specify the paper type from the printer touch panel.

a Press the  (Information) button.

b Select the Tools tab, and then select Tray Management.

c Select Tray Settings.

d Select Tray2.

e Select Type.

f Select  until the desired paper type appears, and then select the desired paper type.

g Select OK.

13 If you installed the optional 550-sheet feeder after installing the printer driver, update your driver by following the 
instructions for each operating system. If the printer is on a network, update the driver for each client.

Updating Your Driver to Detect 550-Sheet Feeder

When Using PCL Driver

Windows 8/
Windows 8 x64/
Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.
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If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps:

1 Click the Options tab, and then select Paper Tray Configuration in the Items list box.

2 Select Tray2 in the Paper Tray Configuration drop-down menu in Change Setting for.

3 Click Apply, and then click OK.

4 Close the Printers and Faxes(Printers, or Devices and Printers) dialog box.

When Using PS Driver

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.

Windows Vista/Vista x64 1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows Server 2008/
Server 2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows XP/XP x64/
Server 2003/
Server 2003 x64

1 Click start → Printers and Faxes.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers and Faxes dialog box.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Devices and Printers dialog box.
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If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Paper Tray Configuration in the Items list box.

3 Select Tray2 in the Paper Tray Configuration drop-down menu in Setting for.

4 Click OK.

5 Click Apply, and then click OK.

6 Close the Printers and Faxes (Printers, or Devices and Printers) dialog box.

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Devices and Printers dialog box.

Windows Vista/Vista x64 1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers dialog box.

Windows Server 2008/
Server 2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers dialog box.

Windows XP/XP x64/
Server 2003/
Server 2003 x64

1 Click Start → Printers and Faxes.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers and Faxes dialog box.

Mac OS X 10.7.x/10.8.x 1 Select the Print & Scan in System Preferences.
2 Select the printer in Printers list, and click Options & Supplies.
3 Select Driver, select the options that have been installed on the printers, and then click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.
2 Select the printer in Printers list, and click Options & Supplies.
3 Select Driver, select the options that have been installed on the printers, and then click OK.
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When Using XPS Driver

 NOTE: The XPS driver does not support Windows XP, XP x64, and Windows Server 2003. 

Installing the Optional Wireless Adapter
The wireless adapter allows you to use the printer with wireless network connection. 

The specifications of the wireless adapter are described below.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup Utility).
2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show 

Info.
3 Select Installable Options, and select the options that have been installed on the printer, 

and then click Apply Changes.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.

Windows Vista/Vista x64 1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows Server 2008/
Server 2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Device Setting tab, and then select Available in Tray2 drop-down menu.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Item Specification

Connectivity Technology Wireless

Compliant Standards IEEE 802.11b, 802.11g, and 802.11n

Bandwidth 2.4 GHz
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*1 This item is available only when the optional hard disk is installed.
*2 EAP method supports PEAPv0, EAP-TLS, EAP-TTLS PAP, and EAP-TTLS CHAP.
*3 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, 

WPA-PSK AES, WPA2-PSK AES, WPA-PSK TKIP, Open (No Security)

 NOTE: When the wireless adapter is installed, you cannot use IEEE 802.1x authentication and/or the Ethernet port for a wired 
connection.

Verifying the Contents of the Box

 NOTE: To complete wireless installation, you require the corresponding Software and Documentation disc that comes with your 
printer, which can also be downloaded from support.dell.com.

Installing the Wireless Adapter Using Video Instructions (Recommended)
To install the wireless adapter, perform the following method.

1 Insert the Software and Documentation disc in your computer. The Easy Setup Navigator file launches 
automatically. 

2 Select Optional Accessories Setup on the Easy Setup Navigator window.

Data Transfer Rate IEEE 802.11n: 65 Mbps
IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps
IEEE 802.11b: 11, 5.5, 2, and 1 Mbps

Security 64 (40-bit key)/128 (104-bit key) WEP, 
WPA- PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES)*1*2, 
WPA2-Enterprise (AES)*1*2

Wi-Fi Protected Setup® (WPS)*3 Push-Button Configuration (PBC), 
Personal Identification Number (PIN)

Item Specification

Installing the Optional 
Wireless Adapter

Wireless Adapter

http://support.dell.com
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3 Click Wireless adapter.

The instruction video starts.

Follow the on-screen instructions to configure wireless settings.

Installing the Optional Wireless Adapter

 NOTE: You can also install the wireless adapter by following the instructions described in Installing the Optional Wireless 
Adapter provided with the wireless adapter.

1 Ensure that the printer is turned off. 

2 Align the connector and the three protrusions of the wireless adapter with the four holes and insert the adapter.

 NOTE: Ensure that the adapter is fully inserted and secured.
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3 Turn on the printer.

 NOTE: If a message displays telling you to make initial setup on the touch panel, always do as instructed.

4 Print the system settings report to confirm that the wireless adapter is installed correctly.

For details about how to print a system settings report, see "Report / List."

5 Confirm that the Network (Wireless) section exists.

6 Configure the wireless adapter to connect to a wireless network. For details, see "Configuring the Optional 
Wireless Adapter."

Determining the Wireless Network Settings
You need to know the settings for the wireless network to set up the wireless printer. For details of the settings, 
contact your network administrator.

Wireless Settings SSID Specifies the name that identifies the wireless network with up to 32 
alphanumeric characters.

Network Mode Specifies the network mode from Ad-hoc or Infrastructure.

Security Settings Security Selects the encryption type from No Security, Mixed mode PSK*, WPA-PSK-
TKIP, WPA2-PSK-AES, and WEP.

Transmit Key Specifies the transmit key from the list.

WEP Key Specifies the WEP key used through the wireless network only when WEP is 
selected as the encryption type.

Pass Phrase Specifies the pass phrase of alphanumeric characters from 8 to 63 bytes long 
only when Mixed mode PSK*, WPA-PSK-TKIP, or WPA2-PSK-AES is 
selected as the encryption type.

* Mixed mode PSK automatically selects an available encryption type from WPA-PSK-TKIP, WPA-PSK-AES, or WPA2-PSK-AES.
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Configuring the Optional Wireless Adapter
This section describes how to configure a wireless adapter through Easy Setup Navigator.

You can select a method to configure a wireless adapter from the following:

 NOTE: The optional wireless adapter must be installed on the printer. For information on how to install a wireless adapter, see 
"Installing the Optional Wireless Adapter."

 NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu.

 NOTE: For details about using WPA-Enterprise-AES, WPA2-Enterprise-AES, or WPA-Enterprise-TKIP, see "Using Digital 
Certificates."

Using Wizard Setup to Configure a Wireless Adapter
1 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 

Navigator file launches automatically. 

2 Click Start Setup.

Wizard Setup through USB Cable(recommended)

Advanced Setup through

WPS-PBC*1*3

WPS-PIN*2*3

Operator Panel

Ethernet Cable

Dell Printer Configuration Web Tool

*1 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for wireless 
configuration, by pressing the button provided on the access point via wireless routers, and then performing WPS-PBC setting on the 
operator panel. This setting is available only when the access point supports WPS.

*2 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required for wire-
less configuration, by entering PIN assignments in the printer and computer. This setting, performed through access point, is available 
only when the access points of your wireless router supports WPS.

*3 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed mode PSK, WPA-PSK AES, WPA2-
PSK AES, WPA-PSK TKIP, Open (No Security)
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3 Click Connect Your Printer.

4 Click Wireless Connection.

5 Click Wizard.

Follow the on-screen instructions to configure wireless settings.
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Using Advanced Setup to Configure a Wireless Adapter
You can configure the wireless adapter with the following connection methods:

• WPS-PBC

• WPS-PIN

• Operator Panel

• Ethernet Cable

• Dell Printer Configuration Web Tool

1 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 
Navigator file launches automatically. 

2 Click Start Setup.

3 Click Connect Your Printer.

4 Click Wireless Connection.
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5 Select Advanced, and then select a connection method from WPS-PBC, WPS-PIN, Operator Panel, Ethernet 
Cable, or Dell Printer Configuration Web Tool.

For Ethernet Cable:

a Select Ethernet Cable, and then click Next.

Follow the on-screen instructions to configure wireless settings, and then click Next.

The Advanced Configuration Tool starts.

b Select the printer, and then click Next.

Wireless Network Settings screen appears.

 NOTE: If the printer is not listed, click Enter IP Address and enter the IP address of your printer, and then click OK.

c Set the wireless network settings, and then click Next.

IP Address Settings screen appears.

 NOTE: For details on each item, see "Assigning an IP Address."

d Set the IP address settings of the printer, and then click Next.

Confirm the settings screen appears.

e Confirm the settings, and then click Apply.

Complete configuration screen appears.

f Click Next.

For WPS-PBC, WPS-PIN, Operator Panel, and Dell Printer Configuration Web Tool, follow the on-screen 
instructions to configure wireless settings.

To configure wireless settings without using the video instructions, see the following instructions.

WPS-PIN

The PIN code of WPS-PIN can only be configured from the operator panel.

 NOTE: WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices 
required for wireless configuration by entering PIN assignments to a printer and computer. This setting, performed through an 
access point, is available only when the access points of your wireless router supports WPS.

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Network appears, and then select Network.

4 Select  until Wireless appears, and then select Wireless.

5 Select  until WPS Setup appears, and then select WPS Setup.

6 Select PIN Code.

7 Write down the displayed 8-digit PIN code or select Print PIN Code. The PIN code is printed.

8 Select Start Configuration.

9 Ensure that the message Setting WPS is displayed, and enter the PIN code displayed on step 7 into the wireless 
LAN access point (Registrar).

 NOTE: For WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN access 
point.

10 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.
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WPS-PBC

You can start Push Button Control only from the operator panel.

 NOTE: WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required 
for wireless configuration by pressing the button provided on the access point via wireless routers, and then performing WPS-
PBC setting on the operator panel. This setting is available only when the access point supports WPS.

 NOTE: Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless LAN access 
point. For information about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless 
LAN access point.

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Network appears, and then select Network.

4 Select  until Wireless appears, and then select Wireless.

5 Select  until WPS Setup, and then select WPS Setup.

6 Select Push Button Control.

7 Select Start Configuration.

Ensure that the message Setting WPS is displayed, and start the WPS-PBC on the wireless LAN access point 
(Registrar) within two minutes.

8 When the WPS operation is successful and the printer is rebooted, wireless LAN connection setting is completed.

Operator Panel

Auto SSID Setup

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Network appears, and then select Network.

4 Select  until Wireless appears, and then select Wireless.

5 Select  until Wireless Setup Wizard appears, and then select Wireless Setup Wizard.

The printer automatically searches the access points on wireless network.

6 Select  until the desired access point appears, and then select the access point.

If  the desired access point does not appear,  go to "Manual SSID Setup."

 NOTE: Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the router.

7 Select Next.

8 Enter the WEP key or pass phrase.

When the encryption type of the selected access point is WEP in step 6:

a Select the WEP Key text box, and then enter the WEP key.

b Select OK.

When the encryption type of the selected access point is WPA, WPA2 or Mixed in step 6:

a Select the Pass Phrase text box, and then enter the pass phrase.

b Select OK.

9 The Restart System screen appears. 

10 Turn off the printer, and turn it on again to apply the settings.
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Wireless LAN connection setting is complete.

Manual SSID Setup

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Network appears, and then select Network.

4 Select  until Wireless appears, and then select Wireless.

5 Select  until Wireless Setup Wizard appears, and then select Wireless Setup Wizard.

6 Select the Manual SSID Setup check box, and then select Next.

7 Enter the SSID, and then select Next.

8 Select the network mode from Infrastructure and Ad-hoc depending on your environment, and then 
select Next.

If you select Infrastructure, proceed to step 9.

If you select Ad-hoc, proceed to step 10.

9 Select the encryption type from No Security, Mixed mode PSK, WPA-PSK-TKIP, WPA2-PSK-AES, or 
WEP.

If you do not set security for your wireless network:

a Select  until No Security appears, and then select No Security.

b Select OK.

To use Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES encryption:

a Select  until Mixed mode PSK, WPA-PSK-TKIP, or WPA2-PSK-AES appears, and then select the 
desired encryption type.

b Select the Pass Phrase text box, and then enter the pass phrase.

c Select OK.

To use WEP encryption:

a Select  until WEP appears, and then select WEP.

b Select the WEP Key text box, and then enter the WEP key.

c Select Transmit Key, and then select the desired transmit key from Auto or WEP Key 1 to WEP Key 4.

d Select OK.

Proceed to step 11.

10 Select the encryption type from No Security or WEP.

If you do not set security for your wireless network:

a Select  until No Security appears, and then select No Security.

b Select OK.

To use WEP encryption:

a Select  until WEP appears, and then select WEP.

b Select the WEP Key text box, and then enter the WEP key.

c Select Transmit Key, and then select the desired transmit key from Auto or WEP Key 1 to WEP Key 4.

d Select OK.

11 The Restart System screen appears.
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12 Turn off the printer, and turn it on again to apply the settings.

Wireless LAN connection setting is complete.

Dell Printer Configuration Web Tool

 NOTE: For details about using WPA-Enterprise-AES, WPA2-Enterprise-AES, or WPA-Enterprise-TKIP, see "Using Digital 
Certificates."

1 Ensure that the printer is turned off and the wireless adapter is connected to the printer.

2 Connect the printer to the network with an Ethernet cable.

For details about how to connect the Ethernet cable, see "Connecting Printer to Computer or Network."

3 Turn on the printer.

4 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser.

5 Click Print Server Settings.

6 Click Print Server Settings tab.

7 Click Wireless LAN.

8 Enter the SSID in the SSID text box.

9 Select Ad-Hoc or Infrastructure in the Network Type drop-down list box.

10 Select the encryption type from No Security, WEP, WPA-PSK-TKIP, WPA-PSK-AES/WEP2-PSK AES, and Mixed 
Mode PSK in the Encryption drop-down list box, and then set each item for the encryption type selected.

 NOTE: For details on each item, see "Dell™ Printer Configuration Web Tool."

11 Click Apply New Settings to apply the settings.

12 Turn off the printer, disconnect the Ethernet cable and turn it on again.

Wireless LAN connection setting is complete.

Reconfiguring the Wireless Setting
To change the wireless setting through an Ethernet or wireless connection from your computer, perform the 
following.

 NOTE: To change the wireless setting through wireless connection, ensure that the wireless connection setting is completed in 
"Configuring the Optional Wireless Adapter." 

 NOTE: The following settings are available when the network mode is set to infrastructure in "Configuring the Optional Wireless 
Adapter." 

1 Check the IP address of the printer.

a Press the  (Information) button.

b Select About This MFP.

c Select the Network tab.

d Select  button until IP(v4) Address appears, and then check the IP address displayed in the 
IP(v4) Address.
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2 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser.

3 Click Print Server Settings.

4 Click Print Server Settings tab.

5 Click Wireless LAN.

6 Change the wireless setting of the printer.

7 Reboot the printer.

8 Change the wireless settings on your computer or access point accordingly.

 NOTE: To change the wireless settings on your computer, refer to the manuals provided with the wireless adapter or if 
your computer provides a wireless adapter tool, change the wireless settings using that tool. 

Installing the Optional Hard Disk 
1 Ensure that the printer is turned off. 

2 Turn the screw on the control board counterclockwise. 
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3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 

5 Insert the two plastic pins on the hard disk into the metal casing holes. 
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6 Attach the plastic pin and the connector to the control board, and push the hard disk firmly into place.

7 Close the left side cover, and then slide it towards the front of the printer. 

8 Turn the screw clockwise. 

9 Turn on the printer. 

10 Print the system settings report to confirm that the newly installed hard disk is detected by the printer.

For details about how to print a system settings report, see "Report / List."

11 Confirm the amount of Hard Disk listed in the system settings report under Printer Options.

If the hard disk is not listed, turn off the printer, unplug the power cable, and re-install the hard disk.

12 If you installed the hard disk after installing the printer driver, update your driver by following the instructions for 
the operating system you are using. If the printer is on a network, update the driver for each client.

Hard disk can be specified on the printer driver only when hard disk or RAM disk is available on the printer driver.
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Updating Your Driver to Detect Hard Disk

 NOTE: When you use XPS driver, driver updating is not required.

When Using PCL Driver

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps:

1 Click the Options tab, and then select Hard Disk in the Items list box.

2 Select Available in the Hard Disk drop-down menu in Change Setting for.

3 Click Apply, and then click OK.

4 Close the displayed active dialog box.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Devices and Printers dialog box.

Windows Vista/
Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows Server 2008/
Server 2008 x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers dialog box.

Windows XP/XP x64/
Server 2003/
Server 2003 x64

1 Click start → Printers and Faxes.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Options tab, and then select Get Information from Printer.
4 Click Apply, and then click OK.
5 Close the Printers and Faxes dialog box.
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When Using PS Driver

If the printer information is not updated automatically after clicking Get Information from Printer, follow these 
steps:

1 Click the Configuration tab, and then select Installable Options.

2 Select Hard Disk in the Items list box.

3 Select Available in the Hard Disk drop-down menu in Setting for.

4 Click OK.

5 Click Apply, and then click OK.

Windows 8/
Windows 8 x64/
Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware and Sound (Hardware for Windows Server 2012) → Devices 
and Printers.

2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 
then select Printer properties.

3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Devices and Printers dialog box.

Windows 7/
7 x64/
Server 2008 R2 x64

1 Click Start → Devices and Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Printer properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Devices and Printers dialog box.

Windows Vista/
Vista x64

1 Click Start → Control Panel → Hardware and Sound → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers dialog box.

Windows Server 2008/Server 2008 
x64

1 Click Start → Control Panel → Printers.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers dialog box.

Windows XP/XP x64/Server 
2003/Server 2003 x64

1 Click Start → Printers and Faxes.
2 Right-click the printer icon of the Dell C3765dnf Multifunction Color Laser Printer, and 

then select Properties.
3 Click the Configuration tab, and then select Bi-Directional Setup.
4 Select Get Information from Printer and then click OK.
5 Click Apply, and then click OK.
6 Close the Printers and Faxes dialog box.
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6 Close the Printers and Faxes (Printers, or Devices and Printers) dialog box.

Mac OS X 10.7.x/10.8.x 1  Select the Print & Scan in System Preferences.
2 Select the printer in Printers list, and click Options & Supplies.
3 Select Driver, select the options that have been installed on the printers, and then click OK.

Mac OS X 10.5.x/10.6.x 1 Select the Print & Fax in System Preferences.
2 Select the printer in Printers list, and click Options & Supplies.
3 Select Driver, select the options that have been installed on the printers, and then click OK.

Mac OS X 10.3.x/10.4.x 1 Select the printer from the Printer List screen in Print Center (or Printer Setup Utility).
2 Click Printers on the Print Center (or Printer Setup Utility) menu bar, and select Show 

Info.
3 Select Installable Options, and select the options that have been installed on the printer, 

and then click Apply Changes.
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7
Connecting Your Printer
Your Dell™ C3765dnf Multifunction Color Laser Printer interconnection cable must meet the following 
requirements:

Connection type Connection specifications

Ethernet 10 Base-T/100 Base-TX/1000 Base-T

USB USB 2.0

Wireless (optional) IEEE 802.11b/802.11g/802.11n

Phone connector RJ11

Wall jack connector RJ11

1 Ethernet port

2 USB port

3 Wireless adapter socket

4 Phone connector

5 Wall jack connector

1

2

3

4

5
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Connecting Printer to Computer or Network

Direct Connection
A local printer is a printer which is directly connected to your computer using the USB cable. If your printer is 
connected to a network instead of your computer, skip this section and go to "Network Connection."

To connect the printer to a computer:

1 Connect the smaller USB connector into the USB port at the back of the printer.

 NOTE: Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

2 Connect the other end of the cable into a USB port of the computer. 

 CAUTION: Do not connect the printer USB cable to the USB port available on the keyboard.

1 USB port

1

1
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Network Connection
To connect the printer to a network:

1 Connect the Ethernet cable.

To connect the printer to the network, connect one end of an Ethernet cable into the Ethernet port on the rear of 
the printer, and the other end to a LAN drop or hub. To setup a wireless connection, insert the wireless adapter into 
the wireless adapter socket on the back of the printer.

For a wireless connection, see "Installing the Optional Wireless Adapter."

 NOTE: To use the wireless adapter, be sure to disconnect the Ethernet cable.

Connecting the Telephone Line
 CAUTION: Do not connect your printer directly to a Digital Subscriber Line (DSL). This may damage the printer. To use a DSL, 

you will need to use an appropriate DSL filter. Contact your service provider for the DSL filter.

1 Connect one end of a telephone line cord into the wall jack connector and the other end into an active wall jack.

1 Ethernet port

1

1

Wall jack connector

To the wall jack
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2 Remove the "Blue" plug from the phone connector.

3 To connect a telephone and/or answering machine to your printer, Connect the telephone or answering machine 
line cord into the phone connector ( ).

If the phone communication is serial in your country (such as Germany, Sweden, Denmark, Austria, Belgium, Italy, 
France and Switzerland), and that you are supplied with a "Yellow" terminator, insert the "Yellow" terminator into 
the phone connector ( ).

Phone connector"Blue" plug

Phone connector
To an external telephone or 
answering machine

Phone connector

"Yellow" terminator
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Turning on the Printer
 WARNING: Do not use extension cords or power strips.

 WARNING: The printer should not be connected to an Uninterruptible Power Supply (UPS) system.

1 Connect the power cable to the power connector on the rear of the printer, and then to a power source.

2 Turn on the printer. When the printer is connected via a USB (Uninterruptible Power Supply) cable, the USB 
driver is automatically installed.

Setting Initial Settings on the Operator Panel
You need to set the printer language, country, clock date, time, and fax settings when you turn on printer for the first 
time.

When you turn the printer on, the wizard screen to perform the initial setup appears on the touch panel. Follow the 
steps below to set the initial settings.

 NOTE: If you do not start configuring the initial settings, the printer automatically restarts in three minutes, and the Main Home 
screen appears on the touch panel. After that, you can set the following initial setup by enabling Power on Wizard on the 
touch panel or Dell Printer Configuration Web Tool if needed.

For more information on operator panel, see "Operator Panel."

For more information on Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration Web Tool."

1 The Select Your Language screen appears. 

a Select  until desired language appears, and then select the desired language.

English

Français

Italiano

Deutsch

Español

Dansk

Nederlands
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b Select Next.

2 The Date/Time screen appears. 

a Select Time Zone.

b Select  until the desired geographic region appears, and then select the desired geographic region.

c Select  until the desired time zone appears, and then select the desired time zone.

Norsk

Svenska

Geographic Region Time Zone

Africa (UTC) Accra, Bamako, Dakar, Nouakchott

(UTC) Casablanca

(UTC +01:00) Algiers, Douala, Libreville, Luanda

(UTC +01:00) Tunis

(UTC +01:00) Windhoek

(UTC +02:00) Cairo

(UTC +02:00) Harare, Johannesburg, Kinshasa, Tripoli

(UTC +03:00) Addis Ababa, Khartoum, Mogadishu, Nairobi 

Americas (UTC -10:00) Adak

(UTC -09:00) Alaska

(UTC -08:00) Pacific Time (US & Canada)

(UTC -08:00) Tijuana

(UTC -07:00) Arizona, Dawson Creek, Sonora

(UTC -07:00) Chihuahua, Mazatlan

(UTC -07:00) Mountain Time (US & Canada)

(UTC -06:00) Cancun, Mexico City, Monterrey

(UTC -06:00) Central America

(UTC -06:00) Central Time (US & Canada) 

(UTC -06:00) Saskatchewan

(UTC -05:00) Atikokan, Resolute

(UTC -05:00) Bogota, Lima, Panama, Quito

(UTC -05:00) Cayman Islands, Jamaica, Port-au-Prince

(UTC -05:00) Eastern Time (US & Canada)

(UTC -05:00) Grand Turk

(UTC -05:00) Havana

(UTC -04:30) Caracas

(UTC -04:00) Asuncion

(UTC -04:00) Atlantic Time (Canada)

(UTC -04:00) Blanc-Sablon

(UTC -04:00) Caribbean Islands

(UTC -04:00) Cuiaba
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Americas (UTC -04:00) Georgetown, La Paz, Manaus

(UTC -04:00) Thule

(UTC -03:30) St. John's

(UTC -03:00) Brasilia, Cayenne, Paramaribo

(UTC -03:00) Buenos Aires

(UTC -03:00) Greenland

(UTC -03:00) Miquelon

(UTC -03:00) Montevideo

(UTC -02:00) Noronha 

Antarctica (UTC -04:00) Palmer Archipelago, Santiago

(UTC -03:00) Rothera

(UTC +03:00) Syowa

(UTC +06:00) Mawson, Vostok

(UTC +07:00) Davis

(UTC +08:00) Casey

(UTC +10:00) Dumont d'Urville

(UTC +12:00) McMurdo 

Asia (UTC +02:00) Amman

(UTC +02:00) Beirut

(UTC +02:00) Damascus

(UTC +02:00) Jerusalem

(UTC +02:00) Nicosia

(UTC +02:00) Palestine

(UTC +03:00) Aden, Baghdad, Qatar, Riyadh

(UTC +03:30) Tehran

(UTC +04:00) Baku

(UTC +04:00) Dubai, Muscat, Tbilisi

(UTC +04:00) Yerevan

(UTC +04:30) Kabul

(UTC +05:00) Aqtau, Aqtobe, Ashgabat, Samarkand

(UTC +05:00) Ekaterinburg

(UTC +05:00) Karachi

(UTC +05:30) Colombo, Kolkata

(UTC +05:45) Kathmandu

(UTC +06:00) Almaty, Bishkek, Dhaka, Thimphu

(UTC +06:00) Novosibirsk, Omsk

(UTC +06:30) Yangon (Rangoon)

(UTC +07:00) Bangkok, Ho Chi Minh, Hovd, Jakarta

(UTC +07:00)  Krasnoyarsk

(UTC +08:00) Chongqing, Hong Kong, Shanghai

(UTC +08:00) Irkutsk

Geographic Region Time Zone
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Asia (UTC +08:00) Kuala Lumpur, Makassar, Manila, Singapore

(UTC +08:00) Taipei

(UTC +08:00) Ulaan Baatar

(UTC +09:00) Dili, Jayapura

(UTC +09:00) Pyongyang

(UTC +09:00) Seoul

(UTC +09:00) Tokyo

(UTC +09:00) Yakutsk

(UTC +10:00) Sakhalin, Vladivostok

(UTC +11:00) Magadan

(UTC +12:00) Anadyr, Kamchatka

Atlantic Ocean (UTC -04:00) Bermuda

(UTC -04:00) Stanley

(UTC -02:00) South Georgia Island

(UTC -01:00) Azores, Scoresbysund

(UTC -01:00) Cape Verde

(UTC) Reykjavik 

Australia (UTC +08:00) Perth

(UTC +08:45) Eucla

(UTC +09:30) Adelaide

(UTC +09:30) Darwin

(UTC +10:00) Brisbane, Lindeman

(UTC +10:00) Hobart, Melbourne, Sydney

(UTC +10:30) Lord Howe Island

Europe (UTC) Dublin, Edinburgh, Lisbon, London

(UTC +01:00) Amsterdam, Berlin, Rome, Stockholm, Vienna

(UTC +01:00) Belgrade, Bratislava, Budapest, Prague

(UTC +01:00) Brussels, Copenhagen, Madrid, Paris

(UTC +01:00) Sarajevo, Skopje, Warsaw, Zagreb

(UTC +02:00) Athens, Bucharest, Istanbul

(UTC +02:00) Helsinki, Kiev, Riga, Sofia

(UTC +02:00) Kaliningrad, Minsk

(UTC +03:00) Moscow

(UTC +04:00) Samara

Indian Ocean (UTC +03:00) Antananarivo, Comoro Islands, Mayotte

(UTC +04:00) Mahe, Reunion

(UTC +04:00) Mauritius

(UTC +05:00) Kerguelen, Maldives

(UTC +06:00) Chagos

(UTC +06:30) Cocos Islands

(UTC +07:00) Christmas Island

Geographic Region Time Zone
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d Select OK.

e Select Date.

f Select a data format from the menu displayed by selecting Format.

g After selecting the box under Year, select  or , or use the number pad to enter the desired value. 
Repeat this step to enter the desired value for Month and Day.

h Select OK.

i Select Time.

j Select the time format from 12 Hour or 24 Hour. If you select 12 Hour, select AM or PM.

k After selecting the box under Hour, use the number pad to enter the desired value. Repeat this step to enter 
the desired value for Minute.

l Select OK.

m Select Next.

3 The Fax (Do you want to setup Fax Now?) screen appears. 

To set Fax settings, select Yes, Setup FAX and follow the procedure below. To end the settings, select No, 
I'll Do It Later and proceed to Step 4. 

a Enter the fax number of the printer using the number pad.

b Select Country.

c Select  until the desired country appears, and then select the desired country.

The default paper size is automatically set when you select a country.

Pacific Ocean (UTC -11:00) Midway Island, Niue, Samoa

(UTC -10:00) Cook Islands, Hawaii, Tahiti

(UTC -09:30) Marquesas Islands

(UTC -09:00) Gambier Islands

(UTC -08:00) Pitcairn Islands

(UTC -06:00) Easter Island

(UTC -06:00) Galapagos Islands

(UTC +09:00) Palau

(UTC +10:00) Guam, Port Moresby, Saipan

(UTC +11:00) Efate, Guadalcanal, Kosrae

(UTC +11:30) Norfolk Island

(UTC +12:00) Auckland

(UTC +12:00) Fiji, Marshall Islands

(UTC +12:45) Chatham

(UTC +13:00) Tongatapu

(UTC +14:00) Kiritimati 

YYYY/MM/DD

DD/MM/YYYY

MM/DD/YYYY

Geographic Region Time Zone
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Algeria A4

Australia A4

Austria A4

Belgium A4

Bulgaria A4

Canada Letter

Colombia Letter

Costa Rica Letter

Cyprus A4

Czech Republic A4

Denmark A4

Dominican Republic Letter

Egypt A4

Estonia A4

Finland A4

France A4

Germany A4

Greece A4

Guatemala Letter

Hungary A4

Iceland A4

Ireland A4

Italy A4

Jamaica Letter

Jordan A4

Latvia A4

Liechtenstein A4

Lithuania A4

Luxembourg A4

Malta A4

Mexico Letter

Netherlands A4

New Zealand A4

Nicaragua Letter

Norway A4

Panama Letter

Poland A4

Portugal A4

Puerto Rico Letter

Romania A4

Russia A4
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d Select Next.

4 The Setup Complete (Congratulations, setup is complete.) screen appears.

5 Select Done.

The printer automatically restarts after selecting Done.

Saudi Arabia A4

Slovakia A4

Slovenia A4

South Africa A4

Spain A4

Sweden A4

Switzerland A4

Tunisia A4

Turkey A4

U.A.E. A4

United Kingdom A4

United States Letter

Unknown Letter
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8
Setting the IP Address

Assigning an IP Address
An IP address is a unique number that consists of four sections that are delimited by a period and can include up to 
three digits in each section, for example, 111.222.33.44.

You can select the IP mode from Dual Stack, IPv4, and IPv6. If your network supports both IPv4 and IPv6, select 
Dual Stack. 

Select the IP mode of your environment, and then set IP address, subnet mask (for IPv4 only), and gateway address.

 CAUTION: Assigning an IP address that is already in use can cause network performance issues.

 NOTE: Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

 NOTE: When you assign an IP address manually in IPv6 mode, use the Dell™ Printer Configuration Web Tool. To display the Dell 
Printer Configuration Web Tool, use the link-local address. To confirm the link-local address, print a system settings report and 
check the Link-Local Address under Network (Wired) or Network (Wireless). 
For details about how to print a system settings report, see "Report / List."

 NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu.

When Using the Easy Setup Navigator
1 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 

Navigator file launches automatically. 

2 Click Advanced Tools on the Easy Setup Navigator window.
The Advanced Tools window opens.

3 Click IP Configuration.

4 Follow the instructions displayed on the screen.

When Using the Operator Panel
For more information on using the operator panel, see "Operator Panel."

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Network.
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4 Do either of the following:

When connecting to network with the Ethernet cable:

Select Ethernet.

When connecting to network with the wireless adapter:

Select Wireless.

5 Select IP Mode.

6 Select IPv4 Mode, and then select OK. 

7 Select TCP / IP.

8 Select Get IP Address.

9 Select Panel, and then select OK.

10 Select IP Address.

The cursor is located at the first octet of the IP address.

11 Use the number pad to enter the first octet of the IP address, and then select .

The cursor moves to the next digit.

 NOTE: You can only enter one octet at a time and must select  after entering each octet.

12 Enter the rest of the octets, and then select OK. 

13 Select Subnet Mask.

14 Repeat steps 11 and 12 to set Subnet Mask.

15 Select Gateway Address.

16 Repeat steps 11 and 12 to set Gateway Address.

17 Turn off the printer, and then turn it on again.

When Using the Tool Box
1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box."

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select TCP/IP Settings from the list at the left side of the page.

The TCP/IP Settings page appears.

4 Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway 
Address.

5 Click Apply New Settings to take effect.

You can also assign the IP address to the printer when installing the printer drivers with the installer. When you use the 
Network Installation feature, and the Get IP Address is set to AutoIP or DHCP on the printer, you can set the IP 
address from 0.0.0.0 to the desired IP address on the printer selection window. 
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Verifying the IP Settings
You can confirm the settings by using the operator panel, printing the system settings report, or using the ping 
command.

Verifying the Settings Using Operator Panel 
1 Press the  (Information) button.

2 Select About This MFP.

3 Select the Network tab.

4 Select IP(v4) Address, and then verify the IP address displayed in IP(v4) Address.

Verifying the Settings Using System Settings Report
1 Print the system settings report.

For details about how to print a system settings report, see "Report / List."

2 Verify the correct IP address, subnet mask, and gateway address are listed in the system settings report under 
Network (Wired) or Network (Wireless).

If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your 
printer, see "Assigning an IP Address."

Verifying the Settings Using Ping Command
Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping 
followed by the new IP address (for example, 192.168.0.11):

ping 192.168.0.11

If the printer is active on the network, you will receive a reply.
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9
Loading Paper

 NOTE: To avoid paper jams, do not remove the tray while printing is in progress.

1 Pull the tray out of the printer about 200 mm. 

2 Hold the tray with both hands, and remove it from the printer.
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3 Adjust the paper guides.

 NOTE: Extend the front side of the tray when you load Legal size paper.

4 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level surface.

5 Load the print media into the tray with the recommended print side facing up.

 NOTE: Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6 Align the width guides against the edges of the paper.

 NOTE: When loading user-specified print media, adjust the width guides and slide the extendable part of the tray by 
pinching the length guide and sliding it until it rests lightly against the edge of the paper.
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7 After confirming that the guides are securely adjusted, insert the tray into the printer.

 NOTE: If the front side of the tray is extended, the tray protrudes when it is inserted into the printer.

8 On the touch panel, select Size.

9 Select  until the desired paper size appears, and then select the desired paper size.

10 Select Type.

11 Select  until the desired paper type appears, and then select the desired paper size.

12 Select OK.
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Installing Printer Drivers on Windows® Computers

Identifying Printer Driver Pre-install Status
Before installing the printer driver on your computer, check the IP address of your printer by performing one of the 
procedures in "Verifying the IP Settings."

Changing the firewall settings before installing your printer
If you are running one of the following operating systems, you must change the firewall settings before installing the 
Dell printer software:

• Microsoft® Windows XP

• Windows Vista®

• Windows 7

• Windows 8

• Windows Server® 2008

• Windows Server 2008 R2

• Windows Server 2012

 NOTE: For Windows XP, Service Pack 2 or 3 must be installed.

The following procedure uses Windows 7 as an example.

1 Insert the Software and Documentation disc into your computer.

2 Click Start → Control Panel.

3 Select System and Security.

4 Click Allow a program through Windows Firewall.

5 Click Change settings → Allow another program.

6 Check Browse.

7 D:\setup_assist.exe (where D is the drive letter of the optical drive) in the File name text box, and then 
click Open.

8 Click Add, and then click OK.

Inserting the Software and Documentation Disc
1 Insert the Software and Documentation disc into your computer and click setup_assist.exe to start Easy Setup 

Navigator.

 NOTE: If the Software and Documentation disc does not launch automatically, follow the procedure below.

For Windows XP, Windows Server 2008, and Windows Server 2008 R2

Click start→ Run, enter D:\setup_assist.exe (where D is the drive letter of the optical drive) in the Run dialog 
box, and then click OK. 

For Windows Vista and Windows 7

Click Start → All Programs → Accessories → Run, enter D:\setup_assist.exe (where D is the drive letter of 
the optical drive) in the Run dialog box, and then click OK.
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For Windows 8 and Windows Server 2012

Point to the top or bottom right corner of the screen, and then click Search → Type Run in the search box, click Apps, and 
then click Run → Type D:\setup_assist.exe (where D is the drive letter of the optical drive), and then click 
OK.

Direct Connection Setup

For installing PCL, PS and Fax printer driver

1 In the Easy Setup Navigator window, click Installing Driver and Software to launch the installation software.

2 Select Personal Installation, and then click Next.

3 Follow the on-screen instructions to connect the computer and the printer with a USB cable, and then turn the 
printer on.

The Plug and Play installation starts and the installation software proceeds to the next page automatically.

 NOTE: If the installation software does not automatically proceed to the next page, click Install.

4 Select either Typical Installation (recommended) or Custom Installation from the installation wizard, and then 
click Install. If you select Custom Installation, you can select the specific software you want to install.

5 Click Finish to exit the wizard when the Congratulations! screen appears.

Personal Installation

A personal printer is a printer connected to your computer or a print server using a USB. If your printer is connected 
to a network and not your computer, see "Network Connection Setup."
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For installing XML Paper Specification (XPS) printer driver

 NOTE: XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, and Windows Server 2012.

 NOTE: If you are using Windows Vista or Windows Server 2008, you need to install Service Pack 2 or later, and then the 
Windows Platform Update (KB971644). The update (KB971644) is available for download from Windows Update.

Windows Vista or Windows Vista 64-bit Edition

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.

3 Click Add a printer.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted folder in step 1.

8 Click OK.

9 Select your printer name and click Next. 

10 To change the printer name, enter the printer name in the Printer name box, and then click Next. To use this 
printer as the default printer, select the check box displayed under the Printer name, and then click Next.

Installation starts.

If the User Account Control dialog box appears, click Continue.

 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

11 As the driver installation is completed, click Print a test page to print a test page.

12 Click Finish.

Windows Server 2008 or Windows Server 2008 64-bit Edition

 NOTE: You must log in as an administrator.

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.

3 Click Add a printer.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted folder in step 1.

8 Click OK.

9 Select your printer name and click Next. 

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.
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11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it.

12 Click Next.

Installation starts.

13 As the driver installation is completed, click Print a test page to print a test page. 

14 Click Finish.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Devices and Printers.

3 Click Add a printer.

When you use Windows Server 2008 R2, click Add a local or network printer as an administrator.

If the User Account Control dialog box appears, click Yes.

 NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

4 Click Add a local printer.

5 Select the port connected to this product, and then click Next.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted folder in step 1.

8 Click OK.

9 Select your printer name and click Next. 

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it.

12 Click Next.

Installation starts.

13 As the driver installation is completed, click Print a test page to print a test page.

14 Click Finish.

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 Extract the zip file you downloaded to your desired location.

2 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel.

3 Click Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers → Add a printer.

4 Click Have Disk to display the Install From Disk dialog box.

5 Click Browse, and then select the extracted folder in step 1.

6 Click OK.

7 Select your printer name and click Next.

8 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation 
starts.
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9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.

10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

11 Click Finish.

Network Connection Setup
 NOTE: To use this printer in a Linux environment, you need to install a Linux driver. For more information on how to install and 

use these, see "Installing Printer Drivers on Linux Computers (CUPS)."

Network Printer Setup on a Local Network

For installing PCL, PS and Fax printer driver

1 In the Easy Setup Navigator window, click Installing Driver and Software to launch the installation software.

2 Select Network Installation, and then click Next.

3 Select Local Installation, and then click Next.

4 Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed 
on the list, click Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify 
the IP address and port name at this point.

If you have installed this printer on the server computer, select the I am setting up this printer on a server check 
box.

 NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP 
address.

 NOTE: In some cases, Windows Security Alert is displayed in this step when you use Windows Vista, Windows Vista 64-
bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-
bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2012. In this case, select Unblock (Allow access for 
Windows Server 2008 R2 and Windows 7), and then continue the procedure.

5 Specify the printer settings, and then click Next.

a Enter the printer name.

b If you want other users on the network to access the printer, select Share this printer with other computers on 
the network, and then enter a share name that users can identify.

c If you want to set the printer as the default printer, select the Set this printer as default check box.

d If you want to restrict color printing, select the appropriate Dell™ ColorTrack option. Enter the password 
when Color-Password Enabled is selected for Dell ColorTrack.

e If you want to install the Fax Driver, select the FAX Driver check box.

If you want to install the PostScript printer driver, select the PostScript Driver check box.

6 Select the software and documentation you want to install, and then click Next. If you want to change the 
installation destination, click Browse and specify a new location.

7 Click Install.

8 Click Finish to exit the wizard when the Congratulations! screen appears.
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For installing XML Paper Specification (XPS) printer driver

 NOTE: XPS driver is supported on the following operating systems: Windows Vista, Windows Vista 64-bit Edition, Windows 
Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, Windows 7 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, and Windows Server 2012.

Windows Vista or Windows Vista 64-bit Edition

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select printer or click The printer that I want isn't listed.

6 Select Add a printer using a TCP/IP address or host name, and then click Next.

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Continue.

 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

8 Click Have Disk to display the Install From Disk dialog box.

9 Click Browse, and then select the extracted folder in step 1.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

Installation starts.

13 As the driver installation is completed, click Print a test page to print a test page.

14 Click Finish.

Windows Server 2008 or Windows Server 2008 64-bit Edition

 NOTE: You must log in as an administrator.

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Control Panel→ Hardware and Sound→ Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 8.

When you click The printer that I want isn't listed, go to step 6.

6 Select Add a printer using a TCP/IP address or host name, and then click Next.

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Continue.
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 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

8 Click Have Disk to display the Install From Disk dialog box.

9 Click Browse, and then select the extracted folder in step 1.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it.

14 Click Next.

Installation starts.

15 As the driver installation is completed, click Print a test page to print a test page.

16 Click Finish.

Windows Server 2008 R2

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Devices and Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select printer or click The printer that I want isn't listed.

 NOTE: When you click The printer that I want isn't listed, Find a printer by name or TCP/IP address screen appears. Find your 
printer on the screen.

If the User Account Control dialog box appears, click Continue.

 NOTE: If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the 
desired action.

6 Click Have Disk to display the Install From Disk dialog box.

7 Click Browse, and then select the extracted folder in step 1.

8 Click OK.

9 Select your printer name and click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

11 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it.

12 Click Next.

Installation starts.

13 As the driver installation is completed, click Print a test page to print a test page.

14 Click Finish.
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Windows 7 or Windows 7 64-bit Edition

1 Extract the following zip file to your desired location.

D:\Drivers\XPS\Win_7Vista\XPS_3765.zip (where D is the drive letter of the optical drive)

2 Click Start→ Devices and Printers.

3 Click Add a printer.

4 Click Add a network, wireless or Bluetooth printer.

5 Select printer or click The printer that I want isn't listed.

When you select your printer, go to step 8.

When you click The printer that I want isn't listed, go to step 6.

6 Select Add a printer using a TCP/IP address or host name, and then click Next.

7 Select TCP/IP Device from Device type, and enter the IP address for Hostname or IP address, and then click 
Next.

If the User Account Control dialog box appears, click Yes.

 NOTE: If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

8 Click Have Disk to display the Install From Disk dialog box.

9 Click Browse, and then select the extracted folder in step 1.

10 Click OK.

11 Select your printer name and click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

To use this printer as the default printer, select the Set as the default printer check box, and then click Next.

13 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it.

14 Click Next.

Installation starts.

15 As the driver installation is completed, click Print a test page to print a test page. 

16 Click Finish.

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 Extract the zip file you downloaded to your desired location.

2 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel.

3 Click Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers → Add a printer.

4 Click Have Disk to display the Install From Disk dialog box.

5 Click Browse, and then select the extracted folder in step 1.

6 Click OK.

7 Select your printer name and click Next.

8 To change the printer name, enter the printer name in the Printer name box, and then click Next. Installation 
starts.

9 If you do not share your printer, select Do not share this printer. If you share your printer, select Share this printer 
so that others on your network can find and use it. Click Next.
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10 As the driver installation is completed, click Print a test page to print a test page. To use this printer as the default 
printer, select the Set as the default printer check box.

11 Click Finish.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your 
desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering 
replacement consumables. You can click the Dell supplies link for ordering supplies.

 NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print 
server.

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer 
configuration appears on the screen.

You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or 
intervention.

To set up e-mail alerts:

1 Launch the Dell Printer Configuration Web Tool.

2 Click E-Mail Alert link.

3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail 
address in the e-mail list box.

4 Click Apply New Settings.

 NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs.

Network Printer Setup on a Remote Network

Before Installation

Before you start remote installation, perform the following procedures.

Allow Print Spooler to Accept Client Connections

 NOTE: This procedure is required for Windows XP 64-bit Edition, Windows Server 2003, Windows Server 2003 x64 Edition, 
Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 
R2, Windows 7, and Windows 7 64-bit Edition.

For Windows XP, Windows Server 2003, Windows Vista, and Windows Server 2008:

1 Open the Run dialog box. 

For Windows XP, Windows Server 2003, Windows Server 2008, click start→ All Programs → Accessories → Run.

For Windows Vista, click Start→ Run.

2 Type gpedit.msc, and then click OK.

3 Click Computer Configuration→ Administrative Templates→ Printers.

4 Right-click Allow Print Spooler to accept client connections and select Properties.

5 On the Setting tab, select Enabled, and then click OK.

6 Restart the computer.

For Windows Server 2008 R2 and Windows 7:

1 Open the Run dialog box.

For Windows Server 2008 R2, click Start→ Run.

For Windows 7, click Start→ All Programs→ Accessories→ Run.
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2 Type gpedit.msc, and then click OK.

3 Click Computer Configuration→ Administrative Templates→ Printers.

4 Right-click Allow Print Spooler to accept client connections and select Edit.

5 Select Enabled, and then click OK.

6 Restart the computer.

Change the Firewall Setting to Share File and Printer

 NOTE: This procedure is required for Windows XP, Windows XP 64-bit Edition, Windows Vista, Windows Vista 64-bit Edition, 
Windows Server 2008, Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 64-bit Edition.

For Windows XP:

1 Click start→ Control Panel.

2 Select Security Center.

3 Click Windows Firewall.

4 On the Exceptions tab, select the File and Printer Sharing check box, and then click OK.

For Windows Vista:

1 Click Start→ Control Panel.

2 Select Security.

3 Click Windows Firewall.

4 Click Change settings.

5 Click Continue.

6 On the Exceptions tab, select the File and Printer Sharing check box, and then click OK.

For Windows Server 2008:

1 Click Start→ Control Panel.

2 Double-click Windows Firewall.

3 Click Change settings.

4 On the Exceptions tab, select the File and Printer Sharing check box, and then click OK.

For Windows Server 2008 R2 and Windows 7:

1 Click Start→ Control Panel.

2 Select System and Security.

3 Click Windows Firewall.

4 Click Allow a program or feature through Windows Firewall.

5 If the check boxes under Allowed programs and features: are dimmed, click Change settings.

6 Select the File and Printer Sharing check box. Home/Work (Private) or Public check box is automatically selected 
according to your settings.

If the File and Printer Sharing Properties dialog box appears, click OK.

7 Click OK.
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Start Remote Registry

 NOTE: This procedure is required for Windows Vista, Windows Vista 64-bit Edition, Windows 7, and Windows 7 64-bit Edition.

1 Click Start→ Control Panel.

2 Select System and Maintenance (System and Security for Windows 7).

3 Click Administrative Tools.

4 Double-click Services.

5 Click Continue (for Windows Vista only).

6 Right-click Remote Registry and select Start.

7 Right-click Remote Registry and select Properties.

8 Change Startup type to Automatic, and then click OK.

Disable User Account Control

 CAUTION: Disabling the User Account Control might leave the system vulnerable to virus attacks.

 NOTE: This procedure is required for Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 
64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 64-bit Edition.

For Windows Vista:

1 Click Start→ Control Panel.

2 Select User Accounts and Family Safety.

3 Click User Accounts.

4 Click Turn User Account Control on or off.

5 Click Continue.

6 Clear the Use User Account Control (UAC) to help protect your computer check box.

7 Restart the computer.

For Windows Server 2008:

1 Click Start→ Control Panel.

2 Double-click User Accounts.

3 Click Turn User Account Control on or off.

4 Clear the Use User Account Control (UAC) to help protect your computer check box.

5 Click OK.

6 Restart the computer.

For Windows Server 2008 R2:

1 Click Start→ Control Panel.

2 Select User Accounts.

3 Click Change User Account Control Settings.

4 Move the slider to the bottom, and then click OK.

5 Restart the computer.

For Windows 7:

1 Click Start→ Control Panel.

2 Select User Accounts and Family Safety.

3 Click User Accounts.
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4 Click Change User Account Control Settings.

5 Move the slider to the bottom, and then click OK.

6 Click Yes in the User Account Control dialog box.

7 Restart the computer.

Enable Network Discovery and File Sharing for all Public Networks

 NOTE: This procedure is required when you use Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows 
Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, and Windows 7 64-bit Edition for the server computer.

1 Click Start→ Network (Start→ your user name→ Network for Windows 7).

2 Click Network discovery and file sharing are turned off. Network computers and devices are not visible. Click to 
change.

3 Click Turn on network discovery and file sharing.

4 Click Yes, turn on network discovery and file sharing for all public networks.

Disable Simple File Sharing

 NOTE: This procedure is required for Windows XP, and Windows XP 64-bit Edition.

1 Click start→ Control Panel.

2 Select Appearance and Themes.

3 Select Folder Options.

4 On the View tab, clear the Use simple file sharing (Recommended) check box, and then click OK.

5 Click Start→ Control Panel.

6 Select Performance and Maintenance.

7 Select Administrative Tools.

8 Click Local Security Policy.

9 Click Local Policies→ Security Options.

10 Right-click Network access: Sharing and security model for local accounts and select Properties.

11 Ensure Classic - local users authenticate as themselves is selected.

Installing the Printer Driver

 NOTE: Installation is not supported on Windows XP Home Edition, Windows Vista Home Basic, Windows Vista Home Premium, 
Windows Vista Home Basic 64-bit Edition, Windows Vista Home Premium 64-bit Edition, Windows 7 Starter, Windows 7 Home 
Basic, Windows 7 Home Premium, Windows 7 Home Basic 64-bit Edition, Windows 7 Home Premium 64-bit Edition, Windows 8, 
Windows 8 64-bit Edition, Windows 8 Pro, Windows 8 Pro 64-bit Edition, and Windows Server 2012.

1 In the Easy Setup Navigator window, click Software Installation to launch the installation software.

2 Select Network Installation, and then click Next.

3 Select Remote Installation, and then click Next.

a Enter the computer name, user ID, and password, and then click Add.

b Click Next.

 NOTE: Windows Security Alert may appear on Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, 
Windows Server 2008 64-bit Edition, Windows Server 2008 R2, Windows 7, or Windows 7 64-bit Edition. In this case, select 
Unblock (Allow access for Windows Server 2008 R2 and Windows 7), and then continue the procedure.
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4 Select a printer from the printer list, and then click Next. If the target printer is not displayed on the list, click 
Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify the IP address 
and port name at this point.

 NOTE: When using AutoIP, 0.0.0.0 is displayed in the installer. Before you continue, you must enter a valid IP address.

5 Specify the printer settings, and then click Next.

a Enter the printer name.

b If you want other users on the network to access this printer, select the Share this printer with other 
computers on the network, and then enter a share name that users can identify.

c If you want to set the printer as default, select the Set this printer as default check box.

d If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when 
Color-Password Enabled is selected for Dell ColorTrack.

e If you want to install the Fax Driver, select the FAX Driver check box.

6 Select the software and documentation you want to install, and then click Next.

If you want to change the installation destination, click Input and specify a new location.

7 Click Install.

8 Click Finish to exit the wizard when the Congratulations! screen appears.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your 
desk. You can view and/or change the printer settings, monitor toner level, and acknowledge the timing of ordering 
replacement consumables. You can click the Dell supplies link for ordering supplies.

 NOTE: The Dell Printer Configuration Web Tool is not available when the printer is directly connected to a computer or a print 
server.

To launch the Dell Printer Configuration Web Tool, type the printer's IP address in your web browser. The printer 
configuration appears on the screen.

You can set up the Dell Printer Configuration Web Tool to send you an e-mail when the printer needs supplies or 
intervention.

To set up e-mail alerts:

1 Launch the Dell Printer Configuration Web Tool.

2 Click E-Mail Alert link.

3 Under E-Mail Server Settings, enter the Primary SMTP Gateway, Reply Address, and your or key operator's e-mail 
address in the e-mail list box.

4 Click Apply New Settings.

 NOTE: Connection pending until printer sends an alert is displayed on the SMTP server until an error occurs.
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Setting Up for Shared Printing
You can share your new printer on the network using the Software and Documentation disc that comes with your 
printer, or using Microsoft® point-and-print or peer-to-peer method. However, if you use one of the Microsoft 
methods, some features, such as the status monitor and other printer utilities, installed with the Software and 
Documentation disc, may not be available.

If you want to use the printer on a network, share the printer and install its drivers on all the computers on the 
network.

 NOTE: You need to purchase an Ethernet cable for shared printing.

Specifying the Shared Settings of the Printer

Windows XP, Windows XP 64-bit Edition, Windows Server 2003, or Windows Server 2003 x64 Edition

1 Click start→ Printers and Faxes.

2 Right-click the printer icon and select Properties.

3 On the Sharing tab, select the Share this printer check box, and then type a name in the Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click OK.

If you are missing files, you are prompted to insert the server operating system CD.

Windows Vista or Windows Vista 64-bit Edition

1 Click Start→ Control Panel→ Hardware and Sound→ Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options.

The message Windows needs your permission to continue appears.

4 Click Continue.

5 Select the Share this printer check box, and then type a name in the Share name text box.

6 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

7 Click OK.

Windows Server 2008 or Windows Server 2008 64-bit Edition

1 Click Start→ Control Panel→ Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change Sharing Options if exists.

4 Select the Share this printer check box, and then type a name in the Share name text box.

5 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

6 Click OK.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2 

1 Click Start→ Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, click Change Sharing Options if exists.

Select the Share this printer check box, and then type a name in the Share name text box.
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4 Click Additional Drivers and select the operating systems of all network clients that print to the printer.

5 Click Apply, and then click OK.

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → Hardware 
and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, click Change Sharing Options if exists.

4 Select the Share this printer check box, and then type a name in the Share name text box.

5 Click Additional Drivers and select the operating systems of all network clients using this printer.

6 Click Apply, and then click OK.

To confirm that the printer is properly shared:

• Ensure that the printer object in the Printers, Printers and Faxes, or Devices and Printers folder is shared. The 
shared icon is shown under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and the shared name you assigned to the 
printer.

Now that the printer is shared, you can install the printer on network clients using the point and print method or the 
peer-to-peer method.

 NOTE: If the OS bit editions (32/64 bit edition) differ between a print server and a client computer, you need to manually add the 
printer driver for the client computer edition on the server. Otherwise, the printer driver cannot be installed on the client 
computer using the point and print or peer-to-peer method. For example, if the print server runs on Windows XP 32-bit edition, 
while the client computer runs on Windows 7 64-bit edition, follow the procedures below to additionally install the printer driver 
for 64-bit client on the 32-bit server.

a Click Additional Drivers on the screen for sharing printers.

For details about how to display this screen, see "Specifying the Shared Settings of the Printer."

b Select the x64 check box, and then click OK.

c Insert the Software and Documentation disc into your computer.

d Click Browse to specify the folder that contains the 64-bit OS driver, and then click OK.

Installation starts.

Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the printer driver.

Windows XP, Windows XP 64-bit Edition, Windows Server 2003, or Windows Server 2003 x64 Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.
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Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers and Faxes folder. The copy time varies, based on network traffic and other 
factors.

4 Close My Network Places.

5 Print a test page to verify installation.

a Click start→ Printers and Faxes.

b Select the printer you just created.

c Click File→ Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

Windows Vista or Windows Vista 64-bit Edition

1 On the Windows desktop of the client computer, click Start→ Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.

6 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers folder. The time this takes varies, based on network traffic and other factors.

7 Print a test page to verify installation.

a Click Start→ Control Panel→ Hardware and Sound.

b Select Printers.

c Right-click the printer you just created and click Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.
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Windows Server 2008 or Windows Server 2008 64-bit Edition

1 On the Windows desktop of the client computer, click Start→ Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Printers folder. The time this takes varies, based on network traffic and other factors.

6 Print a test page to verify installation.

a Click Start→ Control Panel.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 On the Windows desktop of the client computer, click Start→ your user name→ Network (Start→ Network for 
Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Devices and Printers folder. The time this takes varies, based on network traffic and other 
factors.

6 Print a test page to verify installation.

a Click Start→ Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page prints successfully, installation is complete.

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 Point to the top or bottom right corner of the screen, and then click Search → Type Network in the search box, 
click Apps, and then click Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait for the driver information to be copied from the server computer to the client computer, and for a new printer 
object to be added to the Devices and Printers folder. The time this takes varies, based on network traffic and other 
factors.

6 Print a test page to verify installation.

a Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012) → Devices and Printers.

b Right-click the printer you just created and select Printer properties.
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c On the General tab, click Print Test Page.

When a test page is printed successfully, installation is complete.

Peer-to-Peer
If you use the peer-to-peer method, the printer driver is fully installed on each client computer. Network clients 
retain control of driver modifications. The client computer handles the print job processing.

Windows XP, Windows XP 64-bit Edition, Windows Server 2003, or Windows Server 2003 x64 Edition

1 Click start→ Printers and Faxes.

2 Click Add a Printer.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next. If the printer is not 
listed, type the path to the printer in the text box.

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

5 Click Browse for a printer, and then click Next.

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to available drivers.

6 Select Yes if you want this printer to be set as the default printer, and then click Next.

If you want to verify installation, click Yes to print a test page.

7 Click Finish.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>



Installing Printer Drivers on Windows® Computers 109

Windows Vista or Windows Vista 64-bit Edition

1 Click Start→ Control Panel→ Hardware and Sound→ Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a 
shared printer by name text box and click Next.

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, you need to 
specify the path to available drivers.

4 Select Yes if you want this printer to be set as the default printer, and then click Next.

5 If you want to verify installation, click Print a test page.

6 Click Finish.

When a test page prints successfully, installation is complete.

Windows Server 2008 or Windows Server 2008 64-bit Edition

1 Click Start→ Control Panel→ Printers.

2 Click Add a Printer.

3 Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer 
and click Next, or select The printer that I want isn't listed and type the path to the printer in the Select a shared 
printer by name text box and click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will 
need to provide a path to available drivers.

4 Select Yes if you want this printer to be set as the default printer, and then click Next.

5 Click Print a test page if you want to verify installation.

6 Click Finish.

When a test page prints successfully, installation is complete.

For example:\\<server host name>\<shared printer name>
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Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Click Start → Devices and Printers.

2 Click Add a Printer.

3 Select Add a network, wireless or Bluetooth printer. If the printer is listed, select the printer and click Next, or 
select The printer that I want isn't listed. Click Select a shared printer by name and type in the path of the printer 
in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will 
need to provide the path to the available driver.

4 Confirm the printer name, and then click Next.

5 Select Yes if you want this printer to be set as the default printer, and then click Next.

6 Click Print a test page if you want to verify installation.

7 Click Finish.

When a test page prints successfully, installation is complete.

Windows 8, Windows 8 64-bit Edition, or Windows Server 2012

1 Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → Hardware 
and Sound (Hardware for Windows Server 2012) → Devices and Printers.

2 Click Add a Printer to launch the Add Printer wizard.

3 If the printer is listed, select the printer and click Next, or select The printer that I want isn't listed. Click Select a 
shared printer by name and type in the path of the printer in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it to the network. The shared printer name 
is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will 
need to provide the path to the available driver.

4 Confirm the printer name, and then click Next.

5 Select Yes if you want this printer to be set as the default printer, and then click Next.

6 Click Print a test page if you want to verify installation.

7 Click Finish.

When a test page is printed successfully, installation is complete.
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Installing the Drivers and Software
1 Run the Software and Documentation disc on the Macintosh computer.

2 Double-click the Dell C3765 Installer icon, and then click Continue.

3 When the popup dialog box prompts you for confirming the program included in the installation package, click 
Continue.

4 Click Continue on the Important Information screen.

5 Select a language for the Software License Agreement.

6 After reading the Software License Agreement, click Continue.

7 If you agree to the terms of the Software License Agreement, click Agree to continue the installation process.

8 Confirm the installation location.

9 Click Install to perform the standard installation.

If you want to select a custom installation, click Customize to select items that you want to install.

• Dell C3765 Printer Driver

• Dell C3765 Fax Driver

• Dell C3765 Scan Driver

• Dell Printer Status Monitor

10 Type the administrator's name and password, and then click Install Software.

11 Click Continue Installation to continue the installation.

12 When the message The installation was successful. appears, click Log Out to complete installation.

Adding a Printer on Mac OS X 10.5, 10.6, 10.7, or 10.8

When Using a USB connection

1 Turn on the printer.

2 Connect the USB cable between the printer and the Macintosh computer.

The printer is automatically added to your Macintosh computer.

When Using IP Printing

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected.

If you use wired connection, connect the LAN cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer.

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8).

4 Click the Plus (+) sign, and click IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Type the IP address for the printer in the Address area.
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7 Select Dell C3765dnf Color MFP for Print Using (Use for Mac OS X 10.8).

 NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

8 Click Add.

9 Specify the options that have been installed on the printer, and then click Continue.

10 Confirm that the printer is displayed in the Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8) 
dialog box.

When Using Bonjour

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected.

If you use wired connection, connect the LAN cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer.

3 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8).

4 Click the Plus (+) sign, and click Default.

5 Select the printer connected via Bonjour from the Printer Name list. 

6 Name and Print Using (Use for Mac OS X 10.8) are automatically entered.

7 Click Add.

8 Specify the options that have been installed on the printer, and then click Continue.

9 Confirm that the printer is displayed in the Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8) 
dialog box.

Adding a Printer on Mac OS X 10.4.11

When Using a USB Connection

1 Turn on the printer.

2 Connect the USB cable between the printer and the Macintosh computer.

3 Start Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click Default Browser in the Printer Browser dialog box.

6 Select the printer connected via USB from the Printer list.

7 Name and Print Using are automatically entered.

8 Click Add.

When Using IP Printing

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected.

If you use wired connection, connect the LAN cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer.

3 Start Printer Setup Utility.
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 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click IP Printer in the Printer Browser dialog box.

6 Select Line Printer Daemon - LPD for Protocol.

7 Type the IP address for the printer in the Address area.

8 Select Dell C3765dnf Color MFP for Print Using.

 NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it. 

 NOTE: Entry of Location is optional.

9 Click Add.

When Using Bonjour

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected.

If you use wired connection, connect the LAN cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer.

3 Start the Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Click Default Browser in the Printer Browser dialog box.

6 Select the printer connected via Bonjour from the Printer Name list.

7 Name and Print Using are automatically entered.

8 Click Add.

9 Specify the options installed to the printer, and then click Continue.

10 Confirm that the printer is displayed on the Printer list dialog box.

Adding a Printer on Mac OS X 10.3.9

When Using a USB connection

1 Turn on the printer.

2 Connect the USB cable between the printer and the Macintosh computer.

3 Start Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add.

5 Select USB from the menu.

The Printer Model is automatically selected.

6 Click Add.
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When Using IP Printing

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected.

If you use wired connection, connect the LAN cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer.

3 Start Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add in the Printer List dialog box.

5 Select IP Printing from the menu.

6 Select LPD/LPR for Printer Type.

7 Type the IP address for the printer in the Address area.

8 Select Dell for Printer Model, and select Dell C3765dnf Color MFP.

 NOTE: When printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

9 Click Add.

When Using Rendezvous (Bonjour)

1 Turn on the printer.

2 Ensure that Macintosh computer and the printer are connected.

If you use wired connection, connect the LAN cable between the printer and the network.

If you use wireless connection, ensure that wireless connection is configured properly on your Macintosh computer 
and the printer.

3 Start Printer Setup Utility.

 NOTE: You can find Printer Setup Utility in the Utilities folder in Applications.

4 Click Add in the Printer List dialog box.

5 Select Rendezvous from the menu.

6 Select Dell for Printer Model, and select Dell C3765dnf Color MFP.

7 Click Add.
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Configuring Settings
All the optional accessories are verified as installed.

Mac OS X 10.5, 10.6, 10.7, or 10.8

1 Open the System Preferences, and click Print & Fax (Print & Scan for Mac OS X 10.7 and Mac OS X 10.8).

2 Select the printer in the Printer Name list, and click Options & Supplies.

3 Select Driver, and select the options that have been installed in the printer, and then click OK.

Mac OS X 10.3.9 or 10.4.11

1 Start Printer Setup Utility.

2 Select the printer in the Printer List dialog box, and click Show Info.

3 Select Installable Options, and select the options that have been installed in the printer, and then click Apply 
Changes.
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12
Installing Printer Drivers on Linux Computers (CUPS)
This section provides information for installing or setting up the printer driver with CUPS (Common UNIX Printing 
System) on Red Hat® Enterprise Linux® 5/6 Desktop or SUSE® Linux Enterprise Desktop 10/11.

Operation on Red Hat Enterprise Linux 5/6 Desktop

Setup Overview
Red Hat Enterprise Linux 5/6 Desktop:

1 Install the printer driver.

2 Set up the print queue.

3 Specify the default queue.

4 Specify the printing options.

Installing the Printer Driver

 CAUTION: Before you install the printer driver on Red Hat Enterprise Linux 5, confirm that Update 6 or higher is applied to your 
operating system. Consult your Linux distributor for the upgrade of your system.

1 Select Applications→ System Tools (Accessories for Red Hat Enterprise Linux 5 Desktop)→ Terminal.

2 Type the following command in the terminal window.

The printer driver is installed.

Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

For Red Hat Enterprise Linux 5 Desktop:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

Type the name of the printer in the Name box in the Add New Printer window, and click Continue.

You can optionally specify the location and description of the printer for further information.

For network connections:

a Select LPD/LPR Host or Printer from the Device menu, and click Continue.

b Type the IP address of the printer in Device URI, and click Continue.

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

su

(Type the administrator password)
rpm -ivh (Type the file path)/Dell-C3765-Color-
MFP-x.x-x.noarch.rpm
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For USB connections:

a Select Dell C3765dnf Color MFP USB #1 or Dell C3765dnf Color MFP from the Device menu, and click 
Continue.

4 Select Dell C3765dnf Color MFP PS vx.x (en) from the Model menu, and click Add Printer.

5 Type root as the user name, type the administrator password, and click OK.

The message Printer xxx has been added successfully. appears.

The setup is complete.

For Red Hat Enterprise Linux 6 Desktop:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Type root as the user name, type the administrator password, and click OK.

For network connections:

a Select LPD/LPR Host or Printer from the Other Network Printers menu, and click Continue.

b Type the IP address of the printer in Connection, and click Continue.

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

For USB connections:

a Select Dell C3765dnf Color MFP from the Local Printers menu, and click Continue.

5 Type the name of the printer in the Name box in the Add Printer window, and click Continue.

You can optionally specify the location and description of the printer for further information.

6 Select Dell C3765dnf Color MFP PS vx.x (en) from the Model menu, and click Add Printer.

The setup is complete.

Printing From the Applications

When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the 
application, and specify the queue in the print dialog box. 

However, sometimes you can print only from the default queue depending on the application (for example Mozilla). 
In these cases, before you start printing, set queue you want to print to as the default queue. For information on 
specifying the default queue, see "Setting the Default Queue."

Setting the Default Queue
1 Select Applications→ System Tools (Accessories for Red Hat Enterprise Linux 5 Desktop)→ Terminal.

2 Type the following command in the terminal window.

su

(Type the administrator password)

lpadmin -d (Type the queue name)
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Specifying the Printing Options
You can specify the printing options such as color mode.

For Red Hat Enterprise Linux 5 Desktop:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click Set Printer Options of the printer for which you want to specify the printing options.

5 Specify the required settings, and click Set Printer Options.

6 Type root as the user name, and type the administrator password.

The message Printer xxx has been configured successfully. appears.

The setting is complete. 

For Red Hat Enterprise Linux 6 Desktop:

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify the printing options.

5 Select Set Default Options from the Administration menu.

6 Click the desired setting item, specify the required settings, and click Set Default Options.

The message Printer xxx default options have been set successfully. appears.

The setting is complete.

Uninstalling the Printer Driver
1 Select Applications→ System Tools (Accessories for Red Hat Enterprise Linux 5 Desktop)→ Terminal.

2 Type the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Type the following command in the terminal window.

The printer driver is uninstalled.

su

(Type the administrator password)

/usr/sbin/lpadmin -x (Type the print queue name)

su

(Type the administrator password)

rpm -e Dell-C3765-Color-MFP
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Operation on SUSE Linux Enterprise Desktop 10

Setup Overview
SUSE Linux Enterprise Desktop 10:

1 Install the printer driver.

2 Set up the print queue.

3 Specify the default queue.

4 Specify the printing options.

Installing the Printer Driver
1 Select Computer→ More Applications... and select Gnome Terminal on the Application Browser.

2 Type the following command in the terminal window.

The printer driver is installed.

Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

1 Select Computer→ More Applications... and select YaST on the Application Browser.

2 Type the administrator password, and click Continue.

YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configuration dialog box appears.

For network connections:

a Click Add.

b Select Network Printers as Printer Type, and click Next.

c Select Print via LPD-Style Network Server as Network Printers, and click Next.

d Type the IP address of the printer in Hostname of the Print Server. 

e Type the name of the printer queue in Print Queue Name, and click Next.

f Type the printer name in Name for Printing.

 NOTE: Printer Description and Printer Location do not have to be specified.

g Select the Do Local Filtering check box, and click Next.

h Select DELL as Manufacturer. Select C3765dnf Color MFP as Model, and click Next.

i Confirm the settings in Configuration, and click OK.

su

(Type the administrator password)
rpm -ivh (Type the file path)/Dell-C3765-Color-
MFP-x.x-x.noarch.rpm
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For USB connections:

a Select Dell C3765dnf Color MFP on USB (//Dell/C3765dnf%20Color%20MFP or /dev/usblp*) as Available 
are, and click Configure….

b Confirm the settings in Edit configuration, and click OK.

4 Click Finish.

Printing From the Applications

When you have finished setting up the queue you can print jobs from the applications. Start the print job from the 
application, and specify the queue in the print dialog box. 

However, sometimes you can print only from the default queue depending on the application (for example Mozilla). 
In these cases, before you start printing, set queue you want to print to as the default queue. For information on 
specifying the default queue, see "Setting the Default Queue."

Setting the Default Queue
1 To activate the Printer setup: Autodetected printers, do the following.

a Select Computer→ More Applications... and select YaST on the Application Browser.

b Type the administrator password, and click Continue.

YaST Control Center is activated.

c Select Hardware on YaST Control Center, and select Printer.

2 Select the printer you want to set to default on the Printer Configuration, and select Set Default in the Other 
button menu.

3 Click Finish.

Specifying the Printing Options
You can specify the printing options such as color mode.

1 Open a web browser.

2 Type http://localhost:631/admin in Location, and press <Enter>.

3 Type root as the user name, and type the administrator password.

The CUPS window appears.

 NOTE: Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 
"Setting the Password for Authority as the Printer Administrator."

4 Click Manage Printers.

5 Specify the required settings, and click Continue.

The message Printer xxx has been configured successfully. appears.

The setting is complete. Execute printing from the application.
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Setting the Password for Authority as the Printer Administrator
You must set the password for authority as the printer administrator to do operations as the printer administrator.

1 Select Computer→ More Applications... and select Gnome Terminal on the Application Browser.

2 Type the following command in the terminal window.

Uninstalling the Printer Driver
1 Select Computer→ More Applications... and select Gnome Terminal on the Application Browser.

2 Type the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Type the following command in the terminal window.

The printer driver is uninstalled.

Operation on SUSE Linux Enterprise Desktop 11

Setup Overview
SUSE Linux Enterprise Desktop 11:

1 Install the printer driver.

2 Set up the print queue.

3 Specify the default queue.

4 Specify the printing options.

su

(Type the administrator password)

lppasswd -g sys -a root

(Type the password for authority as the printer administrator after 
the Enter password prompt.)

(Retype the password for authority as the printer administrator after 
the Enter password again prompt.)

su

(Type the administrator password)

/usr/sbin/lpadmin -x (Type the printer queue name)

su

(Type the administrator password)
rpm -e Dell-C3765-Color-MFP
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Installing the Printer Driver
1 Select Computer→ More Applications... and select GNOME Terminal on the Application Browser.

2 Type the following command in the terminal window.

The printer driver is installed.

Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

1 Select Computer→ More Applications..., and select YaST on the Application Browser.

2 Type the administrator password, and click Continue.

YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

For network connections:

a Click Add.

The Add New Printer Configuration dialog box opens.

b Click Connection Wizard.

The Connection Wizard dialog box opens.

c Select Line Printer Daemon (LPD) Protocol from Access Network Printer or Printserver Box via.

d Type the IP address of the printer in IP Address or Host Name:.

e Select Dell in the Select the printer manufacturer: drop-down menu.

f Click OK.

The Add New Printer Configuration dialog box appears.

g Select Dell C3765dnf Color MFP PS vx.x [Dell/Dell_C3765dnf_Color_MFP.ppd.gz] from the Assign 
Driver list.

 NOTE: You can specify the printer name in Set Name:.

h Confirm the settings, and click OK.

For USB connections:

a Click Add.

The Add New Printer Configuration dialog box opens.

The printer name is displayed in the Determine Connection list.

b Select Dell C3765dnf Color MFP PS vx.x. [Dell/Dell_C3765dnf_Color_MFP.ppd.gz] from the Assign 
Driver list.

 NOTE: You can specify the printer name in Set Name:.

c Confirm the settings, and click OK.

su

(Type the administrator password)
rpm -ivh (Type the file path)/Dell-C3765-Color-
MFP-x.x-x.noarch.rpm
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Printing From the Applications

When you have finished setting up the queue you can print jobs from the applications. Start the print job from the 
application, and specify the queue in the print dialog box. 

However, sometimes you can print only from the default queue depending on the application (for example Mozilla). 
In these cases, before you start printing, set queue you want to print to as the default queue. For information on 
specifying the default queue, see "Setting the Default Queue."

Setting the Default Queue
You can set the default queue when you add the printer.

1 Select Computer→ More Applications..., and select YaST on the Application Browser.

2 Type the administrator password, and click Continue.

YaST Control Center is activated.

3 Select Hardware on YaST Control Center, and select Printer.

The Printer Configurations dialog box opens.

4 Click Edit.

A dialog box to modify the specified queue opens.

5 Confirm that the printer you want to set is selected in the Connection list.

6 Select the Default Printer check box.

7 Confirm the settings, and click OK.

Specifying the Printing Options
You can specify the printing options such as color mode.

1 Open a web browser.

2 Type http://localhost:631/admin in Location, and press <Enter>.

3 Click Manage Printers.

4 Click Set Printer Options of the printer for which you want to specify the printing options.

5 Specify the required settings, and click Set Printer Options.

6 Type root as the user name, type the administrator password, and click OK.

 NOTE: Set the password for authority as the printer administrator before setting the printer queue. If you have not set it, go to 
"Setting the Password for Authority as the Printer Administrator."

The message Printer xxx has been configured successfully. appears.

The setting is complete. Execute printing from the application.
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Setting the Password for Authority as the Printer Administrator
You must set the password for authority as the printer administrator to do operations as the printer administrator.

1 Select Computer→ More Applications... and select GNOME Terminal on the Application Browser.

2 Type the following command in the terminal window.

Uninstalling the Printer Driver
1 Select Computer→ More Applications... and select GNOME Terminal on the Application Browser.

2 Type the following command in the terminal window to delete the print queue.

3 Repeat the command above for all queues for the same model.

4 Type the following command in the terminal window.

The printer driver is uninstalled.

su

(Type the administrator password)

lppasswd -g sys -a root

(Type the password for authority as the printer administrator after 
the Enter password prompt.)

(Retype the password for authority as the printer administrator after 
the Enter password again prompt.)

su

(Type the administrator password)

/usr/sbin/lpadmin -x (Type the printer queue name)

su

(Type the administrator password)
rpm -e Dell-C3765-Color-MFP



126 Installing Printer Drivers on Linux Computers (CUPS)



127

Using Your Printer

13 Operator Panel .......................................................................... 129

14 Dell™ Printer Configuration Web Tool................................... 135

15 Understanding the Tool Box Menus....................................... 203

16 Understanding the Printer Menus.......................................... 231

17 Print Media Guidelines............................................................. 301

18 Loading Print Media ................................................................. 307



128



Operator Panel 129

13
Operator Panel

About the Operator Panel
The operator panel has a touch panel, a status LED, control buttons, and a number pad, which allows you to control 
the printer.

1  (Home) button

• Moves to the Main Home screen.

2 Touch Panel

• Specifies the settings by directly touching the screen. 

• Displays various settings, instructions, and error messages. 

3 Status LED (Ready / Error)

• Shows a  green light when the printer is ready and a  blinking green light when data is being received.

• Shows an amber light when an error occurs and a blinking amber light when an unrecoverable print error 
occurs.

4  (Start) button

• Starts a job. 

5 Number Pad

• Enters numbers and characters.

6  (Redial / Pause) button

• Re-dials a telephone number. 

• Inserts a pause into a telephone number.

7  (Power Saver) button

• Enters or exits the Power Saver mode. When the machine is not used for a while, it enters the Power Saver 
mode to reduce power consumption. When the Power Saver mode is active, the Power Saver button blinks. 

8  (Delete) button

• Deletes numbers and characters.

1 2 3 4 5 6

89101112

7
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9  (All Clear) button

• Resets the current setting, and returns to the top menu. 

10  (Cancel) button

• Cancels active or pending jobs. 

11  (Job Status) button

• Moves to the Job Status screen. From this screen, you can check or cancel active jobs and also access Secure 
Print and Secure Fax receive.

12  (Information) button

• Moves to the Information screen. You can access various information and menus, check consumable levels, 
and print various types of reports and lists.

 NOTE: Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to select OK 
to save the current entry or setting. 

About the Main Home Screen
This section describes the fields and buttons on the Main Home screen which is displayed by pressing the 

(Home) button. This is the default screen that appears when the printer is turned on.

Message Field
Displays the printer status, error message, and IP address assigned to the printer.

Toner Status Icon
Displays the condition of toner in 6 levels. (The toner level for each color: 100%, 80%, 60%, 40%, 20%, 0%) Selecting 
this icon moves to the Supplies tab.

Wireless LAN Connection Status Icon
Displays the intensity of wireless signal when the wireless adapter is connected to the printer. 

Data Status Icon
Displays when the print data or fax data is stored in the printer. While receiving fax data, this icon blinks on and off. 
When wireless LAN connection status icon is not displayed, the position of the data status icon is right-justified.

Message Field

Function Buttons

Data Status Icon

Wireless LAN Connection 
Status Icon

Toner Status Icon
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Function Buttons
Allows you to set the features for functions such as Copy, E-mail, Scan Menu, Fax, Print Menu, and ID 
Card Copy.

 NOTE: Functions that are disabled do not appear on this screen. For details about enabling and disabling functions, see 
"Function Enabled." 

Copy

You can set the features for the Copy function.

For more information, see "Copying."

E-mail

You can scan documents and send the scanned data as an e-mail attachment.

For more information, see "Sending an E-Mail With the Scanned Image."

Scan Menu

You can set the features for the Scan Menu function.

For more information, see "Scanning."

Fax

You can set the features for the Fax function.

For more information, see "Faxing."

Print Menu

You can set the features for the Print Menu function.

For more information, see "Printing."

ID Card Copy

You can set the features for the ID Card Copy function.

For more information, see "Using the ID Card Copy."

Using the Keyboard Displayed on the Touch Panel
During operations, a keyboard for entering text sometimes appears. The following describes how to enter text.

You can enter the following characters: numbers, alphabets, and symbols.

QWERTY AZERTY QWERTZ
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Using the Number Pad
As you perform various tasks, you may need to enter numbers. For example, when you specify the quantity of copies 
or when you enter fax number directly.

Number Pad Numbers

Changing Numbers or Names
If you make a mistake while entering a number, press the  (Delete) button to delete the last digit or character. 
Then enter the correct number or character.

Item Description

Changing keyboards Select  to change the keyboard layout on the touch panel. Select from 
QWERTY, AZERTY, or QWERTZ. 

Entering alphabets To enter uppercase letters, select . To return to the lowercase letters, select 
 again.

Entering numbers and symbols Select .

Entering a space Select Space or .

Deleting characters Select  to delete one character at a time.

1

2

3

4

5

6

7

8

9

0

∗

#
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Inserting a Pause
For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must be 
entered in order for the access code to function. For example, enter the access code 9 and then press the  
(Redial/Pause) button before entering the telephone number. "-" appears on the display to indicate when a pause is 
entered.

Printing a Panel Settings Report
The panel settings report shows current settings for the printer menus. For details about how to print a panel settings 
report, see "Report / List."

Changing the Language
To change the language used on the touch panel:

When Using the Operator Panel
1 Press the  (Information) button.

2 Select the Tools tab, and then select Panel Language.

3 Select the  until the desired language appears, and then select the desired language.

4 Select OK.

When Using the Tool Box
1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box."

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Panel Language from the list at the left side of the page.

The Panel Language page appears.

4 Select the desired language from Panel Language, and then click Apply New Settings.

Setting the Power Saver Timer Option
You can set the power saver timer for the printer. The printer enters the power saver mode when the printer is not 
used for a certain period of time.

 NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu.

To set the power saver timer:

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings. 

3 Select  until System Settings appears, and then select System Settings.

4 Select  until General appears, and then select General.

5 Select  until Power Saver Timer appears, and then select Power Saver Timer.

6 Select Sleep or Deep Sleep.
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7 Select  or , or use the number pad to enter the desired value.

You can specify from 1 to 60 minutes for Sleep or 1 to 60 minutes for Deep Sleep.

To return to the Information screen, press the (All Clear) button.

About the Concurrent Jobs Feature 
This feature enables you to start a concurrent job while a fax job is running. This is done by temporarily displaying 
the Main Home screen and switching to a different function that can be run concurrently such as copy or scan.

1 While the printer is sending or receiving a fax, press the  (Home) button.

2 Select Copy or Scan Menu. 

3 After setting the copy or scan options, press the  (Start) button.

For details about Copy or Scan Menu, see "Copying" or "Scanning."
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14
Dell™ Printer Configuration Web Tool

Overview
 NOTE: This web tool is available only when the printer is connected to a network using an Ethernet cable or the wireless printer 

adapter.

One of the features of the Dell Printer Configuration Web Tool is E-Mail Alert Setup, which sends e-mail to you or 
the key operator when the printer needs supplies or intervention. 

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the Printer 
Information feature in the Dell Printer Configuration Web Tool. Enter the IP address of each printer on the 
network to display the asset tag number. 

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of 
printing trends. If you are a network administrator, you can copy the printer settings to one or all printers on the 
network using your web browser.
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Setting Up the Dell Printer Configuration Web Tool
Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.

Follow the procedures below to configure both the environment settings of your web browser and the EWS setting 
on the operator panel before using the Dell Printer Configuration Web Tool.

 NOTE: The Dell Printer Configuration Web Tool pages may be displayed unreadable if the pages were configured by the 
language different from the language of your web browser.

Setting Up From Web Browser

For Internet Explorer® 

Setting Up the Display Language

1 Select Internet Options from Tools on the menu bar.

2 Select Languages in the General tab.

3 Specify the display language in order of preference in the Language list.

For example:

• Italian (Italy) [it-IT]

• Spanish (Traditional Sort) [es-ES tradnl]

• German (Germany) [de-DE]

• French (France) [fr-FR]

• English (United States) [en-US]

• Danish [da-DK]

• Dutch (Netherlands) [nl-NL]

• Norwegian (Bokmal) [no]

• Swedish [sv-SE]

Setting the IP Address of the Printer to Non-Proxy

1 Select Internet Options from the Tools menu.

2 Click LAN Settings under Local Area Network (LAN) Settings in the Connections tab.

3 Do either of the following:

• Clear the Use a proxy server for your LAN check box under Proxy server.

• Click Advanced, and then specify the IP address of the printer in the Do not use proxy server for addresses 
beginning with field under Exceptions.

For Firefox 2.0 or Later

Setting Up the Display Language

1 Select Options from the Tools menu.

2 Click Advanced.

3 If you are using Firefox 2.0, click Choose in the General tab. If you are using Firefox 3.0, click Choose in the 
Content tab.
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4 Specify the display language in order of preference in the Languages in order of preference list menu.

For example:

• English [en] or English/United States [en-us]

• Italian [it]

• Spanish [es]

• German [de]

• French [fr]

• Dutch [nl]

• Norwegian [no]

• Swedish [sv]

• Danish [da]

Setting the IP Address of the Printer to Non-Proxy

1 Select Options from the Tools menu.

2 Click Advanced tab.

3 Click Network on the Options dialog box.

4 Click Connection → Settings.

5 If you are using Firefox 2.0, do one of the following:

• Select the Direct connection to the Internet check box.

• Select the Auto-detect proxy settings for this network check box.

• Select the Manual proxy configuration check box, and then enter the IP address of the printer in the No Proxy 
for edit box. 

• Select the Automatic proxy configuration URL check box.

If you are using Firefox 3.0, do one of the following:

• Select the No Proxy check box, if you do not want to use a proxy.

• Select the Auto-detect proxy settings for this network check box.

• Select the Manual proxy configuration check box, and then enter a hostname and a port number if you have a 
list of one or more proxy servers. If you have an IP address that does not use a proxy, enter the IP address of the 
printer in the No Proxy for edit box. 

• Select the Automatic proxy configuration URL check box.

Setting Up From Operator Panel
You can launch the Dell Printer Configuration Web Tool only when EWS is set to Enable (the factory default) on 
the operator panel. Confirm the operator panel setting if you cannot launch the Dell Printer Configuration Web 
Tool. For more information, see "Understanding the Printer Menus."
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Starting the Dell Printer Configuration Web Tool
To launch the Dell Printer Configuration Web Tool, enter the IP address of your printer in your web browser.

If you do not know the IP address of your printer, print the system settings report or display the TCP/IP Settings 
page, which lists the IP address. For details about how to find your printer's IP address, see "Verifying the IP 
Settings."

Overview of the Menu Items
The Dell Printer Configuration Web Tool consists of the following menus:

• Printer Status

• Printer Jobs

• Printer Settings

• Print Server Settings

• Copy Printer Settings

• Print Volume

• Address Book

• Printer Information

• Tray Management

• E-Mail Alert

• Set Password

• Online Help

• Order Supplies at:

• Contact Dell Support at:

Printer Status
Use the Printer Status menu to get immediate feedback on the printer supply status. When a toner cartridge is 
running low, click the order supplies link on the first screen to order a new toner cartridge.

Printer Jobs
Use the Printer Jobs menu to contain information on the Job List page and Completed Jobs page.

These pages show the details of the status regarding each protocol or job.

Printer Settings
Use the Printer Settings menu to change the printer settings and to view the settings in the operator panel remotely.

Print Server Settings
Use the Print Server Settings menu to change the type of printer interface and the necessary conditions for 
communications.



Dell™ Printer Configuration Web Tool 139

Copy Printer Settings
Use the Copy Printer Settings menu to copy the printer settings to another printer or printers on the network by 
typing the IP address of each printer.

 NOTE: You must log in as an administrator to use this feature.

Print Volume
Use the Print Volume menu to check the history of printing, such as paper usage, the types of jobs being printed, 
limit to which users can use the color mode, and the maximum number of pages they can print.

Address Book
Use the Address Book menu to view or edit the e-mail address, server address, and fax number entries in the Address 
Book, or to register new entries.

 NOTE: You must log in as an administrator to use this feature.

Printer Information
Use the Printer Information menu to get information on service calls, inventory reports, or the status of current 
memory and engine code levels.

Tray Management
Use the Tray Management menu to get information about the paper type and size for each tray.

E-Mail Alert
Use the E-Mail Alert menu to receive e-mail when the printer needs supplies or intervention. To be notified, type 
your name or the name of the key operator in the e-mail list box. Set E-mail Alert also when using the Scan to E-
mail or forwarding fax to e-mail feature.

Set Password
Use the Set Password menu to lock the Dell Printer Configuration Web Tool with a password so that other users do 
not inadvertently change the printer settings that you have selected.

 NOTE: You must log in as an administrator to use this feature.

Online Help
Click Online Help to visit the Dell Support website.

Order Supplies at:
www.dell.com/supplies

Contact Dell Support at:
support.dell.com

http://www.dell.com/supplies
http://support.dell.com
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Page Display Format
The layout of the page is divided into three sections listed below: 

• Top Frame

• Left Frame

• Right Frame

Top Frame
The top frame is located at the top of all pages. When the Dell Printer Configuration Web Tool is activated, the 
current status and specifications of the printer are displayed in the top frame on every page. 

The following items are displayed in the top frame.

1 Dell C3765dnf Color 
MFP

Displays the product name of the printer.

2 IPv4 Displays the IP address of the printer.

IPv6

3 Location Displays location of the printer. The location can be changed in the Basic Information section on 
the Print Server Settings page.

4 Contact Person Displays the name of the printer administrator. The name can be changed in the Basic 
Information section on the Print Server Settings page.

5 Event Panel Displays the indicator for the condition of the printer. 

6 Machine image Shows the bitmap image of the printer. The Printer Status menu appears in the right frame when 
you click on the image.

1 2 3 4 65
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Left Frame
The left frame is located on the left side of all the pages. The menu titles displayed in the left frame are linked to 
corresponding menus and pages. You can go to the corresponding page by clicking their characters.

The following menus are displayed in the left frame.

Right Frame
The right frame is located on the right side of all the pages. The contents of the right frame correspond to the menu 
that you select in the left frame. For details on the items displayed in the right frame, see "Details of the Menu 
Items."

1 Printer Status Links to the Printer Status menu.

2 Printer Jobs Links to the Printer Jobs menu.

3 Printer Settings Links to the Printer Settings Report menu.

4 Print Server Settings Links to the Print Server Reports menu.

5 Copy Printer Settings Links to the Copy Printer Settings menu.

6 Print Volume Links to the Print Volume menu.

7 Address Book Links to the E-Mail Address menu.

8 Printer Information Links to the Printer Status menu.

9 Tray Management Links to the Tray Management menu.

10 E-Mail Alert Links to the Print Server Settings menu.

11 Set Password Links to the Security menu.

12 Online Help Links to the Dell Support website. 

13 Order Supplies at: Links to the Dell web page.

14 Contact Dell Support at: Links to the Dell support page web address: http://support.dell.com

1
2
3
4
5
6

8
9

10
11
12
13

14

7

http://support.dell.com
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Buttons in the Right Frame

Changing the Settings of the Menu Items
Some menus allow you to change the printer settings through the Dell Printer Configuration Web Tool. When you 
access these menus, the authentication window appears on the screen. Type a user name and password for the 
printer administrator by following the prompts displayed in the dialog box.

The default user name is admin, and the default password is left blank (NULL). You can change only the password in 
the Set Password page in the Security menu. The user name cannot be changed. See "Set Password" for more 
information.

Details of the Menu Items

1 Refresh Button Receives the current printer configuration and updates the latest information in the right frame.

2 Apply New Settings 
Button

Submits new settings made on the Dell Printer Configuration Web Tool to the printer. The new 
settings replace the old settings of the printer.

3 Restore Settings Button Restores the old settings that existed before any changes were made. New settings will not be 
submitted to the printer.

"Printer Status" "Printer Status" "Printer Status"

"Printer Events"

"Printer Information"

"Printer Jobs" "Printer Jobs" "Job List"

"Completed Jobs"

1 2 3
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"Printer Settings" "Printer Settings Report" "Menu Settings"

"Reports"

"Printer Settings" "System Settings"

"Network Settings"

"USB Settings"

"PCL Settings"

"PostScript Settings"

"PDF Settings"

"Secure Settings"

"Copy Defaults"

"Copy Color Balance"

"Copy Settings"

"Fax Defaults"

"Fax Settings"

"Scan Defaults"

"USB Direct Print Defaults"

"Printer Maintenance" "Paper Density"

"Adjust Transfer Belt Unit"

"Adjust 2nd BTR"

"Adjust Fusing Unit"

"Auto Registration Adjustment"

"Color Registration Adjustments"

"Reset Defaults"

"Initialize PrintMeter"

"Storage"*1

"Non-Dell Toner"

"Adjust Altitude"

"Clock Settings"

"Web Link Customization"
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"Print Server Settings" "Print Server Reports" "Print Server Setup Page"

"E-Mail Alert Setup Page"

"Print Server Settings" "Basic Information"

"Port Settings"

"TCP/IP"

"SMB"

"E-Mail Alert"

"Bonjour (mDNS)"

"SNMP"

"Scan to PC"

"SNTP"

"Wireless LAN"*2

"AirPrint"

"Google Cloud Print"

"Proxy Server"

"Reset Print Server"

"Print Server Settings" "Security" "Set Password"

"Authentication System"

"Kerberos Server"

"LDAP Server"

"LDAP Authentication"

"LDAP User Mapping"

"SSL/TLS"

"IPsec"

"802.1x"*3

"IP Filter (IPv4)"

"SMTP Domain Filtering"

"Copy Printer Settings" "Copy Printer Settings" "Copy Printer Settings"

"Copy Printer Settings Report"

"Print Volume" "Print Volume" "Print Volume"

"Dell ColorTrack"

"Address Book" "E-Mail Address" "E-Mail Address"

"E-Mail Group"

"Default Setup"

"Server Address" "Server Address"

"Phone Book" "FAX Speed Dial"

"FAX Group"

"Tray Management" "Tray Management"
*1 This item is available only when RAM Disk is enabled.
*2 This item is available only when the printer is connected using the wireless network.
*3 This item is available only when the printer is connected using an Ethernet cable. 
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Printer Status
Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer.

The following pages are displayed in the Printer Status menu.

Printer Status

Purpose:

To check the status of the consumables, trays, and covers.

Values:

Printer Events

Purpose:

When faults occur, such as Out of Paper or Cover is open, the details of all alerts or indications of faults are displayed 
in the Printer Events page.

Values:

Cyan Toner Cartridge

Magenta Toner Cartridge

Yellow Toner Cartridge

Black Toner Cartridge

OK Indicates that there is enough amount of toner for use.

Replace Soon Indicates that the toner needs to be replaced soon.

Replace Now Indicates that the toner needs to be replaced now.

Consumables Status OK Indicates that the status of the drum cartridge and/or waste toner 
box is OK for use. 

Replace Soon Indicates that the drum cartridge and/or waste toner box needs to be 
replaced soon. 

Replace Now Indicates that the drum cartridge and/or waste toner box needs to be 
replaced now.

Paper Trays Status OK Indicates that there is some paper in the tray but the quantity is 
unknown.

Add Paper Indicates that there is no paper in the tray.

Capacity Displays the maximum capacity of the paper tray.

Size Displays the size of paper in the tray.

Output Tray Status OK Indicates that the tray is available.

Full Indicates that the tray is not available.

Capacity Displays the maximum capacity of the paper tray.

Cover Status Closed Indicates that the cover is closed.

Open Indicates that the cover is open.

Printer Type Displays the type of the printer. Color Laser is displayed normally.

Printing Speed Displays the printing speed.

Location Displays the location where a fault occurred.

Details Displays the details of the fault.
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Printer Information

Purpose:

To verify the printer details such as the hardware configuration and software version. This page can also be displayed 
by clicking on the Printer Information tab in the left frame.

Values:

Printer Jobs
The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the 
details of the status regarding each protocol or job.

Job List

Purpose:

To confirm the jobs that are being processed. Click the Refresh button to update the screen.

Values:

Completed Jobs

Purpose:

To check the completed jobs. Up to the last 20 jobs are displayed. Click the Refresh button to update the screen.

Values:

Dell Service Tag Number Displays Dell service tag number.

Express Service Code Displays Dell express service code.

Asset Tag Number Displays the asset tag number of the printer.

Printer Serial Number Displays the serial number of the printer.

Memory Capacity Displays the memory capacity.

Hard Disk*1 Displays information on the printer's hard disk.

Processor Speed Displays the processing speed.

Printer Revision Levels Firmware Version Displays the revision date (revision level).

Network Firmware Version Displays the revision date (revision level).

*1 This item is available only when the optional hard disk drive is installed.

ID Displays the job ID.

Job Name Displays the file name of the job being processed.

Owner Displays the name of the job owner.

Host Name Displays the name of the host computer.

Job Status Displays the status of the job being processed.

Job Type Displays the type of the job.

Host I/F Displays the status of the host interface.

Job Submitted Time Displays the date when the job was submitted.

ID Displays the job ID.

Job Name Displays the file name of the completed job.

Owner Displays the name of the job owner.
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Printer Settings
Use the Printer Settings menu to display the Printer Settings Report, Printer Settings, and Printer Maintenance 
tabs and to configure the printer settings.

The following tabbed pages are displayed at the top of the right frame.

Printer Settings Report

The Printer Settings Report tab includes the Menu Settings and Reports pages.

Menu Settings

Purpose:

To display the current settings of the printer menus. 

Values:

Host Name Displays the name of the host computer.

Output Result Displays the status of the completed job.

Job Type Displays the type of the job.

Impression Number Displays the total number of pages for the job.

No. of Sheets Displays the total number of sheets for the job.

Host I/F Displays the status of the host interface.

Job Submitted Time Displays the date when the job was submitted.

System Settings Power Saver Time - Sleep Displays the time taken by the printer to enter Sleep mode after it 
finishes a job.

Power Saver Time - Deep 
Sleep

Displays the time taken by the printer to enter Deep Sleep mode after 
it has entered Sleep mode.

mm / inch Displays the measurement unit that is used on the touch panel.

Display Brightness Displays the brightness level of the touch panel screen.

Control Panel Tone Displays the volume of the tone that is emitted when the operator 
panel input is correct. Off indicates that the tone is disabled.

Invalid Key Tone Displays the volume of the tone that is emitted when the operator 
panel input is incorrect. Off indicates that the tone is disabled.

Machine Ready Tone Displays the volume of the tone that is emitted when the printer 
becomes ready. Off indicates that the tone is disabled.

Copy Completed Tone Displays the volume of the tone that is emitted when a copy job is 
complete. Off indicates that the tone is disabled.

Job Completed Tone Displays the volume of the tone that is emitted when a job other than a 
copy job is complete. Off indicates that the tone is disabled.

Fault Tone Displays the volume of the tone that is emitted when a job ends 
abnormally. Off indicates that the tone is disabled.

Alert Tone Displays the volume of the tone that is emitted when a problem occurs. 
Off indicates that the tone is disabled.

Out of Paper Tone Displays the volume of the tone that is emitted when the printer runs 
out of paper. Off indicates that the tone is disabled.

Low Toner Alert Tone Displays the volume of the tone that is emitted when the toner is low. 
Off indicates that the tone is disabled.
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Auto Clear Alert Tone Displays the volume of the tone that is emitted 5 seconds before the 
printer performs auto clear. Off indicates that the tone is disabled.

All Tones Displays the volume of all the alert tones. Off indicates that all the 
tones are disabled.

Low Toner Alert Message Displays whether to show the alert message when the toner is low. 

OffHook Wake Up Displays whether to wake up from Sleep or Deep Sleep mode when you 
pick up the handset of the external telephone.

Auto Log Print Displays whether to automatically print a job history report after every 
20 jobs.

RAM Disk*1 Displays whether to allocate RAM for the file system for the Secure 
Print, Proof Print, Private Mail Box Print, and Public Mail Box Print 
features. 

Panel Language Displays the language used on the touch panel.

Auto Reset Displays the amount of time before the printer automatically resets its 
settings to the defaults when no additional settings are made.

Fault Time-out Displays the amount of time the printer waits before canceling a job 
that stops abnormally. 

Job Time-out Displays the amount of time the printer waits for data to arrive from 
the computer.

Default Paper Size Displays the default print paper size.

Print ID Displays where to print a user ID on the output paper.

Print Text Displays whether the printer outputs PDL (Page Description 
Language) data (which is not supported by the printer) as text when 
the printer receives it.

Banner Sheet Insert 
Position

Displays where to insert a banner sheet in the output paper.

Banner Sheet Specify Tray Displays the tray to feed a banner sheet. 

Substitute Tray Displays if paper of another size has to be used when the paper that is 
loaded in the specified tray does not match the paper size setting for 
the current job.

Letterhead 2 Sided Displays whether to print both sides on letterhead.

A4<>Letter Switch Displays whether to print A4 size jobs on Letter size paper if A4 is not 
available in the paper trays and vice versa (Letter size job on A4 size 
paper).

Report 2 Sided Print Displays whether to print reports on both sides a sheet of paper. 

Use Another Tray Displays whether to show a message to select another tray when the 
specified paper is not available in the paper tray.

Network Settings Adobe Protocol Displays PostScript communication protocol for each interface.

USB Settings USB Port Displays whether to enable the USB interface. 

Adobe Protocol Displays PostScript communication protocol for each interface.

PCL Settings Paper Tray Displays the paper input tray.

Paper Size Displays the paper size setting.

Custom Paper Size - Y Displays the length of custom size paper.

Custom Paper Size - X Displays the width of custom size paper.

Orientation Displays how text and graphics are oriented on the page.

2 Sided Print Displays whether to print on both sides of a sheet of paper. 
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Font Displays the selected font from the list of registered fonts.

Symbol Set Displays a symbol set for the specified font.

Font Size Displays the font size for scalable typographic fonts.

Font Pitch Displays the font pitch for scalable mono spaced fonts.

Form Line Displays the number of lines in a page.

Quantity Displays the number of copies to print.

Image Enhance Displays whether to enable the Image Enhancement feature.

Hex Dump Displays whether to enable the Hex Dump feature.

Draft Mode Displays whether to print in the draft mode.

Line Termination Displays whether to set the line termination.

Default Color Displays the color mode setting. 

Ignore Form Feed Displays whether to ignore blank pages that only contain Form Feed 
control codes.

PostScript Settings PS Error Report Displays whether the printer outputs error contents for a PostScript 
error.

PS Job Time-out Displays the execution time for one PostScript job.

Paper Select Mode Displays the tray that is selected in the PostScript printing.

Default Color Displays the color mode setting.

PDF Settings Quantity Displays the number of copies to print.

2 Sided Print Displays whether to print on both sides of a sheet of paper. 

Print Mode Displays the print mode setting. 

Collation Displays whether to sort a job.

Output Size Displays the output paper size.

Layout Displays the output layout.

Default Color Displays the color mode setting.

Secure Settings Panel Lock Control Displays whether to lock Admin Settings with a password.

Copy Displays whether to lock the Copy function with a password.

E-mail Displays whether to lock the Scan to E-mail function with a password.

Fax Displays whether to lock the Fax function with a password.

Fax Driver Displays whether to lock the Fax Driver function with a password.

Scan To Network Displays whether to lock the Scan To Network function with a 
password.

Scan To Application Displays whether to lock the Scan To Application function with a 
password.

PC Scan Displays whether to lock the PC Scan function with a password.

Scan To USB Displays whether to lock the Scan To USB function with a password.

USB Direct Print Displays whether to lock the USB Direct Print function with a password.

ID Card Copy Displays whether to lock the ID Card Copy function with a password.

USB Services - Show When 
Inserted

Displays whether to show a USB Drive Detected screen when a USB 
memory is inserted into the printer.

USB Services - Hide Until 
Inserted

Displays whether to hide menus concerning USB memory until a USB 
memory is inserted into the printer.

Secure Receive Set Displays whether a password is required to receive faxes.
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Edit E-mail From Fields Displays whether to enable editing of the transmission source when you 
use the Scan to E-mail function.

Reconfirm Recipients Displays whether to reconfirm before sending fax or scan jobs.

Software Download Displays whether to enable download of firmware updates.

Display of Network 
Information

Displays whether to show network information in the message field of 
the Main Home screen.

Encryption Displays whether to encrypt the data.

Hard Disk Over Write*2 Displays whether to overwrite the hard disk drive.

Login Error Displays how many times an administrator can attempt to log in to 
Panel Lock, Function Enabled, and Secure Receive. 

Expiration Mode*3 Displays whether to set the date to delete the files stored as Secure 
Print in the RAM disk or the hard disk drive.

Expiration Time*3 Displays the time to delete the files stored as Secure Print in the RAM 
disk or the hard disk drive.

Recurrence*3 Displays the period to repeat the setting.

Weekly Settings*3 Displays the day of the week to repeat the setting.

Monthly Settings*3 Displays the day of the month to repeat the setting.

Secure Settings - 
Copy/Scan/Fax/Print

Set Available Time Displays whether to set the available time period for the Print, Copy, 
Fax, and Scan functions, respectively. 

Start Time Displays the start time of the available time period for the Print, Copy, 
Fax, and Scan functions, respectively.

End Time Displays the end time of the available time period for the Print, Copy, 
Fax, and Scan functions, respectively.

Recurrence Displays the day of the week to repeat the setting.

Copy Defaults Output Color Displays whether to make copies in color or in black and white.

Select Tray Displays the default input tray.

Collation Displays whether to sort a copy job.

Reduce/Enlarge Displays the default copy reduction/enlargement ratio.

Original Size Displays the paper size of the original.

Original Type Displays the type of the original.

Darken/Lighten Displays the default copy density.

Sharpness Displays the default sharpness level.

Color Saturation Displays the default color saturation level.

Auto Exposure Displays whether to suppress the background of the original to enhance 
text on the copy.

Auto Exposure Level Displays the background suppression level.
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Copy Color Balance Yellow Low Density Displays the color balance level of low density yellow.

Yellow Medium Density Displays the color balance level of medium density yellow.

Yellow High Density Displays the color balance level of high density yellow.

Magenta Low Density Displays the color balance level of low density magenta.

Magenta Medium Density Displays the color balance level of medium density magenta.

Magenta High Density Displays the color balance level of high density magenta.

Cyan Low Density Displays the color balance level of low density cyan.

Cyan Medium Density Displays the color balance level of medium density cyan.

Cyan High Density Displays the color balance level of high density cyan.

Black Low Density Displays the color balance level of low density black.

Black Medium Density Displays the color balance level of medium density black.

Black High Density Displays the color balance level of high density black.

Copy Settings 2 Sided Copying Displays whether to print on both sides of a sheet of paper. 

Binding of Original Displays the binding position for the 2-sided copying.

2-Up Displays whether the Multiple-Up feature is enabled.

Margin Top/Bottom Displays the value of the top and bottom margins.

Margin Left/Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

Fax Defaults Resolution Displays the resolution level to be used for fax transmission.

2 Sided Scanning Displays whether to scan both sides of a document.

Binding of Original Displays the binding position for the 2-sided scanning.

Darken/Lighten Displays the density level to be used for fax transmission.

Delayed Send Displays the fax transmission start time.

Fax Settings Fax Number Displays the fax number of the printer, which will be printed on the 
header of faxes.

Country Displays the country where the printer is used.

Fax Header Name Displays the name of the sender that will be printed on the header of 
faxes.

Line Type Displays the line type; PSTN or PBX.

Line Monitor Displays the volume of the line monitor, which audibly monitors a 
transmission through the internal speaker until a connection is made.

DRPD Pattern Displays the Distinctive Ring Pattern Detection (DRPD) setting.

Receive Mode Displays the fax receiving mode.

Ring Tone Volume Displays the volume of the ring tone, which indicates that an incoming 
call is a telephone call through the internal speaker when Receive 
Mode is set to Telephone/Fax.

Auto Receive Fax Displays the interval at which the printer goes into the fax receive 
mode after receiving an incoming call.

Auto Receive Tel/Fax Displays the interval at which the printer goes into the fax receive 
mode after the external telephone receives an incoming call.

Auto Receive Answer/Fax Displays the interval at which the printer goes into the fax mode after 
the external answering machine receives an incoming call.

Junk Fax Setup Displays whether to reject faxes sent from unwanted stations.

Sent Fax Forward Displays whether to forward incoming faxes to a specified destination.
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Forwarding Number Displays the fax number of the destination to which incoming faxes are 
to be forwarded.

Forwarding E-mail 
Address 1

Displays the e-mail address to which incoming faxes are to be 
forwarded.

Forwarding E-mail 
Address 2

Displays the e-mail address to which incoming faxes are to be 
forwarded.

Forwarding E-mail 
Address 3

Displays the e-mail address to which incoming faxes are to be 
forwarded.

Forwarding E-mail 
Address 4

Displays the e-mail address to which incoming faxes are to be 
forwarded.

Forwarding E-mail 
Address 5

Displays the e-mail address to which incoming faxes are to be 
forwarded.

2 Sided Printing Displays whether to print on both sides of a sheet of paper.

Remote Receive Displays whether to receive faxes by pressing a remote receive code on 
the external telephone.

Remote Receive Tone Displays the 2-digit remote receive code when Remote Receive is On.

Discard Size Displays whether to delete text or images at the bottom of a fax page 
when the entire page does not fit onto the output paper.

Redial Attempts Displays the number of redial attempts to make if the destination fax 
number is busy.

Interval of Redial Displays the interval between redial attempts.

Resend Delay Displays the interval between re-send attempts. 

Tone/Pulse Displays whether to use tone or pulse dialing.

Prefix Dial Displays whether to set a prefix dial number.

Prefix Dial Number Displays a prefix dial number. This number dials before any auto dial 
number is started. It is useful for accessing the Private Automatic 
Branch Exchange (PABX).

Fax Cover Page Displays whether to attach a cover page to faxes.

Fax Header Displays whether to print the information of the sender on the header 
of faxes.

ECM Displays whether the Error Correction Mode (ECM) is enabled.

Modem Speed Displays the modem speed.

Display Manual Fax 
Recipients

Displays whether to show the fax number of the recipient on the 
Sending Fax screen when manually sending a fax.

Fax Activity Displays whether to automatically print a fax activity report after every 
50 incoming and outgoing fax communications.
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Scan Defaults File Format Displays the file format in which scanned documents are to be saved.

Output Color Displays whether to scan in color or in black and white.

Resolution Displays the default scan resolution.

Original Size Displays the paper size of the original.

2 Sided Scanning Displays whether to scan both sides of a document.

Binding of Original Displays the binding position for the 2-sided scanning.

Darken/Lighten Displays the default scan density level.

Sharpness Displays the default sharpness level.

Contrast Displays the default contrast level.

Auto Exposure Displays whether to suppress the background of the original to enhance 
text on the scan.

Auto Exposure Level Displays the background suppression level.

Margin Top/Bottom Displays the value of the top and bottom margins.

Margin Left/Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

TIFF File Format Displays the selected TIFF file format; TIFF V6 or TTN2.

Image Compression Displays the image compression level.

Max E-mail Size Displays the maximum size of e-mail that can be sent.

File Naming Mode Displays the mode used to name scanned documents.

Prefix/Suffix String Displays the text string that will be added to the file name.

Create Folder Displays the folder to which scanned documents are to be saved.

USB Direct Print 
Defaults

Output Color Displays whether to print in color or in black and white.

Select Tray Displays the default input tray.

2 Sided Printing Displays whether to print on both sides of a sheet of paper. 

Multiple-Up Displays whether to print two or more pages on one side of a sheet of 
paper.

Collation*2 Displays whether to sort a job.

Paper Density Plain Displays the paper density of plain paper.

Label Displays the paper density of labels.

Adjust Transfer Belt Unit K Offset Displays the value for black ghost image.

YMC Offset Displays the value for color ghost image.

Adjust 2nd BTR Plain Displays the voltage setting of the transfer roller (-5 to 10) for plain 
paper. 

Plain Thick*4 Displays the voltage setting of the transfer roller (-5 to 10) for thick 
plain paper. 

Covers (106-163g/m2) Displays the voltage setting of the transfer roller (-5 to 10) for cover 
paper. 

Covers Thick*4 
(164-216g/m2)

Displays the voltage setting of the transfer roller (-5 to 10) for thick 
cover paper. 

Coated (106-163g/m2) Displays the voltage setting of the transfer roller (-5 to 10) for coated 
paper. 

Coated Thick*4 
(164-216g/m2)

Displays the voltage setting of the transfer roller (-5 to 10) for thick 
coated paper. 

Label Displays the voltage setting of the transfer roller (-5 to 10) for labels. 
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Envelope Displays the voltage setting of the transfer roller (-5 to 10) for 
envelopes.

Recycled Displays the voltage setting of the transfer roller (-5 to 10) for recycled 
paper.

Adjust Fusing Unit Plain Displays the temperature setting of the fusing unit (-3 to 3) for plain 
paper. 

Plain Thick*4 Displays the temperature setting of the fusing unit (-3 to 3) for thick 
plain paper. 

Covers (106-163g/m2) Displays the temperature setting of the fusing unit (-3 to 3) for cover 
paper.

Covers Thick*4 
(164-216g/m2)

Displays the temperature setting of the fusing unit (-3 to 3) for thick 
cover paper. 

Coated (106-163g/m2) Displays the temperature setting of the fusing unit (-3 to 3) for coated 
paper. 

Coated Thick*4 
(164-216g/m2)

Displays the temperature setting of the fusing unit (-3 to 3) for thick 
coated paper. 

Label Displays the temperature setting of the fusing unit (-3 to 3) for labels. 

Envelope Displays the temperature setting of the fusing unit (-3 to 3) for 
envelopes.

Recycled Displays the temperature setting of the fusing unit (-3 to 3) for recycled 
paper. 

Auto Registration Adjustment Displays whether to automatically perform color registration 
adjustment.

Adjust Altitude Displays the altitude of the location where the printer is installed.

Non-Dell Toner Displays whether to use toner cartridge of another manufacturer.

Clock Settings Date Format Displays the default date format.

Time Format Displays the default time format; 24H or 12H.

Time Zone Displays the default time zone.

Set Date Displays the date setting.

Set Time Displays the time setting.

Web Link Customization Select Reorder URL Displays a link used for ordering consumables, which can be accessed 
from Order Supplies at: in the left frame.

Regular Displays the regular URL (http://accessories.us.dell.com/sna) that can 
be linked to Order Supplies at:.

Premier Displays the premier URL (http://premier.dell.com) that can be linked 
to Order Supplies at:.

Dell ColorTrack ColorTrack Mode Displays whether to enable the ColorTrack.

Non Registered User Displays whether to permit the printing of data without authentication 
information.

Auto Color To Mono Print Displays whether to print all print jobs in black and white even when 
color print is specified.

ColorTrack Error Report Displays whether to print the error report on the ColorTrack mode.

http://accessories.us.dell.com/sna
http://premier.dell.com
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Reports

Purpose:

To print various types of reports and lists.

Values:

Tray Management MPF Use Driver Settings 
for Print Job

Displays whether to use the printer driver settings for the size and type 
of paper loaded in the multipurpose feeder (MPF).

MPF Paper Size*5 Displays the paper size setting of the MPF.

MPF Paper Type*5 Displays the paper type setting of the MPF.

MPF Custom Paper Size - 
Y*5

Displays the length of custom size paper loaded in the MPF.

MPF Custom Paper Size - 
X*5

Displays the width of custom size paper loaded in the MPF.

MPF Display Tray 
Prompt*5

Displays whether to show a popup menu that prompts the user to set 
the paper size and type when the paper is loaded in the MPF.

Tray 1 Paper Size Displays the paper size setting of tray1.

Tray 1 Paper Type Displays the paper type setting of tray1.

Tray 1 Custom Paper Size - 
Y

Displays the length of custom size paper loaded in tray1.

Tray 1 Custom Paper Size - 
X

Displays the width of custom size paper loaded in tray1.

Tray 1 Display Tray 
Prompt

Displays whether to show a popup menu that prompts the user to set 
the paper size and type when the paper is loaded in tray1.

Tray 2 Paper Size*6 Displays the paper size setting of the optional 550-sheet feeder (tray2).

Tray 2 Paper Type*6 Displays the paper type setting of the optional 550-sheet feeder.

Tray 2 Custom Paper Size - 
Y*6

Displays the length of custom size paper loaded in the optional 550-
sheet feeder.

Tray 2 Custom Paper Size - 
X*6

Displays the width of custom size paper loaded in the optional 550-
sheet feeder.

Tray 2 Display Tray 
Prompt*6

Displays whether to show a popup menu that prompts the user to set 
the paper size and type when the paper is loaded in the optional 550-
sheet feeder.

1st Priority Displays the paper source to be used as the first priority.

2nd Priority Displays the paper source to be used as the second priority.

3rd Priority*6 Displays the paper source to be used as the third priority.
*1 This item is not available when the optional hard disk is installed.
*2 This item is available only when the optional hard disk is installed.
*3 This item is available only when RAM Disk is enabled or the optional hard disk is installed.
*4 For paper weight specifications, see "Paper Type Specifications."
*5 This item is available only when Off in MPF Use Driver Settings for Print Job is selected.
*6 This item is available only when the optional 550-sheet feeder is installed.

System Settings Click Start to print the System Settings page.

Panel Settings Click Start to print the Panel Settings page.

PCL Fonts List Click Start to print the PCL (Hewlett-Packard Printer Control Language) Fonts List.

PCL Macros List Click Start to print the PCL Macro List.
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Printer Settings

The Printer Settings tab includes System Settings, Network Settings, USB Settings, PCL Settings, PostScript 
Settings, PDF Settings, Secure Settings, Copy Defaults, Copy Color Balance, Copy Settings, Fax Defaults, Fax 
Settings, Scan Defaults, and USB Direct Print Defaults pages.

System Settings

Purpose:

To configure the basic printer settings.

Values:

PS Fonts List Click Start to print the PS Fonts List.

PDF Fonts List Click Start to print the PDF Fonts List.

Job History Click Start to print the Job History report.

Error History Click Start to print the Error History report.

Print Meter Click Start to print the Print Meter report.

Color Test Page Click Start to print the Color Test Page.

Protocol Monitor Click Start to print the Protocol Monitor report.

Speed Dial Click Start to print the Speed Dial report.

Address Book Click Start to print the Address Book report.

Server Address Click Start to print the Server Address report.

Fax Activity Click Start to print the Fax Activity report.

Fax Pending Click Start to print the Fax Pending report.

Stored Documents*1 Click Start to print the Stored Documents list.
*1 This item is available only when RAM Disk is enabled or the optional hard disk is installed. 

Power Saver Time - Sleep Sets the time taken by the printer to enter Sleep mode after it finishes a job.

Power Saver Time - Deep Sleep Sets the time taken by the printer to enter Deep Sleep mode after it has 
entered Sleep mode.

mm / inch Sets the measurement unit to be used on the touch panel as either mm or 
inches.

Display Brightness Sets the brightness level of the touch panel screen.

Control Panel Tone Sets the volume of the tone that is emitted when the operator panel input is 
correct, or disables the tone.

Invalid Key Tone Sets the volume of the tone that is emitted when the operator panel input is 
incorrect, or disables the tone.

Machine Ready Tone Sets the volume of the tone that is emitted when the printer becomes ready, 
or disables the tone.

Copy Completed Tone Sets the volume of the tone that is emitted when a copy job is complete, or 
disables the tone.

Job Completed Tone Sets the volume of the tone that is emitted when a job other than a copy job 
is complete, or disables the tone.

Fault Tone Sets the volume of the tone that is emitted when a job ends abnormally, or 
disables the tone.

Alert Tone Sets the volume of the tone that is emitted when a problem occurs, or 
disables the tone.
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Network Settings

Purpose:

To Specify the PostScript communication protocol for this printer.

Values:

USB Settings

Purpose:

To change USB settings on your printer.

Out of Paper Tone Sets the volume of the tone that is emitted when the printer runs out of 
paper, or disables the tone.

Low Toner Alert Tone Sets the volume of the tone that is emitted when the toner is low, or 
disables the tone.

Auto Clear Alert Tone Sets the volume of the tone that is emitted 5 seconds before the printer 
performs auto clear, or disables the tone.

All Tones Sets the volume of all the alert tones, or disables all the tones.

Low Toner Alert Message Alerts you if the toner is low.

OffHook Wake Up Sets whether to wake up from Sleep or Deep Sleep mode when you pick up 
the handset of the external telephone.

Auto Log Print Sets if a job history needs to be printed after every 20 jobs.

RAM Disk*1 Sets whether to allocate RAM for the file system for the Secure Print, Proof 
Print, Private Mail Box Print, and Public Mail Box Print features.

Panel Language Used to set the language on the touch panel.

Auto Reset Sets the amount of time before the printer automatically resets its settings 
to the defaults when no additional settings are made.

Fault Time-out Sets the amount of time the printer waits before canceling a job that stops 
abnormally. 

Job Time-out Sets the amount of time the printer waits for data to arrive from the 
computer.

Default Paper Size Sets the default print paper size. 

Print ID Sets where to print the user ID on the output paper.

Print Text Sets whether the printer outputs PDL data (which is not supported by the 
printer) as text when the printer receives it.

Banner Sheet Insert Position Sets where to insert a banner sheet in the output.

Banner Sheet Specify Tray Sets from which tray a banner sheet is fed.

Substitute Tray Sets whether to use another size paper when the paper that is loaded in the 
specified tray does not match the paper size settings for the current job.

Letterhead 2 Sided Sets whether to print on both sides of letterhead.

A4<>Letter Switch Sets whether to print A4 size jobs on Letter size paper if A4 is not available 
in the paper trays and vice versa (Letter size job on A4 size paper).

Report 2 Sided Print Sets whether to print reports on both sides a sheet of paper. 

Use Another Tray Sets whether to show a message to select another tray when the specified 
paper is not available in the paper tray.

*1 This item is not available when the optional hard disk is installed.

Adobe Protocol Sets PostScript communication protocol for each interface.
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Values:

PCL Settings

Purpose:

To change the PCL settings.

Values:

PostScript Settings

Purpose:

To change printer settings that only affect jobs using the PostScript emulation printer language.

Values:

USB Port Enables the USB interface on your printer.

Adobe Protocol Sets PostScript communication protocol for each interface.

Paper Tray Sets the paper input tray.

Paper Size Sets the paper size.

Custom Paper Size - Y Sets the length of custom size paper. The available range is from 127 mm (5.0 inch) to 355 mm (14.0 
inch).

Custom Paper Size - X Sets the width of custom size paper. The available range is from 77 mm (3.0 inch) to 215 mm (8.5 
inch).

Orientation Sets how text and graphics are oriented on the page.

2 Sided Print Sets duplexing as the default for all print jobs.

Font Sets the font from the list of registered fonts.

Symbol Set Sets a symbol set for the specified font.

Font Size Sets the font size for scalable typographic fonts.

Font Pitch Sets the font pitch for scalable mono spaced fonts.

Form Line Sets the number of lines in a page.

Quantity Sets the number of copies to print.

Image Enhance Sets whether to enable the Image Enhancement feature.

Hex Dump Sets whether to help isolate the source of a print job problem. With Hex Dump selected, all data 
sent to the printer is printed in hexadecimal and character representation. Control codes are not 
executed.

Draft Mode Sets whether to print in the draft mode.

Line Termination Sets how to handle line terminations.

Default Color Sets the print color mode as Color or Black. This setting is used for print jobs without a specified 
color print mode.

Ignore Form Feed Sets whether to ignore blank pages that only contain Form Feed control codes.

PS Error Report Sets whether the printer outputs error contents for a PostScript error.

PS Job Time-out Sets the execution time for one PostScript job.

Paper Select Mode Sets the way to select the tray for the PostScript mode.

Default Color Sets the default color mode for the PostScript mode.
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PDF Settings

Purpose:

To change the PDF settings.

Values:

Secure Settings

Panel Lock

Purpose:

To set a limited access to Admin Settings with a password, and to set or change the password.

Values:

 NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Function Enabled

Purpose:

To specify whether to lock the Copy, Scan, Fax, and Print functions with a password, and to set or change the 
password.

Values:

Quantity Sets the number of copies.

2 Sided Print Sets whether to print on both sides of a sheet of paper. 

Print Mode Sets a print mode.

PDF Password Sets a password.

Re-enter PDF Password Confirms the set password.

Collation Sets whether to sort the output.

Output Size Sets the output paper size.

Layout Sets the output layout.

Default Color Sets the output color. 

Panel Lock Control*1 Enables/Disables password protection for the Admin Settings.

New Password Sets a password that is required to access the Admin Settings.

Re-enter Password Confirms the set password.
*1  Some setting items in the Secure Settings are displayed only when this setting item is enabled.

Copy Sets whether to lock the Copy function with a password.

E-mail Sets whether to lock the Scan to E-mail function with a password.

Fax Sets whether to lock the Fax function with a password.

Fax Driver Sets whether to lock the Fax Driver function with a password.

Scan To Network Sets whether to lock the Scan To Network function with a password.

Scan To Application Sets whether to lock the Scan To Application function with a password.

PC Scan Sets whether to lock the PC Scan function with a password.

Scan To USB Sets whether to lock the Scan To USB function with a password.

USB Direct Print Sets whether to lock the USB Direct Print function with a password.

ID Card Copy Sets whether to lock the ID Card Copy function with a password.
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 NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Secure Receive

Purpose:

Allows you to password protect all the incoming faxes. When the Secure Receive feature is enabled, the printer 
stores incoming faxes and prints them when the correct password is entered on the operator panel.

Values:

 NOTE: You can set the password for the Dell Printer Configuration Web Tool from Set Password in Print Server Settings.

Edit E-mail From Fields

Purpose:

To set whether to enable editing of the transmission source when you use the Scan to E-mail function.

Reconfirm Recipients

Purpose:

To set whether to reconfirm before sending fax or scan jobs.

Software Download

Purpose:

To set whether to enable download of firmware updates.

Display of Network Information

Purpose:

To set whether to show network information in the message field of the Main Home screen.

Data Encryption

Purpose:

To set whether to encrypt the data.

Values:

USB Services - Show 
When Inserted

Sets whether to show a USB Drive Detected screen when a USB memory is inserted into the printer.

USB Services - Hide 
Until Inserted

Sets whether to hide menus concerning USB memory until a USB memory is inserted into the printer.

New Password Sets a password that is required to access the Copy, Scan, Fax, and Print functions.

Re-enter Password Confirms the set password.

Secure Receive Set Enables/Disables password protection for all incoming faxes.

New Password Sets a password for incoming faxes.

Re-enter Password Confirms the set password.

Data Encryption Encryption Sets whether to encrypt the data.

Encryption Key Sets a key that is required to encrypt.

Re-enter Encryption Key Enter the new key again to confirm.
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 NOTE: You can enter only characters from 0 to 9, a to z, A to Z, and NULL values for encryption key.

Hard Disk Over Write

 NOTE: Hard Disk Over Write feature is available only when the optional hard disk is installed.

Purpose:

To set whether to overwrite the hard disk drive.

Values:

Login Error

Purpose:

To specify how many times an administrator can attempt to log in to Panel Lock, Function Enabled, and Secure 
Receive.

Values:

Set Available Time - Copy/Scan/Fax/Print

Purpose:

To specify the time to enable the secure setting for the Copy, Scan, Fax, and Print functions. 

Values:

Secure Job Expiration

 NOTE: Secure Job Expiration feature is available only when RAM Disk is enabled or the optional hard disk is installed.

Purpose:

To specify the date and time to delete the files stored as Secure Print in the RAM disk or the optional hard disk drive.

Values:

Hard Disk Over Write Sets whether to overwrite the hard disk drive.

Login Error Displays how many times an administrator can attempt to log in to Panel Lock, Function Enabled, 
and Secure Receive. 

Set Available Time Allows you to set the available time period for the Copy, Scan, Fax, and Print functions.

Start Time Sets the start time of the available time period for the Copy, Scan, Fax, and Print functions.

End Time Sets the end time of the available time period for the Copy, Scan, Fax, and Print functions.

Recurrence Sets the day of the week to repeat the setting.

Expiration Mode Allows you to set the date to delete the files stored as Secure Print in the RAM disk or the optional 
hard disk drive.

Expiration Time Sets the time to delete the files stored as Secure Print in the RAM disk or the optional hard disk drive.

Recurrence Sets the period to repeat the setting.

Weekly Settings Sets the day of the week to repeat the setting.

Monthly Settings Sets the day of the month to repeat the setting.
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Copy Defaults

Purpose:

To create your own default Copy settings.

Values:

Copy Color Balance

Purpose:

To specify the copy color balance.

Values:

Copy Settings

Purpose:

To configure the Copy settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Output Color Sets whether to print in color or in black and white.

Select Tray Sets the default input tray.

Collation Sets whether to sort a copy job.

Reduce/Enlarge Sets the default reduction/enlargement ratio.

Custom Reduce/Enlarge Sets the custom reduction/enlargement ratio.

Original Size Sets the paper size of the original.

Original Type Sets the type of the original.

Darken/Lighten Sets the default copy density.

Sharpness Sets the default sharpness level.

Color Saturation Adjusts the saturation of colors to make the colors lighter or darker than the original.

Auto Exposure Sets whether to suppress the background of the original to enhance text on the copy.

Auto Exposure Level Sets the background suppression level.

Yellow Low Density Sets the color balance level of low density yellow.

Yellow Medium Density Sets the color balance level of medium density yellow.

Yellow High Density Sets the color balance level of high density yellow. 

Magenta Low Density Sets the color balance level of low density magenta. 

Magenta Medium 
Density

Sets the color balance level of medium density magenta. 

Magenta High Density Sets the color balance level of high density magenta. 

Cyan Low Density Sets the color balance level of low density cyan. 

Cyan Medium Density Sets the color balance level of medium density cyan. 

Cyan High Density Sets the color balance level of high density cyan.

Black Low Density Sets the color balance level of low density black.

Black Medium Density Sets the color balance level of medium density black.

Black High Density Sets the color balance level of high density black.
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Values:

Fax Defaults

Purpose:

To create your own default Fax settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Fax Settings

Purpose:

To configure the Fax settings.

 NOTE: You cannot set up the items on the Fax Settings page unless you set up the country code under Country. 

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

2 Sided Copying Sets whether to print on both sides of a sheet of paper.

Binding of Original Sets the binding position for the 2-sided copying.

2-Up Off* Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

Manual Prints the original pages onto one sheet of paper in the size specified for 
Reduce/Enlarge. 

Margin Top/Bottom Sets the value of the top and bottom margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 
inch).

Margin Left/Right Sets the value of the left and right margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).

Margin Middle Sets the value of the middle margin within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).

Resolution Standard* Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or 
documents printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The super fine 
mode is enabled only if the remote machine also supports the Super Fine 
resolution.

Photo Suitable for documents containing photographic images.

2 Sided Scanning Sets whether to scan both sides of a document.

Binding of Original Sets the binding position for the 2-sided scanning.

Darken/Lighten Sets the default density to fax your documents lighter or darker.

Delayed Send Sets the fax transmission start time when sending a fax at a specified time.

Fax Number Allows you to enter the fax number of the printer, which will be printed on the header of faxes.

Country Sets the country where the printer is used.

Fax Header Name Allows you to enter a name that will be printed on the header of faxes.

Line Type Sets the default line type; PSTN or PBX.

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission through the internal 
speaker until a connection is made.
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DRPD Pattern Sets the Distinctive Ring Pattern Detection (DRPD) setting from Pattern1 to Pattern7.

DRPD is a service provided by some telephone companies.

Receive Mode Fax* Automatically receives faxes.

Telephone Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone and then pressing a remote receive code, or by 
selecting Manual Receive in On Hook and then pressing the  (Start) 
button. For details about Manual Receive, see "Receiving a Fax Manually in 
the Telephone Mode."

Telephone/Fax When the printer receives an incoming fax, the external telephone rings for the 
time specified in Auto Receive Tel/Fax, and then the printer automatically 
receives a fax. If an incoming call is not a fax, the printer beeps from the internal 
speaker indicating that the call is a telephone call.

Ans Machine/Fax The printer can share a telephone line with an answering machine. In this mode, 
the printer will monitor the fax signal and pick up the line if there are fax tones. If 
the telephone communication in your country is serial, this mode is not 
supported. 

DRPD Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive 
ring service must be installed on your telephone line by the telephone company. 
After the telephone company has provided a separate number for faxing with a 
distinctive ring pattern, configure the fax setup to monitor for that specific ring 
pattern.

Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming call is a telephone call through the 
internal speaker when Receive Mode is set to Telephone/Fax.

Auto Receive Fax Sets the interval at which the printer goes into the fax receive mode after answering an incoming call. 

Auto Receive Tel/Fax Sets the interval at which the printer goes into the fax receive mode after the external telephone 
receives an incoming call.

Auto Receive 
Answer/Fax

Sets the interval at which the printer goes into the fax receive mode after the external answering 
machine receives an incoming call.

Junk Fax Setup Sets whether to reject unwanted faxes by accepting only the faxes from the numbers registered in the 
Phone Book

Sent Fax Forward Sets whether to forward incoming faxes to a specified destination.

Forwarding Number Allows you to enter the fax number of the destination to which incoming faxes will be forwarded.

Forwarding E-mail 
Address 1

Allows you to enter the e-mail address to which incoming faxes are to be forwarded.

Forwarding E-mail 
Address 2

Allows you to enter the e-mail address to which incoming faxes are to be forwarded.

Forwarding E-mail 
Address 3

Allows you to enter the e-mail address to which incoming faxes are to be forwarded.

Forwarding E-mail 
Address 4

Allows you to enter the e-mail address to which incoming faxes are to be forwarded.

Forwarding E-mail 
Address 5

Allows you to enter the e-mail address to which incoming faxes are to be forwarded.

2 Sided Printing Sets whether to print on both sides of a sheet of paper.

Remote Receive Sets whether to receive a fax by pressing a remote receive code on the external telephone.

Remote Receive Tone Sets a 2-digit remote receive code when Remote Receive is On.

Discard Size Sets whether to delete text or images at the bottom of a fax page when the entire page does not fit 
onto the output paper. Selecting Auto Reduction automatically reduces the fax page to fit it onto the 
output paper, and does not discard any images or text at the bottom of the page.
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Scan Defaults

Purpose:

To create your own default Scan settings.

Values:

Redial Attempts Sets the number of redial attempts (0–13) to make if the destination fax number is busy. If you enter 
0, the printer will not redial.

Interval of Redial Sets the interval (1–15 minutes) between redial attempts.

Resend Delay Sets the interval (3–255 seconds) between re-send attempts. 

Tone/Pulse Sets whether to use tone or pulse dialing.

Prefix Dial Sets whether to set a prefix dial number.

Prefix Dial Number Sets a prefix dial number of up to five digits. This number dials before any auto dial number is started. 
It is useful for accessing the Private Automatic Branch Exchange (PABX).

Fax Cover Page Sets whether to attach a cover page to faxes.

Fax Header Sets whether to print the information of the sender on the header of faxes.

ECM Sets whether to enable the Error Correction Mode (ECM). To use the ECM, the remote machines 
must also support the ECM.

Modem Speed Allows you to adjust the fax modem speed when a fax transmission or reception error occurs.

Display Manual Fax 
Recipients

Sets whether to show the fax number of the recipient on the Sending Fax screen when manually 
sending a fax.

Fax Activity Sets whether to automatically print a fax activity report after every 50 incoming and outgoing fax 
communications.

Fax Transmit Sets whether to print a transmission report after every fax transmission or only when an error occurs.

Fax Broadcast Sets whether to print a transmission report after every fax transmission to multiple destinations or 
only when an error occurs.

Fax Protocol Sets whether to print the protocol monitor report after every fax transmission or only when an error 
occurs.

File Format Sets the file format in which scanned documents are to be saved. 

Output Color Sets whether to scan in color or in black and white.

Resolution Sets the default scan resolution.

Original Size Sets the paper size of the original.

2 Sided Scanning Sets whether to scan both sides of a document.

Binding of Original Sets the binding position for the 2-sided scanning.

Darken/Lighten Sets the default scan density.

Sharpness Sets the default sharpness level.

Contrast Sets the default contrast level.

Auto Exposure Sets whether to suppress the background of the original to enhance text on the copy.

Auto Exposure Level Sets the default background suppression level.

Margin Top/Bottom Sets the value of the top and bottom margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 
inch).

Margin Left/Right Sets the value of the left and right margins within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch). 

Margin Middle Sets the value of the middle margin within the range of 0 mm (0.0 inch) to 50 mm (2.0 inch).

TIFF File Format Sets the TIFF file format to TIFF V6 or TTN2.
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USB Direct Print Defaults

Purpose:

To create your own USB Direct Print Defaults setting.

Values:

Printer Maintenance

The Printer Maintenance tab includes the Paper Density, Adjust Transfer Belt Unit, Adjust 2nd BTR, Adjust 
Fusing Unit, Auto Registration Adjustment, Color Registration Adjustments, Reset Defaults, Initialize 
PrintMeter, Storage, Non-Dell Toner, Adjust Altitude, Clock Settings, and Web Link Customization pages.

Paper Density

Purpose:

To specify the paper density.

Values:

Adjust Transfer Belt Unit

Purpose:

To adjust the transfer bias when ghosting occur. (The ghost image may be the image of the previous page, or a part of 
the page currently printing.)

Values:

Adjust 2nd BTR

Purpose:

To specify the optimum voltage settings for printing for the 2nd Belt Transfer Roller (2nd BTR). To lower the 
voltage, set negative values. To increase, set positive values.

Image Compression Sets the image compression level.

Max E-mail Size Sets the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes. 

File Naming Mode Sets the detailed settings of File Naming Mode to Auto, Add Prefix or Add Suffix.

Prefix/Suffix String Sets the texts that are added when Add Prefix or Add Suffix are selected.

Create Folder Sets whether to create a folder when saving scanned documents.

Output Color Sets whether to print in color or in black and white.

Select Tray Sets the default input tray.

2 Sided Printing Sets whether to print on both sides of a sheet of paper.

Multiple-Up Sets whether to print two or more pages on one side of a sheet of paper.

Collation Sets whether to sort the output.

PDF Password Sets a password.

Re-enter PDF Password Confirms the set password.

Plain Sets the density of plain paper to Light or Normal.

Label Sets the density of labels to Light or Normal.

K Offset If faint black colored ghosts appear, try to decrease the value.

YMC Offset If faint ghosts in color (yellow, magenta, or cyan) appear, try to decrease the value.
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The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

 CAUTION: The print quality changes depending on the setting values you select for this item.

Values:

Adjust Fusing Unit

Purpose:

To specify the optimum temperature settings for printing for the fusing unit. To lower the temperature, set negative 
values. To increase, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower 
the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

 NOTE: The print quality changes depending on the setting values you select for this item.

Values:

Auto Registration Adjustment

Purpose:

To specify whether to automatically perform color registration adjustment.

Color Registration Adjustments

Purpose:

To specify whether to manually perform color registration adjustment.

Plain Sets the reference voltage setting for the transfer roller for plain paper within the range of -5 to 10.

Plain Thick Sets the reference voltage setting for the transfer roller for thick plain paper within the range of -5 to 
10.

Covers Sets the reference voltage setting for the transfer roller for cover paper within the range of -5 to 10.

Covers Thick Sets the reference voltage setting for the transfer roller for thick cover paper within the range of -5 to 
10.

Coated Sets the reference voltage setting for the transfer roller for coated paper within the range of -5 to 10.

Coated Thick Sets the reference voltage setting for the transfer roller for thick coated paper within the range of -5 to 
10.

Label Sets the reference voltage setting for the transfer roller for labels within the range of -5 to 10.

Envelope Sets the reference voltage setting for the transfer roller for envelopes within the range of -5 to 10.

Recycled Sets the reference voltage setting for the transfer roller for recycled paper within the range of -5 to 10.

Plain Sets the temperature settings for the fusing unit for plain paper within the range of -3 to 3.

Plain Thick Sets the temperature settings for the fusing unit for thick plain paper within the range of -3 to 3.

Covers Sets the temperature settings for the fusing unit for cover paper within the range of -3 to 3.

Covers Thick Sets the temperature settings for the fusing unit for thick cover paper within the range of -3 to 3.

Coated Sets the temperature settings for the fusing unit for coated paper within the range of -3 to 3.

Coated Thick Sets the temperature settings for the fusing unit for thick coated paper within the range of -3 to 3.

Label Sets the temperature settings for the fusing unit for labels within the range of -3 to 3.

Envelope Sets the temperature settings for the fusing unit for envelopes within the range of -3 to 3.

Recycled Sets the temperature settings for the fusing unit for recycled paper within the range of -3 to 3.
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Manual Color Registration Adjustments are required such as when the printer is initially installed and after the 
printer is moved. 

 NOTE: The Color Registration Adjustments feature can be configured when Auto Registration Adjustment is set to Off.

Values:

Auto Correct Click Start to automatically perform color registration correction.

Color Regi Chart Click Start to print a color registration chart. The color registration chart prints a lattice pattern of 
yellow, magenta, and cyan lines. On the chart, look at the values on the right side that are next to the 
line that is perfectly straight for each of the three colors. If the value for this line is 0, color registration 
adjustment is not required. If the value for this line is any value other than 0, specify the adjustment 
values under Color Registration Adjustments.

Color Registration 
Adjustments

Sets lateral (perpendicular to paper feed direction) and process (paper feed direction) color 
adjustment values individually for Yellow, Magenta, and Cyan within the range of -9 to 9.
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Reset Defaults

Purpose:

To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu 
parameters are reset to their default values.

Initialize PrintMeter

Purpose:

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to 0.

Storage

 NOTE: Storage feature is available only when RAM Disk is enabled or the optional hard disk is installed.

Purpose: 

To clear all files stored in the RAM disk or the optional hard disk, or format the optional hard disk.

Values:

Non-Dell Toner

Purpose:

To use toner cartridge of another manufacturer.

 WARNING: Using a non-Dell toner cartridge may severely damage your printer. The warranty does not cover damages caused 
by using non-Dell toner cartridges.

Adjust Altitude

Purpose:

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used.

Reset Defaults Reset Defaults User Fax Section and 
restart printer.

Click Start to reset the fax number entries in the Address 
Book.

Reset Defaults User Scan Section 
and restart printer.

Click Start to reset the e-mail and server address entries 
in the Address Book.

Reset Defaults System Section and 
restart printer.

Click Start to reset the system parameters.

Power On Wizard Power On Wizard Click Start to perform the initial setup for the printer. 

Clear Storage*1 All Clear Click Start to clear all files stored as Secure Print, Proof Print, Private Mail Box 
Print, and Public Mail Box Print in the RAM disk or the optional hard disk.

Secure Document Click Start to clear all files stored as Secure Print, Proof Print, Private Mail Box 
Print, and Public Mail Box Print in the RAM disk or the optional hard disk.

Stored Document Click Start to clear all files stored in the RAM disk or the optional hard disk.

Format Hard Disk*2 Format Hard Disk Click Start to format the optional hard disk. All fonts, forms and files for Secure 
Print, Proof Print, Private Mail Box Print, and Public Mail Box Print stored in the 
optional hard disk are cleared.

*1 This item is available only when RAM Disk is enabled or the optional hard disk is installed.
*2 This item is available only when the optional hard disk is installed.
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Clock Settings

Purpose:

To specify the clock settings.

Values:

Web Link Customization

Purpose:

To specify a link used for ordering consumables, which can be accessed from Order Supplies at: in the left frame.

Values:

Print Server Settings
Use the Print Server Settings menu to set the type of printer interface and the necessary conditions for 
communication.

The following tabbed pages are displayed in the top of the right frame.

Print Server Reports

The Print Server Reports tab includes the Print Server Setup Page and the E-Mail Alert Setup Page.

Print Server Setup Page

Purpose:

To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol and printing 
ports. On this page, you can only verify the settings of items. If you want to change the settings, go to the pages in 
the Print Server Settings tab.

Values:

Date Format Sets the date format; YYYY/MM/DD, MM/DD/YYYY, or DD/MM/YYYY.

Time Format Sets the time format; 24 Hour Clock or 12 Hour Clock.

Time Zone Sets the time zone.

Set Date Sets the current date.

Set Time Sets the current time.

Select Reorder URL Sets a URL to be linked to Order Supplies at:

Regular Displays the regular URL (http://accessories.us.dell.com/sna) that can be linked to Order Supplies 
at:.

Premier Displays the premier URL (http://premier.dell.com) that can be linked to Order Supplies at:.

Ethernet*1 Ethernet Settings Displays the current settings of Ethernet transmission rate and the duplex 
settings.

Current Ethernet 
Settings

Displays the current Ethernet settings.

MAC Address Displays the Media Access Control (MAC) address of the printer.

http://accessories.us.dell.com/sna
http://premier.dell.com
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Wireless Settings*2 SSID Displays the name that identifies the network.

Network Type Displays the network type from either the Ad-Hoc or Infrastructure mode.

MAC Address Displays the MAC address of the wireless adapter.

Link Channel Displays the channel number of the connection.

Link Quality Displays the quality of the connection.

TCP/IP Settings IP Mode Displays the IP mode.

Host Name Displays the host name.

IPv4*3 IP Address Mode Displays the IP address mode.

IP Address Displays the IP address.

Subnet Mask Displays the subnet mask.

Gateway Address Displays the gateway address.

IPv6*4 Enable Stateless Address Displays whether to enable the stateless 
address.

Use Manual Address Displays whether to set the IP address 
manually.

Get IP Address from 
DHCP

Displays whether to automatically set the IP 
address via DHCP.

Manual Address*5 Displays the IP address.

Stateless Address 1-3*6 Displays the stateless addresses.

Stateful Address 1-3 Displays the stateful addresses.

Link Local Address*6 Displays the link local address.

Manual Gateway 
Address*5

Displays the gateway address.

Auto Configure Gateway 
Address*6

Displays the gateway address.

DNS IPv4*3 Get DNS Server Address 
from DHCP

Displays whether to automatically set the 
DNS server address via DHCP.

Current DNS Server 
Address

Displays the current DNS server address.

IPv6*4 Get DNS Server Address 
from DHCPv6-lite

Displays if the printer receives the DNS server 
address automatically from the DHCPv6-lite 
server.

Current DNS Server 
Address

Displays the current DNS server address.

DNS Dynamic Update 
(IPv4)

Displays the status of the DNS Dynamic 
Update feature.

DNS Dynamic Update 
(IPv6)

Displays the status of the DNS Dynamic 
Update feature.

Auto Generate Search List Displays whether to automatically generate a 
search list.

Search Domain Name Displays the search domain name.

Time-out Displays the time-out period.

Priority to IPv6 DNS 
Name Resolution*7

Displays whether to use the DNS Name 
Resolution feature.
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WINS*3 WINS Mode Displays whether to automatically set the primary and secondary WINS 
server addresses via DHCP.

WINS Primary Server Displays the primary WINS server address.

WINS Secondary Server Displays the secondary WINS server address.

LPD Port Status Displays the port status of the Line Printer Daemon (LPD) protocol.

Connection Time-Out Displays the connection time-out period.

Port9100 Port Status Displays the port status.

Port Number Displays the port number.

Connection Time-Out Displays the connection time-out period.

IPP Port Status Displays the port status.

Printer URI Displays the printer URI.

Connection Time-Out Displays the connection time-out period.

Port Number Displays the port number.

Maximum Sessions Displays the maximum number of connections received simultaneously by 
the client.

WSD WSD Scan Displays whether to use WSD for scanning.

WSD Print Displays whether to use WSD for printing.

Port Number Displays the WSD port number.

Receive Time-Out Displays the receive time-out period.

Notification Time-Out Displays the notification time-out period.

Maximum Number of 
TTL

Displays the maximum number of TTLs.

Maximum Number of 
Notification

Displays the maximum number of notifications.

Network TWAIN Port Status Displays the port status.

Connection Time-Out Displays the connection time-out period.

FTP Port Status Displays the port status.

Connection Time-Out Displays the connection time-out period.

HTTP Port Status Displays the port status.

Port Number Displays the port number.

Simultaneous 
Connections

Displays the maximum number of simultaneous connections.

Connection Time-Out Displays the connection time-out period.

SMB Port Status Displays the port status.

Host Name Displays the host name.

Workgroup Displays the workgroup.

Maximum Sessions Displays the maximum number of sessions.

Unicode Support Displays whether to notify the host name and workgroup name in Unicode 
characters during SMB transmission.

Auto Master Mode Displays whether to enable the Auto Master Mode.

Encrypt Password Displays whether to encrypt the password during SMB transmission.

Job Time-Out Displays the job time-out period.

Connection Time-Out Displays the connection time-out period.



Dell™ Printer Configuration Web Tool 173

Bonjour (mDNS) Port Status Displays the port status.

Host Name Displays the host name.

Printer Name Displays the printer name.

Wide-Area Bonjour Displays the status of the Wide-Area Bonjour feature.

Telnet Port Status Displays the port status.

Connection Time-Out Displays the connection time-out period.

SNMP Port Status Displays the port status.

Enable SNMP v1/v2c 
Protocol

Displays the status of the SNMP v1/v2c feature.

Enable SNMP v3 
Protocol

Displays the status of the SNMP v3 feature.

Update Address Book Port Status Displays the port status.

Connection Time-Out Displays the connection time-out period.

FTP Client Connection Time-Out Displays the connection time-out period.

FTP Passive Displays whether to enable the FTP Passive mode.

SMB Client Connection Time-Out Displays the connection time-out period.

SNTP Port Status Displays the port status.

IP Address / Host Name Displays the IP address or the host name of the SNTP server.

Connection Time-Out Displays the connection time-out period.

Time Synchronization 
Interval

Displays the interval for performing time synchronization using SNTP.

AirPrint Port Status Displays the port status.

Name Displays the name of AirPrint.

Location Displays the location of the printer.

Geo-Location Displays the physical location of the printer.

Google Cloud Print Port Status Displays the port status.

Registration state Displays the registration state.

Proxy Server Use Proxy Server Displays the status of proxy server.

Address to Bypass Proxy 
Server

Displays the address of the bypass proxy server.

Server Name Displays the server name.

Port Number Displays the port number.

Authentication Displays the status of authentication feature.

Authentication System Authentication System 
Settings (for ColorTrack 
PRO)

Displays the authentication method.

Authentication System 
Settings (for Server 
Address/Phone Book)

Displays the authentication method.
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E-Mail Alert Setup Page

Purpose:

To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the Scan 
to E-mail feature, forwarding fax to e-mail feature, and E-Mail Alert feature. In this page, you can only verify the 
settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

Values:

SSL/TLS HTTP - SSL/TLS 
Communication

Displays the status of the HTTP - SSL/TLS Communication.

HTTP - SSL/TLS 
Communication Port 
Number

Displays HTTP - SSL/TLS Communication Port Number. 

LDAP - SSL/TLS 
Communication*8

Displays the status of the LDAP - SSL/TLS Communication.

Verify Remote Server 
Certificate*8

Displays the status of the Verify Remote Server Certificate.

IPsec Settings Protocol Displays the protocol status.

IKE Displays IKE authentication.

802.1x*1 Enable IEEE 802.1x Displays the status of IEEE 802.1x.

Authentication Method Displays the setting of authentication method for IEEE 802.1x.

IP Filter (IPv4)*9 Access List Displays the list of IP addresses that are permitted or denied access to the 
printer.

SMTP Domain 
Filtering

Domain Filtering Displays whether to enable Domain Filtering.

Allow Domain List Displays the domains allowed for sending e-mails.
*1 This item is available only when the printer is connected using an Ethernet cable. 
*2 This item is available only when the printer is connected using the wireless network.
*3 This item is displayed when IPv4 Mode or Dual Stack in IP Mode is selected.
*4 This item is displayed when IPv6 Mode or Dual Stack in IP Mode is selected.
*5 This item is displayed only when Use Manual Address is set to Enable.
*6 This item is displayed only when an IP address has been assigned.
*7 This item is available only when using IPv6 dual mode.
*8 This item is displayed only when the optional hard disk is installed and is set to On for encryption.
*9 This item is available only for LPD or Port9100.

E-Mail Server Settings Port Status Displays the port status.

Primary SMTP Gateway Displays the primary SMTP (Simple Mail Transfer Protocol) gateway.

SMTP Port Number Displays the SMTP port number.

E-Mail Send 
Authentication

Displays the authentication method for outgoing e-mail.

POP3 Server Address Displays the POP3 (Post Office Protocol 3) server address.

POP3 Port Number Displays the POP3 port number.

Reply Address Displays the IP address of servers connected with SMTP protocol when data 
is incoming.

SMTP Server 
Connection

Displays the status of the SMTP server connection.
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Print Server Settings

The Print Server Settings tab includes the Basic Information, Port Settings, TCP/IP, SMB, E-Mail Alert, Bonjour 
(mDNS), SNMP, Scan to PC, SNTP, Wireless LAN, AirPrint, Google Cloud Print, Proxy Server, and Reset Print 
Server pages.

Basic Information

Purpose:

To configure basic information of the printer.

Values:

 NOTE: The Auto Refresh feature is effective for the contents of the top frame, Printer Status page, Job List page, and Completed 
Jobs page.

Port Settings

Purpose:

To enable or disable printing ports and management protocol features.

E-Mail Alert Settings E-Mail List 1 Displays the acceptable e-mail addresses for 
the E-Mail Alert feature specified in E-Mail 
List 1.

Select Alerts for List 1 Supplies Alerts Displays the e-mail alert receive status for 
consumables.

Paper Handling Alerts Displays the e-mail alert receive status for 
paper handling.

Service Call Displays the e-mail alert receive status for 
service calls.

E-Mail List 2 Displays the acceptable e-mail addresses for 
the E-Mail Alert feature specified in E-Mail 
List 2.

Select Alerts for List 2 Supplies Alerts Displays the e-mail alert receive status for 
consumables.

Paper Handling Alerts Displays the e-mail alert receive status for 
paper handling.

Service Call Displays the e-mail alert receive status for 
service calls.

System Settings Printer Name Sets the name of the printer.

Location Sets the location of the printer.

Contact Person Sets the contact name, number, and other information of the printer 
administrator and service center. 

Administrator E-Mail 
Address

Sets the contact address of the printer administrator and service center.

Asset Tag Number Enters the asset tag number for the printer.

EWS Settings Auto Refresh Automatically refreshes the contents of the status display pages.

Auto Refresh Interval Sets the time interval for refreshing the contents of the status display pages 
automatically from 15 to 600 seconds.
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Values:

 NOTE: The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the 
settings, click the Apply New Settings button to apply the new settings.

TCP/IP

Purpose:

To configure the IP address, subnet mask, and gateway address of the printer. 

Ethernet*1 Ethernet Settings Auto Detects the Ethernet transmission rate and the 
duplex settings automatically.

10Base-T Half-Duplex Selects 10Base-T Half-Duplex as the default 
value.

10Base-T Full-Duplex Selects 10Base-T Full-Duplex as the default 
value.

100Base-TX Half-Duplex Selects 100Base-TX Half-Duplex as the default 
value.

100Base-TX Full-Duplex Selects 100Base-TX Full-Duplex as the default 
value.

1000Base-T Full-Duplex Selects 1000Base-T Full-Duplex as the default 
value.

Current Ethernet Settings Displays the current settings of the Ethernet.

MAC Address Displays the MAC address of the printer.

Port Status LPD Sets whether to enable LPD.

Port9100 Sets whether to enable Port9100.

IPP Sets whether to enable IPP.

WSD Print Sets whether to enable WSD Print.

WSD Scan Sets whether to enable WSD Scan.

Network TWAIN Sets whether to enable Network TWAIN

FTP Sets whether to enable FTP.

SMB Sets whether to enable SMB.

Bonjour (mDNS) Sets whether to enable Bonjour (mDNS).

E-Mail Alert Sets whether to enable E-Mail Alert.

Telnet Sets whether to enable Telnet.

SNMP Sets whether to enable SNMP.

Update Address Book Sets whether to enable Update Address Book.

SNTP Sets whether to enable SNTP.

Google Cloud Print Sets whether to enable Google Cloud Print.
*1 This item is available only when the printer is connected using an Ethernet cable. 
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Values:

TCP/IP 
Settings

IP Mode Sets the IP mode.

Host Name Sets the host name.

IPv4 IP Address Mode Sets the method for acquiring the IP address. 

Manual IP Address When an IP address is being set manually, the IP is allocated to 
the printer using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 
127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address.

Manual Subnet Mask When an IP address is being set manually, the subnet mask is 
specified using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 
255.255.255.255 cannot be specified as the subnet mask.

Manual Gateway 
Address

When an IP address is being set manually, the gateway address 
is specified using the format nnn.nnn.nnn.nnn. Each octet 
that makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 
254. 127 and any value in the range of 224 to 254 cannot be 
specified for the first octet of a gateway address.

IPv6 Enable Stateless 
Address

Select the check box to enable the stateless address.

Use Manual Address Select the check box to set the IP address manually.

Get IP Address from 
DHCP

Allows you to enable or disable the automatic setting of the IP 
address via DHCP.

Manual Address Sets the IP address. To specify an IPv6 address, enter the 
address followed by a slash (/) and then "64". For details, 
consult your system administrator.

Manual Gateway 
Address

Sets the gateway address.
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DNS DNS Domain Name Sets the DNS domain name.

IPv4 Get DNS Server 
Address from DHCP

Allows you to enable or disable the automatic setting of the 
DNS server address via DHCP.

Manual DNS Server 
Address

Manually sets the DNS server address in xxx.xxx.xxx.xxx 
format when Get DNS Server Address from DHCP is not 
selected.

IPv6 Get DNS Server 
Address from DHCPv6-
lite

Select the check box to get the DNS server address 
automatically from the DHCPv6-lite server.

Manual DNS Server 
Address

Sets the DNS server address.

DNS Dynamic Update 
(IPv4)

Select the check box to enable dynamic updates to DNS.

DNS Dynamic Update 
(IPv6)

Select the check box to enable dynamic updates to DNS.

Auto Generate Search 
List

Select the check box to automatically generate the search list.

Search Domain Name Sets the search domain name. Up to 255 alphanumeric 
characters, periods, and hyphens can be used. If you need to 
specify more than one domain name, separate them using a 
comma or semicolon.

Time-out Sets the time-out period between 1 and 60 seconds.

Priority to IPv6 DNS 
Name Resolution

Select the check box to enable the DNS Name Resolution 
feature.

WINS WINS Mode Allows you to enable or disable the automatic setting of the primary and secondary 
WINS server addresses via DHCP.

WINS Primary Server Manually sets the primary WINS server address in xxx.xxx.xxx.xxx format when WINS 
Mode is not selected.

WINS Secondary 
Server

Manually sets the secondary (backup) WINS server address in xxx.xxx.xxx.xxx format 
when WINS Mode is not selected.

LPD Connection Time-
Out

Sets the connection time-out period from 1 to 3,600 seconds.

IP Filter (IPv4) Click IP Filter (IPv4) to set the IP Filter settings on the IP Filter (IPv4) page.

Port9100 Port Number Sets the port number from 9,000 to 9,999.

Connection Time-
Out

Sets the connection time-out period between 1 and 1,000 seconds.

IP Filter (IPv4) Click IP Filter (IPv4) to set the IP filter settings on the IP Filter (IPv4) page.

IPP Printer URI Displays the printer URI.

Connection Time-
Out

Sets the connection time-out period from 1 to 1,000 seconds.

Port Number Displays the port number for receiving requests from the client.

Maximum Sessions Displays the maximum number of connections received simultaneously by the client.
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To configure the IP Filter feature, enter an IP address to be filtered in the Address field and the subnet mask in the 
Address Mask field. Enter a numeric value between 0 and 255 in each field. "*" is appended to the current value.

IP Filter Setup Procedure

You can set up to a maximum of five items and the first item set takes priority. When setting multiple filters, enter 
the shortest address first followed by a slightly longer address, a longer address and so on.

Enabling Printing From a Specified User

The following describes the procedure to enable printing only from the "192.168.100.10" IP address.

1 Click the first column of the Access List row 1.

2 Enter "192.168.100.10" in the Address field and "255.255.255.255" in the Address Mask field.

3 Select Accept.

4 Click Apply New Settings.

Disabling Printing From a Specified User

The following describes the procedure to disable printing only from the "192.168.100.10" IP address.

1 Click the first column of the Access List row 1.

2 Enter "192.168.100.10" in the Address field and "255.255.255.255" in the Address Mask field.

3 Select Reject.

4 Click the first column of the Access List row 2.

WSD Port Number Sets the port number to 80 or from 8,000 to 9,999.

Receive 
Time-Out

Sets the receive time-out period from 1 to 65,535 seconds.

Notification Time-
Out

Sets the notification time-out period from 1 to 60 seconds.

Maximum Number 
of TTL

Sets the maximum number of TTL from 1 to 10.

Maximum Number 
of Notification

Sets the maximum number of notifications from 10 to 20.

Network 
TWAIN

Connection Time-
Out

Sets the connection time-out period between 1 and 65,535 seconds.

FTP Password Sets the password for FTP.

Re-enter Password Enter the password again to confirm it.

Connection Time-
Out

Sets the connection time-out period from 1 to 1000 seconds.

HTTP Port Number Sets the port number to 80 or from 8,000 to 9,999.

Simultaneous 
Connections

Displays the maximum number of simultaneous connections.

Connection Time-
Out

Sets the connection time-out period from 1 to 255 seconds.

Telnet Password Sets the password for Telnet.

Re-enter Password Confirms the set password.

Connection Time-
Out

Sets the connection time-out period from 1 to 1,000 seconds.

Update 
Address Book

Connection Time-
Out

Sets the connection time-out period from 1 to 65,535 seconds.
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5 Enter "0.0.0.0" in the Address field and "0.0.0.0" in the Address Mask field.

6 Select Accept.

7 Click Apply New Settings.

Enabling and Disabling Printing from Network Addresses

You can enable printing from the "192.168" network address and disable printing from the "192.168.200" 
network address. 

The example below describes how to enable printing from the "192.168.200.10" IP address.

1 Click the first column of the Access List row 1.

2 Enter "192.168.200.10" in the Address field and "255.255.255.255" in the Address Mask field.

3 Select Accept.

4 Click the first column of the Access List row 2.

5 Enter "192.168.200.0" in the Address field and "255.255.255.0" in the Address Mask field.

6 Select Reject.

7 Click the first column of the Access List row 3.

8 Enter "192.168.0.0" in the Address field and "255.255.0.0" in the Address Mask field.

9 Select Accept.

10 Click Apply New Settings.

SMB

Purpose:

To specify the setting of the Server Message Block (SMB) protocol.

Values:

E-Mail Alert

Purpose:

To configure detailed settings of E-Mail Alert. This page can also be displayed by clicking the E-Mail Alert in the 
left frame.

Values:

Host Name Sets the host name of the server computer.

Workgroup Sets the workgroup.

Maximum Sessions Sets the maximum number of sessions.

Unicode Support Sets whether to notify the host name and workgroup name in Unicode characters during 
SMB transmission.

Auto Master Mode Sets whether to enable the Auto Master Mode.

Encrypt Password Sets whether to encrypt the password.

Job Time-Out Sets the job time-out period between 60 and 3,600 seconds.

Connection Time-Out Sets the connection time-out period between 60 and 3,600 seconds.

E-Mail Server Settings Primary SMTP Gateway Sets the primary SMTP gateway.

SMTP Port Number Sets the SMTP port number. This must be 25, 587 or between 5,000 and 
65,535.
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E-Mail Send 
Authentication

Sets the authentication method for outgoing e-mail.

SMTP Login User Sets the SMTP login user. Up to 63 alphanumeric characters, periods, 
hyphens, underscores, and at symbols (@) can be used. If specifying more 
than one address, separate them using commas.

SMTP Login Password Sets the SMTP account password using up to 31 alphanumeric characters.

Re-enter SMTP Login 
Password

Confirms the set SMTP account password.

POP3 Server Address*1 Sets the POP3 server address in IP address format of "aaa.bbb.ccc.ddd" or 
as a DNS host name using up to 63 characters.

POP3 Port Number*1 Sets the POP3 server port number. This must be 110 or between 5,000 and 
65,535.

POP User Name*1 Sets the POP3 account user name. Up to 63 alphanumeric characters, 
periods, hyphens, underscores, and at symbols (@) can be used. If 
specifying more than one address, separate them using commas.

POP User Password*1 Sets the POP3 account password using up to 31 alphanumeric characters.

Re-enter POP User 
Password*1

Confirms the set password.

Reply Address Designates the reply e-mail address sent with each E-mail Alert.

SMTP Server 
Connection

Displays the status of the SMTP server connection.

E-Mail Alert Settings E-Mail List 1 Sets acceptable e-mail addresses for the E-
Mail Alert feature using up to 255 
alphanumeric characters.

Select Alerts for List 1 Supplies Alerts Select the check box to receive an E-Mail 
Alert for consumables.

Paper Handling Alerts Select the check box to receive an E-Mail 
Alert for paper handling.

Service Call Select the check box to receive an E-Mail 
Alert for Service Calls.

E-Mail List 2 Sets acceptable e-mail addresses for the E-
Mail Alert feature using up to 255 
alphanumeric characters.

Select Alerts for List 2 Supplies Alerts Select the check box to receive an E-Mail 
Alert for consumables.

Paper Handling Alerts Select the check box to receive an E-Mail 
Alert for paper handling.

Service Call Select the check box to receive an E-Mail 
Alert for Service Calls.

*1 This item is available only when POP before SMTP (Plain) or POP before SMTP (APOP) for E-Mail Send Authentication is selected.
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Bonjour (mDNS)

Purpose:

To configure the detailed settings of Bonjour.

Values:

SNMP

Purpose:

To configure the detailed settings of SNMP.

Values:

SNMP v1/v2c

Purpose:

To edit the detailed settings of SNMP v1/v2 protocol.

To enter this page, click Edit SNMP v1/v2 Properties in the SNMP page.

Host Name Sets the host name up to 63 alphanumeric characters and "-" (dash). The original setting will remain 
valid if no input is made.

Printer Name Sets the printer name up to 63 alphanumeric characters and symbol sets. The original setting will 
remain valid if no input is made.

Wide-Area Bonjour Select the check box to enable the Wide-Area Bonjour protocol.

SNMP Configuration Enable SNMP v1/v2c 
Protocol

Select the check box to enable the SNMP v1/v2c protocol.

Edit SNMP v1/v2c 
Properties

Click to display the SNMP v1/v2c page and to edit the setting of SNMP 
v1/v2c protocol from the page.

Enable SNMP v3 
Protocol

Select the check box to enable the SNMP v3 protocol.

Edit SNMP v3 
Properties

Click to display the SNMP v3 page and to edit the setting of SNMP v3 
protocol from the page.

You can click this item only when SSL communication is enabled.
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Values:

SNMP v3

Purpose:

To edit the detailed settings of SNMP v3 protocol.

To enter this page, click Edit SNMP v3 Properties in the SNMP page.

Community Name Community Name 
(Read only)*1

Sets the community name to access (read only) data using up to 31 
alphanumeric characters.
The original setting will remain valid if no input is made. Characters 
entered for community name in the previous settings will not be displayed 
on the screen. The default Read Community is public.

Re-enter Community 
Name (Read only)*1

Enters the community name to access (read only) data again to confirm it.

Community Name 
(Read/Write)*1

Sets the community name to access (read and write) data using up to 31 
alphanumeric characters.
The original setting will remain valid if no input is made. Characters 
entered for community name in the previous settings will not be displayed 
on the screen. The default Read/Write Community is private.

Re-enter Community 
Name (Read/Write)*1

Enters the community name to access (read and write) data again to 
confirm it.

Community Name 
(Trap)*1

Sets the community name used for trap up to 31 alphanumeric characters.
The original setting will remain valid if no input is made. Characters 
entered for Community Name (Trap) in the previous settings will not be 
displayed on the screen. The default Trap Community is " " (NULL).

Re-enter Community 
Name (Trap)*1

Enters the community name used for trap again to confirm it.

Trap Notification 1-4 Trap Address Type

Trap Address 

Port Number

Notify

Select the check boxes to notify trap occurrence. In this case, specify the IP 
address and IP socket in the following format:

IPv4

Specify the IP address and IP socket in the nnn.nnn.nnn.nnn:mmmmm 
format. Each section of "nnn" is a variable value between 0 and 255. Note 
that values 127 and 224-254 are not valid for the first three-digits only. IP 
socket mmmmm is a variable value between 0 and 65,535.

IPv6

Specify the IP address and IP socket in the 
xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:mmmmm format. Each section 
of "xxxx" is a hexadecimal variable value between 0 and ffff. IP socket 
mmmmm is a variable value between 0 and 65,535.

Authenticate Error Trap Select the check box to notify Authenticate Error Trap.
*1 The default value can be changed by using Dell Printer Configuration Web Tool.
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Values:

Scan to PC

Purpose:

To specify the client when scanning data.

Values:

SNTP

Purpose:

To configure the SNTP server settings in order to perform time synchronization through SNTP.

Values:

Wireless LAN

 NOTE: Wireless LAN feature is available only when the printer is connected using the wireless network.

Purpose:

To configure the detailed setting for the wireless network. 

To use the wireless adapter, be sure to disconnect the Ethernet cable.

 NOTE: Once wireless LAN is activated, wired LAN protocol will be disabled.

Administrator Account Account Enabled Select the check box to enable the administrator account.

User Name Enters the user name of the administrator account.

Authentication 
Password

Sets the authentication password of the administrator account using 8 to 32 
alphanumeric characters.

Re-enter Authentication 
Password

Confirms the set password.

Privacy Password Sets the privacy password of the administrator account using 8 to 32 
alphanumeric characters.

Re-enter Privacy 
Password

Confirms the set password.

Print Drivers / Remote 
Client Account

Account Enabled Select the check box to enable the print drivers and remote client account.

Reset to default 
Password

Click to reset the password for the print drivers and remote client account 
to default.

FTP Client Connection Time-Out Sets the connection time-out period from 1 to 60 seconds.

FTP Passive Sets whether to enable the FTP Passive mode.

SMB Client Connection Time-Out Sets the connection time-out period from 1 to 60 seconds.

SNTP IP Address / Host Name Sets the IP address or the host name of the SNTP server.

Connection Time-Out Sets the connection time-out period from 1 to 120 seconds.

Time Synchronization 
Interval

Sets the interval for performing time synchronization using SNTP.

Last Connection Time Displays the last date and time when your printer was connected to the 
SNTP server.

Connection Status Displays the status of the connections between the SNTP server and your 
printer.
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Values:

Wireless Settings SSID Sets the name that identifies the wireless network. Up to 32 alphanumeric 
characters can be entered.

Network Type Sets the network type from either Ad-Hoc or Infrastructure.

MAC Address Displays the MAC address of the wireless adapter for the printer.

Link Channel Displays the channel number of the wireless connection for the printer.

Link Quality Displays the quality of the wireless network connection for the printer.

Security Settings Encryption Select the encryption type from the list.

No Security Sets No Security to configure the wireless 
setting without specifying an encryption type 
from WEP, WPA-PSK, and WPA-Enterprise.

WEP Sets the WEP to use through the wireless 
network.

WPA-PSK TKIP*1, 2 Sets the WPA-PSK TKIP to use through the 
wireless network.

WPA-PSK AES/WPA2-PSK 
AES*1, 2

Sets the WPA-PSK AES/WPA2-PSK AES to 
use through the wireless network.

WPA-Enterprise 
TKIP*2, 3, 4

Sets the WPA-Enterprise TKIP to use 
through the wireless network.

WPA-Enterprise 
AES/WPA2-Enterprise 
AES*2, 3, 4

Sets the WPA-Enterprise AES/WPA2-
Enterprise AES to use through the wireless 
network.

Mixed Mode PSK*1, 2 Sets the Mixed Mode PSK to use through the 
wireless network. Mixed Mode PSK 
automatically selects the encryption type 
from either WPA-PSK TKIP, WPA-PSK AES, 
or WPA2-PSK AES.

Mixed Mode 
Enterprise*2, 3, 4

Sets the Mixed Mode Enterprise to use 
through the wireless network. Mixed Mode 
Enterprise automatically selects the 
encryption type from either WPA-Enterprise 
TKIP, WPA-Enterprise AES, or WPA2-
Enterprise AES.

WEP Encryption Select the WEP key code from either Hex or Ascii.

WEP Key 1 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption.

Re-enter WEP Key 1 Enters the WEP key 1 again to confirm it.

WEP Key 2 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption.

Re-enter WEP Key 2 Enters the WEP key 2 again to confirm it.

WEP Key 3 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption.

Re-enter WEP Key 3 Enters the WEP key 3 again to confirm it.

WEP Key 4 Sets the WEP key set used through the wireless network only when WEP 
128bit or WEP 64bit is selected for Encryption.

Re-enter WEP Key 4 Enters the WEP key 4 again to confirm it.

Transmit Key*6 Sets the transmit key type from the list.
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AirPrint

Purpose:

To configure the detailed setting of AirPrint.

Values:

Google Cloud Print

Purpose:

To register the printer to Google Cloud Print.

Values:

Proxy Server

Purpose:

To configure the Proxy Server settings.

WPA-PSK Pass Phrase Sets the pass phrase.

Re-enter Pass Phrase Enters the pass phrase again to confirm it.

WPA-Enterprise*4, 5 EAP-Identity Sets the EAP-Identity for the authentication.

Authentication Method Shows the authentication method.

Login Name Sets the login name for the authentication.

Password Sets the password.

Re-enter Password Enters the password again to confirm it.
*1 For encryption, AES or TKIP method is used.
*2 This item is available only when Infrastructure is selected for Network Type.
*3 For authentication and encryption by digital certificate, AES or TKIP method is used.
*4 This item is displayed only when the optional hard disk is installed and is set to On for encryption.
*5 To activate the setting, import a certificate which supports wireless LAN (server/client) on the SSL/TLS pages, and enable the relevant 

certificate in advance.
*6 When Auto is selected for Transmit Key, the key set specified for WEP Key 1 is used.

AirPrint Enable AirPrint Click to enable the printer for AirPrint.

Name Enters the name that is to be displayed as an AirPrint printer.

Location Sets the location of the printer.

Geo-Location Sets the physical location of the printer.

Supply Levels Cyan Toner Cartridge Displays the cyan toner level.

Magenta Toner 
Cartridge

Displays the magenta toner level.

Yellow Toner Cartridge Displays the yellow toner level.

Black Toner Cartridge Displays the black toner level.

Google Cloud Print*1 (Registration state) Displays the Google Cloud Print registration state. 

Register This Device to 
Google Cloud Print

Click to register the printer to Google Cloud Print.

*1 Google Cloud Print can only be used when the machine is using IPv4. 
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Values:

Reset Print Server

Purpose:

To initialize NVRAM (non-volatile RAM) for the network feature and reboot the printer. You can also initialize 
NVRAM of the printer from Reset Defaults in the Printer Settings menu.

Values:

Security

The Security tab includes Set Password, Authentication System, Kerberos Server, LDAP Server, LDAP 
Authentication, LDAP User Mapping, SSL/TLS, IPsec, 802.1x, IP Filter (IPv4), and SMTP Domain Filtering.

Set Password

Purpose:

To set or change the password that is required to access the setup parameters of the printer from the Dell Printer 
Configuration Web Tool. This page can also be displayed by clicking Set Password in the left frame.

 NOTE: To restore the password to the default (NULL), initialize the non-volatile memory (NVM).

 NOTE: You can set the password for access to Admin Settings from Panel Lock in Printer Settings.

Values:

Authentication System

Purpose:

To specify the server authentication type, the server response time-out, or the search time-out.

Proxy Server Use Proxy Server Sets whether to enable the use of a proxy server.

Address to Bypass Proxy 
Server

Sets the address to bypass proxy server.

Server Name Sets the name of the proxy server.

Port Number Sets the port number from 1 to 65535.

Authentication Sets whether to enable authentication.

Login Name Sets the login name for the proxy server.

Password Sets the login password for the proxy server.

Retype Password Confirms the set password.

Initialize NIC NVRAM Memory 
and restart printer.

Click Start to initialize NVRAM, revert network settings to the factory default settings, and 
reboot the network capability.

Restart Printer Click Start to reboot the printer.

Administrator Password Sets the password using up to 128 alphanumeric characters. 

Re-enter Administrator Password Confirms the set password.

Access denial by the authentication 
failure of the Administrator

Sets the amount of time the administrator should wait for the access to the printer 
setup from Dell Printer Configuration Web Tool. Sets the time period from 5 to 255 
seconds. The access is denied if the time-out time is exceeded. If you set 0, this mode 
is disabled.



188 Dell™ Printer Configuration Web Tool

Values:

Kerberos Server

Purpose:

To specify the settings for the Kerberos server.

Values:

LDAP Server

Purpose:

To specify the settings of the LDAP server. 

Values:

Authentication Type 
(for ColorTrack PRO)

Authentication System 
Settings

Select the authentication system from the list.

Authentication Type 
(for Server Address/
Phone Book)*1

Authentication System 
Settings

Select the authentication system from the list.

Optional Information Server Response Time-
Out

Sets the amount of time the printer should wait for response from the 
server. Sets the time period from 1 to 75 seconds.

Search Time-Out Sets the amount of time the printer should wait for searching for the server. 
Sets the time period from 5 to 120 seconds.

*1 If Off or Internal Mode is selected for ColorTrack Mode, be sure to select LDAP. For details about ColorTrack Mode, see "Dell ColorTrack."

Kerberos Server (for 
ColorTrack PRO)

IP Address / Host Name 
& Port

Sets the IP address or host name, and the port address. The port address 
must be 88 or between 5,000 and 65,535.

Domain Name Enter the domain name.

Kerberos Server (for 
Server Address/Phone 
Book)

IP Address / Host Name 
& Port

Sets the IP address or host name, and the port address. The port address 
must be 88 or between 5,000 and 65,535.

Domain Name Enter the domain name.

Login Name Enter the login name.

Password Enter the login password.

Re-enter Password Enter the login password again to confirm it.

Server Information

(for ColorTrack PRO)

IP Address / Host Name 
& Port

Sets IP address or the host name, and the port address. The port address 
must be 389, 3268, or between 5,000 and 65,535.*1

LDAP Server Displays the current software information of the LDAP server.

Optional Information

(for ColorTrack PRO)

Search Directory Root Enters the search directory root.

Login Name Enters the login name.

Password Enters the login password using 1 to 127 alphanumeric characters. If the 
password is left blank (NULL), you cannot log in to a server.

Re-enter-Password Enters the login password again to confirm it.

Search 
Time-Out

Select Wait LDAP Server Limit to follow the time specified by the LDAP 
server. Select Wait to specify the time between 5 and 120 seconds.

Server Information

(for Server 
Address/Phone Book)

IP Address / Host Name 
& Port

Sets IP address or the host name, and the port address. The port address 
must be 389, 3268, or between 5,000 and 65,535.*1

LDAP Server Displays the current software information of the LDAP server.
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 NOTE: Server Address Book must be set to On before you can use the server address book for the Scan to E-mail feature.

 NOTE: Server Phone Book must be set to On before you can use the server phone book for the Fax function.

LDAP Authentication

Purpose:

To specify the LDAP server authentication method.

Values:

LDAP User Mapping

Purpose:

To specify the settings of the LDAP user mapping.

Values:

SSL/TLS

Purpose:

To specify the settings for the SSL encryption communication to the printer, and set/delete the certificate used for 
IPsec, LDAPS, or Wireless LAN.

Optional Information

(for Server 
Address/Phone Book)

Search Directory Root Enters the search directory root.

Login Name Enters the login name.

Password Enters the login password using 1 to 127 alphanumeric characters. If the 
password is left blank (NULL), you cannot log in to a server.

Re-enter-Password Enters the login password again to confirm it.

Search 
Time-Out

Select Wait LDAP Server Limit to follow the time specified by the LDAP 
server. Select Wait to specify the time between 5 and 120 seconds.

Search Name Order Sets the search order. 

Server Address Book Select the check box to enable the server address book.

Server Phone Book Select the check box to enable the server phone book.
*1 When the optional hard disk is installed, 636 and 3269 also can be specified as the port address.

LDAP Authentication 
(for ColorTrack PRO)

Authentication Method Shows the authentication method.

Use Added Text String Select whether to use the added text string from the list.

Text String Added to 
User Name

Enter the added text string.

LDAP Authentication 
(for Server Address/
Phone Book)

Authentication Method Shows the authentication method.

Use Added Text String Select whether to use the added text string from the list.

Text String Added to 
User Name

Enter the added text string.

Common Name Sets the attribute type of the common name set for the LDAP server.

Surname Sets the attribute type of the surname set for the LDAP server.

Given Name Sets the attribute type of the given name set for the LDAP server.

E-mail Address Sets the attribute type of the e-mail address set for the LDAP server.

Fax Phone Sets the attribute type of the fax phone number set for the LDAP server. 
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Values:

HTTP-SSL/TLS 
Communication*1

Select the check box to enable the HTTP-SSL/TLS Communication.

HTTP-SSL/TLS 
Communication Port 
Number

Sets the port number, which is not identical with that of HTTP for SSL/TLS. This must be 443 or 
between 8000 and 9999.

LDAP-SSL/TLS 
Communication*1, 2

Select the check box to enable the LDAP, and access is established using SSL/TLS communication.

Verify Remote Server 
Certificate*2

Select the check box to enable the Verify Remote Server Certificate function.

Generate Self-Signed 
Certificate*3

Click to display the Generate Self-Signed Certificate page and to create a security certification from 
the page. The Generate Self-Signed Certificate button is available only when the self-signed 
certificate is not generated.

Public Key Method Select the public key method of the self-signed certificate.

Size of Public Key Select the size of public key.

Issuer Sets the issuer of SSL self-signed certificate.

Generate Signed 
Certificate

Click to generate the SSL self-signed certificate.

Upload Signed 
Certificate*3, 4

Click to display the Upload Signed Certificate page and to upload the certificate file to the device 
from the page.

Password Enter the password to upload the certificate file.

Re-enter Password Enter the password again for confirmation.

File Name Click Browse to browse the file name to upload to the device.

Import Click Import to upload the certificate file to the device.

Certificate 
Management*3, 4

Click to display the Certificate Management page and to manage a security certification from the 
page.

Category Select the device to certificate.

Certificate Purpose Select the connection to certificate.

Certificate Order Select the order to certificate.

Display the List Click to display the Certificate List page.

Certificate List*3 Category Displays the device to certificate selected at the Certificate Management 
page.

Certificate Purpose Displays the connection to certificate selected at the Certificate 
Management page.

Issued To Displays the list of certificate order.

Validity Displays whether certificate is valid or not.

Certificate Details Click to display the Certificate Details page. The SSL/TLS page is 
displayed when no item in the Issued To column is selected.
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IPsec

Purpose:

To specify the Security Architecture settings for Internet Protocol (IPsec) for encrypted communication to the 
printer.

Values:

Certificate Details*3 Category Displays the device to certificate selected at the Certificate Management 
page or SSL/TLS page.

Issued To Displays the device to certificate.

Issuer Displays the issuer to certificate.

Serial Number Displays the serial number of the device.

Public Key Method Displays the public key method.

Size of Public Key Displays the size of public key.

Valid From Displays the time the certificate is valid.

Valid Until Displays the time the certificate is invalid.

Status Displays whether certificate is valid or not.

Certificate Purpose Displays the purpose of certificate.

Certificate Selection 
Status

Displays the type of device certificate you selected.

E-mail Address Displayed only when an e-mail address is specified in the certificate.

Use this certificate*2 Click to apply this certificate to the device.

Delete Click to delete this certificate.

Export This 
Certificate*2

Click to export the certificate to the other device.

*1 This item is available only when the self-signed certificate has been generated.
*2 This item is displayed only when the optional hard disk is installed and is set to On for encryption.
*3 This item is effective only when connected via SSL/TLS (https). Only the administrator is allowed to display the pages.
*4 This item is displayed only when the optional hard disk is installed and is set to On for encryption. If not, Certificate Details is displayed.

IPsec Settings Protocol Select the check box to enable the protocol.

IKE Sets IKE authentication. Device Certificate is displayed on the list only 
when an effective digital signature is set up.

Pre-Shared Key Sets a shared key. Up to 255 alphanumeric characters, periods, and 
hyphens can be used.

Re-enter Pre-Shared Key Enters the shared key again to confirm it.

Device Certificate*1 Displays the device certificate.

IKE SA Lifetime Sets the lifetime for IKE SA from 5 to 28,800 minutes.

IPsec SA Lifetime Sets the lifetime for IPsec SA from 5 to 2,880 minutes.

DH Group Sets the DH group.

PFS Select the check box to enable the PFS setting.

Remote peers IPv4 address Sets the IP address to connect to.

Remote peers IPv6 address Sets the IP address to connect to.

Non IPsec communication 
policy

Allows communication with a device which does not support IPsec.
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 NOTE: If IPsec is enabled with incorrect settings, you must disable it using the IPsec menu on the operator panel.

802.1x

Purpose:

To specify the settings for IEEE 802.1x authentication for encrypted communication to the printer.

Values:

IP Filter (IPv4)

Purpose:

To specify the IP address and subnet mask to be permitted or denied access to the printer.

Values:

SMTP Domain Filtering

Purpose:

To specify whether to restrict sending e-mails to specific domains only.

 NOTE: This feature does not restrict sending e-mails through the E-Mail Alert feature.

*1  This item is effective only when the optional hard disk is installed and is set to On for encryption.

Configure 802.1x Enable IEEE 802.1x Select the check box to enable IEEE 802.1x authentication.

Authentication Method EAP-MD5 Selects the authentication method to use for IEEE 
802.1x authentication.EAP-MS-

CHAPv2

PEAP/MS-
CHAPv2

EAP-TLS*1, 2

Login Name: (Device 
Name)

Sets the login name (device name) for IEEE 802.1x authentication using 
up to 128 alphanumeric characters.

Password Sets the login password for IEEE 802.1x authentication using up to 128 
alphanumeric characters.

Re-enter Password Confirms the set login password.

Certificate Validation Select the check box to enable Certificate Validation.
*1  This item is displayed only when the optional hard disk is installed and is set to On for encryption.
*2  When this item is selected, Password and Re-enter Password need not to be specified.

Access List Address Sets the IP addresses that are permitted or denied access to the printer. Enter a 
numeric value between 0 and 255 in each field.

Address Mask Sets the subnet mask that are permitted or denied access to the printer. Enter a 
numeric value between 0 and 255 in each field.

Active Mode Reject Rejects printing from specified network address.

Accept Permits printing from specified network address.

Off Disables the IP Filter feature for the specified IP address.
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Values:

Copy Printer Settings
The Copy Printer Settings menu includes the Copy Printer Settings and Copy Printer Settings Report pages.

Copy Printer Settings

Purpose:

To copy the printer settings to one or more of the same model of the printer.

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are 
copied in the IP Address text box and Password text box. Then, click the Copy the settings to the Host in the above 
list button. Copying the settings is complete. The connection time-out period is 60 seconds. After that, you can 
check whether the settings were copied to this page. And you need to check the Copy the settings to the Host in the 
above list and reboot the printer menu of the Dell Printer Configuration Web Tool in the destination printer to 
verify if the settings were actually copied or not.

If the settings can be copied but the printer configuration is different, the settings of only the same items are copied. 
Printer settings are simultaneously copied to printers of up to 10 IP addresses.

 NOTE: You cannot copy the Address Book when the destination printer has a fax job. 

Copy Printer Settings Report

Purpose:

To verify whether the printer setting is copied to other printers successfully. 

 NOTE: The history is cleared by turning off the printer.

Print Volume
The Printer Volume menu includes the Print Volume and Dell ColorTrack pages.

Print Volume

Purpose:

To verify the number of printed pages. This page can also be displayed by clicking Print Volume in the left frame.

Values:

Dell ColorTrack

Purpose:

To specify which users have access to color printing and to limit print volume per user.

SMTP Domain Filtering Domain Filtering Select the check box to enable Domain Filtering.

Allow Domain List Allows you to register up to five domains allowed for sending e-mails.

Printer Page Count Displays the total number of pages printed since the printer was shipped from the factory.

Paper Used Displays the number of pages printed for each paper size.
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Values:

Address Book
The Address Book menu includes the E-Mail Address, Server Address, and Phone Book pages.

ColorTrack Mode Off Enables to print the data with no authentication information.

Internal Mode Restricts printing based on the print user information registered in the 
internal server.

External Mode Restricts printing based on the print user information registered in the 
external server.

Non Registered User Sets whether to permit the printing of data with no authentication information. To permit the 
printing for non-account user, select the check box.

Non Registered User 
Password*1

Sets the password to be used for non-account user using 1 to 127 alphanumeric characters. If the 
password is left blank (NULL), you cannot log in to a server.

Re-enter Non Registered 
User Password*1

Enter the password again to confirm it.

ColorTrack Error Report Sets whether to automatically print error-related information if printing using ColorTrack results in an 
error.

Auto Color To Mono 
Print

Sets whether to print all print jobs in black and white even when color print is specified.

User Registration*2 Click Edit User Registration to display the Edit Print User Registration page.

• To register a user, click Create to open the Print User Settings page.

• To delete a user, click Delete to open the Delete User page. 
Clicking Back returns the screen to the status prior to deleting the user.

• To confirm or change the registered user, click Confirm / Change to open the Print User Settings 
page.

User Registration No. Displays the user registration number. The Delete User button is displayed 
when the user is already registered.

User Name Sets the user name.

Password Sets the user password using 4 to 12 alphanumeric characters.

Re-enter password Enter the password again to confirm it.

Color Mode Limitation Sets whether to limit color printing.

Upper Limit for Color 
Print

Sets the maximum number of pages allowed for color printing.

Cumulative Color Page 
Count

Displays the cumulative number of pages printed for color printing.

Upper Limit for 
Monochrome Print

Sets the maximum number of pages allowed for monochrome printing.

Cumulative 
Monochrome Page 
Count

Displays the cumulative number of pages printed for monochrome printing.

Setup Remote 
Authentication*3

Click to display the Authentication System page.

*1 The password must be set when External Mode is selected for ColorTrack Mode and Non Registered User is set to on.
*2 This item is displayed only when ColorTrack Mode is Internal Mode.
*3 This item is displayed only when ColorTrack Mode is External Mode.
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E-Mail Address 

The E-mail Address page includes the following subpages.

E-Mail Address

Purpose:

To view the e-mail address entries registered on the E-Mail Address page.

Values:

E-Mail Address (Confirm/Change, Create)

Purpose:

To view or edit the e-mail address entries on the E-Mail Address page, or create a new entry. The following items are 
in the dialog box that appears when you click Confirm / Change or Create on the E-Mail Address top page.

Values:

E-Mail Address E-Mail Address Allows you to view, edit, or create e-mail address entries.

E-Mail Group Allows you to view, edit, or create e-mail group entries.

Default Setup Allows you to view, edit, or set the default e-mail subject and message.

Server Address Server Address Allows you to view, edit, or create server address entries.

Phone Book FAX Speed Dial Allows you to view, edit, or create speed dial entries.

FAX Group Allows you to view, edit, or create fax group entries.

E-Mail Address Allows you to view, edit, or create e-mail address entries.

E-Mail Group Allows you to view, edit, or create e-mail group entries.

Default Setup Allows you to view, edit, or set the default e-mail subject and message.

Address List to: Selecting each button displays a list of entries for the group of user IDs indicated on the button.

ID Displays the user ID.

Name Displays the user name. (Not in Use) is displayed when there is no registration.

Address Displays the e-mail address of the user.

Delete Deletes the entry for the selected user ID. 

Confirm / Change Displays a dialog box where you can edit the entry of the selected user ID.

Create Displays a dialog box where you can create a new entry under the selected user ID.

ID Displays the selected user ID.

Name Allows you to view or edit the name of the user registered under the user ID, or enter a name for the 
new entry.

Address Allows you to view or edit the e-mail address of the user, or enter an e-mail address for the new entry.

Delete*1 Click this button to delete the selected user. 

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 

Back Click this button to return to the top page.
*1 This item is available only when you click Confirm / Change. 
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E-Mail Address (Delete)

Purpose:

To delete the e-mail address entries registered on the E-Mail Address page. The following items are in the dialog box 
that appears when you click Delete on the E-Mail Address top page.

Values:

E-Mail Group

Purpose:

To view the e-mail address entries registered on the E-Mail Group page.

Values:

ID Displays the selected user ID.

Name Displays the name of the user registered under the selected user ID.

Address Displays the e-mail address of the user.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.

GroupID Displays the group ID.

Name Displays the assigned group name. (Not in Use) is displayed when there is no registration.

Delete Deletes the entry for the selected group ID. 

Confirm / Change Displays a dialog box where you can edit the entry for the selected group ID.

Create Displays a dialog box where you can create a new entry under the selected group ID.
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E-Mail Group (Confirm/Change, Create)

Purpose:

To view or edit the e-mail address group entries on the E-Mail Group page, or create a new entry. The following 
items are in the dialog box that appears when you click Confirm / Change or Create on the E-Mail Group top page.

Values:

E-Mail Group (Delete)

Purpose:

To delete the e-mail group entries registered on the E-Mail Group page. The following items are in the dialog box 
that appears when you click Delete on the E-Mail Group top page.

Values:

Default Setup

Purpose:

To set the default e-mail subject and message.

Values:

E-Mail Group ID Displays the selected group ID.

Name Allows you to view or edit the name assigned for the group ID, or enter a 
new group name.

Delete*1 Click this button to delete the current entry. 

E-Mail Address Address List to: Selecting each button displays a list of entries for the group of IDs indicated 
on the button. 

ID Displays the user ID.

Select the check box on the left to create the group.

Name Displays the user name. (Not in Use) is displayed when there is no 
registration.

Address Allows you to view or edit the e-mail address of an entry registered under 
the selected user ID, or enter an e-mail address for the new entry.

Apply New Settings Click this button to apply the new settings.

Restore Settings Click this button to restore the previous settings.

Back Click this button to return to the top page.
*1 This item is available only when you click Confirm / Change. 

ID Displays the selected group ID.

Name Displays the name assigned for the group ID.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.

Default Subject Allows you to enter the default e-mail subject.

Body Text Allows you to enter the default e-mail message.

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 
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Server Address

Server Address

Purpose:

To view the server address entries registered on the Server Address page.

Values:

Server Address (Confirm/Change, Create)

Purpose:

To view or edit the server address entries on the Server Address page, or create a new entry. The following items are 
in the dialog box that appears when you click Confirm / Change or Create on the Server Address top page.

Values:

Address List to: Selecting each button displays a list of entries for the group of IDs indicated on the button.

ID Displays the server ID.

Name Displays the file directory name. (Not in Use) is displayed when there is no registration.

Server Address Displays the address of the file directory.

Delete Deletes the entry for the selected server ID. 

Confirm / Change Displays a dialog box where you can edit the entry for the selected server ID.

Create Displays a dialog box where you can create a new entry under the selected server ID.

ID Displays the selected server ID.

Name Allows you to view or change the server name assigned to the server ID, or enter a new server name.

Server Type Allows you to view the server type if you click Confirm / Change. Allows you to edit the server type if 
you click Create.

FTP*1 Select this to store scanned documents on a server via the FTP protocol.

SMB*1 Select this to store scanned documents on a computer via the Server 
Message Block (SMB) protocol.

Server Address Allows you to view or edit the server address registered under the server ID, or enter a new server 
address.

Share Name*2 Allows you to view or edit the assigned shared name, or enter a new shared name, when Server Type is 
set to SMB.

Server Path Allows you to view or edit the assigned server path, or enter a new path.

Server Port Number Allows you to view or edit the assigned server port number, or enter a new port number. If you leave 
the text box blank, the default port number (FTP: 21, SMB: 139) will be used.

Login Name Allows you to view or edit the login name that is required to access the selected protocol, or enter a 
new login name.

Login Password Allows you to view or edit the password that is required to access the selected protocol, or enter a new 
password.

Re-enter Password Confirms the set password.

Delete*3 Click this button to delete the current entry. 

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 

Back Click this button to return to the top page.



Dell™ Printer Configuration Web Tool 199

Server Address (Delete)

Purpose:

To delete the server address entries registered on the Server Address page. The following items are in the dialog box 
that appears when you click Delete on the Server Address top page.

Values:

Phone Book

The Phone Book page includes the following subpages.

FAX Speed Dial

Purpose:

To view the fax number entries registered on the FAX Speed Dial page.

Values:

FAX Speed Dial (Confirm/Change, Create)

Purpose:

To view or edit the speed dial entries on the FAX Speed Dial page, or create a new entry. The following items are in 
the dialog box that appears when you click Confirm / Change or Create on the FAX Speed Dial top page.

Values:

*1 You can edit this item only when you click Create.
*2 This item is available only when Server Type is set to SMB.
*3 This item is available only when you click Confirm / Change.

ID Displays the selected server ID.

Name Displays the name assigned for the server ID.

Server Address Displays the server address registered under the server ID.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.

FAX Speed Dial Allows you to view, edit, or create speed dial entries.

FAX Group Allows you to view, edit, or create fax group entries.

Speed Dial List to: Selecting each button displays a list of entries for the group of speed dial codes indicated on the 
button.

Speed Dial Displays the speed dial ID.

Name Displays the assigned name for a speed dial ID.

Phone Number Displays the speed dial code. (Not in Use) is displayed when there is no registration.

Delete Deletes the entry for the selected speed dial code. 

Confirm / Change Displays a dialog box where you can edit the entry for the selected speed dial code.

Create Displays a dialog box where you can create a new entry under the selected speed dial code.

Speed Dial Displays the selected speed dial code.
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FAX Speed Dial (Delete)

Purpose:

To delete the speed dial entries registered on the FAX Speed Dial page. The following items are in the dialog box 
that appears when you click Delete on the FAX Speed Dial top page.

Values:

FAX Group

Purpose:

To view the fax group entries registered on the FAX Group page.

Values:

FAX Group (Confirm/Change, Create)

Purpose:

To view or edit the fax number group entries on the FAX Group page, or create a new entry. The following items are 
in the dialog box that appears when you click Confirm / Change or Create on the FAX Group top page.

Values:

Name Allows you to view or edit the name of an entry registered under the speed dial code, or enter a 
name for the new entry.

Phone Number Allows you to view or edit the fax number of an entry registered under the speed dial code, or 
enter a fax number for the new entry.

Delete*1 Click this button to delete the entry for the speed dial code. This button is available only on 
the dialog box for editing an existing entry. 

Apply New Settings Click this button to apply the new settings. 

Restore Settings Click this button to restore the previous settings. 

Back Click this button to return to the top page.
*1 This item is available only when you click Confirm / Change. 

Speed Dial Displays the selected speed dial code.

Name Displays the name registered under the speed dial code.

Phone Number Displays the fax number registered under the speed dial code.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.

ID Displays a fax group ID.

Name Displays the assigned group name. (Not in Use) is displayed when there is no registration.

Delete Deletes the entry for the selected group ID. 

Confirm / Change Displays a dialog box where you can edit the entry for the selected group ID.

Create Displays a dialog box where you can create a new entry under the selected group ID.

FAX Group ID Displays the selected group ID.

Name Allows you to view or edit the name assigned for the group ID, or enter a 
new group name.

Delete*1 Click this button to delete the current entry.
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FAX Group (Delete)

Purpose:

To delete the fax number group entries registered on the FAX Group page. The following items are in the dialog box 
that appears when you click Delete on the FAX Group top page.

Values:

Tray Management
Use the Tray Management menu to set the paper size and type of paper loaded in tray1 and the optional 550-sheet 
feeder.

Values:

FAX Speed Dial Speed Dial List to: Selecting each button displays a list of entries for the group of speed dial 
codes indicated on the button. 

Speed Dial Displays the speed dial code. Select the check box on the left to add the 
speed dial code in the group.

Name Displays the name registered for the speed dial code. (Not in Use) is 
displayed when there is no registration.

Phone Number Allows you to view or edit the fax number of an entry registered under the 
selected speed dial code, or enter a fax number for the new entry.

Apply New Settings Click this button to apply the new settings.

Restore Settings Click this button to restore the previous settings.

Back Click this button to return to the top page.
*1 This item is available only when you click Confirm / Change. 

ID Displays the selected group ID.

Name Displays the name assigned for the group ID.

Apply New Settings Click this button to apply the new settings. 

Back Click this button to return to the top page.

MPF Use Driver 
Settings for Print Job

Sets whether to use the printer driver settings for the size and type of paper loaded in the MPF.

MPF Paper Size*1 Sets the size of paper loaded in the MPF.

MPF Paper Type*1 Sets the type of paper loaded in the MPF.

MPF Custom Paper 
Size - Y*1

Sets the length of custom size paper loaded in the MPF.

MPF Custom Paper 
Size - X*1

Sets the width of custom size paper loaded in the MPF.

MPF Display Tray 
Prompt*1

Sets whether to display a popup message that prompts the user to set the paper size and type when 
the paper is loaded in the MPF.

Tray 1 Paper Size Sets the size of paper loaded in tray1.

Tray 1 Paper Type Sets the type of paper loaded in tray1.

Tray 1 Custom Paper 
Size - Y

Sets the length of custom size paper loaded in tray1.

Tray 1 Custom Paper 
Size - X

Sets the width of custom size paper loaded in tray1.
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Tray 1 Display Tray 
Prompt

Sets whether to display a popup message that prompts the user to set the paper size and type when 
the paper is loaded in tray1.

Tray 2 Paper Size*2 Sets the size of paper loaded in the optional 550-sheet feeder.

Tray 2 Paper Type*2 Sets the type of paper loaded in the optional 550-sheet feeder.

Tray 2 Custom Paper 
Size - Y*2

Sets the length of custom size paper loaded in the optional 550-sheet feeder.

Tray 2 Custom Paper 
Size - X*2

Sets the width of custom size paper loaded in the optional 550-sheet feeder.

Tray 2 Display Tray 
Prompt*2

Sets whether to display a popup message that prompts the user to set the paper size and type when 
the paper is loaded in the optional 550-sheet feeder.

1st Priority Sets the paper source to be used as the first priority.

2nd Priority Sets the paper source to be used as the second priority.

3rd Priority*2 Sets the paper source to be used as the third priority.
*1 This item is available only when Off in MPF Use Driver Settings for Print Job is selected.
*2 This item is available only when the optional 550-sheet feeder is installed.
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15
Understanding the Tool Box Menus
The Tool Box allows you to view, specify, and diagnose the system settings. 

 NOTE: A Password dialog box appears the first time you try to change settings on Tool Box when Panel Lock is set on the 
printer. In this case, input the password that you have already specified, and click OK to apply the settings.

Starting the Tool Box
1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Tool Box.

The screen to select the printer appears.

2 Click Network Connection or USB Connection, and then select the printer listed in Select From the Found 
Printers.

 NOTE: If the printer is not listed in Select From the Found Printers when you click Network Connection, click Directly Input 
IP Address/Host Name and enter the IP address of the printer. For details about how to verify the IP address of the printer, 
see "Verifying the IP Settings."

 NOTE: On Microsoft® Windows® XP or Windows Server® 2003, printers using IPv6 addresses cannot be detected.

3 Click OK.

The Tool Box opens.

The Tool Box consists of the Printer Setting Reports, Printer Maintenance, and Diagnosis tabs.

Printer Setting Reports
The Printer Setting Reports tab includes the Printer Information, Menu Settings, Reports, TCP/IP Settings, Tray 
Settings, Default Settings, Fax Settings, and Panel Language pages.

Printer Information
Purpose:

To display the system information of the printer.

Values:

Dell Service Tag Number Displays the service tag number of your printer.

Express Service Code Displays the express service code number.

Printer Serial Number Displays the serial number of your printer.

Printer Type Displays the type of printing for the printer. Color Laser is displayed normally.

Asset Tag Number Displays the asset tag number of your printer.

Memory Capacity Displays the memory capacity.

Processor Speed Displays the processing speed.

Firmware Version Displays the version of the controller.

Network Firmware Version Displays the NIC version.

MCU Firmware Version Displays the version of the Machine Control Unit (MCU) firmware.

Color Printing Speed Displays the speed for color printing.

Monochrome Printing Speed Displays the speed for monochrome printing.
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Menu Settings
Purpose:

To display the menu settings of the printer.

Values:

System Settings - 
General

Power Saver Timer - Sleep Displays the amount of transition time to the Sleep mode 
after the printer finishes a job.

Power Saver Timer - Deep Sleep Displays the amount of transition time between the Sleep 
mode and the Deep Sleep mode.

Time Zone Displays the selected time zone. 

Set Date Displays the date setting.

Set Time Displays the time setting.

Date Format Displays the selected date format.

Time Format Displays the selected time format; 24 Hour or 12 Hour.

mm / inch Displays the measurement unit used on the operator 
panel.

Low Toner Alert Message Displays whether to show the alert message when the 
toner is low.

OffHook Wake Up Displays whether to wake up from Sleep or Deep Sleep 
mode when you pick up the handset of the external 
telephone.

Auto Log Print Displays whether to automatically print a job history 
report after every 20 jobs.

RAM Disk*1 Displays whether to allocate RAM for the disk file system 
for the Secure Print, Private Mail Box Print, Public Mail 
Box Print, and Proof Print features.

Fax Server Address Book Displays whether to specify the fax numbers from the 
Address Book for the LDAP server.

E-mail Server Address Book Displays whether to specify the e-mail addresses from the 
Address Book for the LDAP server.

System Settings - Audio 
Tone

Control Panel Tone Displays the volume of the tone that is emitted when the 
operator panel input is correct. Off indicates that the tone 
is disabled.

Invalid Key Tone Displays the volume of the tone that is emitted when the 
operator panel input is incorrect. Off indicates that the 
tone is disabled.

Machine Ready Tone Displays the volume of the tone that is emitted when the 
printer becomes ready. Off indicates that the tone is 
disabled.

Copy Completed Tone Displays the volume of the tone that is emitted when a 
copy job is complete. Off indicates that the tone is 
disabled.

Job Completed Tone Displays the volume of the tone that is emitted when a job 
other than copying is complete. Off indicates that the 
tone is disabled.

Fault Tone Displays the volume of the tone that is emitted when a job 
ends abnormally. Off indicates that the tone is disabled.
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Alert Tone Displays the volume of the tone that is emitted when a 
problem occurs. Off indicates that the tone is disabled.

Out of Paper Alert Tone Displays the volume of the tone that is emitted when the 
printer runs out of paper. Off indicates that the tone is 
disabled.

Low Toner Alert Tone Displays the volume of the tone that is emitted when the 
toner is low. Off indicates that the tone is disabled.

Auto Clear Alert Tone Displays the volume of the tone that is emitted 5 seconds 
before the printer performs auto clear. Off indicates that 
the tone is disabled.

System Settings - Timers Auto Reset Displays the amount of time before the printer 
automatically resets the settings on the operator panel to 
the defaults when no additional settings are made.

Fault Time-out Displays the amount of time the printer waits before 
canceling a job that stops abnormally. 

Job Time-out Displays the amount of time the printer waits for data to 
arrive from the computer.

System Settings - 
Output Settings

Default Paper Size Displays the default paper size.

Print ID Displays where to print a user ID on the output paper.

Print Text Displays whether the printer outputs PDL (Page 
Description Language) data (which is not supported by 
the printer) as text when the printer receives it. 

Banner Sheet Insert Position Displays where to insert the banner sheet. 

Banner Sheet Specify Tray Displays the banner sheet tray. 

Substitute Tray Displays an indication to use paper of a different size 
when the paper that is loaded in the specified tray does 
not match the paper size settings for the current job.

Letterhead 2 Sided Displays whether to print on both sides of a sheet of 
letterhead paper.

Enable A4<>Letter Switch Displays whether to print A4 size jobs on Letter size paper 
if A4 is not available in the paper trays and vice versa 
(Letter size job on A4 size paper). 

Report 2 Sided Print Displays whether to print reports on both sides of a sheet 
of paper.

Use Another Tray Displays whether to show a message to select another tray 
when the specified paper is not available in the paper tray.

Service Tools - Paper 
Density

Plain Displays the plain paper density settings.

Label Displays the label paper density settings.

Service Tools - Auto 
Registration Adjustment

Auto Registration Adjustment Displays whether to automatically adjust color 
registration.

Service Tools - Non-Dell 
Toner

Non-Dell Toner Displays whether to use toner cartridge of another 
manufacturer.

Service Tools - Adjust 
Altitude

Adjust Altitude Displays the altitude of the location where the printer is 
installed.

*1 This item is not available when the optional hard disk is installed.
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Reports
Purpose:

To print the settings and history information of the printer. 

The reports are printed in the paper size specified in system settings.

Values:

TCP/IP Settings
Purpose:

To display the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol).

Values:

System Settings Click this button to print a detailed list of the system settings.

Panel Settings Click this button to print a detailed list of the panel settings.

PCL Fonts List Click this button to print a list of the PCL (Hewlett-Packard Printer Control Language) fonts.

PCL Macros List Click this button to print a list of the PCL Macro.

PS Fonts List Click this button to print a list of the PS fonts.

PDF Fonts List Click this button to print a list of the PDF fonts.

Job History Click this button to print the Completed Jobs history of the printer.

Error History Click this button to print the error history of the printer.

Print Meter Click this button to print the report for the total number of pages printed.

Color Test Page Click this button to print a color test page.

Protocol Monitor Click this button to print the Protocol Monitor report.

Speed Dial Click this button to print a list of all the members stored as speed dial numbers.

Email Address Book Click this button to print a list of all the addresses stored as address book information.

Server Address Click this button to print a list of all the members stored as server address information.

Fax Activity Click this button to print the report of faxes recently received or sent.

Fax Pending Click this button to print a list of status of pending faxes.

Stored Documents*1 Click this button to print a list of the Stored Documents.
*1 You can print the list only when the RAM disk is enabled or the optional hard disk is installed.

IPv4 IP Address Mode Displays the method for acquiring the IP address.

IP Address Displays the IP address of the printer.

Subnet Mask Displays the subnet mask.

Gateway Address Displays the gateway address.

IPv6 Use Manual Address Displays whether to set the IP address manually.

Manual Address Displays the IP address of the printer.

Link Local Address Displays the link local address.



Understanding the Tool Box Menus 207

Tray Settings
Purpose:

To display the tray settings of the printer.

Values:

Default Settings
Purpose:

To display the default settings for the Copy, Scan, Fax, and USB Direct Print functions of the printer.

Values:

Tray Settings MPF Display Tray 
Prompt

Displays a popup menu that prompts to set the paper size and type when 
paper is loaded in the multipurpose feeder (MPF).

MPF Use Driver 
Settings for Print Job

Displays whether to use the printer driver settings for the size and type of 
paper loaded in the MPF.

MPF Paper Size Displays the paper size setting of the MPF.

MPF Custom Size - Y Displays the length of custom size paper loaded in the MPF.

MPF Custom Size - X Displays the width of custom size paper loaded in the MPF.

MPF Paper Type Displays the paper type setting of the MPF.

Tray 1 Display Tray 
Prompt

Displays a popup menu that prompts to set the paper size and type when 
paper is loaded in tray1.

Tray 1 Paper Size Displays the paper size setting of tray1.

Tray 1 Custom Size - Y Displays the length of custom size paper loaded in tray1.

Tray 1 Custom Size - X Displays the width of custom size paper loaded in tray1.

Tray 1 Paper Type Displays the paper type setting of tray1.

Tray 2 Display Tray 
Prompt*1

Displays a popup menu that prompts to set the paper size and type when 
paper is loaded in the optional 550-sheet feeder (tray2).

Tray 2 Paper Size*1 Displays the paper size setting of the optional 550-sheet feeder.

Tray 2 Custom Size - Y*1 Displays the length of custom size paper loaded in the optional 550-sheet 
feeder.

Tray 2 Custom Size - X*1 Displays the width of custom size paper loaded in the optional 550-sheet 
feeder.

Tray 2 Paper Type*1 Displays the paper type setting of the optional 550-sheet feeder.

Tray Priority Tray Priority Displays the priority order of the paper trays.
*1 This item is available only when the optional 550-sheet feeder is installed.

Copy Defaults Output Color Displays whether to make copies in color or in black and white.

Select Tray Displays the input tray.

Collation Displays whether to sort the copy job.

Reduce / Enlarge Displays the default copy reduction/enlargement ratio.

Original Size Displays the paper size of the original document.

Original Type Displays the type of the original document.

Darken / Lighten Displays the default copy density level.

Sharpness Displays the default sharpness level.
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Color Saturation Displays the default color saturation level.

Auto Exposure Displays whether to suppress the background of the original to enhance text 
on the copy.

Auto Exposure Level Displays the background suppression level.

Color Balance (Yellow 
Low)

Displays the color balance level of low density yellow.

Color Balance (Yellow 
Medium)

Displays the color balance level of medium density yellow.

Color Balance (Yellow 
High)

Displays the color balance level of high density yellow.

Color Balance (Magenta 
Low)

Displays the color balance level of low density magenta.

Color Balance (Magenta 
Medium)

Displays the color balance level of medium density magenta.

Color Balance (Magenta 
High)

Displays the color balance level of high density magenta.

Color Balance (Cyan 
Low)

Displays the color balance level of low density cyan.

Color Balance (Cyan 
Medium)

Displays the color balance level of medium density cyan.

Color Balance (Cyan 
High) 

Displays the color balance level of high density cyan.

Color Balance (Black 
Low)

Displays the color balance level of low density black.

Color Balance (Black 
Medium)

Displays the color balance level of medium density black.

Color Balance (Black 
High)

Displays the color balance level of high density black.

2 Sided Copying Displays whether to print on both sides of a sheet of paper.

2-Up Displays whether the Multiple-Up feature is enabled.

Margin Top / Bottom Displays the value of the top and bottom margins.

Margin Left / Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

Scan Defaults File Format Displays the file format in which scanned documents are to be saved.

Output Color Displays whether to scan in color or in black and white.

Resolution Displays the default scan resolution.

Original Size Displays the paper size of the original document.

2 Sided Scanning Displays whether to scan both sides of a document.

Darken / Lighten Displays the default scan density level.

Sharpness Displays the default sharpness level.

Contrast Displays the default contrast level.

Auto Exposure Displays whether to suppress the background of the original to enhance text 
on the copy.

Auto Exposure Level Displays the background suppression level.

Margin Top / Bottom Displays the value of the top and bottom margins.
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Fax Settings
Purpose:

To display the fax settings of the printer.

Values:

Margin Left / Right Displays the value of the left and right margins.

Margin Middle Displays the value of the middle margin.

TIFF File Format Displays the TIFF file format; TIFF V6 or TTN2.

Image Compression Displays the image compression level.

Max E-mail Size Displays the maximum size of e-mail that can be sent.

File Naming Mode Displays the mode used to name scanned documents.

Create Folder Displays the folder to which scanned documents are to be saved.

Fax Defaults Resolution Displays the resolution level to be used for fax transmission.

2 Sided Scanning Displays whether to scan both sides of a document.

Darken / Lighten Displays the density level to be used for fax transmission.

Delayed Send Displays the fax transmission start time.

USB Direct Print 
Defaults

Output Color Displays the default color mode. 

Select Tray Displays the default tray.

2 Sided Printing Displays whether to print on both sides of a sheet of paper. 

Multiple-Up Displays the default paper layout when Multiple-Up is selected.

Collation Displays whether to sort the print job.

Fax Number Displays the fax number of the printer, which will be printed on the header of 
faxes.

Country Displays the country where the printer is used.

Fax Header Name Displays the name of the sender that will be printed on the header of faxes.

Line Type Displays the line type; PSTN or PBX.

Line Monitor Displays the volume of the line monitor, which audibly monitors a transmission 
through the internal speaker until a connection is made.

DRPD Pattern Displays the Distinctive Ring Pattern Detection (DRPD) setting.

Receive Mode Displays the fax receiving mode.

Ring Tone Volume Displays the volume of the ring tone, which indicates that an incoming call is a 
telephone call through the internal speaker when Receive Mode is set to 
Telephone / Fax.

Auto Receive Fax Displays the interval at which the printer goes into the fax receive mode after 
receiving an incoming call.

Auto Receive Tel/Fax Displays the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call.

Auto Receive Ans/Fax Displays the interval at which the printer goes into the fax mode after the external 
answering machine receives an incoming call.

Junk Fax Setup Displays whether to reject faxes sent from unwanted stations.

Sent Fax Forward Displays whether to forward incoming faxes to a specified destination.

Fax Forwarding Number Displays the fax number of the destination to which incoming faxes are to be 
forwarded.



210 Understanding the Tool Box Menus

Panel Language
Purpose:

To display the panel language setting of the printer.

Values:

2 Sided Printing Displays whether to print the received fax on both sides of a sheet of paper.

Remote Receive Displays whether to receive faxes by pressing a remote receive code on the external 
telephone.

Remote Receive Tone Displays the tone to start Remote Receive.

Discard Size Displays whether to delete text or images at the bottom of a fax page when the 
entire page does not fit onto the output paper.

Redial Attempts Displays the number of redial attempts.

Interval of Redial Displays the redial interval.

Resend Delay Displays the interval between transmission attempts.

Tone / Pulse Displays whether to use tone or pulse dialing.

Prefix Dial Displays whether to set a prefix dial number.

Prefix Dial Number Displays a prefix dial number. This number dials before any auto dial number is 
started. It is useful for accessing the Private Automatic Branch Exchange (PABX).

Fax Cover Page Displays whether to attach a cover page to faxes.

Fax Header*1 Displays whether to print the information of the sender on the header of faxes.

ECM Displays whether the Error Correction Mode (ECM) is enabled.

Modem Speed Displays the fax modem speed when a fax transmission or reception error occurs.

Display Manual Fax Recipients Displays whether to show the fax number of the recipient on the Sending Fax 
screen when manually sending a fax. 

Fax Activity Displays whether to automatically print a fax activity report after every 50 
incoming and outgoing fax communications.

Fax Transmit Displays whether to print a transmission report after every fax transmission or only 
when an error occurs.

Fax Broadcast Displays whether to print a transmission report after every fax transmission to 
multiple destinations or only when an error occurs.

Fax Protocol Displays whether to automatically print a protocol monitor report after every fax 
transmission or only when an error occurs.

*1  This item is not available when Country is set to United States.

Panel Language Displays the language that is used on the touch panel.
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Printer Maintenance
The Printer Maintenance tab includes the System Settings - General, System Settings - Timers, System Settings - 
Output Settings, Service Tools, Tray Management, Panel Language, TCP/IP Settings, Network Settings, Copy 
Defaults, Scan Defaults, Fax Defaults, USB Direct Print Defaults, and Fax Settings pages.

System Settings - General
Purpose:

To configure the power management of the printer, date and time, mm/inch setting, alarm tones, job log auto print, 
and setting of the additional memory.

Values:

Power Saver Timer Sleep*1 Available Range: 
1–60 minutes

Sets the amount of transition time to the Sleep mode 
after the printer finishes a job.

Deep Sleep*1 Available Range: 
1–60 minutes

Sets the amount of transition time between the Sleep 
mode and the Deep Sleep mode.

Date & Time Time Zone 
Settings

Click to display the Time Zone Settings dialog box. Select 
the geographic region and time zone, and then click OK.

Time Zone Displays the time zone selected on the Time Zone 
Settings dialog box.

Set Date Sets the date.

Date Format Sets the date format. 

Set Time Sets the time. You can select AM or PM when Time 
Format is set to 12 Hour.

Time Format Sets the time format in 24 Hour or 12 Hour.

mm / inch Millimeters(mm) Selects millimeter or inch as the default measurement 
unit.Inches(")

Audio Tone Control Panel 
Tone

Off Does not emit a tone when the operator panel input is 
correct.

Soft Emits a tone at the specified volume when the operator 
panel input is correct.Normal

Loud

Invalid Key Tone Off Does not emit a tone when the operator panel input is 
incorrect.

Soft Emits a tone at the specified volume when the operator 
panel input is incorrect.Normal

Loud

Machine Ready 
Tone

Off Does not emit a tone when the printer becomes ready.

Soft Emits a tone at the specified volume when the printer 
becomes ready.Normal

Loud
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Copy Completed 
Tone

Off Does not emit a tone when copying is complete.

Soft Emits a tone at the specified volume when copying is 
complete.Normal

Loud

Job Completed 
Tone

Off Does not emit a tone when any other job except copying is 
complete.

Soft Emits a tone at the specified volume when any other job 
except copying is complete.Normal

Loud

Fault Tone Off Does not emit a tone when a job ends abnormally.

Soft Emits a tone at the specified volume when a job ends 
abnormally.Normal

Loud

Alert Tone Off Does not emit a tone when a problem occurs.

Soft Emits a tone at the specified volume when a problem 
occurs.Normal

Loud

Out of Paper Alert 
Tone

Off Does not emit a tone when the printer runs out of paper.

Soft Emits a tone at the specified volume when the printer 
runs out of paper.Normal

Loud

Low Toner Alert 
Tone

Off Does not emit a tone when the toner is low.

Soft Emits a tone at the specified volume when the toner is 
low.Normal

Loud

Auto Clear Alert 
Tone

Off Does not emit a tone before the printer performs auto 
clear.

Soft Emits a tone at the specified volume 5 seconds before the 
printer performs auto clear.Normal

Loud

Low Toner Alert Message On Shows the alert message when the toner is low.

Off Does not show the alert message when the toner is low.

OffHook Wake Up Off Does not wake up from Sleep or Deep Sleep mode when 
you pick up the handset of the external telephone.

On Wake up from Sleep or Deep Sleep mode when you pick 
up the handset of the external telephone.

Auto Log Print Off Does not automatically print a job history report after 
every 20 jobs.

On Automatically prints a job history report after every 20 
jobs.
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System Settings - Timers
Purpose:

To configure the auto clear time and time-out time.

Values:

RAM Disk*2 Off Does not allocate RAM for the disk file system. Secure 
Print, Private Mail Box Print, Public Mail Box Print, and 
Proof Print jobs will abort and be recorded to the job log.

Available Range: 50–100MBytes Allocates RAM for the disk file system automatically. 

(in 50 MB increments)Available Range: 50–600MBytes*3

Fax Server Address Book On Enables the server address book for fax numbers.

Off Disables the server address book for fax numbers.

E-mail Server Address Book On Enables the server address book for e-mail addresses.

Off Disables the server address book for e-mail addresses.

Apply New Settings After you change the settings, click this button to apply 
the changes.

Restart printer to apply new settings Click this button to apply the changes.
*1 When you specify 1 minute for Sleep,  the printer enters  power saver mode 1 minute after it finishes a job. This uses much less energy, 

but requires more warm-up time for the printer. Specify 1 minute if your printer shares an electrical circuit with room lighting and you 
notice lights flickering.
Select a high value if your printer is in constant use. Under most circumstances, this keeps the printer ready to operate with minimum 
warm-up time.
Select a value between 1 and 60 minutes for the power saver mode if you want a balance between energy consumption and a shorter 
warm-up period.
The printer automatically returns to the standby mode from the power saver mode when it receives data from the computer. You can 
also return the printer to the standby mode by pressing the  (Power Saver) button on the operator panel.

*2 This item is not available when the optional hard disk is installed.
*3 When the optional 512MB memory module is installed.

Auto Reset 45 seconds Sets the amount of time before the printer automatically 
resets the settings on the operator panel to the defaults 
when no additional settings are made.

1 minute

2 minutes

3 minutes

4 minutes

Fault Time-out 0 Sets the amount of time the printer waits before canceling 
a job when the job stops abnormally.Available Range: 3–300 seconds

Job Time-out 0 Sets the amount of time the printer waits for additional 
data from the computer before it cancels the job.Available Range: 5–300 seconds

Apply New Settings After you change the settings, click this button to apply 
the changes.

Restart printer to apply new settings Click this button to apply the changes.
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System Settings - Output Settings
Purpose:

To configure the setting of the print ID, substitute tray, and other settings.

Values:

Default Paper Size A4 (210x297mm) Sets the default paper size.

Letter (8.5x11")

Print ID Off Does not print the user ID.

Top Left Prints the user ID on the specified location.

Top Right

Bottom Left

Bottom Right

Print Text Off Does not print the received PDL data as text data.

On Prints the received PDL data as text data.

Banner Sheet Insert 
Position

Off Does not insert the banner sheet.

Front Sets where to insert the banner sheet.

Back

Front & Back

Banner Sheet Specify Tray MPF Sets the tray for the banner sheet.

Tray 1

Tray 2*1

Substitute Tray Off No tray size substitute accepted.

Larger Size Substitutes paper of next largest size. When there is no 
larger paper size, the printer substitutes paper of nearest 
size.

Nearest Size Substitutes paper of nearest size.

Use MPF Substitutes paper from the MPF.

Letterhead 2 Sided Disable Does not print on both sides of a sheet of letterhead paper.

Enable Prints on both sides of a sheet of letterhead paper.

Enable A4<>Letter 
Switch

On Prints A4 size jobs on Letter size paper if A4 is not 
available in the paper trays and vice versa (Letter size job 
on A4 size paper).

Off Does not print A4 size jobs on Letter size paper or Letter 
size jobs on A4 paper. 

Report 2 Sided Print 1 Sided Prints reports on one side of a sheet of paper.

2 Sided Prints reports on both sides of a sheet of paper.

Use Another Tray On Sets to show a message to select another tray when the 
specified paper is not available in the paper tray.

Off Does not print on other paper sizes in other paper trays if 
the paper size specified in the job is not available. 

Apply New Settings After you change the settings, click this button to apply 
the changes.

Restart printer to apply new settings Click this button to apply the changes.
*1 This item is available only when the optional 550-sheet feeder is installed.
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Service Tools

 CAUTION: Using a non-Dell™ toner cartridge may severely damage your printer. The warranty does not cover damages 
caused by using non-Dell toner cartridges.

Purpose:

To configure the paper density, the color registration adjustments, the initialization of the printer, and other settings.

Values:

Paper Density Plain Light Sets plain paper density. 

Normal

Label Light Sets label paper density.

Normal

Color Registration 
Adjustments

Auto Correct Click Start to perform color registration 
automatically.

Print Color Regi Chart Click Start to print a color registration chart.

Registration 
Adjustments

LY(Left Yellow) Available Range: 
-9 to +9

Sets lateral (perpendicular to paper feed 
direction) and process (paper feed direction) 
color adjustment values that are found in the 
color registration chart individually for Yellow, 
Magenta, and Cyan.

LM(Left Magenta) Available Range: 
-9 to +9

LC(Left Cyan) Available Range: 
-9 to +9

RY(Right Yellow) Available Range: 
-9 to +9

RM(Right Magenta) Available Range: 
-9 to +9

RC(Right Cyan) Available Range: 
-9 to +9

PY(Process Yellow) Available Range: 
-9 to +9

PM(Process Magenta) Available Range: 
-9 to +9

PC(Process Cyan) Available Range: 
-9 to +9

Reset Defaults User Fax Section Initializes the fax number entries in the 
Address Book.

User Scan Section Initializes the e-mail and server address entries 
in the Address Book.

System Section Initializes the system parameters.

Initialize Print Meter Click Initialize Print Meter to initialize the 
Print Meter.

Non-Dell Toner Off Disables the use of another manufacturer's 
toner cartridge.

On Enables the use of another manufacturer's 
toner cartridge.
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Tray Management
Purpose:

To specify the paper types and sizes, and the tray priority for the MPF, tray1, and the optional 550-sheet feeder 
respectively.

Values:

Adjust Altitude 0 meter Sets the altitude of the location where the 
printer is installed. 1000 meters

2000 meters

3000 meters

Apply New Settings After you change the settings, click this button 
to apply the changes.

Restart printer to apply new settings Click this button to apply the changes.

Tray Settings MPF Display Tray 
Prompt

On Displays a popup message that prompts the user 
to set Paper Type and Paper Size when the paper 
is loaded in the MPF.

Off

MPF Use Driver 
Settings for Print Job

On Sets whether to use the printer driver settings 
for the size and type of paper loaded in the MPF.Off

MPF Paper Size*1 A4 (210x297mm) Sets the size of paper loaded in the MPF.

A5 (148x210mm)

B5 (182x257mm)

Letter (8.5x11")

Folio (8.5x13") 

Legal (8.5x14")

Executive (7.3x10.5")

Envelope #10 (4.1x9.5")

Monarch Env. (3.9x7.5")

DL Env. (110x220mm)

C5 Env. (162x229mm)

Custom Size

MPF Custom Size - 
Y*1

Available Range: 
127–355 mm (5.0–14.0 inches)

Sets the length of custom size paper loaded in 
the MPF.

MPF Custom Size - 
X*1

Available Range: 
77–215 mm (3.0–8.5 inches)

Sets the width of custom size paper loaded in 
the MPF.

MPF Paper Type*1 Plain Sets the type of paper loaded in the MPF.

Plain Thick

Covers(106–163g/m2)

Covers Thick(164–216g/m2)

Coated(106–163g/m2)

Coated Thick(164–216g/m2)

Label

Envelope
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Recycled

Letterhead

Preprinted

Prepunched

Color

Plain - Side 2

Color - Side 2

Plain Thick - Side 2

Recycled - Side 2

Tray 1 Display Tray 
Prompt

On Displays a popup message that prompts the user 
to set Paper Type and Paper Size when the paper 
is loaded in tray1.

Off

Tray 1 Paper Size A4 (210x297mm) Sets the size of paper loaded in tray1.

A5 (148x210mm)

B5 (182x257mm)

Letter (8.5x11")

Folio (8.5x13")

Legal (8.5x14")

Executive (7.3x10.5")

Custom Size

Tray 1 Custom Size - 
Y

Available Range: 
210–355 mm (8.3–14.0 inches)

Sets the length of custom size paper loaded in 
tray1.

Tray 1 Custom Size - 
X

Available Range: 
148–215 mm (5.8–8.5 inches)

Sets the width of custom size paper loaded in 
tray1.

Tray 1 Paper Type Plain Sets the type of paper loaded in tray1.

Plain Thick

Covers(106–163g/m2)

Covers Thick(164–216g/m2)

Coated(106–163g/m2)

Coated Thick(164–216g/m2)

Recycled

Letterhead

Preprinted

Prepunched

Color

Plain - Side 2

Color - Side 2

Plain Thick - Side 2

Recycled - Side 2

Tray 2 Display Tray 
Prompt*2

On Displays a popup message that prompts the user 
to set Paper Type and Paper Size when the paper 
is loaded in the optional 550-sheet feeder.

Off
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 NOTE: For details about the paper density for paper types, see "Paper Type Specifications."

Tray 2 Paper Size*2 Auto Sensed Sets the size of paper loaded in the optional 
550-sheet feeder.Custom Size

Tray 2 Custom Size - 
Y*2

Available Range: 
210–355 mm (8.3–14.0 inches)

Sets the length of custom size paper loaded in 
the optional 550-sheet feeder.

Tray 2 Custom Size - 
X*2

Available Range: 
148–215 mm (5.8–8.5 inches)

Sets the width of custom size paper loaded in 
the optional 550-sheet feeder.

Tray 2 Paper Type*2 Plain Sets the type of paper loaded in the optional 
550-sheet feeder.Plain Thick

Covers(106–163g/m2)

Covers Thick(164–216g/m2)

Coated(106–163g/m2)

Coated Thick(164–216g/m2)

Recycled

Letterhead

Preprinted

Prepunched

Color

Plain - Side 2

Color - Side 2

Plain Thick - Side 2

Recycled - Side 2

Tray Priority MPF->Tray1 Sets the priority order of the paper trays.

Tray1->MPF

MPF->Tray1->Tray2*2

MPF->Tray2*2->Tray1

Tray1->MPF->Tray2*2

Tray1->Tray2*2->MPF

Tray2*2 ->MPF->Tray1

Tray2*2 ->Tray1->MPF

Apply New Settings After you change the settings, click this button 
to apply the changes.

Restart printer to apply new settings Click this button to restart the printer and apply 
the changes.

*1  This item is available only when MPF Use Driver Settings for Print Job is set to Off.
*2  This item is available only when the optional 550-sheet feeder is installed.
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Panel Language
Purpose:

To determine the language of the text on the touch panel.

Values:

TCP/IP Settings

 NOTE: TCP/IP Settings is not available when IP Mode of the printer is set to IPv6 Mode.

Purpose:

To configure TCP/IP settings.

Values:

Panel Language English Sets the language to be used on the touch panel.

French

Italian

German

Spanish

Danish

Dutch

Norwegian

Swedish

Apply New Settings After you change the settings, click this button to apply the changes.

Restart printer to apply new settings Click this button to apply the changes.

IP Address Mode AutoIP Automatically sets the IP address.

A random value in the range of 169.254.1.0 to 169.254.254.255 that is not 
currently in use on the network is set as the IP address. The subnet mask is set as 
255.255.0.0. 

BOOTP Sets the IP address using BOOTP. 

RARP Sets the IP address using RARP. 

DHCP Sets the IP address using DHCP.

Panel Manually sets the IP address.

IP Address Manually sets the IP address allocated to the printer.

It is allocated to the printer using the format nnn.nnn.nnn.nnn. Each octet that 
makes up nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in 
the range of 224 to 254 cannot be specified for the first octet of a gateway address.

Subnet Mask Manually sets the subnet mask.

It is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up 
nnn.nnn.nnn.nnn is a value in the range of 0 to 255. 255.255.255.255 cannot be 
specified as the subnet mask.

Gateway Address Manually sets the gateway address.

It is specified using the format nnn.nnn.nnn.nnn. Each octet that makes up 
nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the range 
of 224 to 254 cannot be specified for the first octet of a gateway address.

Apply New Settings After you change the settings, click this button to apply the changes.
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Network Settings

 NOTE: Network Settings is not available when the printer is connected using a USB cable.

Purpose:

To configure the setup of the printer using your web browser. 

Values:

Copy Defaults
Purpose:

To create your own copy settings.

Values:

Restart printer to apply new settings Click this button to restart the printer and apply the changes.

Print Server Settings*1 Display Click to display the Print Server Setup page on the Dell Printer Configuration 
Web Tool.

Display of Dell 
Configuration Web Tool

Off Does not display the server settings for the Dell Printer Configuration Web Tool.

On Displays the server settings for the Dell Printer Configuration Web Tool.

Apply New Settings After you change the settings, click this button to apply the changes.

Restart printer to apply new settings Click this button to restart the printer and apply the changes.
*1 This item is available only when Display of Dell Configuration Web Tool is set to On.

Output Color Full Color Prints in color mode. 

Black & White Prints in black and white mode.

Select Tray MPF The paper is fed from the MPF.

Tray 1 The paper is fed from tray1. 

Tray 2*1 The paper is fed from the optional 550-sheet feeder.

Collation Auto Automatically sorts the copy job.

Collated Sorts the copy job.

Uncollated Does not sort the copy job.

Reduce / Enlarge 
mm series

100% Does not enlarge or reduce the size of a copied image.

50% Sets the default reduction ratio.

A4->A5 (70%)

B5->A5 (81%)

A5->B5 (122%) Sets the default enlargement ratio.

A5->A4 (141%)

200%

Custom Sets the default enlargement / reduction ratio to a 
custom ratio.

inch series 100% Does not enlarge or reduce the size of a copied image.

50% Sets the default reduction ratio.

Ledger->Letter (64 %)

Legal->Letter (78 %)
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Statement->Letter (129 %) Sets the default enlargement ratio.

Statement->Legal (154 %)

200%

Custom Sets the default enlargement / reduction ratio to a 
custom ratio.

Custom Reduce / 
Enlarge

Available Range: 25–400% Sets the custom enlargement / reduction ratio when 
you set Reduce / Enlarge to Custom.

Original Size Auto Sets the document size automatically.

A4 (210x297mm) Sets the document size. 

A5 (148x210mm)

B5 (182x257mm)

Letter (8.5x11")

Folio (8.5x13") 

Legal (8.5x14")

Executive (7.3x10.5")

Original Type Photo & Text Improves the image quality of documents with both 
text and photos.

Text Improves the image quality of documents with text.

Photo Improves the image quality of documents with photos.

Darken / Lighten Darken +3 Makes the copy darker than the original. Works well 
with light documents or faint pencil markings.Darken +2

Darken +1

Normal Works well with standard typed or printed documents. 

Lighten +1 Makes the copy lighter than the original. Works well 
with dark documents.Lighten +2

Lighten +3

Sharpness Sharpen Makes the copy sharper than the original.

Normal Does not make the copy sharper or softer than the 
original.

Soften Makes the copy softer than the original.

Color Saturation High Increases the color saturation to brighten the color of 
the copy.

Normal The color saturation is the same as the original.

Low Decreases the color saturation to lighten the color of 
the copy.

Auto Exposure Off Does not suppress the background.

On Suppresses the background of the original to enhance 
text on the copy.

Auto Exposure Level Normal Sets the background suppression level to Normal.

High Sets the background suppression level to High.

Highest Sets the background suppression level to Highest.

Color Balance Yellow Low Density Available Range: 
-3 to +3

Sets the color balance level of low density yellow. 



222 Understanding the Tool Box Menus

Yellow Medium 
Density

Available Range: 
-3 to +3

Sets the color balance level of medium density yellow. 

Yellow High Density Available Range: 
-3 to +3

Sets the color balance level of high density yellow. 

Magenta Low 
Density

Available Range: 
-3 to +3

Sets the color balance level of low density magenta.

Magenta Medium 
Density

Available Range: 
-3 to +3

Sets the color balance level of medium density 
magenta. 

Magenta High 
Density

Available Range: 
-3 to +3

Sets the color balance level of high density magenta. 

Cyan Low Density Available Range: 
-3 to +3

Sets the color balance level of low density cyan.

Cyan Medium 
Density

Available Range: 
-3 to +3

Sets the color balance level of medium density cyan. 

Cyan High Density Available Range: 
-3 to +3

Sets the color balance level of high density cyan. 

Black Low Density Available Range: 
-3 to +3

Sets the color balance level of low density black.

Black Medium 
Density

Available Range: 
-3 to +3

Sets the color balance level of medium density black. 

Black High Density Available Range: 
-3 to +3

Sets the color balance level of high density black. 

2 Sided Copying 1 -> 1 Sided Prints on one side of a sheet of paper.

1 -> 2 Sided Prints one sided originals on both sides of a sheet of 
paper.

2 -> 1 Sided Prints two sided originals on one side of a sheet of 
paper.

2 -> 2 Sided Prints two sided originals on both sides of a sheet of 
paper.

Binding of Output*2 Long Edge Binding Prints on both sides of a sheet of paper to be bound by 
long edge.

Short Edge Binding Prints on both sides of a sheet of paper to be bound by 
short edge.

Binding of 
Original*3

Long Edge Binding Scans both sides of a document bound by long edge.

Short Edge Binding Scans both sides of a document bound by short edge.

2-Up Off Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one 
sheet of paper.

Manual Prints the original pages onto one sheet of paper in the 
size specified in Reduce / Enlarge.

Margin Top / Bottom Available Range: 0–50 mm (0.0–2.0 inches) Sets the value of the top and bottom margins.

Margin Left / Right Available Range: 0–50 mm (0.0–2.0 inches) Sets the value of the left and right margins.

Margin Middle Available Range: 0–50 mm (0.0–2.0 inches) Sets the value of the middle margin.

Apply New Settings After you change the settings, click this button to apply 
the changes.

Restart printer to apply new settings Click this button to restart the printer and apply the 
changes.
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Scan Defaults
Purpose:

To create your own scan settings.

Values:

*1 This item is available only when the optional 550-sheet feeder is installed.
*2 This item is available only when 2 Sided Copying is set to 1 -> 2 Sided in the Copy Defaults page.
*3 This item is available only when 2 Sided Copying is set to 2 -> 1 Sided or 2 -> 2 Sided in the Copy Defaults page.

File Format PDF Saves the scanned image in PDF.

Multi-Page TIFF Saves the scanned image in Multi-Page TIFF.

TIFF (1File per Page) Saves the scanned image in TIFF (1File per Page).

JPEG (1File per Page) Saves the scanned image in JPEG (1File per Page).

Output Color Color Scans in color mode.

Black & White Scans in black and white mode.

Gray Scale Scans in grayscale.

Resolution 200 dpi Scans an image at 200 dpi.

300 dpi Scans an image at 300 dpi.

400 dpi Scans an image at 400 dpi.

600 dpi Scans an image at 600 dpi.

Original Size A4 (210x297mm) Sets the document size. 

A5 (148x210mm)

B5 (182x257mm)

Letter (8.5x11")

Folio (8.5x13")

Legal (8.5x14")

Executive (7.3x10.5")

2 Sided 
Scanning

1 Sided Scans one side of a document.

2 Sided Scans both sides of a document.

Binding of 
Original

Long Edge Binding Scans both sides of a document bound by long edge.

Short Edge Binding Scans both sides of a document bound by short edge.

Darken / 
Lighten

Darken +3 Makes the scanned image darker than the original. Works well 
with light documents or faint pencil markings.Darken +2

Darken +1

Normal Works well with standard typed or printed documents. 

Lighten +1 Makes the scanned image lighter than the original. Works well 
with dark documents.Lighten +2

Lighten +3

Sharpness Sharpen Makes the scanned image sharper than the original.

Normal Does not make the scanned image sharper or softer than the 
original.

Soften Makes the scanned image softer than the original.
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Fax Defaults
Purpose:

To create your own fax settings.

Values:

Contrast High Adjusts the amount of colors to make the contrast of colors 
darker than the original.

Medium Does not adjust the amount of colors to make the contrast of 
colors darker or lighter than the original.

Low Adjusts the amount of colors to make the contrast of colors 
lighter than the original.

Auto Exposure On Suppresses the background of the original to enhance text on the 
copy.

Off Does not suppress the background.

Auto Exposure 
Level

Normal Sets the background suppression level to Normal.

High Sets the background suppression level to High.

Highest Sets the background suppression level to Highest.

Margin Top / 
Bottom

Available Range: 0–50 mm (0.0–2.0 inches) Sets the value of the top and bottom margins. 

Margin Left / 
Right

Available Range: 0–50 mm (0.0–2.0 inches) Sets the value of the left and right margins. 

Margin Middle Available Range: 0–50 mm (0.0–2.0 inches) Sets the value of the middle margin.

TIFF File 
Format

TIFF V6 Sets the TIFF file format to TIFF V6.

TTN2 Sets the TIFF file format to TTN2.

Image 
Compression

High Sets the image compression level to High.

Normal Sets the image compression level to Normal.

Low Sets the image compression level to Low.

Max E-mail 
Size

Available Range: 50–16384 KBytes Sets the maximum size of e-mail that can be sent within the 
range of 50 KB to 16384 KB. 

File Naming 
Mode

Auto Sets the default file name.

Add Prefix Adds a prefix to the file name.

Add Suffix Adds a suffix to the file name.

Prefix/Suffix String Sets the texts that are added when Add Prefix or Add Suffix are 
selected.

Create Folder Off Does not create a folder when saving a scanned image.

On Creates a folder when saving a scanned image.

Apply New Settings After you change the settings, click this button to apply the 
changes.

Restart printer to apply new settings Click this button to restart the printer and apply the changes.

Resolution Standard Improves the output quality of the original. For documents with normal sized 
characters.

Fine Improves the output quality of the original. For documents containing small 
characters or thin lines or documents printed using a dot-matrix printer.
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USB Direct Print Defaults
Purpose:

To create your own settings for USB Direct Print Defaults.

Values:

Super Fine Improves the output quality of the original. For documents containing 
extremely fine detail. The super fine mode is enabled only if the remote 
machine also supports the Super Fine resolution.

Photo Improves the output quality of the original. For documents containing 
photographic images.

2 Sided Scanning 1 Sided Scans one side of a document.

2 Sided Scans both sides of a document.

Binding of 
Original

Long Edge 
Binding

Scans both sides of a document bound by long edge.

Short Edge 
Binding

Scans both sides of a document bound by short edge.

Darken / Lighten Darken +3 Makes the documents darker than the original. Works well with light 
documents or faint pencil markings.Darken +2

Darken +1

Normal Works well with standard typed or printed documents. 

Lighten +1 Makes the documents lighter than the original. Works well with dark 
documents.Lighten +2

Lighten +3

Delayed Send 00:00–23:59*1 Sets the fax transmission start time in 24-hour format when sending a fax at a 
specified time. 

01:00–12:59*2 AM Sets the fax transmission start time in 12-hour format when sending a fax at a 
specified time.PM

Apply New Settings After you change the settings, click this button to apply the changes.

Restart printer to apply new settings Click this button to restart the printer and apply the changes.
*1 This item is available only when Time Format is set to 24 Hour in the System Settings - General page.
*2 This item is available only when Time Format is set to 12 Hour in the System Settings - General page.

Output Color Full Color Prints in color mode. 

Black & White Prints in black and white mode.

Select Tray MPF The paper is fed from the MPF.

Tray 1 The paper is fed from tray1. 

Tray 2*1 The paper is fed from the optional 550-sheet feeder.

2 Sided Printing 1 Sided Prints on one side of a sheet of paper.

2 Sided Prints on both sides of a sheet of paper.

Binding of 
Output

Long Edge Binding Prints on both sides of a sheet of paper to be bound by long edge.

Short Edge Binding Prints on both sides of a sheet of paper to be bound by short edge.

Multiple-Up Off Prints one page on one side of a sheet of paper.

2-Up Prints two pages on one side of a sheet of paper.

4-Up Prints four pages on one side of a sheet of paper.
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Fax Settings
Purpose:

To specify the fax settings.

Values:

Collation Collated Sorts the print job.

Uncollated Does not sort the print job.

Apply New Settings After you change the settings, click this button to apply the changes.

Restart printer to apply new settings Click this button to restart the printer and apply the changes.
*1 This item is available only when the optional 550-sheet feeder is installed.

Fax Number Sets the fax number of the printer, which will be printed on the 
header of faxes.

Country Selects the country where the printer is used.

Fax Header Name Sets the sender's name to be printed on the header on faxes.

Line Type PSTN Sets the default line type to PSTN.

PBX Sets the default line type to PBX.

Line Monitor Off Turns off the volume of the line monitor, which audibly monitors a 
transmission through the internal speaker until a connection is made.

Low Sets the volume of the line monitor.

Medium

High

DRPD Pattern Pattern1–7 Provides a separate number for faxing with a distinctive ring pattern. 

Receive Mode Telephone Sets the default fax receiving mode to Telephone.

Fax Sets the default fax receiving mode to Fax.

Telephone / Fax Sets the default fax receiving mode to Telephone / Fax.

Ans Machine / Fax Sets the default fax receiving mode to Ans Machine / Fax.

DRPD Sets the default fax receiving mode to DRPD.

Ring Tone Volume Off Turns the volume of the ring tone, which indicates that an incoming 
call is a telephone call through the internal speaker when Receive 
Mode is set to Telephone / Fax.

Low Sets the volume of the ring tone.

Medium

High

Auto Receive Fax Available Range: 0–255 seconds Sets the interval at which the printer goes into the fax receive mode 
after receiving an incoming call in 0 to 255 seconds.

Auto Receive Tel/Fax Available Range: 0–255 seconds Sets the interval at which the printer goes into the fax receive mode 
after the external telephone receives an incoming call in 0 to 255 
seconds.

Auto Receive 
Ans/Fax

Available Range: 0–255 seconds Sets the interval at which the printer goes into the fax mode after the 
external answering machine receives an incoming call in 0 to 255 
seconds. 
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Junk Fax Setup On Rejects faxes sent from unwanted numbers by accepting faxes only 
from the fax numbers registered in the Phone Book.

Off Does not reject faxes sent from unwanted numbers.

Sent Fax Forward Off Does not forward any of the incoming faxes to a specified destination.

Forward Forwards the incoming faxes to a specified destination.

Print and Forward Prints the incoming fax and forwards it to a specified destination.

Print and E-mail Prints incoming faxes and also forward them to a specified e-mail 
address.

Fax Forwarding Number Sets the destination to which incoming faxes will be forwarded.

2 Sided Printing On Prints the received fax on both sides of a sheet of paper.

Off Does not print the received fax on both sides of a sheet of paper.

Remote Receive On Receives a fax by pressing a remote receive code on the external 
telephone after picking up the handset of the telephone.

Off Does not receive a fax by pressing a remote receive code on the 
external telephone after picking up the handset of the telephone.

Remote Receive 
Tone

Available Range: 00–99 Sets the tone to start Remote Receive. 

Discard Size Off Prints any excess at the bottom of a fax page without discarding it.

On Discards any excess at the bottom of the page.

Auto Reduction Automatically reduces a fax page to fit it onto the appropriate sized 
paper.

Redial Attempts Available Range: 0–13 Sets the number of redial attempts to make when the destination fax 
number is busy, within the range of 0 to 13. 

Interval of Redial Available Range: 1–15 minutes Sets the interval between redial attempts within the range of 1 to 15 
minutes.

Resend Delay Available Range: 3–255 seconds Sets the interval between transmission attempts within the range of 3 
to 255 seconds. 

Tone / Pulse Tone Sets the dialing type to Tone.

Pulse (10PPS) Sets the dialing type to Pulse (10PPS).

Pulse (20PPS) Sets the dialing type to Pulse (20PPS).

Prefix Dial On Sets a prefix dial number.

Off Does not set a prefix dial number.

Prefix Dial Number Sets a prefix dial number of up to five digits. This number dials 
before any auto dial number is started. 

Fax Cover Page On Attaches a cover page to faxes.

Off Does not attach a cover page to faxes.

Fax Header*1 On Prints the information of the sender on the header of faxes.

Off Does not print the information of the sender on the header of faxes.

ECM On Enables the ECM (Error Correction Mode). To use the ECM, the 
remote machines must also support the ECM. 

Off Disables the ECM.
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Diagnosis
The Diagnosis tab includes the Chart Print and Environment Sensor Info pages.

Chart Print
Purpose:

To print various charts that can be used for diagnosis of the printer. The chart is printed to A4 or letter size paper.

Values:

Modem Speed 2.4 kbps Allows you to adjust the fax modem speed when a fax transmission or 
reception error occurs. 4.8 kbps

9.6 kbps

14.4 kbps

33.6 kbps

Display Manual Fax 
Recipients

On Displays the fax number when manually sending a fax.

Off Does not display the fax number when manually sending a fax.

Fax Activity Auto Print Automatically prints a fax activity report after every 50 incoming and 
outgoing fax communications.

No Auto Print Does not print a fax activity report automatically.

Fax Transmit Print Always Prints a transmission report after every fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Fax Broadcast Print Always Prints a transmission report after every fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission to 
multiple destinations.

Fax Protocol Print Always Prints a protocol monitor report after every fax transmission.

Print On Error Prints the protocol monitor report only when an error occurs.

Print Disable Does not print the protocol monitor report.

Apply New Settings After you change the settings, click this button to apply the changes.

Restart printer to apply new settings Click this button to restart the printer and apply the changes.
*1  This item is not available when Country is set to United States. The setting is fixed to On and cannot be changed.

Pitch Configuration Chart Prints full halftone pages for yellow, magenta, cyan, and black. Also prints pages to 
check the pitch. A total of five pages are output. 

Ghost Configuration Chart Prints a chart to check for ghost printing. One page is printed. 

4 Colors Configuration Chart Bands of yellow, magenta, cyan, and black are printed with varying density. One 
page is printed. 

Banding Detection Chart Prints charts to check which color the banding occurred and the distance between 
each band.

MQ Chart Prints charts to check for the banding in A4 or Letter.

Alignment Chart Prints a chart to check for proper alignment of the print image on the paper. One 
page is printed. 
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Environment Sensor Info
Purpose:

To print the internal environment sensor information of the printer to Result.

Values:

Resetting Defaults
After executing this function and rebooting the printer, the phone book, address book, or menu parameters are reset 
to their default values.

The following menu parameters are exceptions and are not reset. 

• Network settings 

• Panel Lock settings and password

• Function Enabled settings (Copy, E-mail, Fax, Scan To Network, Scan To Application, PC Scan, Scan To USB, 
USB Direct Print) and passwords

• Secure Receive settings and password

• Login Error settings

• Set Available Time settings

• Secure Job Expiration settings

• USB Port settings

• Data Encryption settings

• Hard Disk Over Write settings

• ColorTrack Mode settings

• ColorTrack Error Report settings

• Non Registered User settings

When Using the Tool Box
1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box."

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Service Tools from the list at the left side of the page.

The Service Tools page appears.

4 Click User Fax Section, User Scan Section, or System Section.

The printer restarts automatically to apply the settings.

Get Environment Sensor 
Info

Click this button to confirm the internal environment sensor information of the printer such as 
temperature and humidity. 
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16
Understanding the Printer Menus
When your printer is connected to a network and available to a number of users, the access to the Admin 
Settings can be limited. This prevents other users from using the operator panel to inadvertently change a user 
default that has been set by the administrator. 

However, you can use your printer driver to override user defaults and select settings for individual print jobs.

Report / List
Use the Report/List menu to print various types of reports and lists.

System Settings
Purpose:

To print a list of the current user default values, the installed options, the amount of installed print memory, and the 
status of printer supplies.

Panel Settings
Purpose:

To print a detailed list of all the settings of the printer menus.

PCL Fonts List
Purpose:

To print a sample of the available PCL fonts.

See also:

"Understanding Fonts"

PCL Macros List
Purpose:

To print the information on the downloaded PCL macro.

PS Fonts List
Purpose:

To print a sample of the available PS fonts.

See also:

"Understanding Fonts"

PDF Fonts List
Purpose:

To print a sample of the available PDF fonts.

Job History
Purpose:

To print a detailed list of the print, copy, fax, or scan jobs that have been processed. This list contains the last 20 jobs.
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Error History
Purpose:

To print a detailed list of paper jams and fatal errors.

Print Meter
Purpose:

To print the reports for the total number of pages printed.

Color Test Page
Purpose:

To print a page for testing colors.

Protocol Monitor
Purpose:

To print a detailed list of monitored protocols.

Speed Dial
Purpose:

To print the list of all members stored as speed dial numbers.

Address Book
Purpose:

To print the list of all addresses stored as Address Book information.

Server Address
Purpose:

To print the list of all members stored as Server Address information.

Fax Activity
Purpose:

To print the report of faxes you recently received or sent.

Fax Pending
Purpose:

To print the list of status of pending faxes. 

Stored Documents

 NOTE: Stored Documents feature is available only when RAM Disk under System Settings is enabled or when the 
optional hard disk is installed.

Purpose:

To print a list of all files stored for Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof Print in the 
RAM disk.
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Printing a Report/List Using the Operator Panel
1 Press the  (Information) button.

2 Select Report/List.

3 Select  until the desired report or list appears, and then select that report or list .

4 Select Print.

The selected report or list is printed.

Printing a Report/List Using the Tool Box
1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box."

The Tool Box opens.

2 Ensure that the Printer Setting Reports tab is open.

3 Select Reports from the list at the left side of the page.

The Reports page appears.

4 Click the button for the desired report or list.

The report or list is printed

Admin Settings
Use the Admin Settings menu to configure a variety of printer features.

Phone Book
Use the Phone Book menu to configure the speed dial and group dial settings.

Individuals

Purpose:

To store up to 200 frequently dialed numbers in speed dial locations.

Groups

Purpose:

To create a group of fax destinations and register it under a two-digit dial code. Up to six group dial codes can be 
registered.

PCL
Use the PCL menu to change printer settings that only affect jobs using the PCL emulation printer language.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Paper Tray

Purpose:

To specify the default paper tray.
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Values:

Paper Size

Purpose:

To specify the default paper size.

Values:

mm series

Auto*

MPF

Tray1

Tray2*1

*1 This item is available only when the optional 550-sheet 
feeder is installed.

A4 

(210x297mm)*1

A5

(148x210mm) 

B5

(182x257mm)

Letter

(8.5x11")

Folio

(8.5x13")

Legal

(8.5x14")

Executive

(7.3x10.5")

Envelope #10

(4.1x9.5")

Monarch Env.

(3.9x7.5")

DL Env.

(110x220mm)

C5 Env.

(162x229mm)

Custom Size
*1 Denotes country-specific factory default value.
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inch series

 NOTE: Selecting a custom size for the paper size prompts you to enter a custom length and width.

Orientation

Purpose:

To specify how text and graphics are oriented on the page.

Values:

2 Sided Print

Purpose:

To specify whether to print on both sides of a sheet of paper.

Letter

(8.5x11")*1

Folio

(8.5x13")

Legal

(8.5x14")

A4

(210x297mm)

A5

(148x210mm)

B5

(182x257mm)

Executive

(7.3x10.5")

Envelope #10

(4.1x9.5")

Monarch Env.

(3.9x7.5")

DL Env.

(110x220mm)

C5 Env.

(162x229mm)

Custom Size
*1 Denotes country-specific factory default value.

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.
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Values:

Font

Purpose:

To specify the default font from the fonts registered in the printer.

Values:

Symbol Set

Purpose:

To specify a symbol set for a specified font.

1 Sided* Does not print on both sides of a sheet of paper.

2 Sided Flip on Long Edge* Prints on both sides of a sheet of paper to be bound by long edge.

Flip on Short Edge Prints on both sides of a sheet of paper to be bound by short edge.

CG Times LetterGothic CourierPS

CG Times It LetterGothic It CourierPS Ob

CG Times Bd LetterGothic Bd CourierPS Bd

CG Times BdIt Albertus Md CourierPS BdOb

Univers Md Albertus XBd SymbolPS

Univers MdIt Clarendon Cd Palatino Roman

Univers Bd Coronet Palatino It

Univers BdIt Marigold Palatino Bd

Univers MdCd Arial Palatino BdIt

Univers MdCdIt Arial It ITCBookman Lt

Univers BdCd Arial Bd ITCBookman LtIt

Univers BdCdIt Arial BdIt ITCBookmanDm

AntiqueOlv Times New ITCBookmanDm It

AntiqueOlv It Times New It HelveticaNr

AntiqueOlv Bd Times New Bd HelveticaNr Ob

CG Omega Times New BdIt HelveticaNr Bd

CG Omega It Symbol HelveticaNrBdOb

CG Omega Bd Wingdings N C Schbk Roman

CG Omega BdIt Line Printer N C Schbk It

GaramondAntiqua Times Roman N C Schbk Bd

Garamond Krsv Times It N C Schbk BdIt

Garamond Hlb Times Bd ITC A G Go Bk

GaramondKrsvHlb Times BdIt ITC A G Go BkOb

Courier* Helvetica ITC A G Go Dm

Courier It Helvetica Ob ITC A G Go DmOb

Courier Bd Helvetica Bd ZapfC MdIt

Courier BdIt Helvetica BdOb ZapfDingbats
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Values:

Font Size

Purpose:

To specify the font size for scalable typographic fonts.

Values:

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

 NOTE: The Font Size menu is only displayed for typographic fonts.

See also:

"Pitch and Point Size"

Font Pitch

Purpose:

To specify the font pitch for scalable mono spaced fonts.

Values:

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For non-scalable mono spaced 
fonts, the pitch is displayed, but cannot be changed.

 NOTE: The Font Pitch menu is only displayed for fixed or mono spaced fonts.

See also:

"Pitch and Point Size"

DESKTOP ISO L5 PC-8 TK

DNGBTSMS ISO L6 PI FONT

ISO-11 LEGAL PS MATH

ISO-15 MATH-8 PS TEXT

ISO-17 MC TEXT ROMAN-8*

ISO-21 MS PUB SYMBOL

ISO-4 PC-1004 WIN 3.0

ISO-6 PC-775 WINBALT

ISO-60 PC-8 WINGDINGS

ISO-69 PC-850 WIN L1

ISO L1 PC-852 WIN L2

ISO L2 PC-8 DN WIN L5

12.00* Sets the values in increments of 0.25.

Available Range: 4.00 – 50.00

10.00* Sets the value in increments of 0.01.

Available Range: 6.00–24.00
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Form Line

Purpose:

To set the number of lines in a page.

Values:

mm series

inch series

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 
Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also:

"Orientation"

Quantity

Purpose:

To set the default print quantity. (Set the number of copies required for a specific job from the printer driver. Values 
selected from the printer driver always override values selected from the operator panel.)

Values:

Image Enhance

Purpose:

To specify whether to enable the Image Enhance feature, which makes the boundary line between black and white 
smoother to decrease jagged edges and enhance the visual appearance.

Values:

Hex Dump

Purpose:

To help isolate the source of a print job problem. With Hex Dump selected, all data sent to the printer is printed in 
hexadecimal and character representation. Control codes are not executed.

64 mm*1 Sets the value in increments of 1 mm.

Available Range: 5–128 mm
*1 Denotes country-specific factory default values. 

60 inches*1 Sets the value in increments of 1 inch.

Available Range: 5–128 inches
*1 Denotes country-specific factory default values. 

1* Sets the value in increments of 1.

Available Range: 1–999

Off Disables the Image Enhance feature.

On* Enables the Image Enhance feature.
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Values:

Draft Mode

Purpose:

To save toner by printing in the draft mode. The print quality is reduced when printing in the draft mode.

Values:

LineTermination

Purpose:

To add the line termination commands.

Values:

Default Color

Purpose:

To specify the color mode to Color or Black. This setting is used for a print job that does not specify a print mode.

Values:

Ignore Form Feed

Purpose:

To specify whether to ignore blank pages that only contain Form Feed control codes.

Values:

Disable* Disables the Hex Dump feature.

Enable Enables the Hex Dump feature.

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.

CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF

Black* Prints in the black and white mode.

Color Prints in the color mode.

Off* Disables the Ignore Form Feed feature.

On Enables the Ignore Form Feed feature.
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PostScript
Use the PostScript menu to change printer settings that only affect jobs using the PostScript emulation printer 
language.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

PS Error Report

Purpose:

To specify whether the printer outputs error contents for a PostScript error.

The change becomes effective after the printer is turned off and then on again.

Values:

 NOTE: Instructions from the PS driver override the settings specified on the operator panel.

PS Job Time-out

Purpose:

To specify the execution time for one PostScript job. The change becomes effective after the printer is turned off 
and then on again.

Values:

Paper Select Mode

Purpose:

To specify the way to select the tray for PostScript mode. The change becomes effective after the printer is turned off 
and then on again.

Values:

Default Color

Purpose:

To specify the color mode to Color or Black. This setting is used for a print job which does not specify a print mode.

Values:

PDF
Use the PDF menu to change printer settings that only affect the PDF jobs.

Off Discards the print job without printing an error message.

On* Prints an error message before it discards the job.

Off* Job time-out does not occur.

On 1 minute* A PostScript error occurs if processing is not completed after the 
specified time.Available Range: 1-900 minutes

Auto* The tray is selected as the same setting as in the PCL mode.

Select from Tray The tray is selected in a method compatible with regular Post Script printers.

Color* Prints in the color mode.

Black Prints in the black and white mode.
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 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Quantity

Purpose:

To specify the number of copies to print.

Values:

2 Sided Print

Purpose:

To specify whether to print on both sides of a sheet of paper.

Values:

Print Mode

Purpose:

To specify the print mode.

Values:

PDF Password

Purpose:

To specify the password to print a PDF file secured with a document open password (password to open the PDF file).

Values:

Collation

Purpose:

To specify whether to sort the job.

Values:

1* Sets the value in increments of 1.

Available Range: 1–999

1 Sided* Does not print on both sides of a sheet of paper.

2 Sided Flip on Long Edge* Prints on both sides of a sheet of paper to be bound by long edge.

Flip on Short Edge Prints on both sides of a sheet of paper to be bound by short edge.

Normal* For documents with normal sized characters. 

High Quality For documents with small characters or thin lines, or documents printed using a dot-matrix printer.

High Speed Prints with the higher speed than the Normal mode, but the quality is less. 

Enter PDF Password Enter the document open password to print the secure PDF.

Collated Sorts the job.

Uncollated* Does not sort the job. 
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Output Size

Purpose:

To specify the output paper size for PDF.

Values:

Layout

Purpose:

To specify the output layout.

Values:

Default Color

Purpose:

To specify the default output color.

Values:

Network
Use the Network menu to change the printer settings affecting jobs sent to the printer through the wired or 
wireless network.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Ethernet/Wireless

 NOTE: When using a wired network, Ethernet is displayed. When the optional wireless adapter is attached and the 
Ethernet cable is disconnected, Wireless is displayed. 

Purpose:

To confirm or specify network settings. 

Values:

Wireless Status

 NOTE: Wireless Status feature is available only when the printer is connected using the wireless network.

A4*1

Letter*1

Auto
*1 The default paper size is displayed.

Auto %*

100% (No Zoom)

Booklet

2 Pages Up

4 Pages Up

Color (Auto)*

Black
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Purpose:

To confirm the wireless communication status.

Values:

Wireless Setup Wizard

 NOTE: Wireless Setup Wizard is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless network interface.

Values:

Status Good

Acceptable

Low

No Reception

SSID Displays the name that identifies the wireless network.

Encryption Type Displays the encryption type.

Select Access Select the access point from the list.

WEP Key When you select an access point using WEP as the 
encryption type, enter the WEP key.

Pass Phrase When you select an access point using WPA, WPA2, or 
Mixed as the encryption type, enter the pass phrase.

Manual SSID Setup Enter SSID Specifies a name to identify the wireless network. Up to 32 
alphanumeric characters can be entered.

Infrastructure Select when you configure the wireless setting through the 
access point such as a wireless router.

No Security Specifies No Security to configure the wireless setting 
without specifying a encryption type from WEP, WPA-PSK-
TKIP, and WPA-PSK-AES.

Mixed mode PSK* Select to configure the wireless setting with the encryption 
type of Mixed mode PSK. Mixed mode PSK automatically 
selects the encryption type from either WPA-PSK-TKIP, 
WPA-PSK-AES, or WPA2-PSK-AES.

Pass Phrase Specifies the passphrase of 
alphanumeric characters from 8 to 63.

WPA-PSK-TKIP Select to configure the wireless setting with the encryption 
type of WPA-PSK-TKIP.

Pass Phrase Specifies the passphrase of 
alphanumeric characters from 8 to 63.

WPA2-PSK-AES Select to configure the wireless setting with the encryption 
type of WPA2-PSK-AES.

Pass Phrase Specifies the passphrase of 
alphanumeric characters from 8 to 63.

WEP Specifies the WEP key to use through the wireless network. 
For 64bit keys, up to 10 hexadecimal characters can be 
entered. For 128bit keys, up to 26 hexadecimal characters 
can be entered.
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WPS Setup

 NOTE: WPS Setup is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless network using WPS.

Values:

IP Mode

Purpose:

To configure the IP mode.

Values:

TCP/IP

Purpose:

To configure TCP/IP settings.

Values:

Transmit Key Specifies the transmit key from Auto*, 
WEP Key 1, WEP Key 2, WEP Key 3, 
and WEP Key 4.

Ad-hoc Select to configure the wireless setting without the access 
point such as a wireless router.

No Security* Select to configure the wireless setting without specifying 
the encryption type from WEP.

WEP Specifies the WEP key to use through the wireless network. 
For 64bit keys, up to 10 hexadecimal characters can be 
entered. For 128bit keys, up to 26 hexadecimal characters 
can be entered.

Transmit Key Specifies the transmit key from WEP 
Key 1*, WEP Key 2, WEP Key 3, and 
WEP Key 4.

Push Button Control* Start Configuration Configures the wireless setting with WPS-PBC.

PIN Code Start Configuration Configures the wireless setting using the PIN code assigned automatically by 
the printer.

Print PIN Code Prints the PIN code. Confirm it when entering PIN assigned to the printer 
into your computer.

Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Mode Uses IPv4 to set the IP address.

IPv6 Mode Uses IPv6 to set the IP address.

Get IP Address AutoIP* Sets the IP address automatically. A random value in the range of 169.254.1.0 
to 169.254.254.255 that is not currently in use on the network is set as the IP 
address. The subnet mask is set as 255.255.0.0.

BOOTP Sets the IP address using BOOTP.

RARP Sets the IP address using RARP.



Understanding the Printer Menus 245

IPsec

 NOTE: IPsec feature is available only when IPsec is enabled on the Dell Printer Configuration Web Tool.

Purpose:

Disables IPsec.

Reset Wireless

 NOTE: Reset Wireless feature is available only when the printer is connected using the wireless network.

Purpose:

To initialize wireless network settings. After executing this function and rebooting the printer, all wireless network 
settings are reset to their default values.

Connection Speed

 NOTE: Connection Speed feature is available only when the printer is connected using the wired network.

Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the 
printer is turned off and then on again.

Values:

Protocols

Purpose:

To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.

DHCP Sets the IP address using DHCP.

Panel Use this option when you want to set the IP address manually on the 
operator panel.

IP Address When an IP address is being set manually, the IP is allocated to the printer 
using the format nnn.nnn.nnn.nnn. Each octet that makes up 
nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the 
range of 224 to 254 cannot be specified for the first octet of a gateway 
address.

Subnet Mask When an IP address is being set manually, the subnet mask is specified using 
the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is 
a value in the range of 0 to 255.255.255.255.255 cannot be specified as the 
subnet mask.

Gateway Address When an IP address is being set manually, the gateway address is specified 
using the format nnn.nnn.nnn.nnn. Each octet that makes up 
nnn.nnn.nnn.nnn is a value in the range of 0 to 254. 127 and any value in the 
range of 224 to 254 cannot be specified for the first octet of a gateway 
address.

Auto* Detects the Ethernet settings automatically.

10BASE-T Half Uses 10BASE-T Half-duplex.

10BASE-T Full Uses 10BASE-T Full-duplex.

100BASE-TX Half Uses 100BASE-TX Half-duplex.

100BASE-TX Full Uses 100BASE-TX Full-duplex.

1000BASE-T Full Uses 1000BASE-T Full-duplex.
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Values:

Advanced Settings

Purpose:

To specify advanced network settings.

LPD Disable Disables the LPD port.

Enable* Enables the Line Printer Daemon (LPD) port.

Port9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

FTP Disable Disables FTP port.

Enable* Enables FTP port.

IPP Disable Disables IPP port.

Enable* Enables IPP port.

SMB TCP/IP Disable Disables SMB TCP/IP port.

Enable* Enables SMB TCP/IP port.

SMB NetBEUI Disable Disables SMB NetBEUI port.

Enable* Enables SMB NetBEUI port.

WSD Print Disable Disables WSD print.

Enable* Enables WSD print.

WSD Scan Disable Disables WSD scan.

Enable* Enables WSD scan.

Network TWAIN Disable Disables Network TWAIN.

Enable* Enables Network TWAIN.

SNMP UDP Disable Disables the SNMP UDP port.

Enable* Enables the Simple Network Management Protocol (SNMP) UDP port.

E-mail Alert Disable Disables the E-mail Alert feature.

Enable* Enables the E-mail Alert feature.

EWS Disable Disables an access to Dell Printer Configuration Web Tool embedded in the 
printer.

Enable* Enables an access to Dell Printer Configuration Web Tool embedded in the 
printer.

Bonjour(mDNS) Disable Disables Bonjour (mDNS).

Enable* Enables Bonjour (mDNS).

Telnet Disable Disables Telnet.

Enable* Enables Telnet.

Update Address Book Disable Disables Update Address Book.

Enable* Enables Update Address Book.

HTTP-SSL/TLS Disable* Disables HTTP-SSL/TLS.

Enable Enables HTTP-SSL/TLS.

Google Cloud Print Disable* Disables Google Cloud Print.

Enable Enables Google Cloud Print.
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IP Filter

 NOTE: IP Filter feature is available only for LPD or Port9100.

Purpose:

To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP 
addresses. The change becomes effective after the printer is turned off and then on again.

Values:

IEEE 802.1x

 NOTE: IEEE 802.1x feature is available only when the printer is connected using Ethernet cable and it is available only when the 
IEEE 802.1x authentication is enabled.

Purpose:

To disable IEEE 802.1x authentication. The change becomes effective after the printer is turned off and then on 
again.

Adobe Protocol

Purpose:

To specify PostScript communication protocol for a parallel interface, you can configure the Adobe Protocol 
settings for the wired network. The change becomes effective after the printer is turned off and then on again.

Values:

Reset LAN

Purpose:

To initialize wired network data stored in non-volatile memory (NVM). After executing this function and rebooting 
the printer, all wired network settings are reset to their default values.

Fax Settings
Use the Fax Settings menu to configure the basic fax settings. 

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Fax Line Settings

Purpose:

To configure basic settings for the fax line.

n (n is 1-5) IP Address Sets the IP address for Filter n.

Subnet Mask Sets the address mask for Filter n.

Mode Off* Disables the IP Filter feature for Filter n.

Accept Accepts an access from the specified IP address.

Reject Rejects an access from the specified IP address.

Auto* Used when auto-detecting the PostScript communication protocol.

Standard Used when the communication protocol is in ASCII interface.

BCP Used when the communication protocol is in binary format.

TBCP Used when the communication protocol supports both ASCII and binary data to switch 
between them according to the specified control code.

Binary Used when no special processing is required for data.
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Fax Number

Purpose:

To set the fax number of the printer, which will be printed on the header of a fax message.

 NOTE: Ensure to specify Fax Number before using Junk Fax Setup.

Country

Purpose:

To select the country where the printer is used.

Values:

Fax Header Name

Purpose:

To set the sender name to be printed on the header on faxes.

Line Type

Purpose:

To select the default line type.

Values:

Algeria Hungary Puerto Rico

Australia Iceland Romania

Austria Ireland Russia

Belgium Italy Saudi Arabia

Bulgaria Jamaica Slovakia

Canada Jordan Slovenia

Colombia Latvia South Africa

Costa Rica Liechtenstein Spain

Cyprus Lithuania Sweden

Czech Republic Luxembourg Switzerland

Denmark Malta Tunisia

Dominican Republic Mexico Turkey

Egypt Netherlands U.A.E.

Estonia New Zealand United Kingdom

Finland Nicaragua United States

France Norway Unknown*

Germany Panama

Greece Poland

Guatemala Portugal

PSTN* Uses PSTN.

PBX Uses PBX.
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Line Monitor

Purpose:

To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a 
connection is made.

Values:

DRPD Pattern

Purpose:

To provide a separate number for faxing with a distinctive ring pattern.

Values:

Off Turns off the volume of the line monitor.

Low Sets the volume of the line monitor to Low.

Medium* Sets the volume of the line monitor to Medium.

High Sets the volume of the line monitor to High.

Pattern1–7 DRPD is a service provided by some telephone companies. DRPD Patterns are specified by your 
telephone company. The patterns provided with your printer are shown below:

Ask your telephone company which pattern you need to select to use this service. For example, Pattern 
7 is the New Zealand FaxAbility distinctive ringing pattern: rings for 400 ms, stops for 800 ms, rings 
for 400 ms and stops for 1400 ms. This pattern is repeated over and over again. This printer only 
responds to Distinctive Alert cadence(s) DA4 in New Zealand.

Pattern 1

Pattern 2

Pattern 3

Pattern 4*

Pattern 5

Pattern 6

Pattern 7
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Incoming Defaults

Purpose:

To configure settings for incoming fax.

Receive Mode

Purpose:

To select the default fax receiving mode.

Values:

Ring Tone Volume

Purpose:

To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal 
speaker when Receive Mode is set to Telephone/Fax.

Values:

Auto Receive Setup

Purpose:

To configure settings for automatic fax reception.

Values:

Telephone Automatic fax reception is turned off. You can receive a fax by picking up the handset of the external 
telephone and then pressing the remote receive code, or by selecting Manual Receive in On 
Hook and then pressing the  (Start) button. For details about Manual Receive, see 
"Receiving a Fax Manually in the Telephone Mode."

Fax* Automatically receives faxes.

Telephone / Fax When the printer receives an incoming fax, the external telephone rings for the time specified in 
Auto Receive Tel/Fax, and then the printer automatically receives a fax. If an incoming call 
is not a fax, the printer beeps from the internal speaker indicating that the call is a telephone call.

Ans Machine/Fax The printer can share a telephone line with an answering machine. In this mode, the printer will 
monitor the fax signal and pick up the line if there are fax tones. If the phone communication in your 
country is serial, this mode is not supported. 

DRPD Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive ring service must be 
installed on your telephone line by the telephone company. After the telephone company has provided 
a separate number for faxing with a distinctive ring pattern, configure the fax setup to monitor for 
that specific ring pattern.

Off Turns off the volume of the ring tone.

Low Sets the volume of the ring tone to Low.

Medium Sets the volume of the ring tone to Medium.

High* Sets the volume of the ring tone to High.

Auto Receive Fax 0 seconds* Sets the interval at which the printer goes into the fax 
receive mode after receiving an incoming call. The value is 
set in increments of 1 second.

Available Range: 0-255 seconds
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Junk Fax Setup

Purpose:

To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Phone Book.

Values:

Secure Receive

 NOTE: Secure Receive feature is available only when Panel Lock Control is set to Enable.

Purpose:

To specify whether to require a password to receive faxes, and to set or change the password.

Values:

Sent Fax Forward

 NOTE: Print and E-mail feature is available only when E-mail Alert information and Forwarding E-mail 
Address are registered. For information on e-mail alert, see "E-Mail Alert" and on forwarding e-mail address information, see 
"Fax Settings."

Purpose:

To set whether to forward incoming faxes to a specified destination.

Values:

Auto Receive Tel/Fax 6 seconds* Sets the interval at which the printer goes into the fax 
receive mode after the external telephone receives an 
incoming call. The value is set in increments of 1 second.

Available Range: 0-255 seconds

Auto Receive Ans/Fax 21 seconds* Sets the interval at which the printer goes into the fax 
receive mode after the external answering machine receives 
an incoming call. The value is set in increments of 1 
second.

Available Range: 0-255 seconds

Off* Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers.

Secure Receive Set Disable* Does not require a password to receive faxes.

Enable Requires a password to receive faxes.

Change Password*1 0000–9999 Sets or changes the password required to receive faxes.
*1 This item is available only when Secure Receive Set is set to Enable.

Off* Does not forward incoming faxes.

Forward Forwards incoming faxes to a specified destination. Prints incoming faxes if 
an error occurs during the transfer.

Print and Forward Prints incoming faxes and also forwards them to a specified destination.

Forwarding Number Specifies the fax number of the destination to which incoming faxes will be 
forwarded.

Print and E-mail*1, 2 Prints incoming faxes and also forward them to a specified e-mail address.
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2 Sided Print

To set the duplex printing for fax. 

Values:

Remote Receive

Purpose:

To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the 
telephone.

Values:

Discard Size 

Purpose:

To set the printer to discard images or any text at the bottom of a fax page when the entire page does not fit the 
output paper.

Values:

Transmission Defaults

Purpose:

To configure settings for transmitting fax.

Auto Redial Setup

Purpose:

To configure settings for automatic redial.

Values:

*1 This item is available only when the E-mail Alert information is registered.
*2 This item is available only when Forwarding E-mail Address is registered.

Off* Does not perform duplex printing.

On Performs duplex printing.

Off* Does not receive a fax by pressing a remote receive code on the external 
telephone.

On Receives a fax by pressing a remote receive code on the external telephone.

Remote Receive Tone Specifies the tone in two digits to start Remote Receive.

Off* Prints excess images or text at the bottom of a fax page without discarding it.

On Discards any excess images or text.

Auto Reduction Automatically reduces a fax page to fit it onto the appropriate paper size.

Redial Attempts 3* Sets the number of redial attempts to make when the 
destination fax number is busy. If you enter 0, the printer 
will not redial. The value is set in increments of 1.

Available Range: 0-13
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Tone / Pulse

Purpose:

To select the dialing type.

Values:

Prefix Dial

Purpose:

To select whether to set a prefix dial number.

Values:

Fax Cover Page

Purpose:

To set whether to attach a cover page to faxes.

Values:

Fax Header

Purpose:

To print the information of the sender on the header of the faxes.

Values:

 NOTE: If United States is selected for the setting of Country, this option does not appear on the menu. The setting is 
fixed to On and cannot be changed. For information on the country setting, see "Setting Your Country." 

Interval of Redial 1 minute* Sets the interval between redial attempts. The value is set 
in increments of 1 minute.

Available Range: 1-15 minutes

Resend Delay 8 seconds* Sets the interval between re-send attempts. The value is set 
in increments of 1 second.

Available Range: 3-255 seconds

Tone* Uses tone dialing.

Pulse(10PPS) Sets "DP (10PPS)" (Dial Pulse, 10 Pulse Per Second) as the dial type. 

Pulse(20PPS) Sets "DP (20PPS)" (Dial Pulse, 20 Pulse Per Second) as the dial type. 

Off* Does not set a prefix dial number.

On Sets a prefix dial number.

Prefix Dial Number Sets a prefix dial number of up to five digits. This number dials before any 
auto dial number is started. It is useful for accessing the Private Automatic 
Branch Exchange (PABX).

Off* Does not attach a cover page to faxes.

On Attaches a cover page to faxes.

Off Does not print the sender's information on the header of faxes.

On* Prints the sender's information on the header of faxes.
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ECM

Purpose:

To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote machines must 
also support the ECM.

Values:

Modem Speed

Purpose:

To adjust the fax modem speed when a fax transmission or reception error occurs. 

Values:

Display Manual Fax Recipients

Purpose:

To set whether to display the fax number of the recipient on the Sending Fax screen when manually sending a fax. 

Values:

Fax Reports

Purpose:

To configure settings for fax reports.

Fax Activity

Purpose:

To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

Values:

Fax Transmit

Purpose:

To set whether to print a transmission result after a fax transmission.

Off Disables the ECM.

On* Enables the ECM.

2.4 Kbps

4.8 Kbps

9.6 Kbps

14.4 Kbps

33.6 Kbps*

Off Does not display the fax number when manually sending a fax.

On* Displays the fax number when manually sending a fax.

Auto Print* Automatically prints a fax activity report after every 50 incoming and outgoing fax communications.

No Auto Print Does not automatically print a fax activity report after every 50 incoming and outgoing fax 
communications.
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Values:

Fax Broadcast

Purpose:

To set whether to print a transmission result after a fax transmission to multiple destinations.

Values:

Fax Protocol

Purpose:

To set whether to print the protocol monitor report, which helps you identify the cause of a communication problem.

Values:

System Settings
Use System Settings to configure the power saving mode, warning tones, time-out duration, display language, 
and job log auto print settings. 

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

General

Purpose:

To configure general settings for the printer.

Power Saver Timer

Purpose:

To specify the time for transition to power saver mode.

Values:

Print Always Prints a transmission report after every fax transmission.

Print On Error* Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always* Prints a transmission report after every fax transmission.

Print On Error Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission to multiple destinations.

Print Always Prints a protocol monitor report after every fax transmission.

Print On Error Prints the protocol monitor report only when an error occurs.

Print Disable* Does not print the protocol monitor report.

Sleep 3 minutes* Specifies the time taken by the printer to enter Sleep mode after it 
finishes a job.Available Range: 1–60 minutes

Deep Sleep 5 minutes* Specifies the time taken by the printer to enter Deep Sleep mode after it 
has entered Sleep mode.Available Range: 1–60 minutes
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When you specify 1 minute for Sleep,  the printer enters power saver mode 1 minute after it finishes a job. This 
uses much less energy, but requires more warm-up time for the printer. Specify 1 minute if your printer shares an 
electrical circuit with room lighting and you notice lights flickering.

Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate 
with minimum warm-up time. 

Select a value between 1 and 60 minutes for power saver mode if you want a balance between energy consumption 
and a shorter warm-up period.

The printer automatically returns to the standby mode from the power saver mode when it receives data from the 
computer or remote fax machine. You can also change the status of the printer to the standby mode by pressing any 
button on the operator panel.

Date & Time

Purpose:

To specify the date and time formats.

Values:

mm / inch

Purpose:

To specify the default measurement unit displayed after the numeric value on the operator panel.

Values:

 NOTE: The default for mm/inch varies depending on other settings, such as Country and Document Size.

Display Brightness

Purpose:

To adjust the screen brightness of the touch panel.

Values:

Audio Tone

Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message appears. 

Time Zone Sets the time zone.

Date Sets the date depending on the Format settings.

Format Sets the date format.

Time Sets the time.

Format 12 Hour Sets the time in 12-hour format.

24 Hour Sets the time in 24-hour format.

Millimeters(mm)* Selects millimeter as the default measurement unit.

Inches(") Selects inch as the default measurement unit.

5* Sets the brightness in ten levels, with ten being the brightest.

Available Range: 1-10
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Values:

Control Panel Off* Does not emit a tone when the operator panel input is correct.

Soft Emits a tone when the operator panel input is correct.

Normal 

Loud

Invalid Key Off* Does not emit a tone when the operator panel input is incorrect.

Soft Emits a tone when the operator panel input is incorrect.

Normal 

Loud

Machine Ready Off Does not emit a tone when the printer is ready to process a job.

Soft Emits a tone when the printer is ready to process a job.

Normal*

Loud

Copy Completed Off Does not emit a tone when a copy job is complete.

Soft Emits a tone when a copy job is complete.

Normal*

Loud

Job Completed Off Does not emit a tone when a job other than a copy job is complete.

Soft Emits a tone when a job other than a copy job is complete.

Normal*

Loud

Fault Tone Off Does not emit a tone when a job ends abnormally.

Soft Emits a tone when a job ends abnormally.

Normal*

Loud

Alert Tone Off Does not emit a tone when a problem occurs.

Soft Emits a tone when a problem occurs.

Normal*

Loud

Out of Paper Off Does not emit a tone when the printer runs out of paper.

Soft Emits a tone when the printer runs out of paper.

Normal*

Loud

Low Toner Alert Off Does not emit a tone when a toner is low.

Soft Emits a tone when a toner is low.

Normal*

Loud

Auto Clear Alert Off* Does not emit a tone 5 seconds before the printer performs auto clear.

Soft Emits a tone 5 seconds before the printer performs auto clear.

Normal 

Loud
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Low Toner Alert Message

Purpose:

To specify whether to show the alert message when the toner is low.

Values:

OffHook Wake Up

Purpose:

To specify whether to wake up from Sleep or Deep Sleep mode when you pick up the handset of the external 
telephone. 

Values:

Auto Log Print

Purpose:

To automatically print a job history report after every 20 jobs.

Values:

Print logs can also be printed using the Report / List menu.

RAM Disk

 NOTE: RAM Disk feature is not available when the optional hard disk is installed.

Purpose:

To allocate memory to the RAM disk file system for the Secure Print, Private Mail Box Print, Public Mail Box Print, 
and Proof Print features. The change becomes effective after the printer is turned off and then on again.

Values:

All Tones Off Disables all the alert tones.

Soft Sets the volume of all the alert tones at once.

Normal*

Loud

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.

OffHook Wake Up Off* Does not wake up from Sleep or Deep Sleep mode when you pick up the handset of 
the external telephone. 

On Wakes up from Sleep or Deep Sleep mode when you pick up the handset of the 
external telephone. 

Off* Does not automatically print a job history report.

On Automatically prints a job history report.

Off Does not allocate memory to the RAM disk file system. Secure Print, Private Mail 
Box Print, Public Mail Box Print, and Proof Print jobs will abort and be recorded to 
the job log.
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 NOTE: Restart your printer when you change the settings for the RAM Disk menu.

Fax Server Address Book

Purpose:

To specify whether to search the phone numbers from the Address Book for the LDAP server.

Values:

 NOTE: You can search the phone numbers only from the local Address Book when Fax Server Address Book is set 
to Off.

Email Server Address Book

Purpose:

To specify whether to search the e-mail addresses from the Address Book for the LDAP server. 

Values:

 NOTE: You can search the e-mail addresses only from the Address Book that is local when Email Server Address 
Book is set to Off.

Power On Wizard

Purpose:

To perform initial setup for the printer.

Timers

Purpose:

To configure timer settings.

Auto Reset

Purpose:

To automatically reset the settings for Copy, Scan, Fax, E-mail, or Print to the default settings and return to the 
standby mode after you do not specify any settings for the specified time.

Values:

On* 50 MB* (300 MB*1) Sets the allocation of memory to the RAM disk file system in increments of 50 MB.

Available Range:
50-100 MB (50-600 MB*1)

*1 When the optional 512 MB memory module is installed.

Off* Does not search the phone numbers from the Address Book for the LDAP server.

On Searches the phone numbers from the Address Book for the LDAP server.

Off* Does not search the e-mail addresses from the Address Book for the LDAP server.

On Searches the e-mail addresses from the Address Book for the LDAP server. 

45sec*

1min

2min
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Fault Time-out

Purpose:
To specify the amount of time the printer waits before canceling a job that stops abnormally. The print job is cancelled if the 
time-out time is exceeded. 

Values:

Job Time-out

Purpose:
To specify the amount of time the printer waits for data to arrive from the computer. The print job is cancelled if the time-out 
time is exceeded.

Values:

Output Settings

Purpose:

To configure settings concerning output from the printer.

Default Paper Size 

Purpose:

To specify the default paper size.

Values:

mm series

inch series

Print ID

Purpose:

3min

4min

Off Disables the fault time-out.

On* 60 seconds* Sets the amount of time the printer waits before canceling a job that stops 
abnormally.Available Range: 3-300 seconds

Off Disables the job time-out.

On* 30 seconds* Sets the time the printer waits for data to arrive from the computer.

Available Range: 5–300 seconds

A4 (210x297mm)*1

Letter(8.5x11")
*1 Denotes country-specific factory default values.

A4 (210x297mm)

Letter(8.5x11")*1

*1 Denotes country-specific factory default values.
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To specify a location where the user ID is printed. 

Values:

 NOTE: When printing on DL size paper, a part of the user ID may not be printed correctly.

Print Text

Purpose:

To specify whether the printer outputs PDL data, which is not supported by the printer, as text when the printer 
receives it. Text data is printed on A4 or Letter size paper.

Values:

Banner Sheet

Purpose:

To specify the position of banner sheet, and also specify the tray in which the banner sheet is loaded. 

Values:

Substitute Tray

Purpose:

Specifies whether to use paper of a different size when the paper that is loaded in the specified tray does not match 
the paper size settings for the current job.

Values:

Off* Does not print the user ID.

Top Left Prints the user ID on the top left of the page.

Top Right Prints the user ID on the top right of the page.

Bottom Left Prints the user ID on the bottom left of the page.

Bottom Right Prints the user ID on the bottom right of the page.

Off Does not print the received data.

On* Prints the received data as text data.

Insert Position Off* Does not print the banner sheet.

Front Inserted before the first page of every copy.

Back Inserted after the last page of every copy.

Front & Back Inserted before the first page of every copy and after the last page of every 
copy.

Specify Tray MPF The banner sheet is loaded in the MPF.

Tray1* The banner sheet is loaded in tray1.

Tray2*1 The banner sheet is loaded in the optional 550-sheet feeder.
*1 This item is available only when the optional 550-sheet feeder is installed.

Off No tray size substitute accepted.

Larger Size Substitutes paper of next largest size. When there is no larger paper size, the printer substitutes paper of 
nearest size.

Nearest Size* Substitutes paper of nearest size.
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Letterhead 2 Sided

Purpose:

To specify whether to print on both sides when using letterhead.

Values:

A4<>Letter Switch

Purpose:

To print A4 size jobs on Letter size paper if A4 size paper is not available or to print Letter size jobs on A4 size paper 
if Letter size paper is not available.

Values:

Report 2 Sided Print

Purpose:

To specify to print reports on both sides a sheet of paper.

Values:

Use Another Tray

Purpose:

To change to another paper tray when a paper size runs out in the specified paper tray.

 NOTE: If you select another paper tray with paper size smaller than the paper size specified in the job, the parts that do not fit 
are not printed (print size is not adjusted automatically).

Values:

Set Available Time

Purpose:

Sets the available time for the Copy, Scan, Fax, and Print functions.

Use MPF Substitutes paper from the MPF.

Disable* Does not print on both sides of letterhead.

Enable Prints on both sides of letterhead.

Off*1 Does not print A4 size jobs on Letter size paper or Letter size jobs on A4 paper.

On* Prints A4 size jobs on Letter size paper if A4 is not available in the paper trays and vice versa (Letter 
size job on A4 size paper).

*1 Depending on the printer setting, the printer will continue to print on existing media of a different size or prompt the user to select from 
the following: 
• Delete Job
• Supply with correct media

1 Sided* Prints reports on one side of a sheet of paper.

2 Sided Prints reports on both side of a sheet of paper.

Off Does not print on other paper sizes in other paper trays if the paper size specified in the job runs out.

On* Shows a message to select another tray when the specified paper runs out in the paper tray.
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Values:

 NOTE: Set Available Time can be configured when Print, Copy, Scan, or Fax is set to On.

Secure Job Expiration

 NOTE: Secure Job Expiration feature is available only when RAM Disk is set to On.

Purpose:

To specify the date and time to delete the files stored as Secure Print in the RAM disk.

Values:

ColorTrack Mode

Purpose:

To specify who has access to color printing.

Values:

Copy, Scan, Fax, Print Set Available Time Off* Does not set the time when function is available.

On Sets the time when function is available.

Start Time Sets the start time of the available time.

End Time Sets the end time of the available time.

Recurrence Sets the day of the week to repeat the setting.

Expiration Mode Off* Does not set the date and time to delete the files stored as Secure 
Print in the RAM disk.

On Sets the date and time to delete the files stored as Secure Print in 
the RAM disk.

Expiration Time Sets the time to delete the files stored as Secure Print in the RAM 
disk.

Recurrence Daily Sets the recurrence to delete the files stored as Secure Print in the 
RAM disk daily.

Weekly* Sets the recurrence to delete the files stored as Secure Print in the 
RAM disk weekly.

Monthly Sets the recurrence to delete the files stored as Secure Print 
monthly.

Weekly Setting Monday Sets the day of the week to delete the files stored as Secure Print.

Tuesday

Wednesday

Thursday

Friday

Saturday

Sunday*

Monthly Setting 1 day* Sets the day of the month to delete the files stored as Secure Print 
in the RAM disk.Available Range: 1-28 days

Off* Does not limit access to color printing.
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Non Registered User

Purpose:
To specify whether to permit the printing of data without authentication information. 

Values:

Auto Color To Mono Print

 NOTE: Auto Color To Mono Print feature is available when Dell ColorTrack is disabled.

Purpose:

To specify whether to print all print jobs in black and white even when color print is specified.

Values:

ColorTrack Error Report

Purpose:
To specify whether to automatically print error-related information if printing with ColorTrack results in an error.

Values:

Maintenance
Use the Maintenance menu to initialize the NV (non-volatile) memory, configure the plain paper quality 
adjustment settings, and configure the security settings.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Paper Density

Purpose:

To specify paper density settings.

Values:

Internal Mode Limits access to color printing. Authentication is done using user information registered on the 
printer .

External Mode Limits access to color printing. Authentication is done using an external authentication server .

Off* Does not permit non-account user to print the data.

On*1 Permits non-account user to print the data.
*1 Set Non Account User Password using the Dell Printer Configuration Web Tool.

Off* Prints according to the specified color mode.

On Prints all print jobs in black and white even when color print is specified.

Off* Does not print the error report when printing with ColorTrack results in an error.

On Prints the error report when printing with ColorTrack results in an error.

Plain Light

Normal*

Label Light

Normal*
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Adjust Transfer Belt Unit

Purpose:

To adjust the transfer bias when ghosting occur. (The ghost image may be the image of the previous page, or a part of 
the page currently printing)

Values:

Adjust 2nd BTR

 NOTE: The print quality changes depending on the setting values you select for this item.

Purpose:

To specify the transfer roller voltage adjustment for each paper type.

Values:

Adjust Fusing Unit

 NOTE: The print quality changes depending on the setting values you select for this item.

Purpose:

To adjust the temperature setting of the fusing unit for each paper type.

K Offset 0* If faint black colored ghosts appear, try to decrease the value.

Available Range:  -5 to  +5

YMC Offset 0* If faint ghosts in color (yellow, magenta, or cyan) appear, try to decrease 
the value.Available Range:  -5 to  +5

Plain 0* Sets the transfer roller voltage in increments of 1. The default settings 
may not give the best output on all paper types. If you see mottles on 
the print output, try to increase the voltage. If you see white spots on 
the print output, try to decrease the voltage.

Available Range:  -5 to +10

Plain Thick 0*

Available Range:  -5 to +10

Covers
(106-163g/m2)

0*

Available Range:  -5 to +10

Covers Thick
(164-216g/m2)

0*

Available Range:  -5 to +10

Coated
(106-163g/m2)

0*

Available Range:  -5 to +10

Coated Thick
(164-216g/m2)

0*

Available Range:  -5 to +10

Label 0*

Available Range:  -5 to +10

Envelope 0*

Available Range:  -5 to +10

Recycled 0*

Available Range:  -5 to +10
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Values:

Auto Reg Adjust

Purpose: 

To specify whether to automatically perform color registration adjustment.

Values:

Color Reg Adjust

Purpose:

To manually perform color registration adjustment.

Manual Color Registration Adjustments are required when the printer is initially installed and after the printer is 
moved. 

 NOTE: The Color Reg Adjust feature can be configured when Auto Reg Adjust is set to Off.

Values:

Plain 0* Sets the fusing unit temperature in increments of 1. The default 
settings may not give the best output on all paper types. When the 
printed paper has curled, try to lower the temperature. When the toner 
does not fuse on the paper properly, try to increase the temperature.

Available Range:  -3 to  +3

Plain Thick 0*

Available Range:  -3 to  +3

Covers
(106-163g/m2)

0*

Available Range:  -3 to  +3

Covers Thick
(164-216g/m2)

0*

Available Range:  -3 to  +3

Coated
(106-163g/m2)

0*

Available Range:  -3 to  +3

Coated Thick
(164-216g/m2)

0*

Available Range:  -3 to  +3

Label 0*

Available Range:  -3 to  +3

Envelope 0*

Available Range:  -3 to  +3

Recycled 0*

Available Range:  -3 to  +3

Off Does not automatically perform color registration adjustment.

On* Automatically performs color registration adjustment.

Auto Correct Start Automatically performs color registration correction. 
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 NOTE: Ensure that you remove the paper from the single sheet feeder before performing Auto Correct.

Reset Defaults

Purpose:

To initialize the non-volatile (NV) memory. After executing this function and rebooting the printer, all the menu 
parameters are reset to their default values.

Values:

Initialize Print Meter

Purpose:

To initialize the print meter of the printer. When the print meter is initialized, the meter count is reset to zero.

Reset Fusing Unit

Purpose:

To initialize the life counter of the fusing unit. After replacing the fusing unit, be sure to initialize its life counter.

Reset Transfer Belt Unit

Purpose:

To initialize the life counter of the transfer belt unit. After replacing the transfer belt unit, be sure to initialize its life 
counter.

Clear Storage

 NOTE: Clear Storage feature is available only when RAM Disk is set to On or when the optional hard disk is installed.

Color Regi Chart Print Prints a color registration chart. The color registration chart 
prints a lattice pattern of yellow, magenta, and cyan lines. 
On the chart, find the values on the right side that are next 
to the line that is perfectly straight for each of the three 
colors. If the value for this line is 0, color registration 
adjustment is not required. If the value for this line is any 
value other than 0, specify the adjustment values under 
under lateral adjustment and process adjustment in 
Enter Number.

Enter Number LY Available Range: 
-9 to +9

Sets lateral (perpendicular to paper feed direction) and 
process (paper feed direction) color adjustment values 
individually for Yellow, Magenta, and Cyan. Enter a number 
in order of lateral adjustment (left), lateral adjustment 
(right), and process adjustment. Select OK to save all the 
settings.

LM

LC

RY Available Range: 
-9 to +9RM

RC

PY Available Range: 
-9 to +9PM

PC

User Fax Section Initialize Initializes the fax number entries in the Address Book.

User Scan Section Initialize Initializes the e-mail and server address entries in the Address Book.

System Section Initialize Initializes the system parameters.
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Purpose:

To clear all files stored as Secure Print, Private Mail Box Print, Public Mail box Print, Proof Print, and Stored Print in 
the RAM Disk or the optional hard disk.

Values:

Format Hard Disk

 NOTE: Format Hard Disk feature is available only when the optional hard disk is installed.

Purpose:

To initialize the optional hard disk.

Non-Dell Toner

Purpose:

To use toner cartridge of another manufacturer.

 CAUTION: Using a non-Dell™ toner cartridge may severely damage your printer. The warranty does not cover damages 
caused by using non-Dell toner cartridges.

Values:

Adjust Altitude

Purpose:

To specify the altitude of the location where the printer is installed. 

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used. 

 NOTE: An incorrect altitude adjustment setting leads to poor printing quality, incorrect indication of remaining toner, etc. 

Values:

Clear Job History

Purpose:

To clear the job history of all finished jobs.

Calibrate Touchscreen

Purpose:

All Deletes all files stored as Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof 
Print in the RAM Disk or the optional hard disk.

Secure Document Deletes all files stored as Secure Print in the RAM Disk or the optional hard disk.

Stored Document Deletes all files stored as Stored Print in the RAM Disk or the optional hard disk.

Off* Does not use toner cartridge of another manufacturer.
On Uses toner cartridge of another manufacturer.

0m* Sets the altitude of the location where the printer is installed.

1000m

2000m

3000m
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To calibrate the touch panel.

Fax Line Test

 NOTE: Fax Line Test feature is not available when the Fax function is disabled.

Purpose:

To test if the voltage supply from the fax line is sufficient.

Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

See also:

"Panel Lock"

Panel Lock

Purpose:

To set a limited access to Admin Settings with a password, and to set or change the password. 

Values:

Function Enabled

 NOTE: Function Enabled feature is available only when Panel Lock Control is set to Enable.

Purpose:

To specify whether to enable or disable each of the printer functions, or to require a password to use the functions.

Values:

Panel Lock Control Disable* Disables password protection for Admin Settings.

Enable Enables password protection for Admin Settings.

Change Password*1 0000–9999 Sets or changes the password required to access Admin Settings.
*1 This item is available only when Panel Lock Control is set to Enable.

Copy On* Enables the Copy function.

On (Password) Enables the Copy function, but requires a password to 
use the function.

On (Color 
Password)

Enables the Copy function with a color mode, but 
requires a password.

Off Disables the Copy function.

E-mail On* Enables the E-mail function.

On (Password) Enables the E-mail function, but requires a password.

Off Disables the E-mail function.

Fax On* Enables the Fax function.

On (Password) Enables the Fax function but requires a password to 
send faxes (does not require a password to receive 
incoming faxes).
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Edit E-mail From Fields

Purpose:

Off Disables the Fax function (the printer will not send or 
receive faxes).

Fax Driver Enable* Enables the Fax Driver function.

Disable Disables the Fax Driver function (the printer will not 
send faxes).

Scan To Network On* Enables the Scan To Network function.

On (Password) Enables the Scan To Network function, but requires a 
password.

Off Disables the Scan To Network function.

Scan To Application On* Enables the Scan To Application and WSD Scan 
function.

On (Password) Enables the Scan To Application function, but 
requires a password. WSD Scan is disabled since On 
(Password) is not supported by WSD Scan.

Off Disables the Scan To Application and WSD Scan 
function.

PC Scan On* Enables the PC Scan function.

On (Password) Enables the PC Scan function, but requires a 
password.

Off Disables the PC Scan function.

Scan To USB On* Enables the Scan To USB function.

On (Password) Enables the Scan To USB function, but requires a 
password.

Off Disables the Scan To USB function.

USB Direct Print On* Enables the USB Direct Print function.

On (Password) Enables the USB Direct Print function, but requires a 
password.

On (Color 
Password)

Enables the USB Direct Print function with a color 
mode, but requires a password.

Off Disables the USB Direct Print function.

ID Card Copy Enable* Enables the ID Card Copy function.

Disable Disables the ID Card Copy function.

USB Services Show When 
Inserted

Enable* Shows a USB Drive Detected screen when a USB 
memory is inserted in to the printer. 

Disable Does not show a USB Drive Detected screen when a 
USB memory is inserted in to the printer. 

Hide Until 
Inserted

Enable* Hides menus concerning USB memory until a USB 
memory is inserted to the printer.

Disable Menus concerning USB memory are shown without a 
USB memory inserted to the printer.

Change Password*1 Changes the password that is set under the 
Function Enabled menu. 

*1 This item is available only when On (Password) or On (Color Password) is enabled.
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To specify whether to enable editing of the transmission source when you use Scan to E-mail.

Values:

Reconfirm Recipient

Purpose:

To specify whether to reconfirm the recipient before sending a fax or scan.

 NOTE: If Reconfirm Recipient menu is set to Reconfirm Recipient, recipients can only be selected from 
the phone book or the address book. You cannot directly enter an address or fax number.

Values:

Domain Filtering

Purpose:

To specify whether to only send e-mails to specified domains.

 NOTE: Set the domains from SMTP Domain Filtering on the Dell Printer Configuration Web Tool.

Values:

Software Download

Purpose:

To enable or disable download of firmware updates.

Values:

Display of Network Information

Purpose:

To show or hide network information in the message field of the Main Home screen.

Values:

Disable Disables editing of the transmission source.

Enable* Enables editing of the transmission source.

No Confirmation* Does not display a screen to reconfirm the recipient before the job is actually sent.
Reconfirm Recipient Displays a screen to reconfirm the recipient before the job is actually sent.

Off* Disables Domain Filtering. 
Allow Domains Only allows e-mails to be sent to specified domains. 

Disable Disables firmware updates.
Enable* Enables firmware updates.

Show IPv4 Address* Shows the IPv4 address of the printer on the Main Home screen.
Show Host Name Shows the host name of the printer on the Main Home screen.
Hide Network Information Does not show network information on the Main Home screen.
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Data Encryption

 NOTE: Data Encryption feature is available only when the optional hard disk is installed.

Purpose:

To disable or enable data encryption when using the printer.

Values:

Hard Disk Over Write

 NOTE: Hard Disk Over Write feature is available only when the optional hard disk is installed.

 NOTE: Overwrite of the hard disk may take several hours. When overwriting the hard disk, all functions of the printer are 
inoperable.

Purpose:

To erase the contents of the entire hard disk by overwriting the hard disk with meaningless data.

Values:

Login Error

 NOTE: Login Error feature is available only when Panel Lock Control is set to Enable.

Purpose:

To specify the number of error entry attempts allowed when you log in as an administrator in the Admin 
Settings and Report/List menu.

Values:

USB Settings
Use the USB Settings menu to change printer settings affecting a USB port.

USB Port

 NOTE: USB Port feature is available only for the USB port on the rear of the printer.

Purpose:

To specify whether to enable the USB port. The change becomes effective after the printer is turned off and then on 
again.

Encryption Off* Disables encryption of the data.

On Enables encryption of the data.

Encryption Key Sets a key that is required for encryption.

Off* Disables overwrite of the hard disk.
Single Pass Overwrites the hard disk once.
3 Pass Overwrites the hard disk three times.

Off* Does not allow an administrator to log in after one error entry attempt.

On 5* Sets the number of error entry attempts allowed when an administrator logs in.

Available Range: 1-10
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Values:

Adobe Protocol

Purpose:

To specify PostScript communication protocol for a parallel interface. You can configure the Adobe Protocol settings 
for the wired network. The change becomes effective after the printer is turned off and then on again.

Values:

Default Settings
Use Default Settings to modify the Copy, Scan Menu, or Fax menu defaults. 

Copy Defaults
Purpose:

To modify the Copy menu defaults.

Copy Defaults allows you to configure the following items in addition to the items under the Copy menu.

Auto Exposure Level

Purpose:

To specify the default background suppression level.

Values:

Color Balance

Purpose:

To specify the default color balance level within the range of -3 to +3.

Values:

Disable Disables the USB interface.

Enable* Enables the USB interface.

Auto Used when auto-detecting the PostScript communication protocol.

Standard Used when the communication protocol is in ASCII interface.

BCP Used when the communication protocol is in binary format.

TBCP* Used when the communication protocol supports both ASCII and binary data to switch 
between them according to the specified control code.

Binary Used when no special processing is required for data.

Normal* Sets the background suppression level to Normal.
High Sets the background suppression level to High.

Highest Sets the background suppression level to Highest.

Yellow Low Density 0* Sets the color balance level of low density yellow.

Available Range: -3 to +3

Med. Density 0* Sets the color balance level of medium density yellow.

Available Range: -3 to +3
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Scan Defaults
Purpose:

To modify the Scan Menu and E-mail menu defaults.

Scan Defaults allows you to configure the following items in addition to the items under the Scan Menu and 
E-mail menus.

Auto Exposure Level

Purpose:

To specify the default background suppression level.

Values:

TIFF File Format

Purpose:

To specify the default TIFF file format.

Values:

High Density 0* Sets the color balance level of high density yellow.

Available Range: -3 to +3

Magenta Low Density 0* Sets the color balance level of low density magenta.

Available Range: -3 to +3

Med. Density 0* Sets the color balance level of medium density magenta.

Available Range: -3 to +3

High Density 0* Sets the color balance level of high density magenta.

Available Range: -3 to +3

Cyan Low Density 0* Sets the color balance level of low density cyan.

Available Range: -3 to +3

Med. Density 0* Sets the color balance level of medium density cyan.

Available Range: -3 to +3

High Density 0* Sets the color balance level of high density cyan.

Available Range: -3 to +3

Black Low Density 0* Sets the color balance level of low density black.

Available Range: -3 to +3

Med. Density 0* Sets the color balance level of medium density black.

Available Range: -3 to +3

High Density 0* Sets the color balance level of high density black.

Available Range: -3 to +3

Normal* Sets the background suppression level to Normal.
High Sets the background suppression level to High.

Highest Sets the background suppression level to Highest.

TIFF V6* Sets the default TIFF file format to TIFF V6.

TTN2 Sets the default Tiff file format to TTN2.
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Image Compression

Purpose:

To specify the image compression level.

Values:

Max E-mail Size

Purpose:

To specify the maximum size of e-mail that can be sent. 

Values:

Fax Defaults
Purpose:

To modify the Fax menu defaults. See "Fax Menu" for more details.

USB Direct Print Defaults
Purpose:

To modify the defaults for the USB Direct Print Defaults menu. See "USB Direct Print Menu" for more 
details.

Tray Management
Use the Tray Settings menu to define the print media loaded in tray1 and the optional 550-sheet feeder.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Tray Settings
To configure tray settings.

MPF

Purpose:

To specify the paper loaded in the MPF.

Values:

High Sets the image compression level to High.

Normal* Sets the image compression level to Normal.

Low Sets the image compression level to Low.

2048 KB* Sets the maximum size of e-mail that can be sent, in increments of 1 KB.

50-16384 KB

Display Tray Prompt Enter a check to display a popup message that prompts to set Paper 
Type and Paper Size when paper is loaded in the MPF. The factory 
default is on (check). 

Use Driver Settings for Print Job Enter a check to use the paper size and type set on the printer 
driver. The factory default is off (blank). 
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Size A4

(210x297mm)*1

mm series A5

(148x210mm) 

B5

(182x257mm)

Letter

(8.5x11")

Folio

(8.5x13")

Legal

(8.5x14")

Executive

(7.3x10.5")

Envelope #10

(4.1x9.5")

Monarch Env.

(3.9x7.5")

DL Env.

(110x220mm)

C5 Env.

(162x229mm)

Custom

inch series Letter

(8.5x11")*1

Folio

(8.5x13")

Legal

(8.5x14")

A4

(210x297mm)

A5

(148x210mm) 

B5

(182x257mm)

Executive

(7.3x10.5")

Envelope #10

(4.1x9.5")

Monarch Env.

(3.9x7.5")
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Tray1

Purpose:

To specify the paper loaded in tray1.

Values:

DL Env.

(110x220mm)

C5 Env.

(162x229mm)

Custom

Type Plain*

Plain Thick

Covers

(106-163g/m2)

Covers Thick

(164-216g/m2)

Coated

(106-163g/m2)

Coated Thick

(164-216g/m2)

Label

Envelope

Recycled

Letterhead

Preprinted

Prepunched

Color

Plain S2

Color S2

Plain Thick S2

Recycled S2
*1 Denotes country-specific factory default value.

Display Tray Prompt Enter a check to display a popup message that 
prompts to set Paper Type and Paper Size when 
paper is loaded in tray1. The factory default is on 
(check). 

Size A4

(210x297mm)*1

mm series A5

(148x210mm) 

B5

(182x257mm)
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Letter

(8.5x11")

Folio

(8.5x13")

Legal

(8.5x14")

Executive

(7.3x10.5")

Custom

inch series Letter

(8.5x11")*1

Folio

(8.5x13")

Legal

(8.5x14")

A4

(210x297mm)

A5

(148x210mm) 

B5

(182x257mm)

Executive

(7.3x10.5")

Custom

Type Plain

Plain Thick

Covers

(106-163g/m2)

Covers Thick

(164-216g/m2)

Coated

(106-163g/m2)

Coated Thick

(164-216g/m2)

Recycled

Letterhead

Preprinted

Prepunched

Color

Plain S2

Color S2

Plain Thick S2
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 NOTE: For more information on supported paper sizes, see "Supported Paper Sizes."

Tray2

 NOTE: Tray2 feature is available only when the optional 550-sheet feeder is installed.

Purpose:

To specify the paper loaded in the optional 550-sheet feeder. 

Values:

Tray Priority

Purpose:

To set the priority order of the paper trays for automatic tray selection. If paper trays loaded with the same paper size 
and type exists, the paper tray is selected according to this priority order.

Values:

Recycled S2
*1 Denotes country-specific factory default value.

Display Tray Prompt Enter a check to display a popup message that prompts to set Paper Type 
and Paper Size when paper is loaded in the optional 550-sheet feeder. 
The factory default is on (check). 

Size Auto Sensed*

Custom

Type Plain

Plain Thick

Covers

(106-163g/m2)

Covers Thick

(164-216g/m2)

Coated

(106-163g/m2)

Coated Thick

(164-216g/m2)

Recycled

Letterhead

Preprinted

Prepunched

Color

Plain S2

Color S2

Plain Thick S2

Recycled S2

First MPF*1 Sets the MPF as the first priority.
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Panel Language
Purpose:

To determine the language of the text on the touch panel.

Values:

Print Menu
Use the Print Menu to print a job using the Secure Print, Private Mail Box Print, Public Mail Box Print, and Proof 
Print features.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Private Mailbox

 NOTE: Private Mailbox feature is available only when RAM Disk is set to On or the optional hard disk is installed.

Purpose:

To specify whether and how to print the job stored in the Private Mailbox.

Values:

Tray1* Sets tray1 as the first priority. 

Tray2 Sets the optional 550-sheet feeder as the first priority. 

Second MPF* Sets the MPF as the second priority.

Tray1*1 Sets tray1 as the second priority. 

Tray2 Sets the optional 550-sheet feeder as the second priority. 

Third MPF Sets the MPF as the third priority.

Tray1 Sets tray1 as the third priority. 

Tray2*1 Sets the optional 550-sheet feeder as the third priority. 
*1 The factory default when the optional 550-sheet feeder is installed.

English*

Français

Italiano

Deutsch

Español

Dansk

Nederlands

Norsk

Svenska

Select User ID Enter the password you specified on the printer driver.

Select a Job Selects a job to print.

Select All Selects all the documents stored for this User ID.

Quantity 1* Specifies the quantity of prints in increments of 1. 

Available Range: 1-999
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Public Mailbox

 NOTE: Public Mailbox feature is available only when RAM Disk is set to On or the optional hard disk is installed.

Purpose:

To specify whether and how to print the job stored in the Public Mailbox.

Values:

Proof Print

 NOTE: Proof Print feature is available only when RAM Disk is set to On or the optional hard disk is installed.

Purpose:

To specify whether and how to print the job stored in the Proof Print. When the print job is sent from the printer 
driver on the computer, a single copy is printed for you to check the print result. If you do not  have  problems with 
the print result, you can choose to print more copies. This prevents a large number of misprinted copies from being 
printed at one time.

Values:

Secure Print
Secure Print feature is available only when RAM Disk is set to On or the optional hard disk is installed.

Purpose:

To print confidential jobs. The printer can hold the job in memory until you arrive at the printer and type the 
password on the operator panel.

Use Driver Settings Sets the quantity of prints specified on the printer driver.

Print Prints the selected job.

Print and Delete* Deletes the document after it is printed.

Delete Deletes the specified document from print memory.

Select User ID Select a Job Selects a job to print.

Select All Selects all the documents stored for this User ID.

Quantity 1* Specifies the quantity of prints in increments of 1. 

Available Range: 1-999

Use Driver Settings Sets the quantity of prints specified on the printer driver.

Print Prints the selected job.

Print and Delete Deletes the document after it is printed.

Delete Deletes the specified document from print memory.

Select User ID Select a Job Selects a job to print.

Select All Selects all the documents stored for this User ID.

Quantity 1* Specifies the quantity of prints in increments of 1. 

Available Range: 1-999

Use Driver Settings Sets the quantity of prints specified on the printer driver.

Print Prints the selected job.

Print and Delete Deletes the document after it is printed.

Delete Deletes the specified document from print memory.
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Values:

Secure Fax Receive
Purpose:

To specify the password to receive faxes.

Values:

Copy Menu
Use the Copy menus to configure a variety of copy features.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Copy Tab
Purpose:

To set the basic copy options.

Output Color

Purpose:

To select color or black and white copying.

Values:

Select Tray

Purpose:

To specify the input tray.

Values:

Select User ID Enter the password you specified on the printer driver.

Select a Job Selects a job to print.

Select All Selects all the documents stored for this User ID.

Print Prints the selected job.

Print and Delete* Deletes the document after it is printed.

Delete Deletes the specified document from print memory.

Enter Password Enter the password you specified in Secure Receive.

Full Color* Prints in color mode. 

Black & White Prints in black and white mode.

MPF The paper is fed from the MPF. When Use Driver Settings 
for Print Job is set in MPF of Tray Settings, Any is 
displayed for Size and Type.  If you start the copy job with Any as the 
paper size and type, A4 or Letter is selected as the paper size and 
plain is selected as the paper type. If you want to specify the size and 
type of paper in the MPF, select MPF and specify the paper size and type.
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Size

mm series

A4

(210x297mm)*1

A5

(148x210mm) 

B5

(182x257mm)

Letter

(8.5x11")

Folio

(8.5x13")

Legal

(8.5x14")

Executive

(7.3x10.5")

Envelope #10

(4.1x9.5")

Monarch Env.

(3.9x7.5")

DL Env.

(110x220mm)

C5 Env.

(162x229mm)

Custom

inch series Letter

(8.5x11")*1

Folio

(8.5x13")

Legal

(8.5x14")

A4

(210x297mm)

A5

(148x210mm) 

B5

(182x257mm)

Executive

(7.3x10.5")

Envelope #10

(4.1x9.5")

Monarch Env.

(3.9x7.5")
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Darken / Lighten

Purpose:

To make the copy darker or lighter than the original.

Values:

DL Env.

(110x220mm)

C5 Env.

(162x229mm)

Custom

Type Plain

Plain Thick

Covers

(106-163g/m2)

Covers Thick

(164-216g/m2)

Coated

(106-163g/m2)

Coated Thick

(164-216g/m2)

Label

Envelope

Recycled

Letterhead

Preprinted

Prepunched

Color

Plain S2

Color S2

Plain Thick S2

Recycled S2

Tray1* The paper is fed from tray1.

Tray2*2 The paper is fed from the optional 550-sheet feeder.
*1 Denotes country-specific factory default value.
*2 This item is available only when the optional 550-sheet feeder is installed.

Darken +3 Works well with light documents or faint pencil markings. 

Darken +2

Darken +1

Normal* Works well with standard typed or printed documents. 
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2 Sided Copying

Purpose:

To specify whether to make duplex copy and select the binding position.

Values:

Quality Tab
Purpose:

To set the options concerning image quality.

Original Type

Purpose:

To improve the image quality by selecting the type of the original document.

Values:

Sharpness

Purpose:

To adjust the sharpness to make the copy sharper or softer than the original.

Values:

Lighten +1 Works well with dark documents.

Lighten +2

Lighten +3

1 → 1 Sided* Prints on one side of a sheet of paper.

1 → 2 Sided Prints one sided originals on both sides of a sheet of paper.

Binding of Output Long Edge Binding* Prints on both sides of a sheet of paper to be bound by long 
edge.

Short Edge Binding Prints on both sides of a sheet of paper to be bound by short 
edge.

2 → 1 Sided Prints two sided originals on one side of a sheet of paper.

Binding of Original Long Edge Binding* Scans both sides of a document bound by long edge.

Short Edge Binding Scans both sides of a document bound by short edge.

2 → 2 Sided Prints two sided originals on both sides of a sheet of paper.

Binding of Original Long Edge Binding* Scans both sides of a document bound by long edge.

Short Edge Binding Scans both sides of a document bound by short edge.

Photo & Text* Used for documents with both text and photos. 

Text Used for documents with text.

Photo Used for documents with photos. 

Sharpen Makes the copy sharper than the original. 

Normal* Does not make the copy sharper or softer than the original. 

Soften Makes the copy softer than the original.
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Color Saturation

Purpose:

To adjust the amount of colors to make the colors darker or lighter than the original.

Values:

Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

Output Tab
Purpose:

To set other copy options.

Collation

Purpose: 

To sort the copy job. For example, if you make two copies of three page documents, one complete set of three page 
documents is printed one by one. 

Values:

Reduce / Enlarge

Purpose:

To reduce or enlarge the size of a copied image.

Values:

High Increases the color saturation to brighten the color of the copy.

Normal* The color saturation is the same as the original.

Low Decreases the color saturation to lighten the color of the copy.

Off Does not suppress the background.

On* Suppresses the background to enhance text.

Auto* Automatically sorts a copy job only when you use the DADF.

Collated Sorts a copy job. 

Uncollated Does not sort a copy job. 

Custom ratio 100* Enter a custom ratio in increments of 1 percent.

25-400 %

mm series 100%*

50%

70%

A4→A5
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Original Size

Purpose:

To specify the default document size.

Values:

mm series

inch series

81%

B5→A5

122%

A5→B5

141%

A5→A4

200%

inch series 100%*

50%

64%

Ledger→Letter

78%

Legal→Letter

129%

Statement→Letter

154%

Statement→Legal

200%

Auto*1

A4 (210x297mm) 

A5 (148x210mm) 

B5 (182x257mm) 

Letter (8.5x11") 

Folio (8.5x13") 

Legal (8.5x14") 

Executive (7.3x10.5") 

Auto*1

Letter (8.5x11") 

Folio (8.5x13") 

Legal (8.5x14") 

A4 (210x297mm) 

A5 (148x210mm) 
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 NOTE: When Auto is selected, the printer assumes that the document size is the size of the print media loaded in tray1 or the 
MPF.

2-Up

Purpose:

To print two original pages to fit onto one sheet of paper.

Values:

Margin

Purpose:

To specify the top, bottom, right, left, and middle margins of the copy.

Values:

Scan Menu
Use the Scan Menu to configure a variety of scanner features.

Network
Purpose:

To store the scanned image on a network server or a computer. See "Scan Options" for more details about the various 
scan options you can set for the scan.

Values:

Application
Purpose:

B5 (182x257mm) 

Executive (7.3x10.5") 
*1 Denotes country-specific factory default values.

Off* Does not perform 2-up printing. 

Auto Automatically reduces the original pages to fit onto one sheet of paper. 

Manual Prints the original pages onto the one sheet of paper in the size specified in 
Reduce/Enlarge.

Top / Bottom 0.2 inch* (4 mm*) Sets the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Left / Right 0.2 inch* (4 mm*) Sets the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Middle 0.0 inches*(0 mm*) Sets the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Address Book Selects a FTP address or Server Message Block (SMB) protocol address from the Local 
Address Book.



Understanding the Printer Menus 289

To save scanned data on a computer. The Scan to Application feature allows you to import scanned data from the 
printer to a computer connected via a USB cable. The computer must have ScanButton Manager installed to receive 
the data. See "Scan Options" for more details about the various scan options you can set for the scan.

USB
Purpose:

To save the scanned image to a USB memory attached to the printer. See "Scan Options" for more details about the 
various scan options you can set for the scan.

Values:

Scan Options
Use the scan options to configure a variety of scanner features when scanning to a Network, Application, or USB.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Scan To Network/Application/USB Tab

Purpose:

To set the basic options of the scan.

Output Color

Purpose:

To select color or black and white scanning.

Values:

Resolution

Purpose:

To specify the resolution of the scanned image.

Values:

2 Sided Scanning

Purpose:

To specify whether to scan both sides of a document.

Change Folder Selects which folder the scanned image is saved to. 

Color* Scans in color mode. Works well with texts and photos.

Black & White Scans in black and white mode. Works well with texts.

Gray Scale Scans in grayscale mode. Works well with texts and photos.

200 dpi*

300 dpi

400 dpi

600 dpi
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Values:

File Format

Purpose:

To specify the file format to save the scanned image.

Values:

Quality Tab

Purpose:

To set the options concerning image quality.

Darken / Lighten

Purpose:

To adjust the density to make the scanned image darker or lighter than the original.

Values:

Sharpness

Purpose:

To adjust the sharpness to make the scanned image sharper or softer than the original.

Values:

Contrast

Purpose:

1 Sided* Scans one side of a document.

2 Sided Long Edge Binding* Scans both sides of a document bound by the long edge.

Short Edge Binding Scans both sides of a document bound by the short edge.

PDF*

Multi-Page TIFF

TIFF (1 File per Page)

JPEG (1 File per Page)

Darken +3 Works well with light documents or faint pencil markings. 

Darken +2

Darken +1

Normal* Works well with standard typed or printed documents. 

Lighten +1 Works well with dark documents.

Lighten +2

Lighten +3

Sharpen Makes the scanned image sharper than the original.

Normal* Does not make the scanned image sharper or softer than the original.

Soften Makes the scanned image softer than the original.
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To adjust the amount of colors to make the contrast of colors darker or lighter than the original.

Values:

Auto Exposure

Purpose:

To suppress the background of the original to enhance text on the copy.

Values:

Options Tab

Purpose:

To set other options for the scan.

Original Size

Purpose:

To specify the default paper size.

Values:

mm series

inch series

High Adjusts the amount of colors to make the contrast of colors darker than the original.

Medium* Does not adjust the amount of colors to make the contrast of colors darker or lighter than the 
original.

Low Adjusts the amount of colors to make the contrast of colors lighter than the original.

Off Does not suppress the background.

On* Suppresses the background to enhance text.

A4 (210x297mm) *1

A5 (148x210mm) 

B5 (182x257mm) 

Letter (8.5x11") 

Folio (8.5x13") 

Legal (8.5x14") 

Executive (7.3x10.5") 
*1 Denotes country-specific factory default values.

Letter (8.5x11") *1

Folio (8.5x13") 

Legal (8.5x14") 

A4 (210x297mm) 

A5 (148x210mm) 

B5 (182x257mm) 

Executive (7.3x10.5") 
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Margin

Purpose:

To specify the top, bottom, right, left, and middle margins of the scanned image.

Values:

File Naming Mode

Purpose:

To specify the detailed setting of File Naming Mode.

Values:

Create Folder

Purpose:

To specify whether to create a folder when saving scanned images.

Values:

WSD Scan
Purpose:

To save scanned data on a computer using WSD. 

 NOTE: WSD Scan is available when the OS of the client computer is Windows Vista SP2 (or later), Windows 7, and Windows 8.

Values:

*1 Denotes country-specific factory default values.

Top / Bottom 0.1 inch* (2 mm*) Sets the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Left / Right 0.1 inch* (2 mm*) Sets the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Middle 0.0 inches*(0 mm*) Sets the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Auto* Sets the default file name.

Add Prefix Adds texts in front of the file name.

Prefix/Suffix String Specifies the texts that are added when Add Prefix 
is selected.

Add Suffix Adds texts after the file name.

Prefix/Suffix String Specifies the texts that are added when Add Suffix 
is selected.

Off Does not create a folder when saving a scanned image.

On* Creates a folder when saving a scanned image.

Scan to Computer 
Name

Selects which computer the scanned image is saved to. Up 
to 20 computers will be listed.
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E-mail
Use the E-mail to configure a variety of e-mail features. See "Scan Options" for details about the Quality and 
Options tab.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Values:

Fax Menu
Use the Fax menus to configure a variety of fax features.

 NOTE: The Fax function cannot be used unless you set up a country code under Country. If Country is not set up, a 
message Set the Country Code appears on the display.

 NOTE: Values marked by an asterisk (*) are the factory default menu settings.

Fax Tab
Purpose:

To set the recipient and basic fax options.

Specify the Recipient

Purpose:

To specify the recipient

Values:

Event Scan Sends the scanned image to the computer according to the 
chosen event. Which application each event is associated 
with depends on the setting on the computer. 

ScanToPrint

ScanToEmail

ScanToFax

ScanToOCR

New Recipient Enters the e-mail address of the recipient using the keyboard.

Address Book Machine Address Book - Individuals Selects an e-mail address from the Local Address Book.

Machine Address Book - Groups Selects an e-mail group from the Local Address Book.

Search Network Address Book Searches an e-mail address from the Server Address Book.

From Keyboard Enters the e-mail address of the sender using the keyboard.

Machine Address Book Selects an e-mail address of the sender from the Local 
Address Book.

Search Network Address Book Searches an e-mail address of the sender from the Server 
Address Book.

Enter number text box Enters the fax number using the number pad.

Enters the speed dial number stored in the printer.

Machine Address Book - Individuals Selects a fax number from the Local Address Book.

Machine Address Book - Groups Selects a group dial number from the Local Address Book.

Search Network Address Book Searches a fax number from the Server Address Book.
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Darken / Lighten

Purpose:

To adjust the density to make the copy darker or lighter than the original.

Values:

2 Sided Scanning

Purpose:

To specify whether to scan both sides of a document.

Values:

Resolution

Purpose:

To specify the scan resolution to improve the output quality.

Values:

 NOTE: Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

OnHook

Purpose:

To send or receive faxes manually.

Values:

Darken +3 Works well with light documents or faint pencil markings. 

Darken +2

Darken +1

Normal* Works well with standard typed or printed documents. 

Lighten +1 Works well with dark documents. 

Lighten +2

Lighten +3

1 Sided* Scans one side of a document.

2 Sided Long Edge Binding* Scans both sides of a document bound by the long edge.

Short Edge Binding Scans both sides of a document bound by the short edge.

Standard* Suitable for documents with normal sized characters. 

Fine Suitable for documents containing small characters or thin lines or documents printed using a 
dot-matrix printer. 

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode is 
enabled only if the remote machine also supports the Super Fine mode. See the notes 
below.

Photo Suitable for documents containing photographic images.

Manual Send* Enter Number Enters the fax number using the number pad.

Machine Address Book Selects a fax number from the Local Address Book.
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Options Tab
Purpose:

To set other fax options.

Delayed Send

Purpose:

To send a fax at a later time.

Values:

 NOTE: A maximum of 19 delayed fax jobs can be stored in the Dell C3765dnf Multifunction Color Laser Printer.

Polling Receive
Purpose:

To receive faxes from the remote fax machine when you want to receive it.

Values:

Fax Cover Page
Purpose:

To set whether to attach a cover page to faxes.

Values:

USB Direct Print Menu
 NOTE: USB Direct Print function is available only when a USB memory is inserted in the front USB port.

Select File to Print
Purpose:

To specify the document stored in the root, file, or folder in a USB memory. 

USB Direct Print Tab
Purpose:

To change the file and set basic print options.

Search Network Address Book Searches a fax number from the Server Address Book.

Manual Receive Receives faxes manually.

Manual Polling Manually retrieves information from a remote machine. 

Off* Does not send a fax at a later time.

On Sets the fax transmission start time when sending a fax at a specified time.

Off* Does not receive faxes using Polling Receive. 

On Receives faxes using Polling Receive.

Off* Does not attach a cover page to faxes.

On Attaches a cover page to faxes.
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Change File

Purpose:

To change the file you want to print.

Output Color

Purpose:

To select color or black and white printing.

Values:

Select Tray

Purpose:

To specify the input tray.

Values:

Full Color* Prints in color mode.

Black & White Prints in black and white mode.

MPF The paper is fed from the MPF. When Use Driver 
Settings for Print Job is set in MPF of Tray 
Settings, Any is displayed for Size and Type.  If you 
start the print job with Any as the paper size and type, A4 or 
Letter is selected as the paper size and plain is selected 
as the paper type. If you want to specify the size and type of 
paper in the MPF, select MPF and specify the paper size and 
type.

Size

mm series

A4

(210x297mm)*1

A5

(148x210mm) 

B5

(182x257mm)

Letter

(8.5x11")

Folio

(8.5x13")

Legal

(8.5x14")

inch series Letter

(8.5x11")*1

Folio

(8.5x13")

Legal

(8.5x14")
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2 Sided Printing

Purpose:

To print on both sides of a sheet of paper.

Values:

Multiple-Up

Purpose:

To specify the output layout. 

A4

(210x297mm)

A5

(148x210mm) 

B5

(182x257mm)

Type Plain

Plain Thick

Covers

(106-163g/m2)

Covers Thick

(164-216g/m2)

Coated

(106-163g/m2)

Coated Thick

(164-216g/m2)

Envelope

Recycled

Letterhead

Prepunched

Color

Plain S2

Color S2

Plain Thick S2

Recycled S2

Tray1* The paper is fed from tray1.

Tray2 The paper is fed from the optional 550-sheet feeder.
*1 Denotes country-specific factory default value.

1 Sided* Does not print on both sides of a sheet of paper.

2 Sided Long Edge Binding* Prints on both sides of a sheet of paper to be bound by the 
long edge.

Short Edge Binding Prints on both sides of a sheet of paper to be bound by the 
short edge.
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Values:

Options Tab
Purpose:

To set other print options.

Collation

Purpose:

To specify whether to sort the job.

Values:

PDF Password

Purpose:

To enter the password when you print a PDF file secured with a document open password (password to open the 
PDF file).

Values:

ID Card Copy
Purpose:

To copy both sides of an ID card on one side of a single sheet of paper in the original size.

ID Card Copy Tab
Purpose:

To set the basic ID Card Copy options.

Values:

Quality Tab
Purpose:

To set the options concerning image quality.

Off* Prints one page on one side of a sheet of paper.

2-Up Prints two pages on one side of a sheet of paper.

4-Up Prints four pages on one side of a sheet of paper.

Collated Sorts a job.

Uncollated* Does not sort a job.

Enter PDF Password Enter the document open password to print the secure PDF job.

Output Color For details about each menu, see "Copy Menu."

Select Tray

Darken / Lighten

Auto Exposure
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Values:

Panel Lock
This feature prevents unauthorized personnel from changing the settings made by the administrator. For regular 
printing, items can be selected from the menu and printer settings remain unchanged. For regular printing, items 
can be configured using the printer driver.

 NOTE: Disabling the operator panel menus does not prevent access to the Stored Print and Tray Settings menus.

Enabling the Panel Lock
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Secure Settings appears, and then select Secure Settings.

4 Select  until Panel Lock appears, and then select Panel Lock.

5 Select Panel Lock Control.

6 Select Enable, and then select OK.

7 Enter the new password, and then select OK.

 CAUTION: Be sure to remember the password. The procedure described below allows you to reset the password, but 
the settings for Address Book and Phone Book are cleared.

• Turn off the printer. Then, while holding the  (Information) button, turn on the printer. Perform steps 7 
and 8.

8 Re-enter the password to confirm the password that you entered, and then select OK.

The password has been changed.

To change the password while Panel Lock is Enable, perform steps 1 to 4 above, and then select Change 
Password. Perform steps 7 and 8 above to change the password.

Disabling the Panel Lock
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Secure Settings appears, and then select Secure Settings.

4 Select  until Panel Lock appears, and then select Panel Lock.

5 Select Panel Lock Control.

6 Select Disable.

7 Enter the current password, and then select OK.

The setting has been changed.

Resetting Defaults
After executing this function and rebooting the printer, the phone book, address book, or menu parameters are reset 
to their default values.

Sharpness For details about each menu, see "Copy Menu."

Color Saturation
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The following menu parameters are exceptions and are not reset. 

• Network settings 

• Panel Lock settings and password

• Function Enabled settings (Copy, E-mail, Fax, Scan To Network, Scan To Application, PC Scan, Scan To USB, 
USB Direct Print) and passwords

• Secure Receive settings and password

• Login Error settings

• Set Available Time settings

• Secure Job Expiration settings

• USB Port settings

• Data Encryption settings

• Hard Disk Over Write settings

• ColorTrack Mode settings

• ColorTrack Error Report settings

• Non Registered User settings

When Using the Operator Panel
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Maintenance appears, and then select Maintenance.

4 Select  until Reset Defaults appears, and then select Reset Defaults.

5 Select the desired setting, and then select Initialize.

6 Select Yes, Reset.

The printer is restarted automatically.

User Fax Section Resets the phone book data.

User Scan Section Resets the address book data.

System Section Resets the system parameters.
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17
Print Media Guidelines
Print media refers to paper, labels, envelopes, and coated paper among others. Your printer provides high-quality 
printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing 
troubles. This section describes selecting and caring for print media.

 NOTE: Use only laser print media. Do not use ink jet paper in your printer.

Paper
For the best print quality in color, use 75 g/m2 (20 lb) xerographic, grain long paper. For the best print quality in 
black and white, use 90 g/m2 (24 lb) xerographic, grain long paper. It is recommended that you try a sample first 
before buying large quantities of any print media.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See 
"Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" and "Loading Print Media in the MPF" for 
detailed loading instructions. 

Paper Characteristics
The following paper characteristics affect print quality and reliability. It is recommended that you follow these 
guidelines when evaluating new paper stock. 

Weight

The tray automatically feeds paper weights from 60 g/m2 to 216 g/m2 (16 lb to 80 lb bond) grain long. The 
multipurpose feeder (MPF) automatically feeds paper weights from 60 g/m2 to 216 g/m2 (16 lb to 80 lb bond) grain 
long. Paper lighter than 60 g/m2 (16 lb) may not feed properly, and could cause paper jams. For best performance, 
use 75 g/m2 (20 lb bond) grain long paper.

Curl

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl 
usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper 
unwrapped, even in the paper tray, can contribute to paper curling prior to printing and cause feeding problems 
regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the MPF.

Smoothness

The degree of paper smoothness directly affects the print quality. If the paper is too rough, the toner does not fuse 
on to the paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding 
problems. Smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture Content

The amount of moisture in the paper affects both the print quality and the ability of the printer to feed the paper 
properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper 
to moisture changes that can degrade its performance. 

Grain Direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of 
the paper, or grain short, running the width of the paper. For 60 g/m2 to 135 g/m2 (16 lb to 36 lb bond) paper, grain 
long fibers are recommended. For paper heavier than 135 g/m2 (36 lb bond), grain short is preferred. 
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Fiber Content

Most high-quality xerographic paper is made from 100 % chemically pulped wood. Paper containing fibers such as 
cotton may lead to degraded paper handling. 

Recommended Paper
To ensure the best print quality and feed reliability, use 75 g/m2 (20 lb) xerographic paper. Business paper designed 
for general business use also provides acceptable print quality. Only use paper able to withstand high temperatures 
without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper to high 
temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is 
acceptable for laser printers.

It is recommended that you try a sample first before buying large quantities of any print media. When choosing any 
print media, you should consider the weight, fiber content, and color.

Unacceptable Paper
The following paper types are not recommended for use with the printer:

• Chemically treated paper used to make copies without carbon paper, also known as carbonless paper, carbonless 
copy paper (CCP), or no carbon required (NCR) paper.

• Preprinted paper with chemicals that may contaminate the printer.

• Preprinted paper that can be affected by the temperature in the fusing unit.

• Preprinted paper that requires a registration (the precise print location on the page) greater than ±0.09 inches, 
such as optical character recognition (OCR) forms.

In some cases, you can adjust registration with your software program to successfully print on these forms.

• Coated paper (erasable bond), synthetic paper, and thermal paper.

• Rough-edged, rough or heavily textured surface paper, or curled paper.

• Recycled paper containing more than 25 % post-consumer waste that does not meet DIN 19 309.

• Multiple-part forms or documents.

• Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.

Selecting Paper
Proper paper selection helps prevent jams and ensures trouble-free printing. 

To help avoid jams or poor print quality:

• Always use new, undamaged paper. 

• Before loading the paper, identify the recommended print side of the paper. This information is usually indicated 
on the paper package. 

• Do not use paper that you have cut or trimmed. 

• Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam. 

• Do not remove the tray while printing is in progress.

• Ensure that the paper is properly loaded in the tray. 

• Flex the paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.
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Selecting Pre-Printed Media and Letterheads
When selecting pre-printed and letterhead paper for the printer:

• Use grain long paper for best results.

• Use only forms and letterheads printed using an offset lithographic or engraved printing process.

• Select paper that absorb ink, but does not bleed.

• Avoid paper with rough or heavily textured surfaces.

• Use paper printed with heat-resistant inks designed for use in xerographic copiers. The ink must withstand 
temperatures of 225 °C (437 °F) without melting or releasing hazardous emissions.

• Use inks that are not affected by the resin in the toner or the silicone in the fusing unit. Inks that are oxidation-set 
or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier. 

Selecting Pre-Punched Paper
When selecting pre-punched paper for the printer:

• Test paper from several manufacturers before ordering and using large quantities of pre-punched paper. 

• Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled 
paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam. 

• Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent 
cleaning and feed reliability may not be as good as standard paper. 

• Weight guidelines for pre-punched paper are the same as non-punched paper. 

Envelopes
Depending on the envelopes, it is possible to expect variable levels of wrinkling. It is recommended that you try a 
sample first before buying large quantities of any print media. See "Loading an Envelope in the MPF" for 
instructions on loading an envelope.

When printing on envelopes:

• Use only high-quality envelopes that are designed for use in laser printers. 

• Set the print media source to the MPF. Set the paper type to Envelope, and select the correct size of envelope from 
the printer driver. 

• Use envelopes made from 75 g/m2 (20 lb bond) paper. You can use up to 105 g/m2 (28 lb bond) weight for the 
envelope feeder as long as the cotton content is 25 % or less. Envelopes with 100 % cotton content must not exceed 
90 g/m2 (24 lb bond) weight.

• Use only freshly unpackaged, undamaged envelopes. 

• Use envelopes that can withstand temperatures of 205 °C (401 °F) without sealing, excessive curling, wrinkling, or 
releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the 
envelope supplier. 
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• Adjust the guide to fit the width of the envelopes. 

• To load an envelope into the MPF, insert the envelope with the flaps closed or open and the short-edge of the 
envelope facing into the printer. The print side must be facing up.

• See "Loading an Envelope in the MPF" for instructions on loading an envelope.

• Use one envelope size during a print job.

• Ensure that the humidity is low because high humidity (more than 60 %) and the high printing temperatures may 
seal the envelopes.

• For best performance, do not use envelopes that:

– Have excessive curl or twist

– Are stuck together or damaged in any way

– Contain windows, holes, perforations, cutouts, or embossing

– Use metal clasps, string ties, or metal folding bars

– Have an interlocking design

– Have postage stamps attached

– Have any exposed adhesive when the flap is in the sealed or closed position

– Have nicked edges or bent corners

– Have rough, cockle, or laid finishes

Labels
Your printer can print on many labels designed only for use with laser printers. 

When selecting labels:

• Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205 °C (401 
°F) and pressure of 25 pounds per square inch (psi).

• Use labels that can be without sealing, excessive curling, wrinkling, or releasing hazardous emissions.

• Do not use label sheets with a slick backing material.

 CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first.

When printing on labels:

• Use labels that can withstand temperatures of 205 °C (401 °F) without sealing, excessive curling, wrinkling, or 
releasing hazardous emissions.

• Set the paper type to Label from the printer driver. 

• Load labels in the MPF. Tray1 and the optional 550-sheet feeder do not support labels.

• Do not load labels together with paper in the MPF.

• Do not print within 1 mm (0.04 inches) of the die-cut.

• Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the 
label.

• Do not print a label through the printer more than once.

• Portrait orientation is preferred, especially when printing bar codes. 

• Do not use labels that have exposed adhesive.

• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam.
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• Do not use label sheets that have adhesive to the edge of the sheet. It is recommended that zone coating of the 
adhesive is done at least 1 mm (0.04 inches) away from edges. Adhesive material contaminates your printer and 
could void your warranty. 

 WARNING: Otherwise a jam occurs in the printer and contaminate your printer and your cartridges with adhesive. As a result, 
could void your printer and cartridge warranties.

Storing Print Media
For proper print media storage, the following guidelines will help to avoid media feeding problems and uneven print 
quality.

• Store print media in an environment where the temperature is approximately 21 °C (70 °F) and the relative 
humidity is 40 %.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor. 

• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
that the edges do not buckle or curl. 

• Do not place anything on top of the print media packages. 

Identifying Print Media and Specifications
The following tables show print media information.

Supported Paper Sizes

Paper size MPF Tray1 Optional 550-sheet 
feeder

Duplex unit

Side 1 Side 2 Side 1 Side 2 Side 1 Side 2

A4 (210 x 297 mm) Y Y Y Y Y Y Y

B5 (182 x 257 mm) Y Y Y Y Y Y Y

A5 (148 x 210 mm) Y Y Y Y Y Y Y

Letter (8.5 x 11 in) Y Y Y Y Y Y Y

Folio (8.5 x 13 in) Y Y Y Y Y Y Y

Legal (8.5 x 14 in) Y Y Y Y Y Y Y

Executive (7.25 x 10.5 in) Y Y Y Y Y Y Y

Envelope #10 (4.125 x 9.5 in) Y N N N N N N

Monarch (3.875 x 7.5 in) Y N N N N N N

DL (110 x 220mm) Y N N N N N N

C5 (162 x 229mm) Y N N N N N N

Custom*1, 2 Y Y Y Y Y Y Y
*1 Custom: width: 76.2 mm (3.0 inches) to 215.9 mm (8.5 inches) for the MPF; 148 mm (5.83 inches) to 215.9 mm (8.5 inches) for tray1 and the 

optional 550-sheet feeder
length: 127.0 mm (5.0 inches) to 355.6 mm (14.00 inches) for the MPF; 210 mm (8.27 inches) to 355.6 mm (14.00 inches) for tray1 
and the optional 550-sheet feeder

*2 XPS driver does not support custom size paper.
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Supported Paper Types

 NOTE: For Plain and Label paper, you can set the paper density by selecting the Paper Density (Light or Normal) under 
Maintenance from the operator panel, Tool Box, or Dell™ Printer Configuration Web Tool. Once you set the Paper Density 
settings, the printer uses the settings for Plain and Label paper.

Paper Type Specifications

Paper type MPF Tray1 Optional 550-sheet 
feeder

Duplex unit

Side 1 Side 2 Side 1 Side 2 Side 1 Side 2 Side 1 Side 2

Plain Light Y Y Y Y Y Y Y N

Normal Y Y Y Y Y Y Y N

Thick Y Y Y Y Y Y Y N

Covers Normal Y N Y N Y N Y N

Thick Y N Y N Y N N N

Coated Normal Y N Y N Y N Y N

Thick Y N Y N Y N N N

Label Normal Y N N N N N N N

Light Y N N N N N N N

Envelope Y N N N N N N N

Recycled Y Y Y Y Y Y Y N

Letterhead Y N Y N Y N Y N

Preprinted Y N Y N Y N Y N

Prepunched Y N Y N Y N Y N

Color Y Y Y Y Y Y Y N

Paper type Weight (g/m2) Remarks

Plain 60–90 -

Plain Thick 80/90–105 -

Recycled 60–105 -

Labels - Inkjet printer paper cannot be used.

Covers 106–163 -

Covers Thick 164–216 -

Envelope - -

Coated 106–163 Inkjet printer paper cannot be used.

Coated Thick 164–216 Inkjet printer paper cannot be used.

Letterhead 60–90 -

Preprinted 60–90 -

Prepunched 60–90 -

Color 60–90 -
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18
Loading Print Media
Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading any print media, identify the recommended print side of the print media. This information is usually 
indicated on the print media package.

Capacity
Tray1 and the optional 550-sheet feeder (tray2) can hold:

• 550 sheets of the standard paper.

The multipurpose feeder (MPF) can hold:

• 150 sheets of the standard paper.

Print Media Dimensions
The maximum dimensions of print media that tray1 and the optional 550-sheet feeder can handle are:

• Width — 148 mm (5.83 inches) to 215.9 mm (8.5 inches)

• Length — 210 mm (8.27 inches) to 355.6 mm (14.00 inches)

The maximum dimensions of print media that the MPF can handle are:

• Width — 76.2 mm (3.00 inches) to 215.9 mm (8.5 inches)

• Length — 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

Loading Print Media in Tray1 and the Optional 550-Sheet Feeder
This section describes how to load letterhead. For details about loading print media other than letterhead, see 
"Loading Paper." 

 NOTE: To avoid paper jams, do not remove the tray while printing is in progress.

 NOTE: Use only laser print media. Do not use ink jet paper in the printer.

Loading Letterhead (Pre-Printed and Pre-Punched Paper)
The pre-printed paper such as letterhead and pre-punched paper must be inserted bottom edge first with the print 
side facing down as shown below.

 NOTE: Set Letterhead 2-Sided or Letterhead Duplex Mode to Enable and Paper Type to 
Letterhead, Preprinted, or Prepunched from the operator panel or the printer driver even when you print on a single 
side of letterhead, pre-printed, or pre-punched paper.
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Loading Print Media in the MPF
1 Gently pull open the MPF cover.

Print media source Print side Page orientation

Tray1 and optional 550-sheet 
feeder

Face down Letterhead enters the printer 
last

MPF Face down Letterhead enters the printer 
last

LETTERHEAD

LETTERHEAD
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2 Extend the extension tray as necessary.

3 Slide the width guides to the edge of the tray. The width guides should be fully extended.

4 Insert all media facing up and top edge first into the MPF.

 NOTE: Do not force the print media into the MPF.
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5 Slide both width guides until they rest lightly against the edge of the print media stack.

 NOTE: Do not force the print media into the MPF.

6 On the touch panel, select Size. 

7 Select  or  until the desired paper size appears, and then select the size.

8 Select Type. 

9 Select  or  until the desired paper type appears, and then select the type.

10 Select OK.

Loading an Envelope in the MPF
Use the following guidelines when loading envelopes in the MPF:

 CAUTION: Never use envelopes with windows, coated linings, or self-stick adhesives. These lead to paper jams and can 
cause damage to the printer.

 NOTE: If you do not load envelopes in the MPF right after they have been removed from the packaging, they may bulge. To avoid 
jams, press firmly across the whole envelopes to flatten them as shown below before loading the envelopes in the MPF.

 NOTE: The maximum height (quantity) of envelopes that can be loaded in the MPF is approximately 15 mm (0.59 inches) (15 
envelopes). 
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Envelope #10, Monarch, or DL
Load the envelopes short edge feed with the flaps closed and the print side up. Ensure that the flaps come at the left 
when you face towards the printer.

C5
Load the envelopes short edge feed with the flaps open or closed and the print side up.

Ensure that the flaps come at the bottom with the flaps open or at the top with the flaps closed when you face 
towards the printer.
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Using the MPF
• Load only one size and type of print media during a single print job.

• To achieve the best possible print quality, use only high-quality print media that is designed for use in laser printer. 
For more guidelines on print media, see "Print Media Guidelines."

• Do not add or remove print media when there is still print media in the MPF or when the printer is printing from 
the MPF. This may result in a paper jam.

• Print media should be loaded with the recommended print side up and the top of the print media going into the 
MPF first.

• Do not place objects on the MPF. Also, avoid pressing down or apply excessive force on it.

• The icons on the MPF show how to load the MPF with paper, and how to turn an envelope for printing.

Linking Trays
The printer automatically links the trays when you load the same size and type of print media in them. The first tray 
will be utilized until the media runs out after which the next tray will be used. 

 NOTE: The print media should be the same size and type in each tray. 
The MPF cannot be linked to any of the tray sources. 

After loading the selected trays with the same size and type of print media, select the Paper Type setting in the Tray 
Settings component for each source (tray). 

To disable tray linking change the paper type in one of the sources (trays) to a unique value.

 NOTE: If different types of print media of the same size are loaded in each tray, the printer will automatically link them if the 
paper type is not specified in the printer driver properties/preferences.
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19
Printing
This chapter covers tips for printing, how to print certain information from your printer, and how to cancel a job.

Tips for Successful Printing

Tips on Storing Print Media
Store your print media properly. For more information, see "Storing Print Media."

Avoiding Paper Jams

 CAUTION: Before buying large quantities of any print media, it is recommended that you try a sample first.

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions 
on loading print media:

• "Loading Paper"

• "Loading Print Media in the MPF"

• "Avoiding Jams"

If you encounter a paper jam, see "Clearing Jams."

Sending a Job to Print
To support all of the printer features, use the printer driver. When you choose Print from an application, a window 
representing the printer driver opens. Select the appropriate settings for the specific job that you are sending to 
print. Print settings selected from the driver override the default menu settings selected from the operator panel or 
Tool Box.

You may need to click Preferences from the initial Print box to see all of the available system settings you can 
change. If you are not familiar with a feature in the printer driver window, open the online Help for more 
information.

To print a job from a typical Microsoft® Windows® application:

1 Open the file you want to print.

2 From the File menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the print settings as appropriate (such as the 
pages you want to print or the number of copies).

4 Click Preferences to adjust system settings that are not available from the first screen, and then click OK. 

5 Click OK or Print to send the job to the selected printer.

 NOTE: When you print on a small size medium such as an envelope, lift the operator panel so that you can easily remove the 
printed media from the output tray.
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Canceling a Print Job
There are several methods for canceling a job.

• Canceling a Job From the Operator Panel

• Canceling a Job From a Computer Running Windows

Canceling a Job From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Cancel) button or Select Delete.

Printing is canceled only for the current job. All the following jobs will continue to print.

To cancel a job before it has started printing:

1 Press the  (Job Status) button.

A list of print jobs appears.

2 Select the desired job to cancel.

3 Select Delete.

4 Select Delete Job.

Canceling a Job From a Computer Running Windows

Canceling a Job From the Taskbar

When you send a job to print, a small printer icon appears in the bottom right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the <Delete> key.

Canceling a Job From the Desktop

1 Click Start→ Devices and Printers.

For Windows XP: Click start→ Printers and Faxes.

For Windows Vista®: Click Start→ Control Panel→ Hardware and Sound→ Printers.

For Windows Server® 2008: Click Start→ Control Panel→ Printers. 

For Windows Server 2008 R2: Click Start→ Devices and Printers.

For Windows 8: Under Desktop mode, right-click the bottom left corner of the screen, and then click Control 
Panel → Hardware and Sound → Devices and Printers.

For Windows Server 2012: Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware → Devices and Printers.

A list of available printers appears. 

2 Right-click the printer that you selected when you sent the job for print, and then select See what's printing.

3 Select the printer driver.

A list of print jobs appears in the printer window.

4 Select the job you want to cancel.
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5 Press the <Delete> key.

Duplex Printing
Duplex printing (or two-sided printing) allows you to print on both sides of a sheet of paper. For sizes that are 
acceptable for duplex printing, see "Supported Paper Sizes."

Duplex Printing With Duplex Unit
1 Click Start→ Devices and Printers.

For Windows XP: Click start→ Printers and Faxes.

For Windows Vista: Click Start→ Control Panel→ Hardware and Sound→ Printers.

For Windows Server 2008: Click Start→ Control Panel→ Printers.

For Windows Server 2008 R2: Click Start→ Devices and Printers.

For Windows 8: Under Desktop mode, right-click the bottom left corner of the screen, and then click Control 
Panel → Hardware and Sound → Devices and Printers.

For Windows Server 2012: Under Desktop mode, right-click the bottom left corner of the screen, and then click 
Control Panel → Hardware → Devices and Printers.

2 Right-click the printer and select Printing Preferences.

The General tab appears.

3 From Paper Source, select the paper tray.

For PCL driver:

Select from Auto, Tray1, Tray2, or MPF.

For PS driver:

Select from Automatically Select, Tray1, Tray2, or MPF.

4 From Duplex, select Flip on Short Edge or Flip on Long Edge.

 NOTE: For details on the Flip on Short Edge and Flip on Long Edge options, see "Flip on Short Edge" and "Flip on Long Edge."

5 Click OK.

Using Booklet Print
To use the booklet print feature, select the Enable check box of the Booklet Printing in the Layout tab. 

 NOTE: When the XPS or PS driver is used, booklet print is not available.

 NOTE: You must select Flip on Long Edge in the Duplex when using the Booklet Print feature.
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Using the Stored Print Feature
When you send a job to the printer, you can specify in the printer driver to store the job in the memory or hard disk. 
When you are ready to print the job, go to the printer and use the operator panel to identify which job in the 
memory or hard disk you want to print.

 NOTE: The data in the memory is cleared when the printer is turned off. The data on the optional hard disk is not cleared even 
when the printer is turned off.

 NOTE: Stored Print feature is available when:

• The RAM disk is enabled in the printer menu.

• RAM Disk is set to Available in the printer driver.

OR 

• The optional hard disk is installed.

• Hard Disk is set to Available in the printer driver.

Flip on Long Edge Assumes binding along the long edge of the page (left edge for portrait orientation and top edge 
for landscape orientation). The following illustration shows long-edge binding for portrait and 
landscape pages:

Flip on Short Edge Assumes binding along the short edge of the page (top edge for portrait orientation and left 
edge for landscape orientation). The following illustration shows short-edge binding for portrait 
and landscape pages:

Portrait Landscape

Portrait Landscape
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Overview
The stored printing feature includes the following job types.

Secure Print

You can temporarily store print jobs secured with a password in the memory or hard disk. Users with the password 
can print them from the operator panel. This feature can be used to print confidential documents. A stored print job 
will be deleted after you print it or at a designated time.

Private Mail Box Print

You can store print jobs secured with a password in the memory or hard disk. Users with the password can print them 
at a more convenient time from the operator panel. This feature can be used to print confidential documents. The 
stored jobs remain in the memory or hard disk until you delete them from the operator panel.

Public Mail Box Print

You can store print jobs without a password in the memory or hard disk. Any user can print them at a more 
convenient time from the operator panel. The stored jobs remain in the memory or hard disk until you delete them 
from the operator panel.

Send confidential data.

Enter the password from 
the operator panel.

Print data.

Confidential

Data is deleted at a 
designated time.

Send data.

Enter the password from 
the operator panel.

Print data. 

Send data.

Print data.
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Proof Print

The collated print job is stored in the memory or hard disk, but a single copy is printed automatically so you can 
check the print result. If you do not have problems with the print result, you can choose to print more copies. This 
prevents large number of misprinted copies from being printed at one time.

The difference between each of the job types are listed below. If you want to set the password for confidentiality, 
store the jobs in the Secure Print or Private Mail Box Print. 

 NOTE: If a print job is too large for the memory available, the printer may display an error message.

Procedures for Printing Stored Print

 NOTE: The stored print feature is available when using the PCL or PS driver.

When you select a job type in the printer driver, the job will be stored in the memory or hard disk until you request 
to print it from the operator panel. The following are procedures for storing and printing jobs.

Storing Print Jobs

To use the stored print feature, you need to select a job type other than Normal Print in the General tab of the 
printer driver. The job will be stored in the memory or hard disk until you request to print it from the operator panel.

 NOTE: Secure Print and Private Mail Box Print require specifying a password for confidentiality.

 NOTE: If a document name is not assigned to your print job in the printer driver, the job's name will be identified using the 
printer's time and date of submission to distinguish it from other jobs you have stored under your name.

Printing the Stored Jobs

 NOTE: You can access Secure Print from the Job Status screen. In this case, select Secure Print, and proceed to step 4.

1 Press the  (Home) button.

2 Select Print Menu.

Job types Password Differences

Secure Print Y • The stored jobs will be deleted at a designated time.

• You cannot specify the quantity of copies from the operator panel. The 
quantity of copies depends on the number you specified on the printer 
driver.

Private Mail Box Print Y • The stored jobs remain until you delete them from the operator panel.

• You can specify the quantity of copies from the operator panel.Public Mail Box Print N

Proof Print N • The print job is set to collate.

• A single copy is printed automatically. 

• The stored jobs remain until you delete them from the operator panel.

• You can specify the quantity of copies from the operator panel.

Send data.

Print the rest of sets 
from the operator panel.

One set is 
printed.

Check if the print result 
is OK.
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3 Select a job types such as Secure Print, Private Mailbox, Public Mailbox, or Proof Print.

A list of user ID appears.

4 Select until the desired user ID appears, and then select that user ID.

 NOTE: Secure Print and Private Mail Box Print require specifying a password for confidentiality. If you select Public Mail 
Box Print or Proof Print, proceed to step 6.

5 Enter the password using the number pad, and then select OK.

For details about specifying the password, see "Specifying your password on the operator panel (Secure 
Print/Private Mail Box Print)."

6 Select  until the desired document appears, and then select that document.

 NOTE: You can select Quantity to specify the number of copies. For Secured Print, Quantity is not available.

7 Select Print.

 NOTE: If you want to keep the data in the memory or hard disk for the time being, clear the Print and Delete check box.

8 Select OK.

The stored job will be printed.

Specifying your password on the operator panel (Secure Print/Private Mail Box Print) 

When you select Secure Print or Private Mailbox from Print Menu, a screen to enter the password 
appears after selecting your user ID. 

Use the number pad to enter the numeric password you specified in the printer driver. The password you entered will 
appear as asterisks (*******) to ensure confidentiality.

If you enter an invalid password, the message Wrong Password Retry appears. Wait 3 seconds, or select Close 
to return to the screen for entering the password.

When you enter a valid password, you have access to all print jobs matching the user ID and password you entered. 
The print jobs matching the password you entered appear on the screen. You can then choose to print or delete jobs 
matching the password you entered. (See "Printing the Stored Jobs" for more information.) 

Deleting Stored Jobs

With Secure Print, a job that has been stored will be deleted after printing or deleted at a designated time entered on 
the operator panel.

For other jobs, these jobs remain stored until you delete them from the operator panel.

Printing from USB Memory
The USB Direct Print feature allows you to print files stored in a USB memory by operating from the operator panel.

 CAUTION: To prevent damage to your printer, do not connect any device other than USB memory to the front USB port of the 
printer.

 CAUTION: Do not remove the USB memory from the front USB port until the printer has finished printing.

 NOTE: If the Function Enabled setting for USB Direct Print is set to On (Password), you need to enter the four 
digit password to use the print function. If the Function Enabled setting for USB Direct Print is set to Off, the print 
function is disabled and the menu is not displayed on the screen. For details, see "Function Enabled."
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The front USB port of the printer is designed for USB 2.0 devices. You must use only an authorized USB memory 
with an A plug type connector. Use only a metal shielded USB memory.

Supported File Formats
Files in the following file formats can be printed directly from a USB memory.

• PDF

• TIFF

• JPEG

Inserting and Removing a USB Memory
You can insert the USB memory before printing or scanning images.

Before removing the USB memory, ensure that the printer is not accessing the USB memory.

 CAUTION: If you remove the USB memory while the printer is accessing, the data in the USB memory or the USB memory 
device itself may be destroyed.

Printing a File in a USB Memory
1 Press the  (Home) button.

2 Insert a USB memory to the front USB port of the printer.

For details about inserting a USB memory, see "Inserting and Removing a USB Memory."

 NOTE: If the USB Drive Detected screen appears, select USB Direct Print, and proceed to step 5.

3 Select Print Menu.

4 Select USB Direct Print.

5 Select until the desired file appears, and then select that file.

 NOTE: Only the following characters are displayed on the touch panel: 
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 0 1 2 3 4 5 6 7 8 9 $ % ’ ‘ - @ {} ~ ! # ( ) & _ ^

6 Select OK.

7 Specify print options such as Output Color, Select Tray, 2 Sided Printing, Multiple-Up, 
Collation, and PDF Password on the USB Direct Print and Options tabs. For details, see "USB Direct Print 
Menu."

8 Press the  (Start) button to begin printing.

A plug type
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 NOTE: Color printing is secured with a password if the Function Enabled setting for USB Direct Print is set to 
On (Color Password). If you set Output Color to Full Color and the Function Enabled setting for 
USB Direct Print to On (Color Password), you will need to enter the four digit password after pressing 
the  (Start) button.

 NOTE: You can print files created using the Scan to USB feature of the printer. Files created by other means or sources 
may not be printed properly.

Printing With Web Services on Devices (WSD)
This section provides information for network printing with WSD, the protocol of Microsoft for Windows Vista, 
Windows 7, Windows 8, Windows Server 2008, Windows Server 2008 R2, and Windows Server 2012.

Adding Roles of Printer Services
When you use Windows Server 2008, Windows Server 2008 R2 or Windows Server 2012, you need to add the roles 
of print services to the Windows Server 2008, Windows Server 2008 R2 or Windows Server 2012 client.

For Windows Server 2008:

1 Click Start→ Administrative Tools→ Server Manager.

2 Select Add Roles from the Action menu.

3 Check the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click Next.

4 Check the Print Server check box, and then click Next.

5 Click Install.

For Windows Server 2008 R2:

1 Click Start→ Administrative Tools→ Server Manager.

2 Select Add Roles from the Action menu.

3 Check the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, and 
then click Next.

4 Click Next.

5 Check the Print Server check box, and then click Next.

6 Click Install.

For Windows Server 2012:

1 Click Server Manager of the Start screen.

2 Select Add Roles and Features from the Manage menu.

3 Click Next on the Before You Begin window → Select installation type on the Installation Type window → Select 
destination server on the Server Selection window in the Add Roles and Features Wizard.

4 Check the Print and Document Services check box on the Server Roles window, and then click Next.

5 Select features on the Features window → Confirm installation selections on the Confirmation window.

6 Click Install.

Printer Setup
You can install your new printer on the network using the Software and Documentation disc that shipped with your 
printer, or using Microsoft Windows’ Add Printer wizard.
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Installing a Printer Driver Using the Add Printer Wizard
1 Click Start→ Devices and Printers (Start→ Control Panel→ Hardware and Sound→ Printers for Windows Vista 

and Windows Server 2008).

For Windows 8 and Windows Server 2012:

Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → Hardware 
and Sound (Hardware for Windows Server 2012)→ Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

 NOTE: In the list of available printers, the WSD printer is displayed in the form of http://IP address/ws/.

 NOTE: If no WSD printer is displayed in the list, enter the printer's IP address manually to create a WSD printer. To enter 
the printer's IP address manually, follow the instructions below.
For Windows Server 2008 R2, to create a WSD printer, you must be a member of Administrators group. 
1. Click The printer that I want isn't listed. 
2. Select Add a printer using a TCP/IP address or hostname and click Next. 
3. Select Web Services Device from Device type.
4. Enter the printer's IP address in the Hostname or IP address text box and click Next.

 NOTE: Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, perform one of 
the following:

• Establish the Internet connection so that Windows Update can scan your computer.

• Add the printer driver to your computer.

5 If prompted, install the printer driver on your computer. If you are prompted for an administrator password or 
confirmation, type the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify print installation.

a Click Start→ Devices and Printers (Start→ Control Panel→ Hardware and Sound→ Printers for Windows 
Vista and Windows Server 2008).

For Windows 8 and Windows Server 2012:

Under Desktop mode, right-click the bottom left corner of the screen, and then click Control Panel → 
Hardware and Sound (Hardware for Windows Server 2012)→ Devices and Printers.

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista and 
Windows Server 2008).

c On the General tab, click Print Test Page. When a test page prints successfully, installation is complete.
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Printing With AirPrint
This section provides information for printing with AirPrint. AirPrint allows you to print through a 
network with iPad (all models), iPhone (3GS or  later), and iPod touch (3rd generation or later) running 
the latest version of iOS. AirPrint also allows you to accomplish basic network printing with Macintosh 
(Mac OS X 10.7 or later) without installing additional drivers.

Setting Up AirPrint on Your Printer
To use AirPrint, Bonjour (mDNS) and IPP protocols are required on your printer. Make sure that Bonjour(mDNS) 
and IPP are set to Enable on the operator panel menu. See "Protocols" for details. Bonjour(mDNS) and IPP can 
also be enabled by clicking Turn on AirPrint from the Dell™ Printer Configuration Web Tool. Follow the procedure 
below to configure the environment settings for AirPrint from the Dell Printer Configuration Web Tool.

1 Ensure that the printer is connected to the network.

2 Launch the Dell Printer Configuration Web Tool by entering the IP address of the printer in your web browser. 
For more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer 
Configuration Web Tool."

3 When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click 
Turn on AirPrint in Enable AirPrint. The printer is ready for AirPrint.

 NOTE: If the Turn on AirPrint button is not active, it means that both Bonjour (mDNS) and IPP are already set to 
Enable on the operator panel menu and the printer is ready for AirPrint.

Printing via AirPrint
The following procedure uses the iPhone running iOS5 as an example.

1 Open your email, photo, web page, or document you want to print.

2 Tap the action icon  .

3 Tap Print.

4 Select your printer and set printer options.

5 Tap Print.

 NOTE: To cancel the printing job, double click the Home button, tap the Print Center icon  . If there are more than one 
job in the queue, select the job you want to cancel, then tap Cancel Printing.

Printing With Google Cloud Print™
This section provides information for Google Cloud Print service with your smart phone, tablet, or any other device. 
By registering the printer to your GoogleTM account, you can use the Google Cloud Print service to print from 
various devices connected to the Internet. You can print documents, photos or e-mails using the Google ChromeTM 
browser or applications such as Google DriveTM on your mobile device. For more information about Google Cloud 
Print, visit the Google web site.

Preparing to Use the Printer with Google Cloud Print
To use Google Cloud Print, you need to prepare the following in advance:

• Connect the printer to a network that has access to the Internet.

 NOTE: Google Cloud Print supports only IPv4 connection.

 NOTE: If the printer is connected to a network that uses a proxy server, you need to specify the settings in Proxy Server 
from the Dell Printer Configuration Web Tool. For more information, see "Proxy Server."

• Acquire a Google account and a GmailTM address.
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• Set Google Cloud Print to Enable from the operator panel menu, or set Google Cloud Print to On from 
the Dell Printer Configuration Web Tool. 

When using the operator panel

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Network appears, and then select Network.

4 Select  until Protocols appears, and then select Protocols.

5 Select  until Google Cloud Print appears, and then select Google Cloud Print.

6 Select Enable.

7 Turn off the printer, and turn it on again to apply the settings.

When using the Dell Printer Configuration Web Tool

1 Launch the Dell Printer Configuration Web Tool by entering IP address of the printer in your web browser. For 
more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer 
Configuration Web Tool."

2 When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click Port 
Settings. In Port Status, select the On check box for Google Cloud Print.

Registering the Printer to Your Google Account
To register the printer to your Google account, follow the procedure below.

1 Launch the Dell Printer Configuration Web Tool by entering IP address of the printer in your web browser. For 
more information, see "Setting Up the Dell Printer Configuration Web Tool" and "Starting the Dell Printer 
Configuration Web Tool."

2 When the Dell Printer Configuration Web Tool opens, go to the pages in the Print Server Settings tab. Click 
Register This Device to Google Cloud Print in Google Cloud Print. A sheet with a URL for the Google Cloud 
Print printer registration web site is printed.

3 From the web browser of your computer, visit the Google web site and sign in with your Google account. Visit the 
Google Cloud Print registration web site by entering the URL on the printout into your web browser. You can also 
visit the site by scanning the QR code with your mobile device.

4 On the Google Cloud Print registration web site, click Finish printer registration.

5 Click Manage your printers. Your printer will be listed in the Printers list and will be ready for use with the Google 
Cloud Print service.

Printing via Google Cloud Print
The printing procedure varies depending on the application or the device you are using. You can see the application 
list that supports Google Cloud Print service on the Google web site.

Printing From an Application on a Mobile Device

The following procedure uses the Google Drive application on an Android mobile device as an example.

1 Install the Google Drive application on your mobile device.

 NOTE: You can download the application from Google Play.

2 Access the Google Drive application from your mobile device and tap  to select the document.

3 Tap  and then tap Print.

4 Select your printer from the list.
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5 Select printer options and then tap Print.

Printing From Google Chrome

The following procedure uses the Google Chrome browser on a Windows PC as an example.

1 Open the Google Chrome browser.

2 Open the web page or e-mail that you want to print.

3 Click  or  (varies depending on the version of the Google Chrome browser) in the top right corner and then 
click Print.

4 Click Change in the Destination area.

5 Choose your printer from the Google Cloud Print area.

6 Click Print.

Printing a Report Page
You can print a variety of settings for your printer including system settings, panel setting, and font list. For details about 
how to print reports or lists, see "Report / List."

Printer Settings
You can change most of the print settings from the application you are printing from. If your printer is attached to 
the network, you can also change settings from the Dell Printer Configuration Web Tool. To launch the Dell 
Printer Configuration Web Tool, type the printer's IP address in your web browser. To find your printer's IP address, 
see "Verifying the IP Settings."

Settings from the application update the default system settings for the printer. Settings from the printer driver only 
apply to the job that you are currently sending to the printer.

If you cannot change a setting from the application, use the operator panel, Tool Box or the Dell Printer 
Configuration Web Tool. Changing a system setting from the operator panel, Tool Box or from the Dell Printer 
Configuration Web Tool makes that setting the user default. 

You can verify the detailed system settings by printing a system settings report. For details about how to print a 
system settings report, see "Report / List."

You can reset settings to their default values from the Tool Box or the operator panel. For details, see "When Using 
the Tool Box" or "When Using the Operator Panel."

Using the Operator Panel to Change the Printer Settings
You can select menu items and corresponding values from the operator panel.

When you first browse through the menus from the operator panel, you see some menu items are highlighted.

These highlighted items are the factory default and original system settings.

 NOTE: Factory defaults may vary for different countries.

When you select a new setting from the operator panel, the item selected is highlighted to identify it as the current 
user default menu setting.

These settings are active until new ones are selected or the factory defaults are restored.

Driver settings may override changes previously made and may require you to change the operator panel defaults.

Using the Dell Printer Configuration Web Tool to Change the Printer Settings
If your printer is connected to the network, you can change the printer settings from your web browser. If you are a 
network administrator, you can clone the system settings of one printer to one or all the printers on the network.
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Type the IP address of your printer in your web browser. Choose Printer Settings from the topics list. From the 
Printer Settings tab, select the System Settings to change the printer settings.

To change the paper type and size, choose Tray Management from the topics list. To change the ColorTrack settings, 
choose Print Volume from the topics list, and then select the Dell ColorTrack tab.

To copy your system settings to another printer on the network, choose Copy Printer Settings from the topics list, 
and then type the other printer's IP address.

If you do not know your printer's IP address, see the system settings report or display the TCP/IP settings. For details 
about how to find your printer's IP address, see "Verifying the IP Settings."
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 NOTE: If the Function Enabled setting for Copy is set to On (Password), you need to enter the four digit password to use 
the copy function. If the Function Enabled setting for Copy is set to Off, the copy function is disabled and the menu is not 
displayed on the screen. For details, see "Function Enabled."

Loading Paper for Copying
The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying. For 
details about loading paper, see "Loading Print Media." For details about setting the paper type and size in the tray, 
see "Print Media Guidelines."

Selecting Paper Tray
After loading the print media for copy output, select the desired paper tray to be used for the copy job.

To select the tray:

1 Press the  (Home) button.

2 Select Copy.

3 Select Select Tray.

4 Select the desired tray, and then select OK.

You can select MPF, Tray1, or Tray2*.

* Tray2 is only available when the optional 550-sheet feeder (tray2) is installed.

Preparing a Document
You can use the document glass or the duplex automatic document feeder (DADF) to load an original document for 
copying, scanning, and sending a fax. You can load up to 50 sheets of 75 g/m2 (20 lb) documents for one job using 
the DADF or one sheet at a time using the document glass.

 WARNING: Avoid loading documents that are smaller than 5.5 inches by 5.5 inches (139.7 mm by 139.7 mm) or larger than 8.5 
inches by 14 inches (215.9 mm by 355.6 mm), different sizes or weights together, or booklets, pamphlets, transparencies, or 
documents having other unusual characteristics in the DADF.

 WARNING: Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, curled 
or rolled paper, torn paper, photographs, or  transparencies cannot be used in the DADF.

 WARNING: Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such as 
glue, ink and correcting fluid in the DADF.

 NOTE: To get the best scan quality, especially for color or gray scale images, use the document glass instead of the DADF.
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Making Copies From the Document Glass
 NOTE: A computer connection is not required for copying. 

 NOTE: Remove any documents from the DADF before copying from the document glass.

 NOTE: Contaminants on the document glass may cause black spots on the copy output. For best results, clean the document 
glass before use. For more information, see "Cleaning the Scanner."

To make a copy from the document glass:

1 Lift and open the document cover. 

2 Place the document facing down on the document glass and align it with the registration guide on the top left 
corner of the glass.

3 Close the document cover.

 NOTE: Leaving the document cover open while copying may affect the copy quality and increase the toner consumption.

 NOTE: If you are copying a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then 
close the cover. If the book or magazine is thicker than 30 mm, start copying with the document cover open.

4 Press the  (Home) button.

To simply make a copy without changing the default copy settings, proceed to step 7.
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5 Select Copy.

To customize the copy settings such as Output Color, Select Tray, and Darken / Lighten, see 
"Setting Copy Options."

To clear the option settings, press the  (All Clear) button.

 NOTE: The copy options automatically return to their default status after the auto clear timer is expired.

6 Enter the number of copies from 1 to 99 using the number pad.

7 Press the  (Start) button to begin copying.

 NOTE: You can cancel a copy job at any time while scanning a document by pressing the  (Cancel) button, or selecting 
Delete.

Making Copies From the DADF
 CAUTION: Do not load more than 50 sheets into the DADF or allow more than 50 sheets to be fed to the document output tray. 

The document output tray should be emptied before it exceeds 50 sheets or your original documents may be damaged.

 NOTE: A computer connection is not required for copying.

1 Load the document(s) facing up on the DADF with top edge of the documents in first. Then adjust the document 
guides to the document size.

 NOTE: Ensure that you use the document stopper before copying a legal-size document.

2 Press the  (Home) button.

To simply make a copy without changing the default copy settings, proceed to step 5.

3 Select Copy.

To customize the copy settings such as Output Color, Select Tray, and Darken / Lighten, see 
"Setting Copy Options."

To clear the option settings, press the  (All Clear) button.

 NOTE: The copy options automatically return to their default status after the auto clear timer is expired.

4 Enter the number of copies from 1 to 99 using the number pad.

5 Press the  (Start) button to begin copying.

 NOTE: You can cancel a copy job at any time while scanning a document by pressing the  (Cancel) button, or selecting 
Delete.
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Setting Copy Options
Set the following options for the current copy job before pressing the (Start) button to begin copying.

For details about making copies, see "Making Copies From the Document Glass" and "Making Copies From the 
DADF."

 NOTE: The copy options automatically return to their default status after the auto clear timer is expired.

Options on each tab are below:

• Copy tab

– Output Color

– Select Tray

– Darken / Lighten

– 2 Sided Copying

• Quality tab

– Original Type

– Sharpness

– Color Saturation

– Auto Exposure

• Output tab

– Collation

– Reduce / Enlarge

– Original Size

– 2-Up

– Margin

Output Color
To select mode for color or black and white copying:

1 Select Output Color.

2 Select Full Color or Black & White, and then select OK. 

 NOTE: Color copy is secured with a password if the Function Enabled setting for Copy is set to On (Color 
Password). If you set Output Color to Full Color and the Function Enabled setting for Copy to On 
(Color Password), you will need to enter the four digit password after pressing the  (Start) button.

Select Tray
To select the tray:

1 Select Select Tray.

2 Select the desired setting, and then select OK.

* Denotes the factory default setting.

MPF The paper is fed from the multipurpose feeder.

Tray1* The paper is fed from tray1.

Tray2 The paper is fed from the optional 550-sheet feeder.
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 NOTE: Tray2 is only available when the optional 550-sheet feeder is installed.

 NOTE: When Any is displayed as the paper size and type in the MPF, you can select the paper size and type from this 
menu. For details, see "Select Tray."

Darken / Lighten
To adjust the contrast to make the copy darker or lighter than the original:

1 Select Darken / Lighten.

2 Select the desired level on the Darken / Lighten bar, and then select OK. 

You can select a contrast level from seven levels between Darken and Lighten. 

Selecting a cell on the left side of the bar makes the document contrast darker, and selecting a cell on the right side 
of the bar makes the document contrast lighter. 

* Denotes the factory default setting.

2 Sided Copying
To make duplex copies with the specified binding position:

1 Select 2 Sided Copying.

2 Select the desired setting, and then select OK.

* Denotes the factory default setting.

When you are using the document glass and it is set to 1 → 2 Sided or 2 → 2 Sided, the display prompts you 
for another page after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select 
Continue or press the  (Start) button.

b If you finish copying, select Print Now.

 NOTE: When you use the DADF to copy both sides of a document, the printed position of the front and back of the document 
may differ if the size in the document size setting and the size of the document do not match. In this case, set Original 
Size to the same size as the document.

Darken +3 Works well with light documents or faint pencil markings.

Darken +2

Darken +1

Normal* Works well with normal typed or printed documents.

Lighten +1 Works well with dark documents.

Lighten +2

Lighten +3

1 → 1 Sided* Select 1 sided or 2 sided and specify binding position for the 2 sided copy.

1 → 2 Sided

2 → 1 Sided

2 → 2 Sided

Long Edge Biding

Short Edge Binding
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Original Type
To select the copy image quality:

1 Select the Quality tab, and then select Original Type.

2 Select the desired setting, and then select OK.

* Denotes the factory default setting.

Sharpness
To adjust the sharpness to make the copy image sharper or softer than the original:

1 Select the Quality tab, and then select Sharpness.

2 Select  the desired setting, and then select OK.

* Denotes the factory default setting.

Color Saturation
To adjust the amount of colors of the copy to make the colors darker or lighter than the original:

1 Select the Quality tab, and then select Color Saturation.

2 Select the desired setting, and then select OK.

* Denotes the factory default setting.

Auto Exposure
To suppress the background of the original to enhance text on the copy:

1 Select the Quality tab, and then select Auto Exposure.

2 Select On, and then select OK. 

Photo & Text* Used for documents with both photos and text.

Text Used for documents with text.

Photo Used for documents with photos.

Sharpen Makes the copy image sharper than the original.

Normal* The color clarity of the image is the same as the original.

Soften Makes the copy image softer than the original.

High Makes the color of the copy more vivid.

Normal* The color saturation is the same as the original.

Low Makes the color of the copy less vivid.
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Collation
To sort the copy output: For example, if you make two copies of three page documents, one complete three page 
document will be printed followed by the second complete document:

 NOTE: You can collate more pages when the optional memory module or hard disk is installed.

1 Select the Output tab, and then select Collation.

2 Select the desired setting, and then select OK.

* Denotes the factory default setting.

When you are using the document glass and it is set to Collated, the display prompts you for another page after 
pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select 
Continue or press the  (Start) button.

b If you finish copying, select Print Now.

Reduce / Enlarge
To reduce or enlarge the size of a copied image from 25 to 400 percent when you copy original documents from the 
document glass or DADF:

 NOTE: When you make a reduced copy, black lines may appear at the bottom of your copy.

1 Select the Output tab, and then select Reduce / Enlarge.

2 Select  the desired setting, and then select OK.

(Inch series)

Auto* Only the documents loaded from DADF are copied in collated order.

Collated Copies in collated order.

Uncollated Does not copy in collated order.

100%*

50%

64% (Ledger→Letter)

78% (Legal→Letter)

129% (Statement→Letter)

154% (Statement→Legal)

200%
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(mm series)

* Denotes the factory default setting.

 NOTE: You can also specify the value in increments of 1 percent from 25 to 400 by selecting  or , or entering a 
value using the number pad.

Original Size
To select the default document size:

1 Select the Output tab, and then select Original Size.

2 Select the desired setting, and then select OK.

(Inch series)

(mm series)

* Denotes the factory default setting.

100%*

50%

70% (A4→A5)

81% (B5→A5)

122% (A5→B5)

141% (A5→A4)

200%

Auto*

Letter (8.5x11")

Folio (8.5x13")

Legal (8.5x14")

A4 (210x297mm)

A5 (148x210mm)

B5 (182x257mm)

Executive (7.3x10.5")

Auto*

A4 (210x297mm)

A5 (148x210mm)

B5 (182x257mm)

Letter (8.5x11")

Folio (8.5x13")

Legal (8.5x14")

Executive (7.3x10.5")
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2-Up
To print two original images to fit onto one sheet of paper:

1 Select the Output tab, and then select 2-Up.

2 Select the desired setting, and then select OK.

* Denotes the factory default setting.

When you are using the document glass and it is set to Auto or Manual, the display prompts you for another 
page after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select 
Continue or press the  (Start) button.

b If you finish copying, select Print Now.

 NOTE: When you use the DADF to copy both sides of a document, the printed position of the front and back of the document 
may differ if the size in the document size setting and the size of the document do not match. In this case, set Original 
Size to the same size as the document.

Off* Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

Manual Prints the original pages onto the one sheet of paper in the size specified in Reduce / Enlarge.

Auto:
Automatically 
reduces the 
pages to fit in 
one page.

Manual:
Reduces the 
pages in the 
custom size 
depending on the 
setting of the 
Reduce / Enlarge 
menu.
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Margin
To specify the margins of the copy:

1 Select the Output tab.

2 Select  until Margin appears, and then select Margin.

3 Select  or , or use the number pad to enter the desired value.

* Denotes the factory default settings.

Using the ID Card Copy
 NOTE: If the Function Enabled setting for ID Card Copy is set to Disable, the ID card copy function is disabled and the 

menu is not displayed on the screen. For details, see "Function Enabled."

You can copy both sides of an ID card on one side of a single sheet of paper in its original size by selecting ID Card 
Copy on the touch panel. This feature helps to show both sides of an ID card in one page in its original size.

To make a copy:

1 Place an ID card facing down on the document glass, and close the document cover.

For details about loading a document, see "Making Copies From the Document Glass."

2 Press the  (Home) button.

3 Select ID Card Copy.

4 Specify the copy settings below as required.

• Output Color

• Select Tray

• Darken / Lighten

• Auto Exposure

• Sharpness

• Color Saturation

For details, see "Setting Copy Options."

5 Press the  (Start) button to begin copying.

After the front side of the ID card is scanned, the display prompts you to turn over the card.

a To scan the back side of the ID card, turn the ID card over and select Continue or press the  (Start) 
button.

b To finish copying, select Print Now.

 NOTE: Color copy is secured with a password if the Function Enabled setting for Copy is set to On (Color 
Password). If you set Output Color to Full Color and the Function Enabled setting for Copy to On 
(Color Password), you will need to enter the four digit password after pressing the  (Start) button.

Top / Bottom 0.2 inch* (4 mm*) Specify the value in increments of 0.1 inch (1 mm).

Available Range: 0.0–2.0 inches (0–50 mm)

Left / Right 0.2 inch* (4 mm*) Specify the value in increments of 0.1 inch (1 mm).

Available Range: 0–2.0 inches (0–50 mm)

Middle 0 inches* (0 mm*) Specify the value in increments of 0.1 inch (1 mm).

Available Range: 0–2.0 inches (0–50 mm)
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Changing the Default Settings
The default settings of the copy menu options such as Output Color, Select Tray, and 
Darken / Lighten can be set to the most frequently used modes. When you copy a document, the specified 
default settings are used unless they are changed by using the operator panel.

To create your own default settings:

1 Press the  (Information) button.

2 Select the Tools tab, and then select Default Settings. 

3 Select Copy Defaults. 

4 Select  until the desired menu item appears, and then select that menu item.

5 Select the desired setting or enter the value, and then select OK.

6 Repeat steps 4 and 5 as needed.

To return to the Information screen, press the (All Clear) button.
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 NOTE: If the Function Enabled setting for a scan function (E-mail, Scan To Network, Scan To Application 
/ WSD Scan, PC Scan, or Scan To USB) is set to On (Password), you need to enter the four digit password to 
use that scan function. If the Function Enabled setting for a scan function is set to On, that scan function is disabled and the 
menu is not displayed on the screen. For details, see "Function Enabled."

Scanning Overview
Use your Dell™ C3765dnf Multifunction Color Laser Printer to turn pictures and text into editable images on your 
computer.

The Dell C3765dnf Multifunction Color Laser Printer provides several ways to scan your document. There are two 
main scanning types. One is operated on the printer side without using the scanner driver, and the other is operated 
on the computer side using a software and the scanner driver. See the available features below to help you find the 
information you need.

• Scanning - With scanner driver

• Scanning - Without scanner driver

Scanning - With scanner driver
• Scan into a graphic software such as PaperPort® (a software for Microsoft® Windows® that is bundled with the 

printer) and Adobe® Photoshop® using a TWAIN driver

(Supporting USB and Network connections for both Microsoft Windows and Apple Macintosh using a graphic 
software)

See "Scanning Using the TWAIN Driver."

• Scan into a Microsoft’s default program such as Windows Photo Gallery and Microsoft Paint, using a Windows 
Image Acquisition (WIA) driver

(Supporting USB and Network (including WSD) connections on Windows only)

See "Scanning Using the Windows Image Acquisition (WIA) Driver."

• Scan and send the scanned document to computer connected via USB cable

(Supporting USB connection for both Microsoft Windows and Apple Macintosh using bundled software tool of 
ScanButton Manager)

Using the feature of Scan to Application on the operator panel of your printer, the scanned image is saved in the 
location of your computer specified with the ScanButton Manager.

See "Scanning From the Operator Panel - Scan to Application."

Scanning - Without scanner driver
• Scan and save the scanned document in a USB memory

See "Scanning to a USB Memory."

• Scan and send the scanned document by e-mail

See "Sending an E-Mail With the Scanned Image."

• Scan and send the scanned document to computer or server connected to network

See "Scanning to a PC or Server via SMB/FTP."



342 Scanning

• Scan and send the scanned document to a computer connected to a network using WSD 
See "Scanning from the Operator Panel - WSD Scan."

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or 
document after you scan it to your computer. For the best results, use these recommended settings.

Scanning above these recommended resolutions may exceed the capabilities of the application. If you require a 
resolution above those recommended in the above table, you should reduce the size of the image by previewing (or 
pre-scan) and cropping before scanning the image.

PaperPort

PaperPort that comes bundled with this printer can be used to manage all your documents. You can organize, search, 
and share all of your scanned documents.

 NOTE: PaperPort is supported only on Windows.

 NOTE: You can use PaperPort's built-in Optical Character Recognition (OCR) software to copy text from scanned documents so 
that you can use and edit the text in any text editing, word processing, or spreadsheet program. The OCR process requires 
textual images scanned at 150–600 dpi and 300 dpi or 600 dpi is recommended for graphics.

If you prefer to use another application, such as Adobe Photoshop, you must assign the application to the printer by 
selecting it from the list of available applications through the Select Software button each time you start scanning. If 
you do not assign an application to the Select Software button, PaperPort is automatically selected when you start 
scanning. See "Printer Utility Software."

Dell ScanCenter

Dell ScanCenter is a PaperPort application that enables you to scan items and send them directly to PaperPort or 
other programs on your computer without first running PaperPort. Dell ScanCenter runs as a separate application 
from the Windows start menu and displays the Dell ScanCenter bar. For more information about using Dell 
ScanCenter, refer to the PaperPort's Help menu.

Icons on the Dell ScanCenter bar represent the programs that are limited to PaperPort and to Dell ScanCenter. To 
scan and send an item to a program, click the program icon and then scan the item. Dell ScanCenter automatically 
starts the selected program when the scan is complete.

Type Resolution

Documents 300 dpi black-and-white or 200 dpi grayscale or color

Documents of poor quality or that contain small text 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100–200 dpi color or 200 dpi grayscale

Images for an inkjet printer 150–300 dpi

Images for a high-resolution printer 300–600 dpi
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Scanning From the Operator Panel - Scan to Application
 NOTE: You must connect your computer via USB for selecting the Scan to Application feature from the operator panel. Network 

connection is not supported.

 NOTE: This feature is supported on both Microsoft Windows and Apple Macintosh.

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Scan Menu.

4 Select Application.

5 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on 
the Scan to Application, Quality and Options tabs. For details, see "Application."

6 Press the  (Start) button to begin scanning the document.

 NOTE: If the following dialog box appears on your computer, select Dell C3765dnf Color MFP ScanButton Manager, and 
then click OK.

For Microsoft Windows:

 NOTE: Once you select Dell C3765dnf Color MFP ScanButton Manager with the Always use this program for this action check 
box selected, Dell C3765dnf Color MFP ScanButton Manager will automatically open without selecting an application.

 NOTE: You must use ScanButton Manager on your computer to change the settings for scanning. For details, see "ScanButton 
Manager."

 NOTE: For Macintosh, the dialog box for selecting a program is not displayed.

ScanButton Manager

The Scan to Application stores the image files in the My Documents folder by default, and then you can 
open them using the related application. Use ScanButton Manager to change the output destination of the 
obtained image files and to select whether to open the image files using the related application.
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For Microsoft Windows:

For Apple Macintosh:

Scanning from the Operator Panel - WSD Scan
If the printer is connected to a computer via network using WSD (Web Services on Devices), you can use the WSD 
Scan function to send scanned images to a computer.

 NOTE: To use WSD Scan, you need to setup connection using WSD.

 NOTE: WSD is supported only on Windows Vista®, Windows 7, and Windows 8.

Printer Setup for WSD Scan
Setup the printer and computer for connection using WSD.

Checking the Printer Setting

To use the WSD Scan function, WSD Scan needs to be set to Enable. See "Protocols"  for details.

Setting Up the Computer

 NOTE: For Windows 8, the computer automatically connects the printer using WSD. There is no need to install the printer 
manually.

For Windows 7:

1 Click Start→ Computer→ Network

2 Right-click the icon for the printer, and then click Install. The printer is connected using WSD.

For Windows Vista:

1 Click Start→ Network

2 Right-click the icon for the printer, and then click Install.

3 Click Continue. The printer is connected using WSD.
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Procedures for WSD Scan
1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Scan Menu.

4 Select WSD Scan.

5 Select  until the desired computer you want to send the scan job to appears, and then select that computer.

6 Select Event, and specify the type of scan. For details, see "WSD Scan."

7 Press the  (Start) button to begin sending the scanned file.

Scanning Using the TWAIN Driver
Your printer supports the TWAIN driver for scanning images that supports Microsoft Windows XP, Windows 
Server® 2003, Windows Vista, Windows Server 2008, Windows Server 2008 R2, Windows 7, Windows 8, Windows 
Server 2012, Apple Mac OS X 10.3.9, Mac OS X 10.4.11, Mac OS X 10.5, Mac OS X 10.6, Mac OS X 10.7, Mac OS X 
10.8 works with various scanners.

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Start the drawing software that supports TWAIN, such as PaperPort for Windows. For using other than PaperPort, 
proceed to step 6.

3 To set the location where to store the scanned images: 

Click Desktop→ Folders.
In the Folders panel, specify a destination folder.

4 To set the scanner: 

Click Desktop→ Scan Settings→ Select...

In the Available Scanners dialog box, select TWAIN: Dell C3765dnf Color MFP, and then click OK.

5 Make sure that Display scanner dialog box check box is selected on the Scan or Get Photo panel.

6 Click Scan to begin scanning process.

The Dell C3765dnf Color MFP TWAIN Driver window appears.
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For Microsoft Windows:

For Apple Macintosh:

 NOTE: The screen image may vary depending on the operating system.

7 In the Basic Scanning tab, set the desired preferences, and click Preview to display the preview image.

 NOTE: The Preview feature cannot be used when performing duplex (two-sided) scanning from the DADF.

8 Adjust the settings in the Image Quality and Image Option tabs.

9 Click Scan to start scanning.

10 When the scanning is completed, click Close to exit the window.

11 Click Done to close the PaperPort - Scan window.
The scanned image is automatically saved in the specified location.

If you want to scan more pages, follow the on-screen instructions to edit the picture after it is copied to your 
computer.
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Scan Settings Tool
You can check the IP address of the printer or set the password using the Scan Settings Tool.

To open the Scan Settings Tool:

For Microsoft Windows:

Click Start→ Program→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Scan Settings Tool.

For Apple Macintosh:

Click Settings on the main scanning window of the Dell C3765dnf Color MFP window. 

IP Address Settings
In the IP Address Settings tab, you can check the IP address that is set for your scanner or change the scanner 
selection.

• IP Address

Enter the IP address.

• Search all scanners from the network (Windows only)

Searches scanners in your network.

• Scanner List

Displays a list of scanners that are detected.

• Search again

Searches the scanners in your network. 

• Search Criteria (Windows only)

Displays the Search Criteria dialog box for setting the search condition.
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Search Criteria Dialog Box (Windows only)

• Subnet Address

Enter the subnet address.

• IPv4: Broadcast Address such as "192.168.1.255"

• IPv6: Multicast Address such as "ff02::1"

• Search Time

Specify a time period for searching a scanner.

• Community Name

Enter the SNMPv1/v2 community name. The default community name is "public."

Password Setting
In the Password Setting tab, you can input the password that is set for your scanner to access from your computer to 
the printer.

For Microsoft Windows:
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For Apple Macintosh:

• Password for Scanner

Enter the password.

Scanning Using the Windows Image Acquisition (WIA) Driver
Your printer also supports the WIA driver for scanning images. WIA is one of the standard components provided by 
Microsoft Windows XP and later operating systems and works with digital cameras and scanners. Unlike the TWAIN 
driver, the WIA driver allows you to scan an image and easily manipulate those images without using additional 
software.

 NOTE: The Windows Image Acquisition (WIA) driver is supported only on Windows.

To scan an image from the drawing software:

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Start the drawing software, such as Microsoft Paint for Windows.

 NOTE: When you use Windows Vista or Windows Server 2008, use Windows Photo Gallery instead of Microsoft Paint.

 NOTE: When using applications that utilize WIA 2.0, such as Windows Fax and Scan on Windows Vista, Windows 7 and 
Windows 8, the Feeder (Scan both sides) option can be selected for duplex (two-sided) scanning.
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3 Click File→ From Scanner or Camera (Paint button→ From scanner or camera for Windows 7, Windows 8, 
Windows Server 2008 R2, and Windows Server 2012).

The Scan using Dell C3765dnf Color MFP (USB or LAN) window appears.

 NOTE: The screen image may vary depending on the operating system.

4 Select your desired type of picture that you want to scan, and click Adjust the quality of the scanned picture to 
display the Advanced Properties dialog box.

5 Select the desired properties including brightness and contrast, and then click OK.

6 Click Scan to start scanning.

7 Click File→ Save to save your scanned document in your desired location on your computer.

To scan an image from Control Panel:

 NOTE: This feature is supported on Microsoft Window Server 2003 and Windows XP only.

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Click Start→ Control Panel→ Printers and Other Hardware→ Scanners and Cameras.

3 Double-click the scanner icon. The Scanner and Camera Wizard launches.
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4 Click Next to display the Choose Scanning Preferences page.

 NOTE: The screen image may vary depending on the operating system.

5 Select your desired type of picture, paper source, and paper size, and click Next.

6 Enter a picture name, select a file format, and specify the desired location to save the scanned document.

7 Click Next to start scanning.

8 Follow the on-screen instructions to edit the picture after it is copied to your computer.

Scanning to a PC or Server via SMB/FTP
 NOTE: This feature does not require a network scan driver.

Overview
The Scan to Network feature allows you to send the scanned documents to a computer or FTP server.

Scan
Using FTP

Using SMB

FTP Server

Computer

Computer
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Required operating systems:

For FTP:

 NOTE: For information on how to configure the FTP service, refer to the manual provided with the software.

 NOTE: Microsoft Windows Server 2003, Windows XP, Windows Vista, Mac OS X 10.3.9/10.4.11/10.5 support IPv4 only.

• Microsoft Windows XP Professional

FTP service of Microsoft Internet Information Services 5.1

• Microsoft Windows Server 2003 Service Pack 1

FTP service of Microsoft Internet Information Services 6.0

• Microsoft Windows Vista
Microsoft Windows Server 2008

FTP service of Microsoft Internet Information Services 7.0

• Microsoft Windows 7
Microsoft Windows Server 2008 R2

FTP service of Microsoft Internet Information Services 7.5

• Microsoft Windows 8
Microsoft Windows Server 2012

FTP service of Microsoft Internet Information Services 8.0

• Mac OS X 10.3.9/10.4.11/10.5/10.6/10.7/10.8

FTP service of Mac OS X

For SMB:

 NOTE: Microsoft Windows Server 2003, Windows XP, Mac OS X 10.3.9/10.4.11/10.5/10.6 support IPv4 only.

• Microsoft Windows XP

• Microsoft Windows Server 2003

• Microsoft Windows Vista

• Microsoft Windows Server 2008

• Microsoft Windows Server 2008 R2

• Microsoft Windows 7

• Microsoft Windows 8

• Microsoft Windows Server 2012

• Mac OS X 10.3.9/10.4.11/10.5/10.6

Procedures

For FTP:

1 "Setting a Destination Using an Address Book"

2 "Sending the Scanned File on the Network"

For SMB:

1 "Setting a Login Name and a Password (SMB Only)"

2 "Creating a Shared Folder (SMB Only)"
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3 "Setting a Destination Using an Address Book"

4 "Sending the Scanned File on the Network"

Setting a Login Name and a Password (SMB Only)
The Scan to Network feature requires a user login account with a valid and non-empty password for authentication. 
Confirm a login user name and password.

For Microsoft Windows:

If you do not use a password for your user login, you need to create a password on your User Login Account with the 
following procedure.

For Windows XP:

1 Click start→ Control Panel→ User Accounts.

2 Click Change an account.

3 Click Create a password and add in a password for your user login account.

For Windows Vista and Windows 7:

1 Click Start→ Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

For Windows Server 2008:

1 Click Start→ Control Panel.

2 Double-click User Accounts.

3 Click Create a password for your account and add in a password for your user login account.

For Windows Server 2008 R2:

1 Click Start→ Control Panel.

2 Select User Accounts.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

For Windows 8 and Windows Server 2012:

1 Point to the top or bottom right corner of the screen, and then click Settings.
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2 Click Change PC settings.

3 Click Users.

4 Click Create a Password and add in a password for your user login account.

For Mac OS X 10.3.9:

1 Click System Preferences→ Accounts.

2 Enter a password for your user login account in Password.

3 Re-enter the password in Verify.

For Mac OS X 10.4.11/10.5/10.6:

1 Click System Preferences→ Accounts.

2 Select Change Password.

3 Enter a password for your user login account in New password.

4 Re-enter the password in Verify.

Creating a Shared Folder (SMB Only)
Create a shared folder to store the scanned document from your printer.

For Microsoft Windows XP Home Edition:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click on the folder, and then select Properties.

The Properties dialog box appears.

3 Click on the Sharing tab, and then select Share this folder on the network.

4 Enter a shared name in the Share name box.

 NOTE: Write down this shared name because you will use this name in the next setting procedure.

5 Select the Allow network users to change my files check box, and click OK.

 NOTE: When the following screen appears, click If you understand the security risks but want to share files without 
running the wizard, click here, then select Just enable file sharing, and then click OK.
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 NOTE: To add sub-folders, create new folders in the shared folder you have created.

For example:
Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

For Microsoft Windows XP Professional:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare) and double-click 
the folder.

2 Select Folder Options from Tools.

3 Click View tab, and then clear the check box of Use simple file sharing (Recommended).

4 Click OK.



356 Scanning

5 Right-click the folder, and then select Properties.

The Properties dialog box appears.

6 Select the Sharing tab, and then select Share this folder.

7 Enter a shared name in the Share name box.

 NOTE: Write down this shared name because you will use this name in the next setting procedure.

8 Click on Permissions to create a write permission for this folder.

9 Click Add.

10 Search user login name by clicking Advanced, or enter the user login name in Enter the object names to select box 
and click Check Names to confirm (Example of user login name, Myself).

11 Click OK.

 NOTE: Do not use Everyone as the user login name.
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12 Click on the user login name that you have just entered. Select Full Control check box. This will grant you 
permission to send the document into this folder.

13 Click OK.

 NOTE: To add sub-folders, create new folders in the shared folder you have created.

For example:
Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

For Windows Vista, Windows Server 2008, Windows Server 2008 R2, Windows 7, Windows 8, Windows Server 2012:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click on the folder, and then select Properties.

The Properties dialog box appears.

3 Click on the Sharing tab, and then select Advanced Sharing.

4 Select the Share this folder check box.
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5 Enter a shared name in the Share name box.

 NOTE: Write down the shared name as you need to use this name in the next setting procedure.

6 Click on Permissions to create a write permission for this folder.

7 Click Add.

8 Search user login name by clicking Advanced, or enter the user login name in Enter the object names to select box 
and click Check Names to confirm (Example of user login name, Myself).

9 Click OK.

10 Click on the user login name that you have just entered. Select Full Control check box. This will grant you 
permission to send the document into this folder.

 NOTE: Do not use Everyone as the user login name.
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11 Click OK.

 NOTE: To add sub-folders, create new folders in the shared folder you have created.

For example:
Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

For Mac OS X 10.3.9/10.4.11:

1 Select Go from the Finder menu, and then click Home.

2 Double-click Public.

3 Create a folder (Example of folder name, MyShare).

4 Open System Preferences, and then click Sharing.

5 Select the Personal File Sharing check box and Windows Sharing check box.

For Mac OS X 10.5/10.6:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared Folder check box.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share Files and folders using SMB and account name check boxes.

7 Click Done.

Setting a Destination Using an Address Book
You can register the connection details for SMB and FTP server in the address book using Dell Printer 
Configuration Web Tool or Address Book Editor.

Before beginning to setup a destination, make sure you have the IP addresses you need such as printer and computer.

Verifying the IP Address Setting of the Printer

To setup the server address book through the network, you will first need to locate the IP address of the printer. To 
find your printer's IP address, see "Verifying the IP Settings."

Locating the IP Address Setting of Your Computer

You can locate the IP address of your computer by the following operations.

1 Click Start→ Run.

For Windows Server 2003/Windows Server 2008/Windows Server 2008 R2:
Click Start→ Run.

For Windows Vista/Windows 7: 
Click Start→ All Programs→ Accessories→ Run.

For Windows 8/Windows Server 2012:
Point to the top or bottom right corner of the screen, and then click Search → Type Run in the search box, click 
Apps, and then click Run.

2 Type cmd in the text field and click OK. A command prompt window will open.

3 Type ipconfig and press Enter.
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4 Write down the IP Address xxx.xxx.xxx.xxx.

Using Dell Printer Configuration Web Tool

1 Open a web browser.

2 Type in the IP address of the printer in the address bar, and press the <Enter> key.

The web page of the printer appears.

 NOTE: For details on how to check the IP address of the printer, see "Verifying the IP Settings."

3 Click Address Book. If a security login dialog box appears, type in the correct User Name and Password.

 NOTE: The default user name is "admin", and the default password is left blank (NULL).

4 Click the Server Address tab, and then click Create of an ID.
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Server Address page appears.

To fill in the fields, enter the information as follows:

(1) Name Enter a friendly name that you want it to appear on the Server address book.

(2) Server Type Select FTP if you store document on a FTP server.
Select SMB if you store documents in a shared folder on your computer. 

(3) Server Address Enter a FTP server name that you have shared out or a server name or IP address of your computer.

• For FTP:
Server name: myhost.example.com
(myhost: host name, example.com: domain name)
IP address: 192.168.1.100

• For SMB:
Server name: myhost
IP address: 192.168.1.100

(4) Share Name Enter the name of the shared folder on the recipient computer. For SMB only.

(5) Server Path Enter the subdirectory path where you want the scanned document to be stored. Ensure that the 
subdirectory path is already created in the shared folder or FTP server.

(6) Server Port 
Number

Enter the Server Port Number. If you are unsure, you can enter the default value of 21 for FTP or 139 for 
SMB.

Available ports are: 
FTP: 21, 5000 - 65535
SMB: 139, 445, 5000 - 65535

(7) Login Name Enter the user account name to allow access to a shared folder on your computer or to a FTP server.

• For FTP: Contact the system administrator.

• For SMB: Windows login name that you have specified in the procedure 1.

(8) Login Password Enter the password corresponding to the above login name.

• For FTP: Contact the system administrator

• For SMB: Empty password is not valid in the Network (Computer) feature. Ensure that you have a valid 
password for the user login account. (See "Setting a Login Name and a Password (SMB Only)" for details 
on how to add a password in your user login account.)

(9) Re-enter 
Password

Re-enter your password.

1

2

3
4
5
6

7
8
9
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Using Address Book Editor

1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Address Book 
Editor.

2 Click Tool→ New (Device Address Book)→ Server.

For Microsoft Windows:

For Apple Macintosh:

Server Address dialog box appears.
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For Microsoft Windows:

For Apple Macintosh:

To fill in the fields, enter the information as follows:

(1) Name Enter a friendly name that you want it to appear on the Server address book.

(2) Server Type Select Computer if you store documents in a shared folder on your computer. 
Select Server if you store documents on a FTP server.

(3) Server Name/IP 
Address

Enter a server name or IP address of your computer or the FTP server name that you have shared out.

The following are examples:

• For Computer:

Server name: myhost

IP address: 192.168.1.100

• For Server:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.168.1.100

(4) Share Name Enter the name of the shared folder on the recipient computer. For SMB only.

1
2

3

4

5

6

7

8

9

1
2

3
4
5
6
7
8
9
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Sending the Scanned File on the Network
1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Scan Menu.

4 Select Network.

5 Select  until the desired address appears and then select that address.

6 Select OK.

7 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on 
the Scan to Network, Quality and Options tabs. For details, see "File Format."

8 Press the  (Start) button to begin sending the scanned file.

Scanning to a USB Memory
The Scan to USB Memory feature allows you to store scanned image directly to a USB memory attached to the 
printer without using software.

Types of a USB Memory
You can use a USB memory with the following interfaces:

• USB 1.1

• USB 2.0

The USB memory must be formatted in FAT file systems (FAT16, FAT32, or VFAT) before inserting the memory 
device into the front USB port of the printer.

(5) Path Enter the subdirectory path where you want the scanned document to be stored. Ensure that the 
subdirectory path is already created in the shared folder or FTP server.

(6) Login Name Enter the user account name to allow access to a shared folder on your computer or to a FTP server.

• For Computer: Windows login name that you have specified in the procedure 1.

• For Server: Contact the system administrator.

(7) Login Password Enter the password corresponding to the above login name.

• For Computer: Empty password is not valid in the Network(Computer) feature. Ensure that you 
have a valid password for the user login account. (See "Setting a Login Name and a Password (SMB Only)" 
for details on how to add a password in your user login account.)

• For Server: Contact the system administrator.

(8) Confirm Login 
Password

Re-enter your password.

(9) Port Number Enter the Server Port Number. If you are unsure, you can enter the default value of 139 for Computer and 
21 for FTP server.

Available ports are: 
For Computer: 139, 445, 5000 - 65535
For Server: 21, 5000 - 65535



Scanning 365

 NOTE: If the USB memory is formatted in a file system other than above, the printer may not recognize that the USB memory is 
attached.

 NOTE: A USB memory with authentication feature and some brands of USB memories cannot be used with this printer.

Procedures
To store the scanned images to a USB memory:

 NOTE: If you insert a USB memory to the front USB port first, the USB Drive Detected screen may appear. In this case, select 
Scan to USB, and proceed to step 6.

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Insert a USB memory into the front USB port of the printer. See "Inserting and Removing a USB Memory" for 
more details.

4 Select Scan Menu.

5 Select USB.

6 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on 
the Scan to USB, Quality and Options tabs. For details, see "File Format."

You can also specify the folder to save the scanned image. For details, see "Specifying a Folder to Save the Scanned 
Image."

7 Press the  (Start) button to begin scanning the document.

8 Remove the USB memory from the printer. See "Inserting and Removing a USB Memory" for more details.

Specifying a Folder to Save the Scanned Image
To save the scanned image to a folder in the USB memory, specify the folder before executing the scan job.

1 Select Change Folder on the Scan to USB tab.

2 Select a folder to save the scanned image.

 NOTE: The default saving location is the root directory of the USB memory.

 NOTE: You cannot directly enter a folder path using the numeric keypad.

 NOTE: You can select any folder in the USB memory but cannot create a new folder in this step. You should always create 
a new folder before connecting the memory to the printer. If you want the printer to automatically create a folder and then 
save the scanned image to that folder, set Create Folder to On. For details, see "Create Folder."

If the name of the scanned image has already existed in the folder, the printer automatically generate a new file 
name to save the data.
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Sending an E-Mail With the Scanned Image
To send an e-mail attached with the scanned image from your printer, follow the steps below:

• Set E-Mail Alert

• Register a user

• Start to send e-mail with the scanned file

Setting an E-Mail Alert
1 From the Dell Printer Configuration Web Tool, click E-Mail Alert.

The E-Mail Server Settings page appears.

2 Specify the settings for E-Mail Alert as follows:

Primary SMTP Gateway: Enter the IP address of the e-mail server.

E-Mail Send Authentication: Specify Invalid to enable the e-mail server.

 NOTE: If an error message including 016-506 or 016-764 is displayed, contact your server administrator for the 
settings for E-Mail Send Authentication.

3 Click Apply New Settings.
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Registering a New E-Mail Address
1 From the Dell Printer Configuration Web Tool, click Address Book, and then click the E-Mail Address tab.

2 Click Create.

The E-Mail Address page for registering a new e-mail address appears.

3 Enter the following:

• Name

• Address

4 Click Apply New Settings.

Sending an E-mail With the Scanned File
1 Press the  (Home) button.

2 Select Email.

3 Specify a recipient from the following, and then select OK:

New Recipient: Enter an e-mail address directly.

Address Book: Select from the following types of address books: 

• Machine Address Book - Individuals: Select an e-mail address registered in the address book.

• Machine Address Book - Groups: Select a group of e-mails registered in the address book.

• Search Network Address Book: Search an e-mail address from the LDAP server address book.

Select the recipient you specified from the New Recipient to remove or edit the recipient.

Select the recipient you specified from the Address Book to remove or see details of the recipient. You can also 
change the email to Bcc.

 NOTE: For more information on address book and server address book, see "Address Books."

 NOTE: For details about Search Network Address Book, see "Using the Server Address Book and Server 
Phone Book."

 NOTE: The e-mail addresses needs to be registered before you can select Address Book.
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4 Specify scan options such as Output Color, Resolution, 2 Sided Scanning, and File Format on 
the Quality and Options tabs. For details, see "File Format."

5 Press the  (Start) button to begin sending e-mail.
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 NOTE: If the Function Enabled setting for Fax is set to On (Password), you need to enter the four digit password to use 
the fax function. If the Function Enabled setting for Fax is set to On, the fax function is disabled and the menu is not displayed 
on the touch panel. For details, see "Function Enabled."

 NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu.

Specifying the Fax Initial Settings Using the Easy Setup Navigator
You can specify the country, line type, tone/pulse, receive mode, DRPD pattern, fax header name, and fax number.

1 Insert the Software and Documentation disc provided with the printer in your computer. The Easy Setup 
Navigator file launches automatically.

2 Click Advanced Tools on the Easy Setup Navigator window.
The Advanced Tools window appears.

3 Click Fax Configuration.

4 Follow the instructions displayed on the screen.

Available settings are:

• Country

• Line Type

• Tone/Pulse

• Receive Mode

• DRPD Pattern 
(This setting is available only when a distinctive ring service is installed on your telephone line by your 
telephone company.)

• FAX Header Name

• FAX Number

 NOTE: To make initial settings from the printer operator panel, see "Setting Your Country."
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Setting Your Country
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Fax Line Settings.

5 Select  until Country appears, and then select Country.

6 Select the country where the printer is used, and then select OK.

The printer must be rebooted after you set the country settings. When a screen prompting you to reboot the 
printer, select Start. After the reboot, the Main Home screen is displayed on the touch panel.

 NOTE: When you configure the country setting, the information, which is registered to the printer, is initialized.

Setting the Printer ID
In most countries, you are required by law to indicate your fax number on any fax you send. The printer ID, 
containing your telephone number and name or company name, will be printed at the top of each page sent from 
your printer.

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings. 

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Fax Line Settings.

5 Select  until Fax Number appears, and then select Fax Number.

6 Enter your fax number using the number pad, and then select OK.

 NOTE: If you make a mistake while entering numbers, press the  (Delete) button to delete the last digit.

7 Select  until Fax Header Name appears, and then select Fax Header Name.

8 Enter your name or company name using the keyboard, and then select OK.

For details on how to use the keyboard to enter alphanumeric characters, see "Using the Keyboard Displayed on the 
Touch Panel."

To return to the Information screen, press the  (All Clear) button.

Setting the Time and Date
 NOTE: It may be necessary to reset the correct time and date if loss of power to the printer occurs.

To set the time and date:

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings. 

3 Select  until System Settings appears, and then select System Settings.

4 Select  until General appears, and then select General.

5 Select  until Date & Time appears, and then select Date & Time.

6 Select Time Zone.

7 Select  until the desired geographic region appears, and then select that region.

8 Select  until the desired time zone appears, and then select that time zone.

9 Select OK.
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10 Select Date.

11 Select  or  or enter the date using the number pad.

12 Select Time.

13 Enter the time using the number pad.

14 Select OK.

To return to the Information screen, press the  (All Clear) button.

 NOTE: The printer beeps and does not allow you to proceed to the next step if a wrong number is entered.

Changing the Clock Mode
You can set the current time using either the 12-hour or the 24-hour format.

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings. 

3 Select  until System Settings appears, and then select System Settings.

4 Select  until General appears, and then select General.

5 Select  until Date & Time appears, and then select Date & Time.

6 Select Time.

7 Select 12 Hour or 24 Hour, and then select OK.

To return to the Information screen, press the  (All Clear) button.

Setting Sounds

Speaker Volume
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Fax Line Settings.

5 Select  until Line Monitor appears, and then select Line Monitor.

6 Select the desired volume, and then select OK.

7 Turn off the printer, and turn it on again to apply the settings.

Ringer Volume
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Incoming Defaults.

5 Select  until Ring Tone Volume appears, and then select Ring Tone Volume.

6 Select the desired volume, and then select OK.

7 Turn off the printer, and turn it on again to apply the settings.
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Specifying the Fax Settings Options

Changing the Fax Settings Options
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select the desired menu.

5 Select the desired setting or enter a value.

To enter a value, select  or , or use the number pad or the keyboard.

6 Select OK.

If necessary , repeat steps 4 through 6.

To return to the Information screen, press the  (All Clear) button.

Available Fax Settings Options
You can use the following settings options for configuring the fax system:

Option Description

Fax Line Settings Fax Number Specifies the fax number of the printer, which will be printed on 
the header of faxes. This feature is available when you set Fax 
Header to On. The number specified in Fax Number is used in 
the printer ID.

Country You can select the country where the printer is used.

You can change this setting when:

• No jobs in operation

• No fax jobs waiting in the memory

Fax Header Name Specifies the sender’s name to be printed on the header of faxes.

Line Type You can select the default line type.
• PSTN
• PBX

Line Monitor Sets the volume of the line monitor, which audibly monitors a 
transmission through the internal speaker until a connection is 
made.

DRPD Pattern Before using the Distinctive Ring Pattern Detection (DRPD) 
option, distinctive ring service must be installed on your telephone 
line by the telephone company. After the telephone company has 
provided a separate number for faxing with a distinctive ring 
pattern, configure the fax setup to monitor for that specific ring 
pattern.
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Incoming 
Defaults

Receive Mode You can select the default fax receiving mode. 
• Telephone (manual receive mode): Automatic fax reception is 

turned off. You can receive a fax by picking up the handset of the 
external telephone and then pressing the remote receive code, or 
by selecting Manual Receive in On Hook and then 
pressing the  (Start) button. For details about Manual 
Receive, see "Receiving a Fax Manually in the Telephone 
Mode."

• Fax: (automatic receive mode) 
• Telephone / Fax: When the printer receives an incoming fax, the 

external telephone rings for the time specified in Auto Rec 
Fax/Tel, and then the printer automatically receives a fax. If 
an incoming call is not a fax, the printer beeps from the internal 
speaker indicating that the call is a telephone call. 

• Ans Machine/Fax: The printer can share a telephone line with an 
answering machine. In this mode, the printer will monitor the fax 
signal and pick up the line if there are fax tones. If the phone 
communication is using serial transmission in your country (such 
as Germany, Sweden, Denmark, Austria, Belgium, Italy, France 
and Switzerland), this mode is not supported.

• DRPD: Before using the Distinctive Ring Pattern Detection 
(DRPD) option, distinctive ring service must be installed on your 
telephone line by the telephone company. After the telephone 
company has provided a separate number for faxing with a 
distinctive ring pattern, configure the fax setup to monitor for 
that specific ring pattern.

Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming 
call is a telephone call through the internal speaker when 
Receive Mode is set to Telephone / Fax.

Auto Receive 
Setup

Auto Receive Fax Sets the interval at which the printer goes into the fax receive 
mode after receiving an incoming call. The interval can be 
specified within the range of 0 to 255 seconds. The default is 0 
second.

Auto Receive 
Tel/Fax

Sets the interval at which the printer goes into the fax receive 
mode after the external telephone receives an incoming call. The 
interval can be specified within the range of 0 to 255 seconds. The 
default is 6 seconds.

Auto Receive 
Ans/Fax

Sets the interval at which the printer goes into the fax receive 
mode after the external answering machine receives an incoming 
call. The interval can be specified within the range of 0 to 255 
seconds. The default is 21 seconds.

Junk Fax Setup You can reject faxes sent from unwanted stations. The system only 
accepts faxes from the remote stations registered in the speed dial. 
This feature is useful for blocking any unwanted faxes.

Select Off to turn the feature off. Anybody can send you a fax.

Select On to turn the feature on.

Secure Receive You can specify whether to require a four digit password to receive 
faxes, and to set or change the password.

Option Description
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Sent Fax Fwd You can set your printer to forward incoming faxes to another fax 
number, or forward them to an e-mail address. When a fax arrives 
at your printer, it is stored in the memory. Then, the printer dials 
the fax number you have specified in Forwarding Number 
or sends an e-mail to the address you have specified in 
Forwarding E-mail Address 1-5.

To forward to a fax number, you need to register a fax number on 
Forwarding Number. To forward to an e-mail address, you 
need to register information on E-mail Alert and 
Forwarding E-mail Address. For information on e-
mail alert, see "E-Mail Alert" and on forwarding number and e-
mail address, see "Fax Settings."

Select Off not to forward incoming faxes.

Select Forward to forward incoming faxes without printing. If 
an error occurs during forwarding a received fax, the printer prints 
the fax.

Select Print and Forward to forward and print incoming 
faxes.

Select Print and E-mail to print and forward incoming 
faxes to e-mail.

2 Sided Print You can set whether to make duplex print when you print faxes.

Select Off to print faxes on one side of a sheet of paper.

Select On to print faxes on both sides of a sheet of paper.

Remote Receive You can receive a fax by pressing the remote receive code on the 
external telephone after picking up the handset of the telephone. 
When you set Remote receive to On, specify a two digit 
remote receive code in Remote Receive Tone. 

Discard Size When receiving a document as long as or longer than the paper 
installed in your printer, you can set the printer to discard any 
excess at the bottom of the page. If the received page is outside 
the margin you set, it will print on two sheets of paper at the 
actual size. When the document is within the margin and 
Discard Size is set to Auto Reduction, the printer 
reduces the document to fit it onto the appropriate sized paper 
and discard does not occur. If Discard Size is set to other 
than Auto Reduction, the data within the margin will be 
discarded.

Transmission 
Defaults

Auto Redial Setup Resend Delay You can specify the interval between transmission attempts within 
the range of 3 to 255 seconds. The default is 8 seconds.

Redial Attempts You can specify the number of redial attempts to make when the 
destination fax number is busy, within the range of 0 to 13. If you 
enter 0, the printer will not redial.

Interval of Redial Your printer can automatically redial a remote fax machine if it 
was busy. Intervals from 1–15 minutes can be entered.

Tone/Pulse You can select the dialing type.
• Tone
• Pulse(10PPS)
• Pulse(20PPS)

Option Description
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 NOTE: Prefix Dial supports only the environment where you send a fax to the external line number. To use Prefix Dial, you must 
do the following from the operator panel. 

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Fax Line Settings.

5 Select  until Line Type appears, and then select Line Type.

6 Select PBX, and then OK.

7 Select .

8 Select Transmission Defaults.

9 Select  until Prefix Dial appears, and then select Prefix Dial.

10 Select On.

11 Select the Prefix Dial Number box.

12 Enter a prefix number using the number pad, and then select OK. The characters you can use for a prefix number 
are 0–9, *, and #. The maximum number of characters for a prefix number is five.

Prefix Dial You can specify whether or not to set a prefix dial number. When 
you set Prefix Dial to On, the number set in Prefix 
Dial Number dials before any auto dial number is started. It is 
useful for accessing the Private Automatic Branch Exchange 
(PBX). You can set a prefix dial number of up to five digits. 

Fax Cover Page You can set whether to attach a cover page to faxes when sending 
faxes.

Fax Header Prints the sender’s information on the header of faxes. 

Select Off to turn this feature off. 

Select On to turn this feature on.

Note that if United States is selected for the setting of Country, 
this option does not appear on the menu. The setting is fixed to 
On and cannot be changed.

For information on the country setting, see "Setting Your 
Country."

ECM You can set whether to enable or disable the ECM (Error 
Correction Mode).

Modem Speed You can set the modem speed.

Display Manual 
Fax Recipients

You can set whether to display the fax number of the recipient on 
the Sending Fax screen when manually sending a fax. 

Fax Reports Fax Activity You can set whether to automatically print a fax activity report 
after every 50 incoming and outgoing fax communications.

Fax Transmit You can set whether to print a transmission result after a fax 
transmission.

Fax Broadcast You can set whether to print a transmission result after a fax 
transmission to multiple locations.

Fax Protocol You can set whether to print the protocol monitor report after a fax 
transmission to monitor fax protocol problems.

Option Description
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13 Turn off the printer, and turn it on again to apply the settings.

Advanced Fax Settings

 NOTE: The advanced fax settings are only meant for advanced users. Incorrect settings may damage the printer.

If you are experiencing fax send or receive errors, there is an advanced fax settings menu which you can access and 
change the settings accordingly.

To enter the Diagnostic Menu (Customer Mode), follow the instructions.

1 Turn off the printer.

2 Disconnect all network, phone line, and USB cables from the printer.

3 Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.

After all the advanced fax settings have been made, you will need to turn off and on the printer for the new settings 
to be effective.

Fax Data Encoding Method

Some of the legacy fax devices do not support the Joint Bi-level Image Experts Group (JBIG) data encoding method. 
You may experience fax send or receive errors due to this data encoding method. You can disable the JBIG and select 
the Modified Huffman (MH), Modified Read (MR), or Modified Modified Read (MMR) encoding with the 
following instructions.

You can change the modem transmission encoding with the following instructions.

1 Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.

2 Press  button to select Fax/Scanner Diag, and then select OK.

3 Press  button until Parameter appears, and then select OK.

4 Ensure that FAX Parameter appears, and then select OK.

5 Press  button until G3M TX Coding appears, and then select OK.

6 Press  button until the desired encoding appears, and then select OK.

You can select MH, MR, or MMR.

You can change the modem receive encoding with the following instructions.

1 Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.

2 Press  button to select Fax/Scanner Diag, and then select OK.

3 Press  button until Parameter appears, and then select OK.

4 Ensure that FAX Parameter appears, and then select OK.

5 Press  button until G3M RX Coding appears, and then select OK.

6 Press  button until the desired encoding appears, and then select OK.

You can select MH, MR, or MMR.

Diagnosing the Fax Connection

You can diagnose the Fax connection using the FAX Line Diagnosis feature that can detect the abnormalities of 
telephone line connection.

1 Turn on the printer while holding down the 8 and 2 buttons on the number pad to start in Customer Mode.

2 Press  button to select Fax/Scanner Diag, and then select OK.

3 Press  button until FAX Test appears, and then select OK.

4 When the message Check FAX Connection appears, select OK.
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5 When the message Ready to Start appears, select OK to start diagnosing the FAX connection.

One of the following diagnosing result is displayed.

Sending a Fax
You can fax data from your printer. You can also directly fax data transferred from the computer running a 
Microsoft® Windows® operating system.

Loading an Original Document
You can use the DADF or the document glass to load an original document for faxing. Using the DADF, you can load 
up to 50 sheets of 75 g/m2 (20 lb) paper at a time. Using the document glass, you can load one sheet at a time.

 NOTE: To get the best scan quality, especially for gray scale images, use the document glass instead of the DADF.

To fax a document using the Duplex Automatic Document Feeder (DADF):

1 Place the document(s) facing up on the DADF with the top edge of the documents in first. Then adjust the 
document guides to the correct document size.

2 Adjust the document resolution. (For details, see "Adjusting the Document Resolution.")

Diagnosing result Description

Connection not Detected

Please Reconnect Telephone Line

The telephone line cord is not connected. Make sure that the 
telephone line cord is securely connected.

Cable Connected Wrongly

Reconnect Telephone Line from Wall 
Jack to Line Connection

The telephone line cord is connected to the wrong connector. Make 
sure that the telephone line cord is connected at one end to the wall 
jack connector ( ) of your printer and at the other end to an active 
wall jack. If you use a telephone or answering machine, connect to the 
phone connector ( ).

Fax Connection OK

Please Check Setting of Tone/Pulse 
in Admin Menu after Restart Printer

The telephone line cord is properly connected. Check the Tone/Pulse 
setting. For information on Tone/Pulse setting, see "Available Fax 
Settings Options."
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To fax a document from the document glass:

1 Open the document cover.

2 Place the document facing down on the document glass and align it with the registration guide on the top left 
corner of the glass.

3 Adjust the document resolution. (For details, see "Adjusting the Document Resolution.")

4 Close the document cover.

 NOTE: Ensure that no document is in the DADF. If any document is detected in the DADF, it takes priority over the 
document on the document glass. 

 NOTE: If you are faxing a page from a book or magazine, lift the cover until its hinges are caught by the stopper and then 
close the cover. If the book or magazine is thicker than 30 mm, start faxing with the cover open.

Adjusting the Document Resolution
You can improve the quality of the fax document by adjusting the resolution, especially for documents with low 
image quality or documents containing photographic images.

1 Press the  (Home) button.

2 Select Fax.
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3 Select Resolution.

4 Select  the desired setting, and then select OK.

* Denotes the factory default setting.

 NOTE: Faxes scanned in the Super Fine resolution transmit at the highest resolution supported by the receiving device.

Adjusting the Document Contrast
You can adjust the contrast of the fax document to be lighter or darker than the original.

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Fax.

4 Select Darken/Lighten.

5 Select the desired level on the Darken/Lighten bar, and then select OK. 

You can select a contrast level from seven levels between Darken and Lighten.

Selecting a cell on the left side of the bar makes the document contrast darker, and  selecting a cell on the right side 
of the bar makes the document contrast lighter.

* Denotes the factory default setting.

Sending a Fax From Memory
1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

Standard* Used for documents with normal sized characters.

Fine Used for documents containing small characters or thin lines or documents printed using a 
dot-matrix printer.

Super Fine Used for documents containing extremely fine detail. The super fine mode is enabled only if 
the remote machine also supports the Super Fine resolution. See the note below.

Photo Used for documents containing photographic images.

Darken3 Works well with light documents or faint pencil markings.

Darken2

Darken1

Normal* Works well with standard typed or printed documents.

Lighten1 Works well with dark documents.

Lighten2

Lighten3
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3 Select Fax.

4 Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For 
adjusting the contrast, see "Adjusting the Document Contrast.")

5 To select a fax number, do one of the followings :

• Select , and then select one of the following:

Machine Address Book - Individuals - Select an individual fax number and then select OK. 

Machine Address Book - Groups - Select a group dial number and then select OK. 

Search Network Address Book - Search and select a fax number from the LDAP server and then 
select OK. 

 NOTE: For more information on address book and server address book, see "Address Books."

 NOTE: For details about Search Network Address Book, see "Using the Server Address Book and Server 
Phone Book."

 NOTE: The fax number needs to be registered before you can select Address Book.

• Select .

Enter the speed dial number using the number pad, and then select .

6 Press the  (Start) button to scan data.

When the document is loaded on the document glass, the display prompts you for another page. 

If you want to place a new document, replace the document with a new document, and then press the  (Start) 
button.

When you have finished loading documents, select Send Now.

The printer starts dialing the number, and then sends the fax when the remote fax machine is ready.

 NOTE: You can cancel the fax job at any time while sending the fax by pressing the  (Cancel) button.

 NOTE: Pressing the  (Start) button does not start sending a fax when the available time is set or the Fax function is 
locked. (For details, see "Set Available Time" for the Available time and "Function Enabled" for the Fax function.)

Sending a Fax Manually
1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For 
adjusting the contrast, see "Adjusting the Document Contrast.")

5 Select On Hook.

6 Enter the fax number of the recipient using the number pad.

You can also select the recipient by using speed dial number or address book. (For details, see "Automatic 
Redialing.")

7 Press the  (Start) button to begin sending the fax.

 NOTE: You can cancel the fax job at any time while sending the fax by pressing the  (Cancel) button.
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 NOTE: Pressing the  (Start) button does not start sending a fax when the available time is set or the Fax function is 
locked. (For details, see "Set Available Time" for the Available time and "Function Enabled" for the Fax function.)

Confirming Transmissions
When the last page of your document has been sent successfully, the printer beeps and returns to the standby mode.

If something goes wrong while sending your fax, an error message appears on the display.

If you receive an error message, press the  (Cancel) button to clear the message and try to send the document 
again.

You can set your printer to print a confirmation report automatically after each fax transmission. For further details, 
see "Printing a Report."

Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial 
the number every minute based on the number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Available Fax Settings Options."

 NOTE: The printer will not automatically redial a number that was busy when the number was manually entered.

Sending a Delayed Fax
The Delayed Start mode can be used to save scanned documents for transmission at a specified time to take 
advantage of lower long distance rates.

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For 
adjusting the contrast, see "Adjusting the Document Contrast.")

5 Select the Options tab, and then select Delayed Send.

6 Select On.

7 Enter the start time using the number pad, and then select OK.

8 Select the Fax tab, and then enter the fax number of the recipient using the number pad.

You can also select the recipient by using speed dial number or address book. (For details, see "Automatic 
Redialing.")

9 Press the  (Start) button to scan data.

Once Delayed Start mode is activated, your printer stores all of the documents to be faxed into its memory and 
sends them at the specified time. After faxing in the Delayed Start mode is complete, the data in the memory is 
cleared.

 NOTE: If you turn off and on the printer, the stored documents are sent as soon as the printer is activated.

 NOTE: If the specified start time overlaps with the time periods for the available time or the Fax function, the printer cannot 
send the delayed fax at the specified time. (For details, see "Set Available Time" for the Available time and "Function 
Enabled" for the Fax function.)
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Sending a Fax from the Driver (Direct Fax)
You can send a fax directly from your computer by using the driver.

 NOTE: Only black and white faxes can be sent using Direct Fax.

 NOTE: If the specified start time overlaps with the time periods for the available time or the Fax function, the printer cannot send 
the delayed fax at the specified time. (For details, see "Set Available Time" for the Available time and "Function Enabled" for the 
Fax function.)

Example

Procedure

 NOTE: The names of the dialog boxes and the buttons may be different from those given in the following procedure depending 
on the application you are using. 

 NOTE: To use this feature, you must install the fax driver. (For details, see "Inserting the Software and Documentation Disc" for 
Windows or "Installing the Drivers and Software" for Macintosh.)

1 Open the file you want to send by fax.

2 Open the print dialog box from the application, and then select Dell C3765dnf Color MFP Fax.

3 Click Preferences in Windows, or select FAX Setting in Macintosh.

For Microsoft Windows:

Send data via the 
Dell C3765dnf Color MFP Fax driver

Send fax

Receiving machine (fax 
machine/multifunction 
printer)

Sending machine (Dell™ 
C3765dnf Multifunction 
Color Laser Printer)
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For Apple Macintosh:

4 When the setting dialog box appears, specify the following settings.

 NOTE: The settings done here are only applied to a single fax job.

For Microsoft Windows:

For Apple Macintosh:
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a. Transmission image quality

Purpose: 

To set the output quality.

Values:

* Denotes the factory default setting.

 NOTE: Faxes printed in the Super-high image quality by Direct Fax driver transmits at the highest resolution supported by the 
receiving device.

b. Transmission report

Purpose:

To specify whether to print a fax transmission result.

Values:

* Denotes the factory default setting.

c. Fax Cover Page

Purpose:

To specify whether to attach a cover page to your fax.

Values:

* Denotes the factory default setting.

Sender

Purpose:

To specify whether to print the sender’s name on the fax cover page.

Values:

* Denotes the factory default setting.

Standard For documents with normal sized characters.

High Quality* For documents containing small characters or thin lines or documents printed using a dot-
matrix printer.

Super-high image quality For documents containing extremely fine detail. The super fine mode is enabled only if the 
remote machine also supports Super Fine resolution. See the notes below.

Output regularly Prints a transmission result after every fax transmission.

Output for non-transmission* Prints a transmission result only when an error occurs.

Do not output Does not print fax transmission results.

According to Printer Settings Determines whether to attach a cover page to your fax depending on the setting you specify in 
Fax Cover Page on the operator panel.

Attach Attaches a cover page to your fax.

None* Does not attach a cover page to your fax.

According to Printer Settings* Determines whether or not to print the sender’s name on the fax cover page based on the 
printer settings.

Enter a sender name Allows you to enter a sender’s name that will be printed on the fax cover page in Sender 
Name.
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Sender Name

Purpose:

To enter a sender’s name that will be printed on the fax cover page.

The sender’s name can be up to 30 characters. If it exceeds 30 characters, only the first 30 characters will be printed.

5 For Windows, click OK to close the Printing Preferences dialog box, and then click Print.

For Macintosh, click Print.

The Set/Check Fax Transmission dialog box appears.

For Microsoft Windows:

For Apple Macintosh:
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6 Enter the destination for the recipient. The following procedure is for entering the destination. For details on how 
to enter the destination, please refer to the Help file for the driver.

a Enter the name and fax number directly.

b Select a fax number from a phone book.

• Look Up Phone Book: Displays a list of fax numbers that are saved in the file specified for My Phone 
Book file.

• Look Up Device Data: Displays a list of fax numbers that are saved in the Phone Book on the Dell 
C3765dnf Multifunction Color Laser Printer.

• Import and add file (Windows only): Allows you to select a source file such as a CSV file, WAB file, 
MAPI, or a LDAP server. (For details on LDAP server, see "LDAP Server" and "Fax Server Address Book.")

 NOTE: Enter the password in the Password field in the Authorization area before sending a fax if the fax function is locked 
with a password.

To lock the fax function with a password:

 NOTE: To lock the fax function from Function Enabled, you must first set Panel Lock to On. For details, see 
"Panel Lock."

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Secure Settings appears, and then select Secure Settings.

4 Select Function Enabled.

5 Select  until Fax appears, and then select Fax.

6 Select On (Password).

7 Enter a four digit password, and then select OK.

8 Turn off the printer, and turn it on again to apply the settings.

To check whether the fax has been sent:

Print a job history report. For details about how to print a job history report, see "Report / List."

Receiving a Fax

About Receiving Modes

 NOTE: To use the Telephone / Fax or Ans Machine/Fax, connect an answering machine to the phone connector 
( ) on the back of your printer.

When the memory is full, the fax is received in the Telephone mode.

Loading Paper for Receiving Faxes
The instructions for loading paper in the paper tray are the same whether you are printing, faxing, or copying, except 
that faxes can only be printed on Letter-sized, A4-sized, or Legal-sized paper. For details about loading paper, see 
"Loading Print Media." For details about setting the paper type and size in the tray, see "Print Media Guidelines."

Receiving a Fax Automatically in the Fax Mode
Your printer is preset to the Fax mode at the factory. 

If you receive a fax, the printer automatically goes into the fax mode after a specified period of time and receives the 
fax.
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To change the interval at which the printer goes into the fax mode after receiving an incoming call, see "Available 
Fax Settings Options."

Receiving a Fax Manually in the Telephone Mode
You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive code 
(see "Available Fax Settings Options"). You can also receive a fax by selecting Manual Receive in On Hook.

To receive a fax by selecting Manual Receive:

1 When the external telephone rings, pick up the handset and check for the fax tone.

2 After you hear the fax tone, press the  (Home) button. 

3 Select Fax. 

4 Select On Hook. 

5 Select Mode, and then select Manual Receive. 

6 Press the  (Start) button. 

7 Hang up the hand set of the external telephone. 

The printer begins receiving a fax and returns to the standby mode when the reception is completed.

Receiving a Fax Automatically in the Telephone / Fax or Ans Machine/Fax
To use the Telephone / Fax or Ans Machine/Fax mode, you must connect an external telephone to the 
phone connector ( ) on the back of your printer. 

If the caller leaves a message, the answering machine stores the message as it would normally. If your printer hears a 
fax tone on the line, it automatically starts to receive a fax. 

For details on Telephone / Fax or Ans Machine/Fax mode, see "Available Fax Settings Options."

 NOTE: If you have set your printer to Ans Machine/Fax and your answering machine is switched off, or no answering 
machine is connected to your printer, your printer will automatically go into the Fax mode after a predefined time.

Receiving a Fax Manually Using an External Telephone (Remote Receive)
You can manually receive a fax from the external telephone without having to go to the printer. 

To manually receive a fax using the external telephone, you must connect an external telephone to the phone 
connector ( ) on the back of your printer and also set Remote Receive to On. 

When you receive a call on the external telephone and hear a fax tone, enter the two-digit code from the external 
telephone.

The printer receives the document.

When entering the remote receive code from the external telephone, press the number keys slowly in sequence. If 
you still hear the fax tone from the remote machine, try entering the two-digit code once again.

The default remote receive code is 00. You can change the two-digit code to whatever you choose. For details on 
changing the code, see "Available Fax Settings Options."

 NOTE: Set the dialing system of your external telephone to DTMF.
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Receiving Faxes Using the DRPD
The DRPD is a telephone company service which enables a user to use a single telephone line to answer several 
different telephone numbers. The particular number someone uses to call you on is identified by different ringing 
patterns, which consist of various combinations of long and short ringing sounds.

Before using the Distinctive Ring Pattern Detection option, Distinctive Ring service must be installed on your 
telephone line by the telephone company. To set up Distinctive Ring Pattern Detection, you will need another 
telephone line at your location, or someone available to dial your fax number from outside. 

To set up the DRPD:

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Fax Line Settings.

5 Select  until DRPD Pattern appears, and then select DRPD Pattern.

6 Select the desired pattern, and then select OK.

7 Turn off the printer, and turn it on again to apply the settings.

To receive faxes in the DRPD, you need to set the menu to DRPD. For details, see "Available Fax Settings 
Options."

Your printer provides seven DRPD patterns. If this service is available from your telephone company, ask your 
telephone company which pattern you need to select to use this service.

Receiving Faxes in the Memory
Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you 
receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the 
memory. Then, as soon as you finish copying, printing, or re-supply the consumables, the printer automatically prints 
the fax.

Polling Receive
You can receive faxes from the remote fax machine when you want to receive it.

1 Press the  (Home) button.

2 Select Fax.

3 Select On Hook.

4 Select Mode, and then select Manual Polling

5 Enter the fax number of the remote machine using the number pad.

6 Press the  (Start) button to begin receiving the fax.

Automatic Dialing

Speed Dialing
You can store up to 200 frequently dialed numbers in speed dial locations (001–200).

When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from 
the operator panel or Dell Printer Configuration Web Tool.
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Setting Speed Dial
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Phone Book appears, and then select Phone Book.

4 Select Individuals.

5 Select  until the desired speed dial number between 1 and 200 appears and then select that number.

To jump to a specific speed dial number, enter the desired number and then # using the number pad. 

6 Select the Name text box.

7 Enter the name, and then OK. 

8 Select the Fax Number text box.

9 Enter the fax number using the number pad, and then OK. 

To insert a pause between numbers, press the  (Redial/Pause) button.

"-" appears on the display.

10 Select OK. 

To store more fax numbers, repeat steps 5 to 10.

To return to the Information screen, press the  (All Clear) button.

Sending a Fax Using Speed Dial
1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Fax.

4 Select .

5 Enter the speed dial number between 1 and 200 using the number pad, and then select .

6 Adjust the document resolution to suit your fax needs. (For details, see "Adjusting the Document Resolution." For 
adjusting the contrast, see "Adjusting the Document Contrast.")

7 Press the  (Start) button to scan data.

When the document is loaded on the document glass, the display prompts you for another page. 

If you want to place a new document, replace the document with a new document, and then press the  (Start) 
button.

When you have finished loading documents, select Send Now.

The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote 
fax machine answers.

 NOTE: Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, 
you can send a document to the locations registered between 001 and 009.
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Group Dialing
If you frequently send the same document to several destinations, you can create a group of these destinations and 
set them under a one-digit group dial location. This enables you to use a group dial number setting to send the same 
document to all the destinations in the group.

 NOTE: You cannot include one group dial number within another group dial number.

Setting Group Dial
1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Phone Book appears, and then select Phone Book.

4 Select Groups.

5 Select  until the desired group dial number between 1 and 6 appears and then select that group dial number.

If a speed dial number is already stored in the location you chose, the display shows the name and the number of 
entries stored in that group dial number.

6 Select the Enter Group Name text box.

7 Enter the name, and then OK. 

8 Select Add from Address Book.

 NOTE: The fax number needs to be registered before you can select Add from Address Book.

9 Select  until the desired speed dial number appears and then select that speed dial number.

10 Select OK, and then select OK again.

To store more group dial numbers, repeat steps 5 to 11.

To return to the Information screen, press the  (All Clear) button.

Editing Group Dial
You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Phone Book appears, and then select Phone Book.

4 Select Groups.

5 Select  until the group dial number that you want to edit appears, and then select that group dial number.

6 Select Edit.

7 Select the Enter Group Name text box.

8 Enter a new name, and then OK. 

9 To delete a speed dial number from the group dial number:

a Select  until the speed dial number that you want to edit appears, and then select that speed dial number.

b Select Remove.

10 To add a new speed dial number to the group dial number:

a Select Add from Address Book.

b Select  until the desired speed dial number appears and then select that speed dial number.

c Select OK.
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11 Select OK.

To delete an existing group dial number, select the group dial number, and then select Remove. 

If you want to edit another group dial number, repeat steps 5 to 11.

To return to the Information screen, press the  (All Clear) button.

Sending a Fax Using Group Dial (Multi-address Transmission)
You can use group dialing for Broadcasting or Delayed transmissions.

Follow the procedure of the desired operation. (For Delayed transmission, see "Specifying the Fax Settings 
Options.")

You can use one or more group numbers in one operation. Then continue the procedure to complete the desired 
operation.

Your printer automatically scans the document loaded in the DADF or on the document glass into the memory. The 
printer dials each of the numbers included in the group.

Printing a Speed Dial List
You can check your automatic dial setting by printing a Speed Dial list.

For details about how to print a Speed Dial list, see "Report / List." 

Phone Book
You can select or search the registered phone numbers from the phone books. 

1 Load the document(s) facing up with top edge in first into the DADF.

OR

Place a single document facing down on the document glass, and close the document cover.

For details about loading a document, see "Loading an Original Document."

2 Press the  (Home) button.

3 Select Fax.

4 Select , and then select one of the following:

To select from the local phone book:

a Select Machine Address Book - Individuals or Machine Address Book - Groups.

b Select  until the desired speed dial number or the group dial number appears, and then select that speed 
dial number or group dial number.

c Select OK.

To search from the server phone book:

a Select Search Network Address Book.

b Enter a keyword using the keyboard, and then select OK.

c Select a recipient from the search result, and then select OK. 

 NOTE: For more information on address book and server address book, see "Address Books."

 NOTE: For details about Search Network Address Book, see "Using the Server Address Book and Server 
Phone Book."

 NOTE: A fax number needs to be registered before you can select an address book.
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5 Press the  (Start) button to begin sending the fax.

Other Ways to Fax

Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the secure 
fax mode using the Secure Receive option to restrict printing out all of the received faxes when the printer is 
unattended. In the secure fax mode, all incoming faxes will go in memory. When the mode is turned off, all stored 
faxes will be printed.

 NOTE: Before operation, ensure Panel Lock is enabled.

To turn the secure receiving mode on:

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Fax Settings appears, and then select Fax Settings.

4 Select Incoming Defaults.

5 Select  until Secure Receive appears, and then select Secure Receive.

6 Select Secure Receive Set.

7 Select Enable.

8 Enter a four digit password, and then select OK.

9 To return to the Information screen, press the  (All Clear) button.

When a fax is received in the secure receiving mode, your printer stores it into memory and Secure Fax 
Receive is enabled on the Job Status screen to let you know that there is a fax stored.

To print received documents:

1 Press the  (Job Status) button.

2 Select Secure Fax Receive.

3 Enter a four digit password, and then select OK.

The faxes stored in memory are printed.

To turn the secure receiving mode off:

1 Follow the same steps from 1 to 6 in "To turn the secure receiving mode on:" and select Secure Receive Set.

2 Select Disable.

To return to the Information screen, press the  (All Clear) button.
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Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the back of your printer as shown above.

• Set your printer to the Ans Machine/Fax and set Auto Receive Ans/Fax to specify the time for the 
TAD.

• When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts 
receiving the fax.

• If the answering device is off, the printer automatically goes into the Fax after the ring tone sounds for a 
predefined time.

• If you answer the call and hear fax tones, the printer will answer the fax call if you

Set On Hook to On (you can hear voice or fax tones from the remote machine), and then press the  (Start) 
button and hang up the receiver.

OR

Press the two-digit remote receive code and hang up the receiver.

Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up Internet connection, connect the computer 
modem directly to the back of your printer with the TAD as shown above.

• Set your printer to the Ans Machine/Fax and set Auto Receive Ans/Fax to specify the time for the 
TAD.

• Turn off the computer modem's fax-receive feature.

• Do not use the computer modem if your printer is sending or receiving a fax.

• Follow the instructions provided with your computer modem and fax application to fax via the computer modem.

To the 
wall jack

Printer Line Telephone 
Answering Device

Phone

To the 
Internet

Computer Line Telephone 
Answering Device

PhonePrinter
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Printing a Report
The following reports may be useful when using fax:

 NOTE: For more information about other reports and how to print a report, see "Report / List." 

Changing Setting Options
1 Press the  (Information) button. 

2 Select the Tools tab, and then select Default Settings. 

3 Select Fax Defaults. 

4 Select  until the desired menu appears, and then select that menu.

5 Select  until the desired setting appears or enter the value using the number pad, and then select OK.

To return to the Information screen, press the  (All Clear) button.

Speed Dial This list shows all the numbers currently stored in the memory of your printer as speed dial 
numbers.

Address Book This list shows all the addresses currently stored in the printer's memory as Address Book 
information.

Server Address This list shows all of the numbers currently stored in the printer's memory as Server Address 
information.

Fax Activity This report shows information about the faxes you recently received or sent.

Fax Pending This list shows the status of pending faxes. You may print this list to confirm your changes 
after changing any settings.

Print Meter This report shows the total number of pages printed. The report will be titled Dell ColorTrack 
Report.
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23
Understanding Your Printer Software
Use the Software and Documentation disc that shipped with your printer to install a combination of software 
programs, depending on your operating system.

Printer Status Window

The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper 
jam occurs or toner is running low.

By default, the Printer Status window launches only when an error occurs. When an error occurs, the error message 
appears on the Printer Status window. You can set the Printer Status window to always launch when printing in 
Printing Status Window Properties.

You can also check toner level, quantity of paper remaining or the configuration of options for the printer.

Status Monitor Console

Use the Status Monitor Console to manage multiple instances of the Status Window for a particular printer.

Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window for a 
particular printer. 

Dell™ Supplies Management System

You can launch the Dell Supplies Management System dialog box from the All Programs menu or the desktop icon. 

You can order consumables by phone or from the web.

1 Click Start→ All Programs→ Dell Printers→ Additional Color Laser Software→ Dell Supplies Management 
System.

The Dell Supplies Management System window appears.

2 Select your printer from the Select Printer Model list.

3 If you are ordering from the web:

a Select a URL from the Select Reorder URL list.

b Click Visit Dell printer supplies ordering web site.

 NOTE: When you cannot get information from the printer automatically by two-way communication, a window prompting 
you to type the Service Tag appears. Type the Service Tag of your Dell printer in the field provided.
Your Service Tag is located inside the front cover of your printer.

4 If you order by phone, call the number that appears in the Order by Phone section.

User Setup Disk Creating Tool

The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on the Software 
and Documentation disc and the printer drivers located on the Software and Documentation disc are used to create 
driver installation packages that contain custom driver settings. A driver installation package can contain a group of 
saved printer driver settings and other data for things such as:

• Print orientation and Multiple Up (document settings) 

• Watermarks 

• Font references 

If you want to install the printer driver with the same settings on multiple computers running the same operating 
system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created 
will reduce the amount of work required when installing the printer driver.
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• Install the printer driver in the computer on which the setup disk is to be created.

• The setup disk can only be used on the operating system on which the disk was created or computers running the 
same operating system. Create a separate setup disk for each of the operating systems.

Software Update

The firmware and/or driver updates can be downloaded from the Dell Support web site located at support.dell.com.

Printer Utility Software
You can open the Status Window, Tool Box, Updater, Troubleshooting, Address Book Editor, ScanButton Manager, 
and Dell ScanCenter using the Quick Launch Utility window.

 NOTE: Quick Launch Utility is only supported on Microsoft® Windows®.

To use the Quick Launch Utility, select to install the Quick Launch Utility when you install the Dell software.

To install the Dell software, follow the instructions below.

1 Insert the Software and Documentation disc into your computer and click setup_assist.exe to start Easy Setup 
Navigator.

2 Click Installing Driver and Software.

3 Follow the on-screen instructions.

To open the Quick Launch Utility window:

1 Click Start→ All Programs→ Dell Printers→ Additional Color Laser Software→ Quick Launch Utility.

The Quick Launch Utility window provides seven buttons: Status Window, Tool Box, Updater, Troubleshooting, 
Address Book Editor, ScanButton Manager, and Dell ScanCenter.

http://support.dell.com
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To exit the Quick Launch Utility window:

1 Click the Close (x) button at the top-right of the window. 

For details, click Help of each application.

Status Window
The Status Window button opens the Printer Status window. For more information about using Status Window, 
refer to "Printer Status Window."

Tool Box
The Tool Box button opens the Tool Box. For more information about using Tool Box, refer to "Understanding the 
Tool Box Menus."

Updater
The Updater button updates the Dell software and printer firmware.

Troubleshooting
The Troubleshooting button opens the Troubleshooting Guide, which allows you to solve problems by yourself.

Address Book Editor
The Address Book Editor button opens the Address Book Editor, which allows you to register the contact 
information such as phone number and e-mail address. For more information about using Address Book Editor, refer 
to "Using Address Book Editor."

ScanButton Manager
The ScanButton Manager button opens the ScanButton Manager, which allows you to specify how the ScanButton 
Manager behaves for scan events that the device generates (USB connection only). For more information about 
using ScanButton Manager, refer to "Scanning From the Operator Panel - Scan to Application."

Dell ScanCenter
The Dell ScanCenter button opens the Dell ScanCenter, which is a PaperPort® application that enables you to 
scan items and send them directly to PaperPort or other programs on your computer without running the PaperPort 
program first. For more information about using Dell ScanCenter, refer to "Dell ScanCenter" or PaperPort's Help 
menu.

Address Books
There are several address books available for Scan and Fax functions. Address books help you organize contact 
information, such as e-mail addresses, fax numbers and server information, and quickly choose the recipient or 
locate the address. The address book data can be obtained from the printer or a remote LDAP server.

 NOTE: Phone Book is described as one of Address Books in this section.

 NOTE: For information on how to setup the LDAP server, see "LDAP Server" and "LDAP User Mapping." For information on how to 
obtain e-mail addresses and fax numbers from LDAP servers, see "Using the Server Address Book and Server Phone Book." 

Types of Address Books
• E-mail Address Book (for Scan to E-mail)

E-mail addresses registered for sending the scanned document via e-mail
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• Email Group (for Scan to E-mail)

Groups of e-mail addresses registered for sending the scanned document via e-mail

• LDAP Server Address Book (for Scan to E-mail)

E-mail addresses registered in the LDAP server for sending the scanned document via e-mail

• Network Address Book (for Scan to Network)

Computer and FTP server information registered for sending the scanned document to a computer or ftp server

• Phone Book (for Fax)

Fax numbers registered for sending documents from your printer

• Group Dial (for Fax)

Groups of fax numbers registered for sending documents from your printer

• LDAP Server Phone Book (for Fax)

Fax numbers registered in the LDAP server for sending documents from your printer

• PC Fax Address Book (for Direct Fax)

Fax numbers registered for sending documents from your computer

• PC Fax Address Book for group (for Direct Fax)

Groups of fax numbers registered for sending documents from your computer

Adding and Editing Entries to the Address Books
There are following three ways to add or edit entries to the address books:

• Operator panel of the printer

• Address Book Editor

• Dell Printer Configuration Web Tool

Functions Features Types of Address Books Entry Registration

Operator Panel on 
the Printer

Address Book Editor Dell Printer 
Configuration Web 
Tool

Scan E-mail Address Book -

Email Group -

Server Address Book 
(LDAP server)

- - -

Network Address Book -

Fax Fax Phone Book

Group Dial

Server Phone Book
(LDAP server)

- - -

Direct Fax PC Fax Address Book - -

PC Fax Address Book - group - -
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Using Operator Panel of the Printer

You can directly enter the fax numbers on the operator panel.

 NOTE: For information on how to add a new entry, see "Setting Speed Dial."

Using Address Book Editor

You can use Address Book Editor installed on your computer to add or edit entries. Address Book Editor is 
synchronized with the address books of your printer and updated simultaneously as you save changes to the entries 
in Address Book Editor.

 NOTE: This tool is supported on both Microsoft Windows and Apple Macintosh.

 NOTE: When the printer and your computer is connected via USB, you must install the scanner driver.

With Address Book Editor, you can:

• Automatically retrieves data from the address books of your printer at startup

• Synchronizes with the printer 

• Allows you to import the Address Book data from CSV file, WAB file, MAPI, and LDAP server

• Allows you to export the Address Book data into a CSV file

 NOTE: Do not edit the exported CSV file with applications other than the Address Book Editor. Editing the CSV file with other 
applications may corrupt the address data.

Address Book Panel

There are two address books you can manage in the Address Book Editor: Device Address Book for Fax, E-mail, and 
Server and PC Fax Address Book for Direct Fax.

For Microsoft Windows:
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For Apple Macintosh:

• Device Address Book 

• Fax

Links to the printer's Address Book for Fax feature. You can register up to 200 fax numbers and 6 groups with 
200 fax numbers.

• E-Mail

Links to the printer’s Address Book for Scan to E-mail feature. You can register up to 100 e-mail addresses and 
10 groups with 10 e-mail addresses.

• Server

Links to the printer’s Address Book for Scan to Network feature. You can register up to 32 server information.

• PC Fax Address Book 

You can manage the PC Fax Address Book for using Direct Fax feature on your computer. You can register up to 
500 fax numbers and 500 groups with 30 fax numbers.

Editing an entry:

1 Select an Address Book that the entry you want to edit is stored.

2 Select an entry that you want to edit.

3 Click Edit, and enter new information.

4 Click Save to save changes.

 NOTE: When the address book entries are updated, it synchronizes with the printer and updates the address books of your 
printer simultaneously.

Using Dell Printer Configuration Web Tool

You can use Dell Printer Configuration Web Tool using a general web browser.

 NOTE: For information on how to add a new entry, see "Address Book."

 NOTE: When the address book entries are updated, it synchronizes with the printer and updates the address books of your 
printer simultaneously.
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Status Monitor Widget for Macintosh
Status Monitor Widget is a printer utility that promotes efficient use of the printer through the exchange of 
information between the Macintosh and the printer.

Status Monitor Widget Feature
• Monitoring Dell Printers

Allows you to check the status of Dell printers currently connected to your Macintosh

• Receiving Alerts

Alerts you to problems, such as paper jams or low toner

• Ordering Supplies

Allows you to access the web site to order supplies

Before Installing the Status Monitor Widget

Operating systems

• Mac OS X 10.4.11

• Mac OS X 10.5

• Mac OS X 10.6

• Mac OS X 10.7

• Mac OS X 10.8

Network protocols and interfaces

• LPR

• Socket 9100

• Bonjour

• USB 2.0 and 1.1 (When connecting with multiple printers of the same model via USB cables, only the printer 
recognized first can be monitored in the Status Monitor Widget.)

Installing the Status Monitor Widget
1 Double-click the Status Monitor Installer icon in the Finder window.

2 Follow the on-screen instructions.

When the Install Succeeded screen appears, the installation is complete.

 NOTE: Entering the administrative login name and password are required during the installation process.

Opening and Closing the Status Monitor Widget

Opening the Status Monitor Widget

1 Click the Dashboard icon in the Dock to launch Dashboard.
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2 Click the Plus (+) sign to display the Widget Bar.

3 Click the icon of Status Monitor in the Widget Bar. The Printer Status window appears.

 NOTE: If the message Select a printer is displayed, select your printer in Preferences. (For more information on 
Preferences, see "Preferences.")

Closing the Status Monitor Widget

1 Click the Close (x) button in the upper-left corner of the Printer Status window.

Printer Status Window
When the Status Monitor Widget is activated, the Printer Status window appears on Dashboard.

Printer Status Message Area

Displays a message of the current printer status.

 NOTE: The Status Monitor Widget automatically obtains the printer information at the updated interval that can be specified in 
Preferences. Also, the printer status is refreshed when Dashboard is launched or Preferences is closed.

 NOTE: If the Status Monitor Widget receives no response from the printer, the message Cannot get printer information is 
displayed.

 NOTE: When the printer is connected via USB cable, you cannot check the status of the printer during a print or scan job.

Printer Status Image Area

Displays the image of printer condition.

• Estimated Toner Level image

Displays the estimated toner level of each color if the printer is functioning properly.
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 NOTE: If the utility does not receive a response from the printer, the Unknown toner image is displayed.

• Printer error image

Displays an indication image when an error occurs.

An error has occurred and the printer cannot be used.

Order Supplies button

Click this button to display the Order window. 
To hide the Order window, click Order Supplies again.

Info (i) button

Click this button to open Preferences.

 NOTE: The info (i) button appears on the lower-right corner of the window when the cursor is over the Printer Status window. 
The info (i) button is a standard used across all widgets.

Order Window
This window provides you with the information for ordering printer supplies by telephone or from the web site.

To open the Order window:

1 Click Order Supplies in the Printer Status window.

The Order window appears.

 NOTE: The Order window appears when low toner is detected.

Order Online

• Visit Dell printer supplies ordering web site hyperlink

Click the Visit Dell printer supplies ordering web site hyperlink to access the web site for ordering Dell printer 
supplies.
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• URL list

Displays a list of available URLs where you can order Dell printer supplies. 

Select a URL address to use when the Visit Dell printer supplies ordering web site hyperlink is clicked.

Order By Phone

• Phone number list

Displays a list of available phone numbers that you can call to order Dell printer supplies.

• Update phone contacts when rebooting check box

Select this check box to regularly update the phone number list. 

Dell and the Environment

Click the hyperlink to access the web site about recycling.

Preferences
To open Preferences:

1 Click the info (i) button in the Printer Status window.

Preferences appears.

 NOTE: The info (i) button appears on the lower-right corner of the window when the cursor is over the Printer Status 
window. The info (i) button is a standard used across all widgets.

Printer

Displays a list of available printer names in the pull down menu. The first printer displayed in this list is set as 
default.

Status Update Interval

You can specify the update interval of the printer status. By default, it is set to obtain the printer information every 
10 seconds. It can be set from 0 second to 600 seconds.

SNMP Community Name

You can change the SNMP (Simple Network Management Protocol) community name if using default community 
name (public). Up to 31 characters can be entered.

Service Tag button

Click this button to obtain the service tag.

 NOTE: You cannot retrieve the service tag when the printer is connected via USB cable.

done button

Click this button to return to the Printer Status window.
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Status Monitor Console for Linux
Status Monitor Console is a printer utility that promotes efficient use of the printer through the exchange of 
information between the Linux and the printer.

Status Monitor Console Feature
• Monitoring Dell Printers

Allows you to check the status of Dell printers currently connected to your Linux.

• Receiving Alerts

Alerts you to problems, such as paper jams or low toner.

• Ordering Supplies

Allows you to access the web site to order supplies.

Before Installing the Status Monitor Console

 NOTE: The Status Monitor Console requires the following modules installed. 

- Python, PyGTK, Net-SNMP, cups-libs, and xdg-open

Please confirm that these modules are installed before you install the Status Monitor Console.

 NOTE: The Status Monitor Console is available when the printer is connected to a network (LPR or Socket 9100). USB 
connection is not supported.

Distributions

• Red Hat® Enterprise Linux® 5 Desktop

• Red Hat Enterprise Linux 6 Desktop

• SUSE® Linux Enterprise Desktop 10

• SUSE Linux Enterprise Desktop 11

Printing system

• CUPS (Common Unix Printing System)

Installing the Status Monitor Console
1 Activate the terminal, and log in as a super user.

2 Type the following rpm command in the terminal window.

# rpm -ivh (Type the package file name)
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Starting the Status Monitor Console
1 Click Dell Printers→ Status Monitor Console

The Printer Selection window appears.

For more information on Printer Selection window, see "Printer Selection Window."

2 Select your printer.

The Printer Status window appears.

For more information on Printer Status window, see "Printer Status Window."

• You can order supplies from the Dell Supplies Management System window. See "Dell Supplies Management 
System Window."

Printer Selection Window

Printers list

All the printers registered in the CUPS (Common UNIX Printing System) are displayed in a list.

• Status icons:

 Ready

 Unknown/Offline/Toner Low/Paper Low

 Door Open/Paper Jam/No Toner/Out Of Paper

Settings button

Click this button to open the Settings window.

Details button

Click this button to open the Printer Status window. If a non-supported printer is selected, it opens the Dell Printer 
Configuration Web Tool. For details on the Dell Printer Configuration Web Tool, see "Dell™ Printer Configuration 
Web Tool."

Refresh button

Click this button to update the information of printers.

Close button

Click this button to close the Printer Selection window.
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Printer Status Window
When the printer is specified in the Printer Selection window, the Printer Status window appears.

Printer Status Message Area

Displays a message of the current printer status.

 NOTE: The Status Monitor Console automatically obtains the printer information at the updated interval that can be specified in 
the Settings window. Also, the printer status is refreshed when the Refresh is clicked.

 NOTE: If the Status Monitor Console receives no response from the printer, the message Cannot get printer information is 
displayed.

Printer Status Image Area

• Current Toner Status icons

Displays icons of the current status of each toner.

The toner level is more than 30%.

The toner level is less than 29%.

The toner level is less than 9%.

The toner level is unknown.

• Estimated Toner Level images

Keeps you informed about the amount of toner that remains for each color.

Toner Alert

Displays an alert message when any remaining toner is low, empty, or unknown.

Order Online

• Order Supplies Online button

Click this button to access the web site for ordering Dell printer supplies. This button appears when the amount 
of toners becomes less than 30%.

Refresh button

Click this button to update the status of the printer.

Close button

Click this button to close the Printer Status window.
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Dell Supplies Management System Window
This window provides you with the information for ordering printer supplies by telephone or from the web site.

To open the Dell Supplies Management System window:

1 Click Order Supplies Online in the Printer Status window.

OR

Click Dell Printers→ Dell Supplies Management System.

Select Printer Model

Select your printer model name.

Order Online

• Order Supplies Online button

• When the Regular URL is selected in the Select Reorder URL:

Click this button to open the Service Tag window.

• When the Premier URL is selected in the Select Reorder URL:

Click this button to open the procurement and support web site.

• Select Reorder URL

Displays a list of available URLs where you can order Dell printer supplies. Select a URL address to use when the 
Order Supplies Online button is clicked.

• Regular URL: http://accessories.us.dell.com/sna/printerseg.aspx

• Premier URL: http://premier.dell.com

Order by Phone

• To order Dell printer supplies by phone, call the following

Select your country with phone number from the list, and call the displayed telephone number to order supplies.

• Update phone contacts when rebooting check box

Select this check box to regularly update the phone number list. 
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Dell and the Environment

Click the hyperlink to access the web site about recycling.

Close button

Click this button to close the Dell Supplies Management System window.

Service Tag Window

1 Enter the Dell printer service tag.

 NOTE: For information on the service tag, see "Express Service Code and Service Tag."

Settings Window
To open the Settings window:

1 Click Settings in the Printer Selection window.

The Settings window appears.

Update of status

• Printer Status is regularly updated check box

Select the check box to enable/disable the printer status to be updated by the specified interval.

• Update interval text box

Specify the update interval of the printer status.

Port Number Settings

• Port Number

Specify the port number in the Port Number text box to open the setting page of your printer in a web browser.
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Protocol Settings - SNMP

• Community Name

Enter the Community name of SNMP in the Community Name text box.

Order URL

• Select Reorder URL

The selected URL address is set as default web site for the Select Reorder URL in the Dell Supplies Management 
System window.
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Printing Using ColorTrack (External Authentication)
With ColorTrack, you can restrict the number of pages that can be printed per user, specify the users who can print 
in color, and restrict the users who can access the printer, based on the user information registered on the external 
authentication server or the printer.

To print using ColorTrack, you must set ColorTrack Settings and the printer driver. Also, you must set the external 
server with ColorTrack for using an external authentication server. To set the external server, consult your system 
administrator.

 NOTE: To restrict color printing when ColorTrack is disabled, set Auto Color To Mono Print to On.  All print jobs 
are printed in black and white even when color is specified. For details, see "Auto Color To Mono Print."

ColorTrack Settings
To print using Dell™ ColorTrack, configure the following settings.

• "Dell ColorTrack"

• "Authentication System"

• "Kerberos Server"

• "LDAP Server"

• "LDAP Authentication"

Dell ColorTrack
Specify the authentication method.

When Using the Dell Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Volume.

3 Click the Dell ColorTrack tab.

• Select External Mode for ColorTrack Mode.

• Select the On check box for Non Registered User when you permit the printing of data with no authentication 
information. If not, clear the On check box.

• Enter the password when External Mode is selected for ColorTrack Mode and On is selected for Non 
Registered User. Then, re-enter the password to confirm the password that you entered.

• Select the On check box for ColorTrack Error Report, if necessary.

4 Click Apply New settings.

5 Turn off the printer, and turn it on again to apply the settings.
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When Using the Operator Panel

You can specify only the settings of ColorTrack Mode, Non Registered User, and ColorTrack Error Report using the 
operator Panel.

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until System Settings appears, and then select System Settings.

4 Select  until ColorTrack Mode appears, and then select ColorTrack Mode.

5 Select External Mode, and then select OK.

6 Select  until Non Registered User appears, and then select Non Registered User.

7 Select Off or On, and then select OK.

8 Select  until ColorTrack Error Report appears, and then select ColorTrack Error Report.

9 Select Off or On, and then select OK.

10 Turn off the printer, and turn it on again to apply the settings.

ColorTrack Mode

The following two authentication modes are available: the Internal Mode using user information registered on the 
printer, and the External Mode using user information registered on an external server. To authenticate on the 
external authentication server with External Mode, you need not register user information on the printer. The 
change becomes effective after the printer is turned off and then on again.

Non Registered User

Specify whether to permit the printing of data with no authentication information. This setting is enabled when the 
printer is restarted. The change becomes effective after the printer is turned off and then on again.

Non Registered User Password

Specify the password to be used for non-account user using 1 to 127 alphanumeric characters. If the password is left 
blank (NULL), you cannot log in to a server. The change becomes effective after the printer is turned off and then 
on again.

 NOTE: When External Mode is specified and Non Registered User is set to On, you must set a password.

 NOTE: When using an LDAP server, you also must set the same password on the server.

Re-enter Non Registered User Password

Enter the Non Registered user password again to confirm it.

ColorTrack Error Report

Specify whether to automatically print error-related information if printing using ColorTrack results in an error.

Setup Remote Authentication

Click Setup Remote Authentication Page to display the Authentication System page.

 NOTE: This item is displayed only when External Mode is specified.

Authentication System
Specify the server authentication type, the server response time-out, or the search time-out.
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When Using the Dell Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select Authentication System.

Authentication System page is displayed.

• Select the authentication system for Authentication System Settings.

• Specify the time-out period for Server Response Time-Out.

• Specify the time-out period for Search Time-Out.

5 Click Apply New settings.

6 Turn off the printer, and turn it on again to apply the settings.

Authentication System Settings

Select the authentication system from the list. The change becomes effective after the printer is turned off and then 
on again.

Server Response Time-Out

Specify the amount of time the printer should wait for response from the server. Set the time period from 1 up to 75 
seconds. The change becomes effective after the printer is turned off and then on again.

Search Time-Out

Specify the amount of time the printer should wait for searching for the server. Set the time period from 5 up to 120 
seconds. The change becomes effective after the printer is turned off and then on again.

Kerberos Server
Specify the settings for the Kerberos Server.

When Using the Dell Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select Kerberos Server.

5 Enter the IP address or host name, and the port address in IP Address / Host Name & Port of Kerberos Server (for 
ColorTrack PRO).

6 Enter the domain name in Domain Name.

7 Click Apply New settings.
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8 Turn off the printer, and turn it on again to apply the settings.

IP Address / Host Name & Port

Specify the IP address or host name, and the port address. The change becomes effective after the printer is turned 
off and then on again.

 CAUTION: Do not use the same port address as that of another port.

 NOTE: The port address must be 88 or between 5,000 and 65,535. The default value is 88.

 NOTE: Specify the IP address in the nnn.nnn.nnn.nnn format for IPv4. Each section of "nnn" is a variable value between 0 and 
255.

 NOTE: Specify the IP address in the xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx format for IPv6. Each section of "xxxx" is a 
hexadecimal variable value.

Domain Name

Specify the domain name of the Active Directory® in Domain Name (Realm Name). The change becomes effective 
after the printer is turned off and then on again.

 NOTE: Specify the domain name with uppercase characters. Depending on your server, an error may occur if you specify the 
domain name with lowercase characters.

LDAP Server
Specify the directory server and the authentication method to execute LDAP authentication or to acquire 
information using LDAP, and specify the range and attributes for searching.

 NOTE: When using LDAPS or certificate verification, you must set the LDAP server or import an external certificate. For more 
information, see "Using Digital Certificates."

When Using the Dell Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select LDAP Server.

Server Information (for ColorTrack PRO):

• Enter the IP address or the host name, and the port address in IP Address / Host Name & Port.

• Confirm the software information for LDAP Server.

Optional Information (for ColorTrack PRO):

• Enter a text string in Search Directory Root.

• Enter the login name in Login Name.

• Enter the password in Password. Then, re-enter the password to confirm the password that you entered.

• Specify the time-out period for Search Time-Out.

5 Click Apply New settings.

6 Turn off the printer, and turn it on again to apply the settings.
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Server Information (for ColorTrack PRO)

IP Address / Host Name & Port

Specify the IP address or the host name, and the port address. The change becomes effective after the printer is 
turned off and then on again.

 CAUTION: Do not use the same port address as that of another port.

 NOTE: The port address must be 389, 636 or between 5,000 and 65,535. The default value is 389. When using LDAPS, normally 
specify 636.

 NOTE: Specify the IP address in the nnn.nnn.nnn.nnn format for IPv4. Each section of "nnn" is a variable value between 0 and 
255.

 NOTE: Specify the IP address in the xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx format for IPv6. Each section of "xxxx" is a 
hexadecimal variable value.

LDAP Server

Displays the current software information of the LDAP server.

Optional Information (for ColorTrack PRO)

Search Directory Root

Specify a text string as the origin of the search when using LDAP communication. The change becomes effective 
after the printer is turned off and then on again.

For example: ou=colortrackv3,dc=win2003ad,dc=colortrack.dc=net

Login Name

Specify the login name for accessing the directory server with LDAP authentication. Specify the name of a user with 
the authority to update the LDAP server. The change becomes effective after the printer is turned off and then on 
again.

Password

Specify the password for accessing the directory server with LDAP authentication. Specify the password of a user 
with the authority to update the LDAP server using 1 to 127 alphanumeric characters. If the password is left blank 
(NULL), you cannot log in to a server. The change becomes effective after the printer is turned off and then on 
again.

Re-enter Password

Enter the password again to confirm it.

Search Time-Out

Specify the amount of time the printer should wait for searching for the server. To specify a time-out period for 
searching, select Wait, and set the time period from 5 up to 120 seconds. To not specify a time-out period, select the 
Wait LDAP Server Limit. The change becomes effective after the printer is turned off and then on again.

LDAP Authentication
Specify the LDAP server authentication method.

When Using the Dell Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.
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b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select LDAP Authentication.

LDAP Authentication (for ColorTrack PRO):

• Confirm the authentication method.

• When adding a text string to the UserID, select Enable for Use Added Text String.

• When Enable is selected for Use Added Text String, enter the additional text string in Text String Added to 
User Name.

5 Click Apply New settings.

6 Turn off the printer, and turn it on again to apply the settings.

Authentication Method

Displays the current LDAP authentication method. Direct Authentication executes server authentication with the 
UserID and password entered.

Use Added Text String

Specify whether to add a text string to the UserID. The change becomes effective after the printer is turned off and 
then on again.

Text String Added to User Name

When using an added string for the user name, specify the text string to be added.

For example: if the user name is "abcde@myhost.example.com", normally you must enter 
"abcde@myhost.example.com". 
However if Use Added Text String is set to Enable, and "@myhost.example.com" is specified in Text String Added 
to User Name, only the data "abcde" must be entered with the printer driver, thus simplifying the entry task.

The change becomes effective after the printer is turned off and then on again.

Setting the Printer Driver
To print using ColorTrack, set the printer driver. Once set, the settings of the printer driver are enabled until they are 
changed.

1 Open Properties of the printer driver.

2 Configure the following settings from the Configuration tab.

Dell ColorTrack Mode
Specify whether to allow general users to change settings related to authentication or whether general users must use 
the settings configured by the Administrator.

Specify Group Name
Specify the name of the belonging group to use when authenticating. If you specify a group that does not belong, 
authentication fails and the data is not printed. Also, the default group is set if Specify Group Name is not specified.
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Specify Job Owner
Select Use Login Name to use the user information logged into your PC, and select Enter ID to enter the user name 
yourself.

Job Owner Name
Specify the user name to use when authenticating with an external server. You can enter this only when selecting 
Enter ID for Specify Job Owner.

Password
Specify the user password to use when authenticating with an external server.
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Using the Server Address Book and Server Phone 
Book
With server address book and server phone book, you can specify an e-mail address or fax number of a recipient 
registered in the external LDAP server when sending a scanned image with e-mail or fax.

To use the server address book and server phone book, the printer needs to be configured in order to access the 
external LDAP server. 

 NOTE: To configure the settings of the external LDAP server, consult your system administrator.

 NOTE: You must also set Email Server Address Book and Fax Server Address Book to On to specify recipients using the server 
address book and server phone book. For details, see "Email Server Address Book" and "Fax Server Address Book."

Setting Server Address Book and Server Phone Book
1 Launch the Dell™ Printer Configuration Web Tool by entering the IP address of your printer in your web browser.

If you do not know the IP address of your printer, print the system settings report or display the TCP/IP Settings 
page, which lists the IP address. For details about how to find your printer's IP address, see "Verifying the IP 
Settings."

2 Select Print Volume, and then click the Dell ColorTrack tab.

3 Select Off, Internal Mode, or External Mode for ColorTrack Mode, and then click Apply New Settings.

Selecting External Mode allows you to authenticate the printer to the external server using the LDAP or Kerberos 
authentication method.

If the external server does not require authentication, select Off or Internal Mode.

4 Click Restart Printer.

5 Select Print Server Settings, click the Security tab, and then select Authentication System.

6 From the Authentication System Settings drop-down menu under Authentication Type (for Server 
Address/Phone Book), select Kerberos or LDAP as the authentication method you are using, and then click Apply 
New Settings.

If Off or Internal Mode is selected in step 3, be sure to select LDAP.

If External Mode is selected, select LDAP or Kerberos according to the authentication method set up for the 
external server.

7 Click Restart Printer.

If you select LDAP in step 6, go to step 11.

8 Select Print Server Settings, click the Security tab, and then select Kerberos Server.

9 Specify the settings under Kerberos Server (for Server Address/Phone Book), and then click Apply New Settings.

For details about each setting item, see "Kerberos Server."

10 Click Restart Printer.

11 Select Print Server Settings, click the Security tab, and then select LDAP Server.

12 Specify the settings under LDAP Server (for Server Address/Phone Book) and Optional Information (for Server 
Address/Phone Book), and then click Apply New Settings.

For details about each setting item, see "LDAP Server."
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13 Click Restart Printer.

14 Select Print Server Settings, click the Security tab, and then select LDAP User Mapping.

Specify the attribute names used in the LDAP server. If the attribute names are not customized in the LDAP 
server, leave the settings in this step as they are by default.

Now the settings are complete. See "Sending an E-mail With the Scanned File" or "Phone Book" to use the address 
information in the external server for sending e-mails or faxes.
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Using Digital Certificates
The authentication feature using digital certificates upgrades security when sending print data or setting data.

This chapter describes how to manage digital certificates.

 NOTE: For information about digital certificate error, see "Understanding Printer Messages" and "Digital Certificate Problem."

The following is a typical setup flow for using digital certificates.

Managing Certificates
This section describes how to manage digital certificates as follows.

• "Preparing to Manage Certificates"

• "Importing a Digital Certificate"

• "Setting a Digital Certificate"

• "Confirming the Settings of a Digital Certificate"

• "Deleting a Digital Certificate"

• "Exporting a Digital Certificate"

 NOTE: The external certificate management described above is enabled only when the optional hard disk is installed and is set 
to On for encryption.

Preparing to Manage Certificates
Before managing digital certificates, the following settings must be applied.

• "Changing the Encryption Setting of the Hard Disk"

• "Setting HTTPS Communication"

Changing the Encryption Setting of the Hard Disk

Some items are effective only when encryption of the optional hard disk is set to On. Change the encryption setting 
to On and set a key that is required to encrypt, if necessary.

 CAUTION: All files stored on the optional hard disk are cleared when changing the encryption setting.

 NOTE: You can enter only characters from 0 to 9, a to z, A to Z, and NULL values for encryption key.

Prepare to manage digital certificates.

• Change the Encryption Setting of the Hard Disk

• Set HTTPS Communication

Import and set digital certificates.

• Import a Digital Certificate

• Set a Digital Certificate

• Confirm the Settings of a Digital Certificate

Set various security features using digital certificates.
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When Using the Operator Panel

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select  until Secure Settings appears, and then select Secure Settings.

4 Select  until Data Encryption appears, and then select Data Encryption.

5 Select Encryption.

6 Select On, and then select OK.

7 Use number pad to enter the passphrase for the encryption key, and then select OK.

8 The Encryption (All stored documents will be deleted. Are you sure) screen appears. When you confirm that all 
stored documents will be deleted to change the encryption setting, select Yes, Delete to change the setting. 
When you quit changing encryption setting, select No, Cancel.

When Using the Dell™ Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Printer Settings.

3 Click the Printer Settings tab.

4 Select Secure Settings.

5 Check that the Enable check box of Panel Lock Control of Panel Lock is selected. 

If Enable is selected, proceed to step 10. If not, perform the following steps.

6 Select the Enable check box of Panel Lock Control of Panel Lock. 

7 Enter a four digit password in New Password.

8 Re-enter the password in Re-enter Password.

9 Click Apply New Settings.

For details about Panel Lock, see "Panel Lock."

10 Click Data Encryption. 

The Data Encryption page is displayed.

11 Select the Encryption check box.

12 Enter a key that is required to encrypt.

13 Re-enter the key again to confirm it.

14 Click Apply New Settings.

Setting HTTPS Communication

Before managing certificates, set HTTPS communication with a self-signed certificate.

 NOTE: Set HTTPS communication after changing the Encryption setting to On.
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When Using the Dell Printer Configuration Web Tool

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.

5 Click Generate Self-Signed Certificate of Machine Digital Certificate. The Generate Self-Signed Certificate 
page is displayed.

6 Select the size of public key from the list of Size of Public Key.

7 Specifies the issuer of SSL self-signed certificate.

8 Click Generate Signed Certificate.

9 The Restart Printer button is displayed after generating the self-signed certificate, and then click Restart Printer.

10 Repeat steps 2 to 4 to display the SSL/TLS page after restarting the printer.

11 If the self-signed certificate is set correctly, since the HTTP- SSL/TLS Communication column is set to Enable 
and a check box is displayed, select Enable.

Importing a Digital Certificate

 CAUTION: Before importing a certificate file, back up the certificate file.

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

 NOTE: Be sure to import the certificate with Internet Explorer.

 NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.

5 Click Upload Signed Certificate of Machine Digital Certificate.

The Upload Signed Certificate page is displayed.

 NOTE: The Upload Signed Certificate button is displayed only when the optional hard disk is installed and is set to On for 
encryption.

6 Enter a password.

7 Re-enter the password again to confirm it.

8 Click Browse of File Name, and select the file to be imported.

9 Click Import to import the certificate.
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Setting a Digital Certificate

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.

5 Click Certificate Management to display the Certificate Management page.

 NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption.

6 When setting a Wireless LAN (Server) certificate, select Trusted Certificate Authorities within Category.
When setting a certificate of SSL Server, SSL Client, IPsec, or Wireless LAN (Client), select Local Device.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

 NOTE: If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.

10 Click Certificate Details to display the Certificate Details page.

11 Confirm the content, and click Use This Certificate at the upper-right corner.

Confirming the Settings of a Digital Certificate

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.

5 Click Certificate Management to display the Certificate Management page.

 NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

 NOTE: If the list includes more than 20 certificates, click Next to display the next page.

9 The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with the 
use purpose and actually used.
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Deleting a Digital Certificate

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.

5 Click Certificate Management to display the Certificate Management page.

 NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

8 Click Display the List to display the Certificate List page.

 NOTE: If the list includes more than 20 certificates, click Next to display the next page.

9 Select the certificate to be deleted.

10 Click Certificate Details to display the Certificate Details page.

11 To delete the selected certificate, click Delete at the upper-right corner.

 NOTE: When a certificate is deleted, the features associated with the deleted certificate are disabled. To delete a 
certificate being used, either set the feature to OFF in advance or switch the association to another certificate, and then 
switch to another operation mode if possible before deleting the certificate.

• For an SSL Server, switch to another certificate such as a self-signed certificate.

• For an SSL Client, set the LDAP-SSL/TLS and IEEE 802.1x (EAP-TLS) setting to OFF.

• For IPsec, change the IKE setting to Pre-Shared Key or set the feature to OFF.

• For Wireless LAN, change the Wireless Security setting to other than WPA-Enterprise before deleting the 
certificate.

Exporting a Digital Certificate

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

 NOTE: Since the secret key is not exported, an imported PKCS#12 format certificate can be exported only as a PKCS#7 
certificate.

1 Launch Dell Printer Configuration Web Tool.

a Open the web browser.

b Enter the IP address of your printer in the web browser.

See "Dell™ Printer Configuration Web Tool."

2 Select Print Server Settings.

3 Click the Security tab.

4 Select SSL/TLS.
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5 Click Certificate Management to display the Certificate Management page.

 NOTE: The Certificate Management button is displayed only when the optional hard disk is installed and is set to On for 
encryption.

6 Select the category from the Category list.

7 Select the purpose of use from the Certificate Purpose list.

Click Display the List to display the Certificate List page.

 NOTE: If the list includes more than 20 certificates, click Next to display the next page.

8 Select the certificate to be exported.

9 Click Certificate Details to display the Certificate Details page.

10 To export the selected certificate, click Export This Certificate.

Setting the Features
You can set various security features using digital certificates.

See the following for details:

• "Setting the Certificate in the IPsec Digital Signature Mode"

• "Setting the SSL-use Server Certificate (HTTP/IPP)"

• "Setting LDAP-SSL/TLS Communication"

• "Setting Server Certificate Verification for LDAP-SSL/TLS Communication"

• "Setting Client Certificate for LDAP-SSL/TLS Communication"

• "Setting for Wireless LAN WPA-Enterprise (EAP-TLS)"

• "Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, EAP-TTLS CHAP)"

• "Setting Client Certificate for IEEE 802.1x (EAP-TLS)"

Setting the Certificate in the IPsec Digital Signature Mode

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

1 Import the certificate to be used with IPsec. For more information, see "Importing a Digital Certificate."

2 Set the certificate to be used with IPsec. For more information, see "Setting a Digital Certificate."

3 Confirm whether the certificate is set correctly in IPsec. For more information, see "Confirming the Settings of a 
Digital Certificate."

4 Select Print Server Settings from the left side of the page.

5 Click the Security tab.

6 Select IPsec.

7 Select the Enable check box for Protocol.

8 Select Digital Signature from the IKE list.

9 Set each item, as necessary.

10 Click Apply New Settings.

11 After restarting the printer, IPsec communication using digital signatures is enabled. You can execute IPsec 
communication (Digital Signature Mode) between the printer and the network device (such as PC) on which the 
certificate and IPsec are set identically as on this device.
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Setting the SSL-use Server Certificate (HTTP/IPP)

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

1 Import the certificate to be used with the SSL-use server. For more information, see "Importing a Digital 
Certificate."

2 Set the certificate to be used with the SSL-use server. For more information, see "Setting a Digital Certificate."

3 Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital 
Certificate."

 NOTE: Confirm whether the newly set certificate, not the self-signed certificate, is associated.

4 After restarting the printer, the certificate set as described above is used as the server certificate when executing 
communication with HTTP/IPP-SSL/TLS.

Setting LDAP-SSL/TLS Communication

 NOTE: This setting is available only when the optional hard disk is installed and is set to On for encryption.

1 Select Print Server Settings from the left side of the page.

2 Click the Security tab.

3 Select SSL/TLS.

4 Select the Enable check box for LDAP-SSL/TLS Communication.

5 Click Apply New Settings.

6 After restarting the printer, LDAP-SSL/TLS Communication is enabled.

 NOTE: When executing the certificate validity of the server and the presentation of the client certificate, see "Setting Server 
Certificate Verification for LDAP-SSL/TLS Communication" and "Setting Client Certificate for LDAP-SSL/TLS Communication."

Setting Server Certificate Verification for LDAP-SSL/TLS Communication

 NOTE: This setting is available only when the optional hard disk is installed and is set to On for encryption.

 NOTE: This feature is enabled only when Enable is set for LDAP-SSL/TLS Communication.

1 Import the root certificate (including intermediate certificate) for the LDAP server certificate. For more 
information, see "Importing a Digital Certificate."

 NOTE: In the verification of a certificate of the connected server, to automatically search for an imported certificate and 
verify the path, the certificate does not need to be associated.

2 Confirm whether the root certificate is correctly imported to the LDAP server. For more information, see 
"Confirming the Settings of a Digital Certificate."

3 Select Print Server Settings.

4 Click the Security tab.

5 Select SSL/TLS.

6 Select the Enable check box for Verify Remote Server Certificate.

7 Click Apply New Settings.

8 After restarting the printer, the certificate presented by the LDAP server is verified when LDAP-SSL/TLS 
communication starts with the LDAP server.

 NOTE: When the result of verification is NG, communication is not established and an error results.
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Setting Client Certificate for LDAP-SSL/TLS Communication

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

 NOTE: This feature is enabled only when Enable is set for LDAP-SSL/TLS Communication.

1 Import a certificate to be used with SSL Client. For more information, see "Importing a Digital Certificate."

2 Set a certificate to be used with SSL Client. For more information, see "Setting a Digital Certificate."

3 Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital 
Certificate."

4 After restarting the printer, the LDAP client certificate is presented when LDAP-SSL/TLS communication with 
the LDAP server starts. When the LDAP server is set to require a client certificate, the client certificate provided 
by the printer is verified by the LDAP server.

Setting for Wireless LAN WPA-Enterprise (EAP-TLS)

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

 NOTE: WPA-Enterprise is available only when infrastructure is selected as the network type.

 NOTE: Be sure to import the certificate with Internet Explorer.

 NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Import the certificate to be used with Wireless LAN (server or root certificate). For details, see "Importing a Digital 
Certificate."

2 Set the digital certificate for wireless LAN (server or root certificate).

a Launch Dell Printer Configuration Web Tool.

b Select Print Server Settings.

c Click the Security tab.

d Select SSL/TLS.

e Click Certificate Management to display the Certificate Management page.

f Select Trusted Certificate Authorities within Category.

g Select the Wireless LAN (Server) of use from the Certificate Purpose list.

h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary 
if you do not need to specify the order for the certificates.

i Click Display the List to display the Certificate List page.

j Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.

k Click Certificate Details to display the Certificate Details page.

l Confirm the content, and click Use This Certificate at the upper-right corner.

3 Confirm whether the certificate is set correctly. For details, see "Confirming the Settings of a Digital Certificate."

4 Import the certificate to be used with Wireless LAN (client or client certificate). For details, see "Importing a 
Digital Certificate."

5 Set the digital certificate for wireless LAN (client or client certificate).

a Launch Dell Printer Configuration Web Tool.

b Select Print Server Settings.

c Click the Security tab.
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d Select SSL/TLS.

e Click Certificate Management to display the Certificate Management page.

f Select Local Device within Category.

g Select the Wireless LAN (Server) of use from the Certificate Purpose list.

h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary 
if you do not need to specify the order for the certificates.

i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.

j Click Certificate Details to display the Certificate Details page.

k Confirm the content, and click Use This Certificate at the upper-right corner.

6 Confirm whether the certificate is set correctly. For details, see "Confirming the Settings of a Digital Certificate."

7 Set WPA-Enterprise for EAP-TLS. 

a Launch Dell Printer Configuration Web Tool.

b Click the Print Server Settings tab.

c Select Wireless LAN.

 NOTE: This setting is available only when the optional wireless adapter is installed.

d Select either of the following from the Encryption list of Secure Settings.

• WPA-Enterprise-AES/WPA2-Enterprise-AES

• WPA-Enterprise-TKIP

 NOTE: WPA-Enterprise-AES/WPA2-Enterprise-AES or WPA-Enterprise-TKIP becomes available only when the 
following steps are set correctly.

• Importing a Digital Certificate

• Setting a Digital Certificate

• Confirming the Settings of a Digital Certificate

e Set EAP-Identity of WPA-Enterprise.

f Select EAP-TLS from the Authentication Method list of WPA-Enterprise.

g Click Apply New Settings.

Setting for Wireless LAN WPA-Enterprise (PEAPV0-MS-CHAPV2, EAP-TTLS PAP, EAP-TTLS CHAP)

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

 NOTE: WPA-Enterprise is available only when infrastructure is selected as the network type.

 NOTE: Be sure to import the certificate with Internet Explorer.

 NOTE: After importing a PKCS#12 format certificate, the secret key is not exported even if you execute exporting.

1 Import the certificate to be used with Wireless LAN (server or root certificate). For details, see "Importing a Digital 
Certificate."

2 Set the digital certificate for wireless LAN (server or root certificate).

a Launch Dell Printer Configuration Web Tool.

b Select Print Server Settings.

c Click the Security tab.

d Select SSL/TLS.

e Click Certificate Management to display the Certificate Management page.
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f Select Trusted Certificate Authorities within Category.

g Select the purpose of use from the Certificate Purpose list.

h Click Display the List to display the Certificate List page.

i Select the certificate to associate. At this time, confirm that Validity of the certificate selected is set to Valid.

j Click Certificate Details to display the Certificate Details page.

k Confirm the content, and click Use This Certificate at the upper-right corner.

3 Confirm whether the certificate is set correctly.

a Launch Dell Printer Configuration Web Tool.

b Select Print Server Settings.

c Click the Security tab.

d Select SSL/TLS.

e Click Certificate Management to display the Certificate Management page.

f Select the category from the Category list.

g Select the Wireless LAN (Server) of use from the Certificate Purpose list.

h From Certificate Order, select how the certificates are sorted in Certificate List. This setting is not necessary 
if you do not need to specify the order for the certificates.

i Click Display the List to display the Certificate List page.

j The certificate displayed with an asterisk as "*Valid" in the Validity column is the certificate associated with 
the use purpose and actually used.

4 Set WPA-Enterprise for PEAPV0-MS-CHAPV2, EAP-TTLS PAP, or EAP-TTLS CHAP.

a Launch Dell Printer Configuration Web Tool.

b Click the Print Server Settings tab.

c Select Wireless LAN.

 NOTE: This setting is available only when the optional wireless adapter is installed.

d Select either of the following from the Encryption list of Secure Settings.

• WPA-Enterprise-AES/WPA2-Enterprise-AES

• WPA-Enterprise-TKIP

 NOTE: WPA-Enterprise-AES/WPA2-Enterprise-AES or WPA-Enterprise-TKIP becomes available only when the 
following steps are set correctly.

• Importing a Digital Certificate

• Setting a Digital Certificate

• Confirming the Settings of a Digital Certificate

e Set EAP-Identity, Login Name, and Password of WPA-Enterprise.

f Select either of the following from the Authentication Method list of WPA-Enterprise:

• PEAPV0 MS-CHAPV2

• EAP-TTLS PAP

• EAP-TTLS CHAP

g Click Apply New Settings.
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Setting Client Certificate for IEEE 802.1x (EAP-TLS)

 NOTE: To manage digital certificates, you must first set encryption of the optional hard disk to On, and then set up HTTPS 
communication. For details, see "Preparing to Manage Certificates."

 NOTE: This feature is enabled only when Enable is set for IEEE 802.1x (EAP-TLS).

1 Import a certificate to be used with SSL Client. For more information, see "Importing a Digital Certificate."

2 Set a certificate to be used with SSL Client. For more information, see "Setting a Digital Certificate."

3 Confirm whether the certificate is set correctly. For more information, see "Confirming the Settings of a Digital 
Certificate."

4 After restarting the printer, the IEEE 802.1x (EAP-TLS) certificate is presented when IEEE 802.1x communication 
with the RADIUS server starts. When the RADIUS server is set to require a client certificate, the client certificate 
provided by the printer is verified by the RADIUS server.
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Understanding Fonts

Typefaces and Fonts
A font is a set of characters and symbols created with a distinct design. The distinct design is called a typeface. The 
typefaces you select add personality to a document. Well-chosen typefaces make a document easier to read.

The printer has numerous resident fonts in PCL 5/PCL 6 and PostScript 3. See "Resident Fonts" for a listing of all 
resident fonts.

Weight and Style
Typefaces are often available in different weights and styles. These variations modify the original typeface so you can, 
for example, emphasize important words in text or highlight book titles. The different weights and styles are 
designed to complement the original typeface.

Weight refers to the thickness of the lines that form the characters. Thicker lines result in darker characters. Some 
words commonly used to describe the weight of a typeface are bold, medium, light, black, and heavy.

Style refers to other typeface modifications, such as tilt or character width. Italic and oblique are styles where the 
characters are tilted. Narrow, condensed, and extended are three common styles that modify the character widths.

Some fonts combine several weight and style modifications; for example, Helvetica BdOb. A group of several weight 
and style variations of a single typeface is called a typeface family. Most typeface families have four variations: 
regular, italic (oblique), bold, and bold italic (bold oblique). Some families have more variations, as the following 
illustration for the Helvetica typeface family shows:

Pitch and Point Size
The size of a font is specified as either a pitch or point size, depending on whether the font is fixed space or 
proportional.

In fixed space fonts, each character has the same width. Pitch is used to specify the size of fixed space fonts. It is a 
measure of the number of characters that will print in one horizontal inch of type. For example, all 10-pitch fonts 
print 10 characters per inch (cpi) and all 12-pitch fonts print 12 cpi:
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In proportional (or typographic) fonts, every character can have a different width. Since proportional fonts have 
characters with different widths, the font size is specified in point size, not pitch. Point size refers to the height of 
the characters in the font. A point is defined as 1/72 inch. The characters in a font printed at 24 point will be twice as 
large as the characters in the same font printed at 12 point.

The following illustration shows samples of a font printed in different point sizes:

The point size of a font is defined as the distance from the top of the tallest character in the font to the bottom of 
the lowest character in the font. Due to the definition of point size, different fonts printed at the same point size 
may appear quite different in size. This is because there are other font parameters that affect how the font looks. 
However, the point size of a font is an excellent specification of the relative size of a font. The following examples 
illustrate two very different proportional fonts at 14 point: 

Bitmapped and Scalable Fonts
The printer uses both bitmapped and scalable fonts.

Bitmapped fonts are stored in print memory as predefined patterns of bits that represent a typeface at a specific size, 
style, and resolution. The following illustration shows an example of a character from a bitmapped font.

Bitmapped fonts are available in different type styles and point sizes as downloadable fonts.

Scalable fonts (also called outline fonts) are stored as computer programs that define the outlines of the characters 
in the font. Each time you print characters from a scalable font, the printer creates a bitmap of the characters at the 
point size you choose and saves it temporarily in print memory.
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These temporary bitmapped fonts are deleted when you turn off or reset the printer. Scalable fonts provide the 
flexibility of printing in many different point sizes.

Your printer uses different scalable font formats for downloading fonts to the printer. PCL 5/PCL 6 uses Intellifont 
and TrueType scalable fonts. PostScript 3 uses Type 1 and TrueType scalable fonts. There are thousands of different 
scalable fonts available in these different font formats from numerous font suppliers.

If you plan to use many downloadable bitmapped or scalable fonts or if you plan to use many different sizes of 
scalable fonts, you may need to purchase additional memory for your printer.

Resident Fonts
Your printer is equipped with resident fonts stored permanently in print memory. Different fonts are available in 
PCL 5/PCL 6 and PostScript 3. Some of the most popular typefaces, like Courier and TimesNew (PCL 5/PCL 
6)/Times New Roman (PostScript 3), are available for all printer languages.

The following table lists all the fonts resident in your printer. See "Report / List" for instructions on how to print 
samples of the fonts. You can select the resident fonts from your software program. You can also select the fonts from 
the operator panel if you are using PCL 5/PCL 6.

Resident bitmapped and scalable fonts

PCL 5/PCL 6 PostScript 3

CG Times Albertus

CG Times It Albertus Italic

CG Times Bd Albertus Light

CG Times BdIt

Antique Olive Roman

Univers Md Antique Olive Italic

Univers MdIt Antique Olive Bold

Univers Bd Antique Olive Compact

Univers BdIt Apple Chancery

Univers MdCd Arial

Univers MdCdIt Arial Italic 

Univers BdCd Arial Bold

Univers BdCdIt Arial Bold Italic

ITC Avant Garde Gothic Book 

AntiqueOlv ITC Avant Garde Gothic Book Oblique

AntiqueOlv It ITC Avant Garde Gothic Demi 

AntiqueOlv Bd ITC AvantGarde Gothic Demi Oblique

Bodoni Roman 
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CG Omega Bodoni Italic

CG Omega It Bodoni Bold

CG Omega Bd Bodoni Bold Italic

CG Omega BdIt Bodoni Poster

Bodoni Poster Compressed

Garamond Antiqua ITC Bookman Light

Garamond Krsv ITC Bookman Light Italic

Garamond Hlb ITC Bookman Demi

Garamond KrsvHlb ITC Bookman Demi Italic

Carta

Courier Chicago

Courier It Clarendon Roman

Courier Bd Clarendon Bold

Courier BdIt Clarendon Light

Cooper Black

LetterGothic Cooper Black Italic

LetterGothic It Cooper Gothic 32BC

LetterGothic Bd Cooper Gothic 33BC

Coronet

Albertus Md Courier

Albertus XBd Courier Oblique 

Courier Bold 

Clarendon Cd Courier Bold Oblique 

Eurostile Medium

Coronet Eurostile Bold

Eurostile Extended No. 2

Marigold Eurostile Bold Extended No. 2

Geneva

Arial Gill Sans

Arial It Gill Sans Italic

Arial Bd Gill Sans Bold

Arial BdIt Gill Sans Bold Italic

Gill Sans Light

TimesNew Gill Sans Light Italic

TimesNew It Gill Sans Extra Bold

TimesNew Bd Gill Sans Condensed

TimesNew BdIt Gill Sans Condensed Bold

Goudy Oldstyle

Symbol Goudy Oldstyle Italic

Goudy Bold

Resident bitmapped and scalable fonts

PCL 5/PCL 6 PostScript 3
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Wingdings Goudy Bold Italic

Goudy Extra Bold

Line Printer Helvetica 

Helvetica Oblique

Times Roman Helvetica Bold 

Times It Helvetica Bold Oblique 

Times Bd Helvetica Narrow 

Times BdIt Helvetica Narrow Oblique 

Helvetica Narrow Bold 

Helvetica Helvetica Narrow Bold Oblique 

Helvetica Ob Helvetica Condensed

Helvetica Bd Helvetica Condensed Oblique

Helvetica BdOb Helvetica Condensed Bold

Helvetica Condensed Bold Oblique

CourierPS Hoefler Text

CourierPS Ob Hoefler Text Italic

CourierPS Bd Hoefler Text Black

CourierPS BdOb Hoefler Text Black Italic

Hoefler Ornaments

SymbolPS Joanna

Joanna Italic

Palatino Roman Joanna Bold

Palatino It Joanna Bold Italic

Palatino Bd Letter Gothic 

Palatino BdIt Letter Gothic Slanted 

Letter Gothic Bold 

ITCBookman Lt Letter Gothic Bold Slanted

ITCBookman LtIt ITC Lubalin Graph Book

ITCBookmanDm ITC Lubalin Graph Book Oblique

ITCBookmanDm It ITC Lubalin Graph Demi

ITC Lubalin Graph Demi Oblique

HelveticaNr Marigold 

HelveticaNr Ob Monaco

HelveticaNr Bd ITC Mona Lisa Recut

HelveticaNr BdOb New Century Schoolbook Roman 

New Century Schoolbook Italic

N C Schbk Roman New Century Schoolbook Bold 

N C Schbk It New Century Schoolbook Bold Italic 

N C Schbk Bd NewYork

N C Schbk BdIt Optima Roman

Resident bitmapped and scalable fonts

PCL 5/PCL 6 PostScript 3
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Optima Italic

ITC A G Go Bk Optima Bold

ITC A G Go BkOb Optima Bold Italic

ITC A G Go Dm Oxford

ITC A G Go DmOb Palatino Roman 

Palatino Italic 

ZapfC MdIt Palatino Bold

Palatino Bold Italic

ZapfDingbats Stempel Garamond Roman

Stempel Garamond Italic

Stempel Garamond Bold

Stempel Garamond Bold Italic

Symbol 

Tekton Regular

Times Roman 

Times Italic 

Times Bold 

Times Bold Italic

Times New Roman

Times New Roman Italic

Times New Roman Bold

Times New Roman Bold Italic

Univers 45 Light

Univers 45 Light Oblique 

Univers 55

Univers 55 Oblique 

Univers 65 Bold

Univers 65 Bold Oblique

Univers 57 Condensed

Univers 57 Condensed Oblique

Univers 67 Condensed Bold

Univers 67 Condensed Bold Oblique

Univers 53 Extended

Univers 53 Extended Oblique

Univers 63 Extended Bold

Univers 63 Extended Bold Oblique

Wingdings

ITC Zapf Chancery Medium Italic 

ITC Zapf Dingbats

Resident bitmapped and scalable fonts

PCL 5/PCL 6 PostScript 3
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Symbol Sets
A symbol set is the collection of alphabetic and numeric characters, punctuation, and special characters available in 
the font you select. Symbol sets support the requirements for different languages or specific applications, such as 
math symbols used for scientific text.

In PCL 5/PCL 6, a symbol set also defines which character will print for each key on the keyboard (or more 
specifically, for each code point). Some applications require different characters at some code points. To support 
multiple applications and languages, your printer has 36 symbol sets for the resident PCL 5/PCL 6 fonts.

Symbol Sets for PCL 5/PCL 6
Not all font names support all of the symbol sets listed. 

Roman 8 (Default) ISO 8859-1 Latin 1 ISO 8859-2 Latin 2

ISO 8859-9 Latin 5 ISO 8859-10 Latin 6 PC-8

PC-8 DN PC-775 Baltic PC-850 Multilingual

PC-852 Latin 2 PC-1004 OS/2 PC Turkish

Windows 3.1 Latin 1 Windows 3.1 Latin 2 Windows 3.1 Latin 5

DeskTop PS Text MC Text

Microsoft Publishing Math 8 PS Math

Pi Font Legal ISO 4 United Kingdom

ISO 6 ASCII ISO 11 Swedish:names ISO 15 Italian

ISO 17 Spanish ISO 21 German ISO 60 Norwegian v1

ISO 69 French Windows 3.0 Latin 1 Windows Baltic

Symbol Wingdings ITC ZapfDingbats MS
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Understanding Printer Messages
The touch panel displays error messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This chapter provides a list of error codes or error messages, and informs you what you 
can do to clear error messages. When you contact customer support about an error, have the error codes and 
messages ready.

 CAUTION: When an error occurs, the print data remaining on the printer and the information accumulated in the memory of 
the printer may be corrupted.

 NOTE: An error code is listed in an error message.

 NOTE: For error codes that are not listed in this chapter, refer to instructions in each error messages.

Error Codes

Error-Code What you can do

004-310 Turn off the printer. Make sure that the tray is correctly installed, and turn on the printer. Contact customer 
support if this failure is repeated.

005-110 Open the DADF cover and remove the jammed documents.

005-121

005-124 Open the DADF cover and remove all documents.

009-340 Turn off the printer. Clean the CTD sensor with a clean dry cotton swab, and turn on the printer. Contact 
customer support if this failure is repeated. For more information about cleaning the CTD sensor, see 
"Cleaning the CTD Sensor."

009-360 Turn off the printer. Make sure that the yellow toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-361 Turn off the printer. Make sure that the magenta toner cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-362 Turn off the printer. Make sure that the cyan toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-363 Turn off the printer. Make sure that the black toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-367 Turn off the printer. Make sure that the yellow toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-368 Turn off the printer. Make sure that the magenta toner cartridge is correctly installed, and turn on the 
printer. Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-369 Turn off the printer. Make sure that the cyan toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

009-370 Turn off the printer. Make sure that the black toner cartridge is correctly installed, and turn on the printer. 
Contact customer support if this failure is repeated. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."
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010-317 Turn off the printer, wait for 30 minutes to let the fusing unit cool, and then make sure that the fusing unit 
is fully installed. For more information about installing the fusing unit, see "Replacing the Fusing Unit."

010-351 Turn off the printer. Remove the used fusing unit, and install a new fusing unit. For more information about 
replacing the fusing unit, see "Replacing the Fusing Unit."

010-377 Turn off the printer. Confirm that the fusing unit is correctly installed, and turn on the printer. Contact 
customer support if this failure is repeated. For more information about installing the fusing unit, see 
"Replacing the Fusing Unit."

016-316 Turn off the printer. Remove the optional 512MB memory module from the slot, and then reattach it firmly. 
Turn on the printer. Contact customer support if this failure is repeated.

016-318 Remove the unsupported memory module. Contact customer support if this failure is repeated.

016-338 Turn off the printer, and turn it on again. If the error message remains on the touch panel, confirm that the 
wireless adapter is securely inserted. Contact customer support if this failure is repeated.

016-404 Contact your system administrator. For more information about digital certificate problems, see "Digital 
Certificate Problem."

016-405 Security setting mismatch. Initialize the security setting, and then restart the printer. Contact your system 
administrator for the security resetting.

016-503 Unable to resolve the e-mail SMTP server hostname. Select Close, or wait for 60 seconds for the printer to 
recover. Check if SMTP server and DNS server are set correctly.

016-504 Unable to resolve the e-mail POP3 server hostname. Select Close, or wait for 60 seconds for the printer to 
recover. Check if user name and password for POP3 server and DNS server are set correctly.

016-505 E-mail POP3 server login error. Select Close, or wait for 60 seconds for the printer to recover. Check if user 
name and password used for POP3 server are set correctly.

016-506 SMTP server is not configured. Select Close, or wait for 60 seconds for the printer to recover. Check if 
SMTP server or POP server is set.

016-507 E-mail SMTP server login error. Select Close, or wait for 60 seconds for the printer to recover. Check if 
user name and password used for SMTP server are set correctly.

016-520 IPsec certificate error. (Certificate error of the printer.) The certificate of the printer is invalid. Contact your 
system administrator. Reset the certificate from other connectable clients with Dell™ Printer 
Configuration Web Tool. If no device can be connected, disconnect Ethernet cable, turn off the IPsec, and 
then reset the certificate with Dell Printer Configuration Web Tool.

016-521 IPsec certificate error. (Remote device certification verification error.) The certificate of the destination 
client is invalid. Contact your system administrator. Confirm the certificate of the destination client and 
reset.

016-522 LDAP certificate error. (No client certificate exists.) The SSL client certificate is requested by the LDAP 
server.  Set the SSL client certificate to the device. Contact your system administrator.

016-523 LDAP certificate error. (Server certificate verification error.) The SSL certificate of the LDAP server is not 
trusted by the device. Register the root certificate of the SSL certificate of the LDAP server with the device.

016-524 LDAP certificate error. (No server certificate exists.) Change the SSL certificate of the LDAP server to a 
valid SSL certificate.

016-527 LDAP certificate error. (SSL authentication internal error.) The error has occurred inside the program. 
Contact your system administrator. 

016-534 The LDAP server information setting for ColorTrack PRO is invalid. Check the LDAP server setting of the 
printer.

016-541 A wireless certificate (server or client) cannot be correctly referenced while using Wireless LAN 
WPA-Enterprise or WPA2-Enterprise. Ask your system administrator to connect the printer with a wired 
network, initialize the wireless settings, import the wireless certificate, and set WPA-Enterprise or 
WPA2-Enterprise again.
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016-542 A server certificate error has occurred when acquiring the certificate with the operation of WPA-Enterprise 
or WPA2-Enterprise. This is a problem in the server certificate, such as the validity period has expired for 
the server certificate being used with the Radius server. Ask your system administrator to confirm the server 
certificate being used with the Radius server.

016-543 A wireless certificate (server or client) corruption error has occurred while using the Wireless LAN 
WPA-Enterprise or WPA2-Enterprise. Ask your system administrator to connect the printer with a wired 
network, initialize the wireless settings, import the wireless certificate, and set WPA-Enterprise or 
WPA2-Enterprise again.

016-720 Error relating to PDL emulation problems has occurred. Change the Print Mode setting in the Graphics tab 
of the printer driver. Contact customer support if this failure is repeated.

016-756 Printing in the prohibited time. Contact your system administrator.

016-757 The account is not registered. Contact your system administrator.

016-758 The function cannot be used. Contact your system administrator.

016-759 Printable page limit is exceeded. Contact your system administrator.

016-764 An error occurs when the printer connected to the SMTP server. Select Close, or wait for 60 seconds for 
the printer to recover. Check the SMTP server settings or contact the SMTP server administrator.

016-765 The capacity of the SMTP server is not enough. Select Close, or wait for 60 seconds for the printer to 
recover. Contact the SMTP server administrator.

016-766 The e-mail exceeds the SMTP server size restriction. Select Close, or wait for 60 seconds for the printer to 
recover. Contact the SMTP server administrator.

016-767 The e-mail address of the recipient is incorrect. Select Close, or wait for 60 seconds for the printer to 
recover. Check e-mail address, and try scanning again.

016-768 The e-mail address of the sender is incorrect. Select Close, or wait for 60 seconds for the printer to 
recover. Check e-mail address, and try scanning again.

016-786 A timeout error occurs when sending or receiving scanned data. Select Close, or wait for 60 seconds for 
the printer to recover. Check if the Ethernet cable is connected properly. If there is no problem with the 
Ethernet cable, contact server administrator.

016-790 Network connection error. (IP address is not determined.) Select Close, or wait for 60 seconds for the 
printer to recover. Check if the Ethernet cable is connected properly. If there is no problem with the 
Ethernet cable, contact server administrator.

016-799 Select Close to clear the message and cancel the current print job. Confirm the configuration of the 
printer on the printer driver.

016-930 The device is not supported. Remove it from the front USB port.

016-931 The USB hub is not supported. Remove it from the front USB port.

016-985 Select Close, or wait for 60 seconds for the printer to recover. Retry scanning by lowering the resolution 
setting or changing the file format of the scanned image.016-986

024-920 Remove the paper from the output tray.

024-927 Check the toner gauge on the touch panel for an empty toner cartridge. Remove the empty toner cartridge, 
and install a new cartridge. For more information about replacing the toner cartridge, see "Replacing the 
Toner Cartridges."

024-965 Confirm that the size and type specified in the tray settings matches the size and type of paper loaded in the 
tray.024-966

024-969

026-721 Check your USB memory:

• If the file size or the number of files exceeds the limit of your USB memory.

• If your USB memory is write-protected.
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027-446 Change the IPv6 address to avoid duplication. Turn off the printer, and turn it on again.

027-452 Change the IPv4 address to avoid duplication. Turn off the printer, and turn it on again.

031-521 SMB server login error. Select Close, or wait for 60 seconds for the printer to recover. Confirm login-able 
computer with your system administrator.

031-522 SMB server login error. Select Close, or wait for 60 seconds for the printer to recover. Check if login name 
(domain name and user name) and password are correct.

031-523 Invalid SMB share name. Select Close, or wait for 60 seconds for the printer to recover. Check the share 
name you specified.

031-524 Exceeded the SMB server user account limit. Select Close, or wait for 60 seconds for the printer to 
recover. Check the number of users who use the server at the same time is not exceeding the upper limit.

031-525 SMB destination client permission error. Select Close, or wait for 60 seconds for the printer to recover. 
Check if the specified user can read and write file at the storage location.

031-526 Unable to resolve the SMB server hostname. Select Close, or wait for 60 seconds for the printer to recover. 
Check DNS connection, or check if forwarding destination server is registered with DNS.

031-527 Unable to resolve the SMB server hostname. Select Close, or wait for 60 seconds for the printer to recover. 
Set DNS address, or set forwarding destination server address as IP address.

031-528 Unable to connect to the SMB server. Select Close, or wait for 60 seconds for the printer to recover. Check 
if the printer can communicate via network with the forwarding destination SMB server. For example, check 
the following:

• Connection of an Ethernet cable

• TCP/IP setting

• Communication with Port 137 (UDP), 138 (UDP), and 139 (TCP).

For communication beyond the subnet, contact your system administrator.

031-529 SMB server login error. (Invalid password.) Select Close, or wait for 60 seconds for the printer to recover. 
Check if password is correct.

031-530 The SMB share folder was not found on the specified SMB server. Select Close, or wait for 60 seconds for 
the printer to recover. Check the following:

• Check if the storage location is correct.

• Check if the file name you specified can be used when creating a file on the SMB server.

• Have your system administrator check the DFS setting, and directly specify the SMB server, share name, and 
storage location according to the checked settings.

031-531 Unable to get a file or folder name on the SMB server. Select Close, or wait for 60 seconds for the printer 
to recover. Check access right of the folder you specified.

031-532 SMB scan file or folder name limit exceeded. Select Close, or wait for 60 seconds for the printer to 
recover. Change file name and forwarding destination folder, or move or delete file in forwarding destination 
folder.

031-533 Unable to write a file in the SMB server. Select Close, or wait for 60 seconds for the printer to recover. 
Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.

031-534 Unable to create a folder on the SMB server. Select Close, or wait for 60 seconds for the printer to recover. 
Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.
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031-535 Unable to delete a file on the SMB server. Select Close, or wait for 60 seconds for the printer to recover. 
Check if other user is not operating file in storage location you specified.

031-536 Unable to delete a folder on the SMB server. Select Close, or wait for 60 seconds for the printer to recover. 
Check if other user is not operating file in storage location you specified.

031-537 SMB server capacity exceeded. Select Close, or wait for 60 seconds for the printer to recover. Check if 
storage location has free space.

031-539 The specified SMB server is invalid. Select Close, or wait for 60 seconds for the printer to recover. Check 
if server name is correct.

031-540 The specified domain name is invalid. Select Close, or wait for 60 seconds for the printer to recover. 
Check if domain name is correct.

031-541 Invalid user name specified for SMB server. Select Close, or wait for 60 seconds for the printer to recover. 
Check if login name (user name) is correct.

031-542 TCP/IP not initialized. Select Close, or wait for 60 seconds for the printer to recover. Wait for a while and 
try the same operation again. Contact customer support if this failure is repeated.

031-543 SMB server login error. Select Close, or wait for 60 seconds for the printer to recover. Check login 
permitted time with your system administrator.

031-544 SMB server login error. (Expired password.) Select Close, or wait for 60 seconds for the printer to recover. 
Check the password valid period with your system administrator.

031-545 SMB server login error. (Password change required.) Select Close, or wait for 60 seconds for the printer to 
recover. Check necessity of password change with your system administrator.

031-546 SMB server login error. (Invalid user is specified.) Select Close, or wait for 60 seconds for the printer to 
recover. Contact your system administrator for the destination server settings.

031-547 SMB server login error. (The specified user is restricted from accessing the SMB server.) Select Close, or 
wait for 60 seconds for the printer to recover. Contact your system administrator for the destination server 
settings.

031-548 SMB server login error. (Logon time of SMB destination expired.) Select Close, or wait for 60 seconds for 
the printer to recover. Contact your system administrator for the destination server settings.

031-549 SMB server login error. Specified user is restricted, and a null password is prohibited. Select Close, or wait 
for 60 seconds for the printer to recover. On server security settings, check access permission of null 
password user.

031-550 Append command not supported by SMB server. Select Close, or wait for 60 seconds for the printer to 
recover. Check if the printer has access rights to append data to the SMB server. Check if server supports 
SMB append command.

031-551 Rename command not supported by SMB server. Select Close, or wait for 60 seconds for the printer to 
recover. Check if the printer has access rights to rename data on the SMB server. Check if server supports 
SMB append command.

031-552 Job canceled. Select Close, or wait for 60 seconds for the printer to recover. Change the file name that 
already exists on FTP server.

031-574 Unable to resolve the FTP server hostname. Select Close, or wait for 60 seconds for the printer to recover. 
Check DNS connection, or check if name of forwarding destination server is registered with DNS.

031-575 Unable to resolve the FTP server hostname. Select Close, or wait for 60 seconds for the printer to recover. 
Set DNS address, or set forwarding destination server address as IP address.

031-576 Unable to connect to the FTP server. Select Close, or wait for 60 seconds for the printer to recover. Check 
if the printer communicates with forwarding destination FTP server. For example, check connection of 
Ethernet cable and if the IP address of the server is correct.

031-578 FTP server login error. Select Close, or wait for 60 seconds for the printer to recover. Check if login name 
(user name) and password are correct.
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031-579 Invalid FTP subdirectory path. Select Close, or wait for 60 seconds for the printer to recover. Check if 
storage location is correct.

031-580 Failed to obtain a file or folder name of the FTP server. Select Close, or wait for 60 seconds for the printer 
to recover. Check server access right.

031-581 FTP scan file or folder name limit exceeded. Select Close, or wait for 60 seconds for the printer to recover. 
Change file name and forwarding destination folder, or move or delete file in forwarding destination folder.

031-582 Unable to write a scan file to the FTP server location. Select Close, or wait for 60 seconds for the printer 
to recover. Check if the file name you specified can be created in storage location. Check if storage location 
has free space.

031-584 Unable to create a scan folder on the FTP server. Select Close, or wait for 60 seconds for the printer to 
recover. Check if the folder name you specified can be created in storage location. Check if the folder that 
has the same name as the one you specified already exists.

031-585 Unable to delete a file on the FTP server. (DEL command failure.) Select Close, or wait for 60 seconds for 
the printer to recover. Check server access rights.

031-587 Unable to delete a folder on the FTP server. (RMD command failure.) Select Close, or wait for 60 seconds 
for the printer to recover. Check server access rights.

031-588 Unable to write a file to the FTP server location. Select Close, or wait for 60 seconds for the printer to 
recover. Check if storage location has free space.

031-590 Job canceled. Select Close, or wait for 60 seconds for the printer to recover. Change the file name that 
already exists on FTP server.

031-594 FTP transfer type error. (TYPE command failure.) Select Close, or wait for 60 seconds for the printer to 
recover. Try the same operation again. Contact customer support if this failure is repeated.

031-595 FTP data port error. (PORT command failure.) Select Close, or wait for 60 seconds for the printer to 
recover. Try the same operation again. Contact customer support if this failure is repeated.

031-598 FTP append data error. (APPE command failure.) Select Close, or wait for 60 seconds for the printer to 
recover. Check if the printer has access rights to append data to the FTP server. Check if server supports 
FTP append command.

031-599 FTP rename file error. (RNFR command failure.) Select Close, or wait for 60 seconds for the printer to 
recover. Check if the printer has access rights to rename data on the FTP server. Check if server supports 
FTP rename command.

033-513 Select Close, or wait for 60 seconds for the printer to recover. Try the following:

• Print the received fax, or wait for a while until sending a fax is completed.

• Print the fax job stored using the Secure Receive feature.

For more information about the Secure Receive feature, see "Using the Secure Receiving Mode."

033-527 Select Close, or wait for 60 seconds for the printer to recover. Wait for a while until the printer is not busy, 
and try again.

033-528 Select Close, or wait for 60 seconds for the printer to recover. Check the available time period for the 
FAX, and try again.

033-762 Select Close, or wait for 60 seconds for the printer to recover. The printer rejects faxes sent from 
unwanted numbers. For more information, see "Junk Fax Setup."

033-788 Select Close, or wait for 60 seconds for the printer to recover. Try the following:

• Remove the received fax, or wait for a while until sending a fax is completed.

• Print the fax job stored using the Secure Receive feature.

For more information about the Secure Receive feature, see "Using the Secure Receiving Mode."
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034-515 Select Close, or wait for 60 seconds for the printer to recover. Try the following:

• Try the same operation.

• Check the printer or remote machine if the memory is full.

034-791 Select Close, or wait for 60 seconds for the printer to recover. Check if the telephone line cord is 
connected properly. If the line connection is correct, check the following:

• If Tone/Pulse setting is correct.

For more information about Tone/Pulse setting, see "Tone / Pulse."

If Tone/Pulse setting is correct, check the following:

• If the remote machine can receive a fax.

035-701 Select Close, or wait for 60 seconds for the printer to recover. Check the following:

• Status of the remote machine

• Tone/Pulse setting

For more information about Tone/Pulse setting, see "Tone / Pulse."

035-708 Select Close, or wait for 60 seconds for the printer to recover. Try the following:

• Try the same operation.

• Reduce the modem speed.

For more information about modem speed, see "Modem Speed."

035-717 Select Close, or wait for 60 seconds for the printer to recover. Reduce the modem speed. For more 
information about modem speed, see "Modem Speed."

035-718 Select Close, or wait for 60 seconds for the printer to recover. Check the status of the remote machine.

035-720 Select Close, or wait for 60 seconds for the printer to recover. Check the features of the remote machine.

035-781 Select Close, or wait for 60 seconds for the printer to recover. Check if the remote machine is busy.

042-700 Wait for a while until the printer cools down. Contact customer support if this failure is repeated.

075-910 Make sure that the multipurpose feeder (MPF) is fully installed.

077-300 Close the front cover.

077-301 Close the right side cover.

077-302 Close the rear cover.

091-911 Remove the used waste toner box, and install a new toner box. For more information about replacing the 
waste toner box, see "Replacing the Waste Toner Box."

091-914 Reinsert the black drum cartridge. If the message remains, replace the cartridge. For more information 
about reinserting the drum cartridge, see "Replacing the Drum Cartridges."

091-917 Reinsert the yellow drum cartridge. If the message remains, replace the cartridge. For more information 
about reinserting the drum cartridge, see "Replacing the Drum Cartridges."

091-918 Reinsert the magenta drum cartridge. If the message remains, replace the cartridge. For more information 
about reinserting the drum cartridge, see "Replacing the Drum Cartridges."

091-919 Reinsert the cyan drum cartridge. If the message remains, replace the cartridge. For more information about 
reinserting the drum cartridge, see "Replacing the Drum Cartridges."

091-921 Make sure that the black drum cartridge is fully installed. For more information about installing the drum 
cartridge, see "Replacing the Drum Cartridges."

091-922 Make sure that the yellow drum cartridge is fully installed. For more information about installing the drum 
cartridge, see "Replacing the Drum Cartridges."

091-923 Make sure that the magenta drum cartridge is fully installed. For more information about installing the 
drum cartridge, see "Replacing the Drum Cartridges."
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091-924 Make sure that the cyan drum cartridge is fully installed. For more information about installing the drum 
cartridge, see "Replacing the Drum Cartridges."

091-931 Remove the used black drum cartridge, and install a new cartridge. For more information about replacing 
the drum cartridge, see "Replacing the Drum Cartridges."

091-932 Remove the used yellow drum cartridge, and install a new cartridge. For more information about replacing 
the drum cartridge, see "Replacing the Drum Cartridges."

091-933 Remove the used magenta drum cartridge, and install a new cartridge. For more information about replacing 
the drum cartridge, see "Replacing the Drum Cartridges."

091-934 Remove the used cyan drum cartridge, and install a new cartridge. For more information about replacing the 
drum cartridge, see "Replacing the Drum Cartridges."

091-942 Reinsert the black drum cartridge. If the message remains, replace the cartridge. For more information 
about replacing the drum cartridge, see "Replacing the Drum Cartridges."

091-943 Reinsert the yellow drum cartridge. If the message remains, replace the cartridge. For more information 
about replacing the drum cartridge, see "Replacing the Drum Cartridges."

091-944 Reinsert the magenta drum cartridge. If the message remains, replace the cartridge. For more information 
about replacing the drum cartridge, see "Replacing the Drum Cartridges."

091-945 Reinsert the cyan drum cartridge. If the message remains, replace the cartridge. For more information about 
replacing the drum cartridge, see "Replacing the Drum Cartridges."

091-960 Remove the unsupported yellow drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges."

091-961 Remove the unsupported magenta drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges."

091-962 Remove the unsupported cyan drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges."

091-963 Remove the unsupported black drum cartridge, and install a supported drum cartridge. For more 
information about installing the drum cartridge, see "Replacing the Drum Cartridges."

092-651 Clean the CTD sensor with a clean dry cotton swab. For more information about cleaning the CTD sensor, 
see "Cleaning the CTD Sensor."

093-930 Remove the used yellow toner cartridge, and install a new cartridge. For more information about replacing 
the toner cartridge, see "Replacing the Toner Cartridges."

093-931 Remove the used magenta toner cartridge, and install a new cartridge. For more information about replacing 
the toner cartridge, see "Replacing the Toner Cartridges."

093-932 Remove the used cyan toner cartridge, and install a new cartridge. For more information about replacing the 
toner cartridge, see "Replacing the Toner Cartridges."

093-933 Remove the used black toner cartridge, and install a new cartridge. For more information about replacing 
the toner cartridge, see "Replacing the Toner Cartridges."

093-960 Remove the unsupported yellow toner cartridge, and install a supported toner cartridge. For more 
information about installing the toner cartridge, see "Replacing the Toner Cartridges."

093-961 Remove the unsupported magenta toner cartridge, and install a supported toner cartridge. For more 
information about installing the toner cartridge, see "Replacing the Toner Cartridges."

093-962 Remove the unsupported cyan toner cartridge, and install a supported toner cartridge. For more information 
about installing the toner cartridge, see "Replacing the Toner Cartridges."

093-963 Remove the unsupported black toner cartridge, and install a supported toner cartridge. For more 
information about installing the toner cartridge, see "Replacing the Toner Cartridges."

093-970 Make sure that the yellow toner cartridge is fully installed. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."
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093-971 Make sure that the magenta toner cartridge is fully installed. For more information about installing the 
toner cartridge, see "Replacing the Toner Cartridges."

093-972 Make sure that the cyan toner cartridge is fully installed. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

093-973 Make sure that the black toner cartridge is fully installed. For more information about installing the toner 
cartridge, see "Replacing the Toner Cartridges."

094-422 Remove the used transfer belt unit, and install a new transfer belt unit. For more information about 
replacing the transfer belt unit, see "Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

094-910 Make sure that the transfer belt unit is fully installed. For more information about installing the transfer belt 
unit, see "Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd BTR), and the Retard Roller."

094-911 Remove the used transfer belt unit, and install a new transfer belt unit. For more information about 
replacing the transfer belt unit, see "Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

116-722 Select Close for the printer to recover. Check the WSD scan address and the destination computer, and 
then try scanning again. Contact your system administrator.

193-700 When genuine toner cartridges are installed, change the Non-Dell Toner setting to disable using the Dell 
Printer Configuration Web Tool or the Tool Box.

Message Cause Action

Cannot access the LDAP address 
book. Consult your network 
administrator if this error persists.

The printer fails to authenticate against an 
authentication server.

Check the server settings. If the error 
persists, consult your network administrator.

An SSL authentication error on connection 
to the LDAP server; an SSL authentication 
internal error occurs.

If the error persists, consult your network 
administrator.

Cannot access the LDAP address 
book. The LDAPS server certificate 
is not correct.

An SSL authentication error on connection 
to the LDAP server; the server certificate 
data is incorrect.

Check the root certificate of the LDAP 
server SSL certificate on the printer.

Cannot access the LDAP address 
book. The LDAPS SSL client 
certificate is not set.

An SSL authentication error on connection 
to the LDAP server; the LDAP server cannot 
acquire an SSL client certificate.

Check that an SSL client certificate is 
correctly imported into the printer.

Cannot access the LDAP address 
book. The server names of LDAPS 
and the SSL certificate do not 
match.

An SSL authentication error on connection 
to the LDAP server; the server certificate for 
the LDAP server is not yet valid or has 
expired.

Change to a valid LDAP server SSL 
certificate.

An SSL authentication error on connection 
to the LDAP server; the LDAP server name 
does not match the certificate.

Set the LDAP server address on the printer 
to match the address on the LDAP server 
SSL certificate.

Cannot access the LDAP address 
book. The time settings of the 
printer and the Kerberos server do 
not match.

The printer and the Kerberos server clocks 
have a time difference that exceeds the 
Kerberos server clock skew value. 

Check that the printer and the Kerberos 
server clocks have the correct time.
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Cannot connect to server. Check the 
server settings.

The specified server settings such as IP 
address and realm/domain name are 
incorrect.

Make sure that the correct IP address/host 
name, port number, realm/domain name, 
and search directory root are specified in IP 
Address / Host Name & Port, Domain 
Name, and Search Directory Root on the 
Dell Printer Configuration Web Tool. (See 
"Kerberos Server" and "LDAP Server.")

The LDAP or Kerberos version on the server 
is not compatible with the printer.

Consult your network administrator.

The server is down. Check that the server is functioning 
normally.

Change the server settings and 
confirm the server connection.

The printer cannot search for destinations 
within the specified time.

Increase the time setting for Search Time-
Out on the Dell Printer Configuration Web 
Tool. (See "Authentication System" and 
"LDAP Server.")

Check that the printer and the server are 
properly connected with an Ethernet cable. 
If there are not any problems with the 
connection and the error persists, the server 
settings may have been changed. Consult 
your network administrator.

Check the authentication settings. The login name and password for access to 
an authentication server are incorrect.

Make sure that the correct login name and 
password are specified in Login Name and 
Password on the Dell Printer Configuration 
Web Tool. (See "Kerberos Server" and 
"LDAP Server.")

Invalid search characters or LDAP 
User Mapping incorrectly configured 
for Configuration Web Tool.

The LDAP search filter fails to work properly 
as special characters are used in your search 
condition or on the LDAP User Mapping 
page on the Dell Printer Configuration 
Web Tool.

Remove special characters, and then search 
again. (See "LDAP User Mapping.") 

Network connection is not ready. Try 
again later.

You have started searching for destinations 
before the IP address is set for the printer.

Wait for a while, and then search again.

No attribute or invalid name. 
Confirm address info. on server.

The address information on the server 
contain incorrect data or are insufficient to 
get your search request.

Check the address information registered on 
the server or consult your network 
administrator.

No Entries. The printer cannot find any destinations 
that meet your search condition.

Select OK to return to the Search Network 
Address Book screen, and then specify a 
new condition to search again.

Search Directory Root incorrectly 
configured for Configuration Web 
Tool.

The directories that do not exist in the 
LDAP server are specified or an invalid DN 
syntax is specified.

Make sure that valid values are specified in 
Search Directory Root on the Dell Printer 
Configuration Web Tool. (See "LDAP 
Server.") Specify the origin of the search 
with the correct DN syntax, as shown in the 
following example:

dc=w2008ad,dc=addressbook,dc=net

Too many search results. Only a 
maximum of 50 search scan be 
displayed. Please refine your search if 
needed.

The number of search results has exceeded 
the limits (50 search results) the printer can 
display.

Select Close to display the search results. 
If you cannot find your desired destination 
on the result list, specify a new condition to 
search again.

Message Cause Action
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Certificate Error 016-530

Job canceled. Restart the printer.

Some other error occurs regarding the LDAP 
server address book.

Turn off the printer, and turn it on again. If 
the error persists, consult your network 
administrator.

Message Cause Action
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Specifications

Operating System Compatibility
Your Dell™ C3765dnf Multifunction Color Laser Printer is compatible with Microsoft® Windows® XP, Windows XP 
64-bit Edition, Windows Server® 2003, Windows Server 2003 x64 Edition, Windows Server 2008, Windows Server 
2008 64-bit Edition, Windows Server 2008 R2 64-bit Edition, Windows Vista®, Windows Vista 64-bit Edition, 
Windows 7, Windows 7 64-bit Edition, Windows 8, Windows 8 64-bit Edition, Windows Server 2012, Mac OS X 
10.3.9, 10.4.11, 10.5, 10.6, 10.7, 10.8, Red Hat® Enterprise Linux® 5/6 Desktop (x86), and SUSE® Linux Enterprise 
Desktop 10/11 (x86).

Power Supply

Dimensions
Height: 558 mm (21.97 inches) Width: 530 mm (20.87 inches) Depth: 530 mm (20.87 inches)

Weight (including toner cartridges and drum cartridges): 32.7 kg (72.09 lb)

Memory

Page Description Language (PDL)/Emulation, Operating System, and 
Interface

Rated voltage 220 VAC - 240 VAC 110 VAC - 127 VAC

Frequency 50/60 Hz 50/60 Hz

Current 5 A or less 9 A or less

Power consumption 78.0 W (Ready)

19.5 W (Sleep)

5.5 W (Deep Sleep)

0 W (Offline)

82.0 W (Ready)

19.5 W (Sleep)

5.5 W (Deep Sleep)

0 W (Offline)

TEC value 3.0 kWh 3.0 kWh

Base memory 512 MB

Maximum memory 1024 MB (512 MB + 512 MB)

Connector 144 pin EP2-2100 DDR2 SDRAM
32b-SO-DIMM

DIMM size 512 MB

Speed EP2-2100

PDL/Emulations PCL 6, PCL5e, PostScript, HBPL, XPS (Host Based)
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MIB Compatibility
Management Information Base (MIB) is a database containing information about network devices (such as adapters, 
bridges, routers, or computers). This information helps network administrators manage the network (analyze 
performance, traffic, errors, and so on). Dell C3765dnf Multifunction Color Laser Printer complies with standard 
industry MIB specifications, allowing the printer to be recognized and managed by various printer and network 
management software systems.

Environment

Operation

Print Quality Guarantee

Storage

Altitude

Cables
Your interconnection cable must meet the following requirements:

Operating systems Microsoft Windows XP/XP x64/Server 2003/Server 2003 x64/Server 2008/Server 2008 x64/Server 
2008 R2 x64/Vista/Vista x64/7/7 x64/8/8 x64/Server 2012, Mac OS X (10.3.9/10.4.11/10.5/10.6/10.7/ 
10.8), Red Hat Enterprise Linux 5/6 Desktop (x86), and SUSE Linux Enterprise Desktop 10/11 
(x86)

Interfaces Standard local: USB 2.0

Standard network: 10Base-T/100Base-TX/
1000Base-T Ethernet

Optional network: IEEE 802.11b/802.11g/802.11n (Wireless)

Temperature 10 °C - 32 °C

Relative humidity 10 % - 85 % RH (no condensation)

Temperature 15 °C - 28 °C

Relative humidity 20 % - 70 % RH (no condensation)

Temperature range -20 °C to 40 °C (0 °F to 104 °F)

Storage humidity range 5 % - 85 % RH (no condensation)

Operating Up to 3,100 m (10,170 feet)

Storage Up to 3,100 m (10,170 feet)

Connection type Connection specifications and symbols

1 Ethernet 10Base-T/100Base-TX/
1000Base-T
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Copier Specifications

2 USB USB 2.0

3 Wireless adapter socket IEEE 802.11b/802.11g/802.11n

4 Phone connector

5 Wall jack connector

Item Description

Copy resolution Optical: 600 dpi x 600 dpi

Copy speed Color 35 cpm or more, Black & White 35 cpm or more (When using the 
document glass to make sequential copies of a document with pages scanned one 
by one.)

Simplex: Color 13 cpm or more, Black & White 22 cpm or more

Duplex: Color 4 cpm or more, Black & White 7 cpm or more 

(When using the Duplex Automatic Document Feeder (DADF) to make 
sequential copies of multiple documents.)

Paper size A4, B5, A5, Letter, Executive, Folio (8.5" x 13"), Legal, Envelope #10, Monarch, 
DL, C5

Zoom rate Document glass: 25 % - 400 %, DADF: 25 % - 400 %

Connection type Connection specifications and symbols

1

2

3

4

5
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Scanner Specifications

*1 : Windows OS only
*2 : Windows Vista/7/8 only

Facsimile Specifications

Multiple copies 1 - 99 pages

Copy mode (=Original type) Text, Text & Photo, Photo

Scanning method Document glass: Document-fixed flatbed scanning

DADF: Carriage-fixed, document-feeding scanning (2- side scanning)

Item Description

Compatibility TWAIN, TWAIN-Net, Windows Image Acquisition (WIA)*1, 
Scan Service for WSD*2

Scan resolution Optical: 600 dpi x 300 dpi (Color only), 600 dpi x 400 dpi, 600 dpi x 600 dpi, 1,200 
dpi, x 1,200 dpi

Enhanced (Pull Scan):

• TWAIN – 50 x 50 to 9,600 x 9,600 dots/25.4 mm

• WIA – 75/100/150/200/300/400/600 dots/25.4 mm

Enhanced (Push Scan):

200(Default)/300/400/600 dots/25.4 mm

Color bit depth 24 bit

Mono bit depth 1 bit for Line art. 8 bit for Gray scale

Effective scanning length Document glass: 297 mm. DADF: 355.6 mm

Effective scanning width 215.9 mm

Scan speed (Text mode) Monochrome: 665 μs/line (600 dpi), 1330 μs/line (1200 dpi) 

Color: 1330 μs/line (600 dpi), 2660 μs/line (1200 dpi)

Item Description

Compatibility ITU-T Super G3, ITU-T G3 ECM, ITU-T G3 

Applicable line Public Switched Telephone Network (PSTN), Private Branch Exchange (PBX), or 
Leased line (3.4 KHz/2-wire)

Data coding 1bit/JBIG/MMR/MR/MH

Max modem speed  33.6 Kbps 

Transmission speed Approx. 3 seconds/page *Transmission time applies to memory transmission of 
text data scanned in Standard resolution with ECM using only ITU-T No.1 Chart. 

Scanning speed Document glass: approx. 3 seconds/A4 (at standard fax resolution mode) DADF: 
approx. 5 seconds/Letter (at standard fax resolution mode), 7.5 seconds/Letter (at 
fine fax resolution mode) 

Maximum document length Document glass: 297 mm DADF: 355.6 mm 

Paper size Letter, A4 (depending on a country)

Item Description
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Optional Wireless Adapter

*1 This item is available only when the optional hard disk is installed.
*2 EAP method supports PEAPv0, EAP-TLS, EAP-TTLS PAP, and EAP-TTLS CHAP.
*3 WPS 2.0 compliant.

Resolution Standard: R8 x 3.85 l/mm, Fine: R8 x 7.7 l/mm, Super Fine: 400 dpi x 400 dpi, 
Photo: R8 x 7.7 1/mm

User memory 4 MB (320 pages) 

Halftone 256 levels

Item Description

Connectivity technology Wireless

Compliant standards IEEE 802.11b, 802.11g, and 802.11n

Bandwidth 2.4 GHz

Data transfer rate IEEE 802.11n: 65 Mbps
IEEE 802.11g: 54, 48, 36, 24, 18, 12, 9, and 6 Mbps
IEEE 802.11b: 11, 5.5, 2, and 1 Mbps

Security 64 (40-bit key)/128 (104-bit key) WEP, 
WPA- PSK (TKIP, AES), WPA2-PSK (AES), WPA-Enterprise (TKIP, AES)*1*2, 
WPA2-Enterprise (AES)*1*2

Wi-Fi Protected Setup® (WPS)*3 Push-Button Configuration (PBC), 
Personal Identification Number (PIN)

Item Description
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30
Maintaining Your Printer
You need to complete certain tasks to maintain optimum print quality.

Determining the Status of Supplies
If your printer is connected to the network, the Dell™ Printer Configuration Web Tool can provide instant feedback 
on remaining toner levels. Type the printer's IP address in your web browser to view this information. To use the E-
Mail Alert Setup feature that notifies you when the printer requires new supplies, type the desired e-mail address in 
the e-mail list box.

On the touch panel screen, you can also confirm the following:

• Any supply or maintenance items that require attention replacing (However, the printer can only display 
information about one item at a time).

• Amount of toner remaining in each toner cartridge.

Conserving Supplies
You can change several settings in your printer driver to conserve toner cartridge and paper.

Ordering Supplies
You can order consumables (toner cartridges, drum cartridges, and waste toner box) from Dell on the Internet when 
using a networked printer. Type the IP address of your printer in your web browser, launch the Dell Printer 
Configuration Web Tool, and click the Order Supplies at: to order consumables for your printer. 

You can also order consumables by the following method.

1 Click Start→ All Programs→ Dell Printers→ Additional Color Laser Software→ Dell Supplies Management 
System.

The Dell Supplies Management System window appears.

2 Select your printer from the Select Printer Model list.

3 If ordering from the web:

a Select a URL from the Select Reorder URL list.

b Click Visit Dell printer supplies ordering web site.

 NOTE: When you cannot get information from the printer automatically by two-way communication, a window that 
prompts you to type the Service Tag appears. Type your Dell printer Service Tag in the field provided.
Your Service Tag number is located inside the front cover of your printer.

4 If ordering by phone, call the number that appears under the Order by Phone heading.

Supply Setting Function

Toner cartridge Toner Saver in the Others tab This check box allows the users to select a print mode that uses less 
toner. The image quality will be lower when this feature is used.

Print media Multiple Up in the Layout tab The printer prints two or more pages on one side of a sheet. 

Print media Duplex in the General tab The printer prints on both sides of a sheet of paper.
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Storing Print Media
To avoid potential paper feeding problems and uneven print quality, there are several things you can do:

• To achieve the best possible print quality, store print media in an environment where the temperature is 
approximately 21 °C (70 °F) and the relative humidity is 40 %.

• Store cartons of print media on a pallet or shelf, rather than directly on the floor.

• If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so 
the edges do not buckle or curl.

• Do not place anything on top of the print media packages.

Storing Consumables
Store consumables in their original packaging until you need to use them. Do not store consumables in:

• Temperatures greater than 40 °C (104 °F).

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• A humid environment.
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Replacing the Toner Cartridges
 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 

Information Guide.

Dell toner cartridges are available only through Dell. You can order cartridges online at http://www.dell.com/supplies 
or by phone. To order by phone, see "Contacting Dell."

It is recommended to use Dell toner cartridges for your printer. Dell does not provide warranty coverage for problems 
caused by using accessories, parts, or components not supplied by Dell.

 WARNING: Never throw used toner cartridges into fire. The residual toner could explode resulting in burns and injuries.

 WARNING: Do not shake the used toner cartridge. This may cause toner spills.

Removing the Toner Cartridge

 NOTE: Ensure that you remove all the paper from the MPF and close the MPF cover before removing the toner cartridge.

1 Grasp the grips on both sides of the front cover, and then pull it down to open.

2 Grasp the handle on the toner cartridge that you want to replace, and then pull it out.

 WARNING: Do not shake the toner cartridge as it may cause toner spills.

http://www.dell.com/supplies
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Installing a Toner Cartridge
1 Unpack a new toner cartridge of the desired color.

2 Shake the new toner cartridge five or six times to distribute the toner evenly.

3 Insert the toner cartridge into the associated cartridge slot, and then push until it stops.

4 Close the front cover.
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Replacing the Drum Cartridges
You need to replace all drum cartridges (yellow, magenta, cyan, and black) at a time.

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 
Information Guide.

 CAUTION: Protect the drum cartridges against bright light. If the right side cover remains open for more than three minutes, 
print quality may deteriorate.

Removing the Drum Cartridge
1 Open the right side cover.

2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.
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3 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out.

 CAUTION: Take care not to drop the waste toner box while you are removing it.

 CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands.

4 Stand the removed waste toner box upright on a level surface.

 WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills.
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5 Slightly pressing down the tab on the drum cartridge that you want to replace, pull it out halfway with one hand.

6 Support the drum cartridge with the other hand from underneath, and then pull it out completely.

7 Repeat the steps 5 and 6 to remove the other three cartridges.

Installing a Drum Cartridge
1 Unpack a new drum cartridge of the desired color.

2 Remove the orange protective cover from the drum cartridge.
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3 Insert the drum cartridge into the associated cartridge slot, and then push until it stops.

4 Repeat the steps 1 to 3 to insert the other three cartridges.

5 Remove the cleaning rod from inside the printer.

6 Remove the cleaning pad by pressing the white tabs between your thumb and index finger.

7 Unpack a new cleaning pad.
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8 Attach the new cleaning pad to the cleaning rod.

9 Insert the cleaning rod fully into one of the four holes until it clicks into the interior of the printer as illustrated 
below, and then pull it out.

10 Repeat step 9 also on the other three holes. One time insertion is enough for each hole.

11 Return the cleaning rod to its original location.
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12 Reinsert the removed waste toner box.

 CAUTION: If the waste toner box does not fit into place properly, make sure that the drum cartridge is fully inserted in 
the previous step.

13 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

14 Close the right side cover.
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Replacing the Fusing Unit
 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 

Information Guide.

Removing the Fusing Unit
1 Turn off the printer and wait for 30 minutes.

2 Push down the latch to open the rear cover.

3 Grasp the grips on both sides of the fusing unit squeezing the lever under the left side grip, and then pull out the 
unit.
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Installing a Fusing Unit
1 Unpack a new fusing unit.

2 Make sure that the two tabs of the fusing unit align with the grooves on the printer, and then insert it into the 
printer until it clicks.

3 Close the rear cover.

 NOTE: After replacing the fusing unit, be sure to initialize its life counter by following the instructions in the accompanying 
manual.
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Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd BTR), 
and the Retard Roller
You need to replace all three parts (transfer belt unit, 2nd BTR, and retard roller) at a time. Both the 2nd BTR and 
the retard roller for replacement come with a new transfer belt unit.

 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 
Information Guide.

 CAUTION: Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, or oil 
from your hands on the film of the transfer belt unit may reduce print quality.

Removing the Transfer Belt Unit
1 Push down the latch to open the rear cover.

2 Open the right side cover.
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3 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.

4 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out.

 CAUTION: Take care not to drop the waste toner box while you are removing it.

 CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands.
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5 Stand the removed waste toner box upright on a level surface.

 WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills.

6 Lift the operator panel.

7 Open the top cover.
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8 Put your fingers through the loops on both sides of the transfer belt unit, and then pull it out.

 CAUTION: If you cannot pull out the unit from the printer, make sure that all of the above procedures are performed 
properly.

9 Clean the CTD sensor (as shown) with a clean, dry cotton swab.

Installing a Transfer Belt Unit
1 Unpack a new transfer belt unit.

2 Remove the two orange packing materials first, and then the protective sheet from the transfer belt unit.

 CAUTION: Ensure nothing touches or scratches the surface (black-colored film) of the transfer belt unit. Scratches, dirt, 
or oil from your hands on the film of the transfer belt unit may reduce print quality.
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3 Make sure that the arrow marks on the transfer belt unit and the printer face each other, and then insert the unit 
into the printer until it clicks.

4 Close the top cover.

5 Lower the operator panel back in place.
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6 Reinsert the removed waste toner box.

 CAUTION: If the waste toner box does not fit into place properly, make sure that the transfer belt unit is fully inserted.

7 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

8 Close the right side cover.

 NOTE: After replacing the transfer belt unit, be sure to initialize its life counter by following the instructions in the 
accompanying manual.
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Removing the 2nd BTR
1 Pinching the tabs on both sides of the 2nd BTR, lift it out of the printer.

Installing a 2nd BTR
1 Unpack a new 2nd BTR.

2 Hold the 2nd BTR by both its ends.

3 Make sure that the arrow marks on the 2nd BTR and the printer face each other, and then press down the 2nd BTR 
until it clicks.
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4 Close the rear cover.

Removing the Retard Roller in Tray1
1 Pull tray1 out of the printer about 200 mm.

2 Hold tray1 with both hands, and remove it from the printer.

 NOTE: Ensure that you remove all the paper from tray1 before removing the retard roller.
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3 Slightly pressing down the lock lever on tray1 to the right with one hand, raise the retard roller with the other hand.

4 Slide the retard roller to the left to remove it from tray1.

Installing a Retard Roller in Tray1
1 Slide the two axles of the retard roller into the holes on tray1.

2 Press down the retard roller until it snaps.
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3 Load paper in tray1, and then insert the tray into the printer and push until it stops.

Replacing the Waste Toner Box
 WARNING: Before performing any of the following procedures, read and follow the safety instructions in the Product 

Information Guide.

Removing the Waste Toner Box
1 Open the right side cover.

2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.
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3 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out.

 CAUTION: Take care not to drop the waste toner box while you are removing it.

 CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands.

4 Insert the used waste toner box into the plastic bag that came with the new waste toner box and seal the bag.

Installing a Waste Toner Box
1 Unpack a new waste toner box.

2 Insert the waste toner box.
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3 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.

4 Close the right side cover.
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Cleaning Inside the Printer

Cleaning the CTD Sensor
Clean the Color Toner Density (CTD) sensor only when an alert for the CTD sensor is shown on the Status Monitor 
or touch panel screen.

1 Ensure that the printer is turned off.

2 Push down the latch to open the rear cover.

3 Open the right side cover.

4 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.
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5 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out.

 CAUTION: Take care not to drop the waste toner box while you are removing it.

 CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands.

6 Stand the removed waste toner box upright on a level surface.

 WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills.
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7 Lift the operator panel.

8 Open the top cover.

9 Put your fingers through the loops on both sides of the transfer belt unit, and then pull it out.
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10 Clean the CTD sensor (as shown) with a clean, dry cotton swab.

11 Make sure that the arrow marks on the transfer belt unit and the printer face each other, and then insert the unit 
into the printer until it clicks.

12 Close the top cover.
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13 Lower the operator panel back in place.

14 Reinsert the removed waste toner box.

 CAUTION: If the waste toner box does not fit into place properly, make sure that the transfer belt unit is fully inserted.

15 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.



492 Maintaining Your Printer

16 Close the right side cover.

17 Close the rear cover.

Cleaning the Raster Optical Scanner (ROS) Window
To prevent deterioration of printing quality due to stains inside the printer, clean inside the printer regularly by using 
the cleaning rod whenever you replace drum cartridges.

1 Open the right side cover.
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2 Turn the waste toner box lock lever 90-degrees counterclockwise to unlock the waste toner box.

3 Grasp the handle on the waste toner box and pull it out making sure to hold it upright so that the waste toner does 
not spill out.

 CAUTION: Take care not to drop the waste toner box while you are removing it.

 CAUTION: After removing the waste toner box, do not touch the parts shown in the illustration. Toner can dirty or stain 
your hands.



494 Maintaining Your Printer

4 Stand the removed waste toner box upright on a level surface.

 WARNING: Never lay the waste toner box on its side as this may cause its malfunction or toner spills.

5 Remove the cleaning rod from inside the printer.

6 Insert the cleaning rod fully into one of the four holes until it clicks into the interior of the printer as illustrated 
below, and then pull it out.

7 Repeat step 6 also on the other three holes. One time insertion is enough for each hole.
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8 Return the cleaning rod to its original location.

9 Reinsert the removed waste toner box.

10 Turn the waste toner box lock lever 90-degrees clockwise to lock the waste toner box.
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11 Close the right side cover.

Cleaning the Scanner
Keeping the scanner clean helps ensure the best possible copies. It is recommended to clean the scanner at the start 
of each day and during the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.

2 Open the document cover.
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3 Wipe the surface of the document glass and DADF glass until it is clean and dry.

4 Wipe the underside of the white document cover and white sheet until it is clean and dry.

5 Close the document cover.

1 White Sheet

NOTE: Handle with care.

2 White Document Cover

3 Document Glass

4 DADF Glass

1

2

3

4
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Cleaning the DADF Feed Roller
Keeping the DADF feed roller clean helps ensure the best possible copies. It is recommended to clean the DADF feed 
roller at regular intervals.

1 Open the DADF cover.

2 Wipe the DADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

If the DADF feed roller gets soiled with ink stains, paper from the DADF may also be soiled. In this case, slightly 
dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the contamination 
from the DADF feed roller until it is clean and dry.

Adjusting Color Registration
To adjust the color registration when you first install the printer or after moving it to a new location, follow the 
procedure below.

• Printing the Color Registration Chart

• Determining Values

• Entering Values

 NOTE: If the Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu.

Printing the Color Registration Chart 

When Using the Operator Panel

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Maintenance.

4 Select  until Color Reg Adjust appears, and then select Color Reg Adjust.
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5 Select Color Regi Chart.

6 Select Print.

The color registration chart is printed.

When Using the Tool Box

1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer → Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box."

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Service Tools from the list at the left side of the page.

The Service Tools page is displayed.

4 Click Start next to Color Regi Chart under Color Registration Adjustments.

The color registration chart is printed.

Determining Values
On the color registration chart, there are two types of charts: Chart 1 (fast scan) and Chart 2 (slow scan).

The Chart 1 is used to adjust the color registration for the fast scan direction, which is vertical to paper feed 
direction. The Chart 2 is used to adjust the color registration for the slow scan direction, which is horizontal to paper 
feed direction.

The following sections explain how to determine the adjustment values for the fast scan and the slow scan using 
Chart 1 and Chart 2.

Chart 1 (fast scan)

Chart 2 (slow scan)
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Fast Scan

On the Chart 1 of the color registration chart, find the straightest lines where the two black lines and the colored line 
are most closely aligned for each color (LY, LM, LC, RY, RM, and RC). If you find the straightest line, make a note 
of the value (-8 to +8) indicated by the straightest line for each color.

When the value is 0 for each color, you do not need to adjust the color registration for the fast scan.

When the value is not 0, enter the value using the procedure in "Entering Values."

 NOTE: If it is difficult to choose only one value, as in the case that there seem to be two values closest to a straight line, take the 
value between the two. For example, in the figure above, -6 and -8 are the values closest to a straight line, so you would enter the 
value -7. 

Slow Scan

On the Chart 2 of the color registration chart, find the medium line within the range of white area for each color 
pattern (PY, PM, and PC). If you find the medium line, make a note of the value (-9 to +9) indicated by the 
medium line for each color.

When the value is 0 for each color, you do not need to adjust the color registration for the slow scan.

When the value is not 0, enter the value using the procedure in "Entering Values."

Straightest line

Lattice pattern
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Entering Values

When Using the Operator Panel

Using the operator panel, enter the values found in the color registration chart to make adjustments. 

1 Press the  (Information) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Maintenance.

4 Select  until Color Reg Adjust appears, and then select Color Reg Adjust.

5 Select Enter Number.

6 Select - or + to specify the values for left colors (LY, LM, and LC), and then select Next.

7 Select - or + to specify the values for right colors (RY, RM, and RC), and then select Next.

8 Select - or + to specify the values for process colors (PY, PM, and PC), and then select OK.

 NOTE: The registration values are always shown as 0 the next time you enter the menu.

9 Select Color Regi Chart.

10 Select Print.

The color registration chart with the new values is printed.

If the straightest line is not at the value of 0, adjust the values again. Checking the charts before and after the 
adjustments will help you to determine the values to enter.
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When Using the Tool Box

Using the Tool Box, enter the values that you found in the color registration chart to make adjustments. 

1 Click Start→ All Programs→ Dell Printers→ Dell C3765dnf Multifunction Color Laser Printer→ Tool Box.

 NOTE: For details about starting the Tool Box, see "Starting the Tool Box."

The Tool Box opens.

2 Click the Printer Maintenance tab.

3 Select Service Tools from the list at the left side of the page.

The Service Tools page is displayed.

4 Specify each value for process, left, and right colors in Enter Number under Color Registration Adjustments, and 
then click Apply New Settings.

5 Click Start next to Color Regi Chart under Color Registration Adjustments.

The color registration chart is printed with the new values.

6 Adjust till all straight lines are at the value of 0. Show image of before and after adjustment will help.

After printing the color registration chart, do not turn off the printer until the printer motor has stopped running. 

 NOTE: If 0 is not next to the straightest lines, determine the values and adjust the printer again. 
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Removing Options
If the printer location needs to change or the printer and print media handling options need to be shipped to a new 
location, all print media handling options must be removed from the printer. For shipping, pack the printer and print 
media handling options securely to avoid damage.

Removing the Optional Memory Module
 WARNING: When you remove the optional memory module, be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks.

1 Ensure that the printer is turned off.

2 Turn the screw on the left side cover counterclockwise.

3 Slide the left side cover towards the back of the printer.
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4 Open the left side cover completely.

5 Push the clips on both sides of the slot outward to raise the memory module up.

6 Hold the memory module and pull it straight out.
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7 Close the left side cover, and then slide it towards the front of the printer.

8 Turn the screw clockwise.

9 Turn on the printer.
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Removing the Optional 550-Sheet Feeder
 WARNING: When you remove the optional 550-sheet feeder (Tray2), be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks.

1 Ensure that the printer is turned off, and then disconnect all cables from the back of the printer.

2 Pull the tray1 out of the printer about 200 mm. 

3 Hold tray1 with both hands, and remove it from the printer.
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4 Remove the two screws joining the printer and the optional 550-sheet feeder by unscrewing them with a coin or 
similar object.

5 Gently lift the printer off the optional 550-sheet feeder, and place it on a level surface.

 WARNING: Two people are required to lift the printer. 
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6 Insert the tray1 into the printer, and push until it stops.

 CAUTION: Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

7 Re-connect all cables into the back of the printer and turn on the printer.
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Removing the Optional Wireless Adapter
 WARNING: When you remove the optional wireless adapter, be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks.

1 Ensure that the printer is turned off.

2 Turn the screw on the left side cover counterclockwise to remove it.

3 Slide the left side cover towards the back of the printer.

4 Open the left side cover completely.
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5 Remove the wireless adapter from the printer by releasing the adapter's hook while pushing the wireless adapter 
towards the front of the printer.

6 Close the left side cover, and then slide it towards the front of the printer.

7 Turn the screw clockwise.

8 Turn on the printer.
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Removing the Optional Hard Disk 
 WARNING: When you remove the optional wireless adapter, be sure to turn off the printer, unplug the power cable, and 

disconnect all cables from the back of the printer before starting these tasks.

1 Ensure that the printer is turned off. 

2 Turn the screw on the control board counterclockwise 

3 Slide the left side cover towards the back of the printer. 

4 Open the left side cover completely. 
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5 Remove the hard disk from the printer by releasing the hook of hard disk.

6 Close the left side cover, and then slide it towards the front of the printer. 

7 Turn the screw clockwise. 

8 Turn on the printer. 
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Clearing Jams
Careful selection of appropriate print media and proper loading allow you to avoid paper jams. See "Print Media 
Guidelines" for more information.

 NOTE: Before buying large quantities of any print media, it is recommended to try a sample first.

Avoiding Jams
• Use only recommended print media. See "Print Media Guidelines" for more information.

• See "Loading Print Media in Tray1 and the Optional 550-Sheet Feeder" and "Loading Print Media in the MPF" to 
load print media properly.

• Do not overload the print media sources. Ensure that the print media stack height does not exceed the maximum 
height indicated by the load-line labels in the tray.

• Do not load wrinkled, creased, damp, or curled print media.

• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a 
time through the multipurpose feeder (MPF).

• Do not use print media that you have cut or trimmed yourself.

• Do not mix print media sizes, weights, or types in the same print media source.

• Ensure that the recommended print side is face up when you insert the print media. 

• Keep print media stored in an acceptable environment. For more information, see "Storing Print Media."

• Do not remove the feeding tray during a print job.

• Push tray1 or the optional 550-sheet feeder (tray2) in firmly after loading.

• Ensure that all cables that connect to the printer are correctly attached.

• Overtightening the guides may cause jams.

• Wipe the retard rollers in the tray or MPF with a cloth that is slightly dampened with water if jams caused by 
misfeeding paper occur frequently.
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Identifying the Location of Paper Jams
 WARNING: Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

1 Duplex Automatic Document Feeder (DADF)

2 Fusing Unit

3 Tray1

4 MPF

5 Optional 550-Sheet Feeder

1

2

345
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Clearing Paper Jams From the DADF
When a document jams while it passes through the DADF, remove the jam according to the following procedure.

 NOTE: To prevent document jams, use the document glass for thick, thin, or mixed documents.

1 Remove the remaining documents from the DADF.

If the document is jammed in the paper feed area:

a Open the DADF cover.

b Lift the release lever 90 degrees and remove the jammed document by carefully pulling it to the right.

If you find it difficult to pull the document:
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c Remove the DADF feed roller assembly and remove the document by gently pulling it straight up.

d Insert the DADF feed roller assembly and press down the release lever.

If the document is jammed in the paper exit area:

e Remove the jammed document from the document output tray. 
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f Close the DADF cover, and then load the documents back into the DADF.

 NOTE: Ensure that you adjust the document guides before printing a Legal-size document.

2 If you cannot see the jammed document or the jammed document do not move when you pulled, open the 
document cover.

3 Remove the document from the white sheet by carefully pulling it to the right.

4 Close the document cover, and then load the documents back into the DADF.

5 Press the  (Start) button.

Clearing Paper Jams From the MPF
 NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

If error code: 050-112 appears:
1 Remove any paper loaded on the MPF
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2 Grasp both sides of the MPF, and then pull it out of the printer.

3 Pull tray1 out of the printer about 200 mm. 

4 Hold tray1 with both hands, and remove it from the printer.
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5 Remove the jammed paper.

6 Insert tray1 into the printer, and push until it stops.

7 Insert the MPF into the printer.

If error code: 050-129 appears:
Follow the instructions in "If error code: 050-129 appears:" to clear paper jams.
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Clearing Paper Jams From Tray1
 NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Pull tray1 out of the printer about 200 mm. 

2 Hold tray1 with both hands, and remove it from the printer.

3 Remove the jammed paper.
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4 Insert tray1 into the printer, and push until it stops.

5 Press the  (Start) button.

Clearing Paper Jams From the Fusing Unit
 NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

If error code: 050-111 appears:
1 Push down the latch to open the rear cover.

2 Lift the levers on both sides of the fusing unit.
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3 Hold and lower the tab to open the inner part.

4 Remove the jammed paper.

5 Replace the inner part.

6 Press down the levers on both sides of the fusing unit, and then close the rear cover.
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If error code: 050-129 appears:
1 Remove any paper loaded on the MPF

2 Grasp both sides of the MPF and then pull it out of the printer.

3 Pull tray1 out of the printer about 200 mm. 
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4 Hold tray1 with both hands, and remove it from the printer.

If you can see the jammed paper:

a Remove the jammed paper.

b Reinsert tray1 and the MPF into the printer.

If you cannot see the jammed paper:

a Go to the next step.
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5 Push down the latch to open the rear cover.

6 Lift the levers on both sides of the fusing unit.

7 Hold and lower the tab to open the inner part.



526 Clearing Jams

8 Remove the jammed paper.

9 Replace the inner part.

10 Press down the levers on both sides of the fusing unit, and then close the rear cover.
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11 Insert tray1 into the printer, and push until it stops.

12 Insert the MPF into the printer.

Clearing Paper Jams From the Optional 550-Sheet Feeder
 NOTE: To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Pull the optional 550-sheet feeder out of the printer about 200 mm. 
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2 Hold the optional 550-sheet feeder with both hands, and remove it from the printer.

3 Remove the jammed paper.

4 Insert the optional 550-sheet feeder into the printer, and push until it stops.
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Basic Printer Problems
Some printer problems can be easily resolved. If a problem occurs with your printer, check each of the following:

• The power cable is plugged into the printer and a properly grounded electrical outlet.

• The printer is turned on.

• The electrical outlet is not turned off at any switch or breaker.

• Other electrical equipment plugged into the outlet is working.

• All options are properly installed.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem.

 NOTE: If error messages are displayed on the touch panel or on your computer screen, follow the on-screen instructions to 
resolve the printer problems. For details about error messages and error codes, see "Understanding Printer Messages."

Display Problems

Printing Problems
 NOTE: If Panel Lock Control is set to Enable, you need to enter the four digit password to enter the Admin 
Settings menu.

Problem Action

Menu settings changed from the operator 
panel have no effect.

Settings in the software program, the printer driver, or the printer utilities are 
overriding the settings made on the operator panel.

Problem Action

Job did not print or incorrect characters 
printed.

Ensure that the top menu appears on the touch panel before you send a job to 
print. Press the  (Home) button to return to the top menu.

Ensure that the print media is loaded in the printer. Press the  (Home) 
button to return to the top menu.

Verify that the printer is using the correct page description language (PDL).

Verify that you are using the correct printer driver.

Ensure that the correct USB or Ethernet cable is securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the printer's interface from the Admin Settings.

Determine the host interface you are using. Print a panel settings report to verify 
that the current interface settings are correct.
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Print Quality Problems
 NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer 

Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, see 
"Understanding the Printer Menus" and "Dell™ Printer Configuration Web Tool."

• The output is too light

• Toner smears or print comes off

• Random spots/Blurred images

• The entire output is blank

• Streaks appear on the output

• Part or the entire output is black

Print media misfeeds or multiple feeds 
occur.

Ensure that the print media you are using meets the specifications for your printer. 
See "Supported Paper Types" for more information.

Fan the print media before loading it.

Ensure that the print media is loaded correctly.

Ensure that the width and length guides of the print media sources are adjusted 
correctly.

Ensure that tray1, the optional 550-sheet feeder (tray2), or the multi-purpose 
feeder (MPF) unit is securely inserted.

Do not overload tray1, the optional 550-sheet feeder, or the MPF.

Do not force print media into the MPF when you load it; otherwise, it may skew or 
buckle.

Ensure that the print media is not curled.

Face the recommended print side up. See "Loading Print Media in Tray1 and the 
Optional 550-Sheet Feeder" for more information.

Turn the print media over or around and try printing again to see if feeding 
improves.

Do not mix print media types.

Do not mix reams of print media.

Remove the top and bottom curled sheets of a ream before loading the print 
media.

Load print media only when tray1, the optional 550-sheet feeder, or the MPF is 
empty.

Wipe the retard rollers in tray1, the optional 550-sheet feeder, or the MPF with a 
cloth moistened with water.

The envelope is creased after printed. Make sure that the envelope is loaded in the MPF as instructed in "Loading an 
Envelope in the MPF."

Page breaks in unexpected places. Increase the value for Time-Out using the operator panel, the Tool Box, or Dell™ 
Printer Configuration Web Tool. 

Print media does not stack neatly in the 
output tray.

Turn the print media stack over in tray1 or the MPF.

Cannot print from tray1 or the optional 550-
sheet feeder because the print media in 
tray1 or the optional 550-sheet feeder is 
curled.

Load the print media into the MPF.

Problem Action
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• Pitched color dots

• Vertical blanks

• Ghosting

• Light-induced fatigue

• Fog

• Bead-Carry-Out (BCO)

• Jagged characters

• Banding

• Auger mark

• Wrinkled/Stained paper

• Damage on the leading edge of paper

The output is too light

Action Yes No

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner left in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor.
b Replace the toner cartridges as necessary.

Does this solve your problem?

The task is complete. Go to action 2.

2 If you are using non-Dell brand toner cartridges, enable the Non-Dell 
Toner option.

a Launch the Tool Box, and click Service Tools on the Printer 
Maintenance tab.

b Ensure that the On check box under Non-Dell Toner is selected.

Does this solve your problem?

The task is complete. Go to action 3.

3 Disable the Toner Saver in the printer driver.
a On the Others tab, ensure that Off is selected in the Toner Saver 

drop-down menu.

Does this solve your problem?

The task is complete. Go to action 4.

4 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick.

a On the General tab, change the Paper Type setting.

Does this solve your problem?

The task is complete. Go to action 5.
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Toner smears or print comes off

5 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer.

Does this solve your problem?

The task is complete. Go to action 6.

6 Clean inside the printer by using the cleaning rod. See "Cleaning the 
Raster Optical Scanner (ROS) Window."

a After the cleaning is completed, click Chart Print on the Diagnosis 
tab.

b Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 7.

7 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click 4 Colors Configuration Chart.

The 4 Colors Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick.

a On the General tab, change the Paper Type setting.

Does this solve your problem?

The task is complete. Go to action 2.

2 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer.

Does this solve your problem?

The task is complete. Go to action 3.

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, test print your document 

again.

Does this solve your problem?

The task is complete. Go to action 4.

Action Yes No
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Random spots/Blurred images

4 Replace the fusing unit.
a Replace the fusing unit. See "Replacing the Fusing Unit."
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab.
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 5.

5 Replace the transfer belt unit, the 2nd Belt Transfer Roller (2nd BTR), 
and the retard roller.

a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 
"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab.

c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that the toner cartridges are installed correctly. See "Installing a 
Toner Cartridge."

Does this solve your problem?

The task is complete. Go to action 2.

2 Ensure that the drum cartridges are installed correctly. See "Installing a 
Drum Cartridge."

Does this solve your problem?

The task is complete. Go to action 3.

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No
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The entire output is blank

Action Yes No

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner left in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor.
b Replace the toner cartridges as necessary.

Does this solve your problem?

The task is complete. Go to action 2.

2 If you are using non-Dell brand toner cartridges, enable the Non-Dell 
Toner option.

a Launch the Tool Box, and click Service Tools on the Printer 
Maintenance tab.

b Ensure that the On check box under Non-Dell Toner is selected.

Does this solve your problem?

The task is complete. Go to action 3.

3 Disable the Toner Saver in the printer driver.
a On the Others tab, ensure that Off is selected in the Toner Saver 

drop-down menu.

Does this solve your problem?

The task is complete. Go to action 4.

4 The print media surface may be uneven. Try changing the Paper Type 
setting in the printer driver. For example, change the plain paper to 
thick.

a On the General tab, change the Paper Type setting.

Does this solve your problem?

The task is complete. Go to action 5.

5 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer.

Does this solve your problem?

The task is complete. Go to action 6.

6 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click 4 Colors Configuration Chart.

The 4 Colors Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.
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Streaks appear on the output

Part or the entire output is black

Action Yes No

1 The toner cartridges may be low or need to be replaced. Confirm the 
amount of toner left in each toner cartridge. 

a Check the toner level in the Status tab in the Status Monitor.
b Replace the toner cartridges as necessary.

Does this solve your problem?

The task is complete. Go to action 2.

2 If you are using non-Dell brand toner cartridges, enable the Non-Dell 
Toner option.

a Launch the Tool Box, and click Service Tools on the Printer 
Maintenance tab.

b Ensure that the On check box under Non-Dell Toner is selected.

Does this solve your problem?

The task is complete. Go to action 3.

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click 4 Colors Configuration Chart.

The 4 Colors Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that the drum cartridges are installed correctly. See "Installing a 
Drum Cartridge."

Does this solve your problem?

The task is complete. Go to action 2.
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Pitched color dots

2 Ensure Output Color is set to Color in the printer driver.
a On the Graphics tab, ensure that Output Color is set to Color.

Does this solve your problem?

The task is complete. Go to action 3.

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click 4 Colors Configuration Chart.

The 4 Colors Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Locate the cause of the problem using the Pitch Configuration Chart.
a Launch the Tool Box, and click Chart Print on the Diagnosis tab.
b Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.
c Compare the pitch of the color spots on your output with that on the 

Pitch Configuration Chart, and locate the cause of the problem. 

Is the cause of the problem located?

Proceed to the action 
corresponding to the 
location of the 
problem:

• Drum cartridge - 2

• Fusing unit - 3

• Transfer belt unit - 4

Contact Dell.

2 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

3 Replace the fusing unit.
a Replace the fusing unit. See "Replacing the Fusing Unit."
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab.
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No
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Vertical blanks

4 Replace the transfer belt unit, the 2nd BTR, and the retard roller.
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab.

c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Clean inside the printer by using the cleaning rod. See "Cleaning the 
Raster Optical Scanner (ROS) Window."

a After the cleaning is completed, click Chart Print on the Diagnosis 
tab.

b Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 2.

2 Ensure the light path is not covered.
a Remove the drum cartridges, and keep them in the dark place. See 

"Removing the Drum Cartridge."
b Check the light path, and then remove the shielding.
c Re-install the drum cartridges. See "Installing a Drum Cartridge."
d Launch the Tool Box, and click Chart Print on the Diagnosis tab.
e Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 3.

3 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No
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Ghosting

Light-induced fatigue

Action Yes No

1 Locate the cause of the problem using the Ghost Configuration Chart.
a Launch the Tool Box, and click Chart Print on the Diagnosis tab.
b Click Ghost Configuration Chart.

The Ghost Configuration Chart is printed.

Is the type of the problem identified?

Proceed to the action 
corresponding to the 
type of ghosting.

Positive ghost - 2a

Negative ghost - 2b

Contact Dell.

2a Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click Ghost Configuration Chart.

The Ghost Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

2b If you are using non-recommended print media, use the print media 
recommended for the printer.

Does this solve your problem?

The task is complete. Go to action 3.

3 Adjust the transfer bias.
a On the operator panel, press the  (Information) button and 

select the Tools tab → select Admin Settings→ 
Maintenance→ Adjust Transfer Belt Unit. 

b Select K Offset or YMC Offset, and then decrease the value.
c Launch the Tool Box, and click Chart Print on the Diagnosis tab.
d Click Ghost Configuration Chart.

The Ghost Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.
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Fog

Bead-Carry-Out (BCO)

Action Yes No

1 Check the light fatigue pattern using the Pitch Configuration Chart.
a Launch the Tool Box, and click Chart Print on the Diagnosis tab.
b Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does the pattern on the output match with that on the Pitch 
Configuration Chart?

Go to action 2. Contact Dell.

2 Replace the drum cartridges. See "Replacing the Drum Cartridges."

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click 4 Colors Configuration Chart.

The 4 Colors Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.
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Jagged characters

Action Yes No

1 If the printer is installed in a high altitude location, set the altitude of 
the location.

a Launch the Tool Box, and click Service Tools on the Printer 
Maintenance tab.

b Under Adjust Altitude, select the value close to the altitude of the 
location where the printer is installed.

Does this solve your problem?

The task is complete. Go to action 2.

2 Replace the drum cartridges. See "Replacing the Drum Cartridges."

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Set Screen to Fineness in the printer driver.
a On the Others tab, set Screen under Items: to Fineness.

Does this solve your problem?

The task is complete. Go to action 2.

2 Set Print Mode to High Quality in the printer driver.
a On the Graphics tab, select High Quality from Print Mode. 

Does this solve your problem?

The task is complete. Go to action 3.

3 Enable Bitmap Smoothing in the printer driver.
a On the Others tab, set Bitmap Smoothing under Items: to On.

Does this solve your problem?

The task is complete. Go to action 4.

4 Enable Print Page Mode in the printer driver.
a On the Others tab, set Print Page Mode under Items: to On.

Does this solve your problem?

The task is complete. Go to action 5.

5 If using a downloaded font, ensure that the font is recommended for the 
printer, operating system, and the application being used.

Does this solve your problem?

The task is complete. Contact Dell.
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Banding

Action Yes No

1 Locate the cause of the problem using the Pitch Configuration Chart.
a Launch the Tool Box, and click Chart Print on the Diagnosis tab.
b Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Is the cause of the problem located?

Proceed to the action 
corresponding to the 
location of the 
problem:

• Drum cartridge - 2

• Fusing unit - 3

• Transfer belt unit - 4

Contact Dell.

2 Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b After you replace the drum cartridges, click Chart Print on the 

Diagnosis tab.
c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

3 Replace the fusing unit.
a Replace the fusing unit. See "Replacing the Fusing Unit."
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab.
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

4 Replace the transfer belt unit, the 2nd BTR, and the retard roller.
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab.

c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.
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Auger mark

Wrinkled/Stained paper

Action Yes No

1 Locate the cause of the problem using the Pitch Configuration Chart.
a Launch the Tool Box, and click Chart Print on the Diagnosis tab.
b Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does the output match with the pattern for auger mark?

Go to action 2. Contact Dell.

2 Replace the drum cartridges. See "Replacing the Drum Cartridges."

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Verify that the correct print media is being used. See "Supported Paper 
Types." If not, use the print media recommended for the printer.

Does this solve your problem?

The task is complete. If printing on an 
envelope, go to action 
2.

If printing on print 
media other than 
envelopes, contact Dell.

2 Check the wrinkle. Is the wrinkle within 30 mm of the four edges of the 
envelope?

This type of wrinkle is 
considered normal. 
Your printer is not at 
fault.

Go to action 3.

3 Load the envelopes in the MPF properly. For details, see "Loading an 
Envelope in the MPF."

Does this solve your problem?

The task is complete. Contact Dell.
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Damage on the leading edge of paper

Jam/Alignment Problems
 NOTE: Some of the following procedures that use the Tool Box can also be performed using the operator panel or Dell Printer 

Configuration Web Tool. For information on how to use the operator panel and Dell Printer Configuration Web Tool, see 
"Understanding the Printer Menus" and "Dell™ Printer Configuration Web Tool."

• The top and side margins are incorrect

• Color registration is out of alignment

• Images are skewed

• Tray1/Optional 550-Sheet Feeder Misfeed Jam

• MPF Misfeed Jam

• Regi Jam (Exit Sensor On JAM)

• Exit Jam (Exit Sensor Off JAM)

• Tray1/Optional 550-Sheet Feeder Multi-feed Jam

• MPF Multi-feed Jam

The top and side margins are incorrect

Action Yes No

1 When you use the MPF, reverse the paper and then try again.

When you use any of the trays, change the paper and then try again.

Does this solve your problem?

The task is complete. (MPF)
Go to action 2.

(trays)
Contact Dell.

2 Change the paper with another one and then try again.

Does this solve your problem?

The task is complete. Go to action 3.

3 Use any of the trays in place of the MPF.

Does this solve your problem?

The task is complete. Contact Dell.
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Color registration is out of alignment

Action Yes No

1 Ensure that the margins are set correctly on the application being used.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Adjust the settings of the paper type on the printer driver to those of the 
tray.

Does this solve your problem?

The task is complete. Go to action 2.

2 Execute auto color registration adjustment.
a On the operator panel, press the  (Information) button and 

select the Tools tab → select Admin Settings→ 
Maintenance→ Color Reg Adjust→ Auto Correct→ 
Start.

OR
a Launch the Tool Box, and click Service Tools on the Printer 

Maintenance tab.
b Click Start under Auto Correct in Color Registration Adjustments.

Does this solve your problem?

The task is complete. Go to action 3.

3 Do you have spare drum cartridges? Go to action 4a. Go to action 4b.

4a Replace the drum cartridges. 
a Replace the drum cartridges. See "Replacing the Drum Cartridges."
b Launch the Tool Box, and click Service Tools on the Printer 

Maintenance tab.
c Click Start under Color Regi Chart in Color Registration 

Adjustments.

The Color Regi Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.
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Images are skewed

Tray1/Optional 550-Sheet Feeder Misfeed Jam

4b Print the Color Regi Configuration Chart and manually correct the color 
registration. 

a Launch the Tool Box, and click Service Tools on the Printer 
Maintenance tab.

b Click Start under Color Regi Chart in Color Registration 
Adjustments.

The Color Regi Configuration Chart is printed.
c Identify the offset values from the chart and specify each value for 

process, left, and right colors in Enter Number. See "Adjusting Color 
Registration" for details.

d Click Apply New Settings.
e Click Start under Color Regi Chart to print the Color Regi 

Configuration Chart again.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Adjust the paper guides properly.

Does this solve your problem?

The task is complete. Go to action 2.

2 Install the transfer belt unit according to an appropriate procedure. See 
"Installing a Transfer Belt Unit."

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that tray1 or the optional 550-sheet feeder is properly inserted.

Does this solve your problem?

The task is complete. Proceed to the action 
corresponding to the 
type of the print media 
being used:

• Thick - 2a

• Thin - 2b

• Coated - 2c

If using paper other 
than the above, go to 
action 2d.

Action Yes No
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MPF Misfeed Jam

2a Use thick paper that is 216 g/m2 or less.

Does this solve your problem?

The task is complete. Go to action 3a.

2b Use thin paper that is 60 g/m2 or more.

Does this solve your problem?

The task is complete. Go to action 3a.

2c Load coated paper one sheet at a time.

Does this solve your problem?

The task is complete. Go to action 3b.

2d Ensure that the print media is not curled.

Does this solve your problem?

The task is complete. Go to action 3a.

2e Is the print media damp? Go to action 3c. Go to action 3a.

3a Fan the print media.

Does this solve your problem?

The task is complete. Go to action 3b.

3b Wipe the retard roller in tray1 or the optional 550-sheet feeder with a 
cloth moistened with water.

Does this solve your problem?

The task is complete. Go to action 4b.

3c Turn over the print media.

Does this solve your problem?

The task is complete. Go to action 4a.

4a Use print media that is not damp.

Does this solve your problem?

The task is complete. Go to action 3a.

4b Replace the drum cartridges.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that the MPF is properly inserted.

Does this solve your problem?

The task is complete. Proceed to the action 
corresponding to the 
type of the print media 
being used:

• Thick - 2a

• Thin - 2b

• Coated - 2c

• Envelope - 2d

If using paper other 
than the above, go to 
action 2e.

2a Use thick paper that is 216 g/m2 or less.

Does this solve your problem?

The task is complete. Go to action 3a.

2b Use thin paper that is 60 g/m2 or more.

Does this solve your problem?

The task is complete. Go to action 3a.

2c Load coated paper one sheet at a time.

Does this solve your problem?

The task is complete. Go to action 3b.

Action Yes No
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Regi Jam (Exit Sensor On JAM)

2d Ensure that the envelope is properly loaded in the MPF as instructed in 
"Loading an Envelope in the MPF."

Does this solve your problem?

The task is complete. Go to action 3c.

2e Is the print media damp? Go to action 3d. Go to action 3a.

3a Fan the print media.

Does this solve your problem?

The task is complete. Go to action 3b.

3b Wipe the retard roller in the MPF with a cloth moistened with water.

Does this solve your problem?

The task is complete. Go to action 4b.

3c If the envelope is deformed, correct it or use another envelope.

Does this solve your problem?

The task is complete. Go to action 3a.

3d Turn over the print media.

Does this solve your problem?

The task is complete. Go to action 4a.

4a Use print media that is not damp.

Does this solve your problem?

The task is complete. Go to action 3a.

4b Replace the drum cartridges.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that the drum cartridges are installed correctly.

Does this solve your problem?

The task is complete. Go to action 2.

2 Replace the drum cartridges. See "Replacing the Drum Cartridges."

Does this solve your problem?

The task is complete. Go to action 3.

3 Ensure that the fusing unit is set properly.

Does this solve your problem?

The task is complete. Go to action 4.

4 Replace the fusing unit.
a Replace the fusing unit. See "Removing the Fusing Unit."
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab.
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 5.

5 Ensure that the transfer belt unit is installed correctly.

Does this solve your problem?

The task is complete. Go to action 6.

Action Yes No
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Exit Jam (Exit Sensor Off JAM)

Tray1/Optional 550-Sheet Feeder Multi-feed Jam

6 Replace the transfer belt unit, the 2nd BTR, and the retard roller.
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab.

c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure the fusing unit is installed correctly. 

Does this solve your problem?

The task is complete. Go to action 2.

2 Replace the fusing unit.
a Replace the fusing unit. See "Replacing the Fusing Unit."
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab.
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 Ensure that tray1 or the optional 550-sheet feeder is properly inserted.

Does this solve your problem?

The task is complete. If using coated paper, 
go to action 2.

If using other type of 
print media, go to 
action 3.

2 Load coated paper one sheet at a time.

Does this solve your problem?

The task is complete. Go to action 4.

3 Use print media that is not damp.

Does this solve your problem?

The task is complete. Go to action 4.

4 Fan the print media.

Does this solve your problem?

The task is complete. Go to action 5.

5 Wipe the retard roller in tray1 or the optional 550-sheet feeder where the 
multi-feed occurred with a cloth moistened with water.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No
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MPF Multi-feed Jam

Noise

1 Ensure the media type you are using.

If using coated paper, go to action 2.

If using other type of print media, go to action 3.

- -

2 Load coated paper one sheet at a time.

Does this solve your problem?

The task is complete. Go to action 4.

3 Use print media that is not damp.

Does this solve your problem?

The task is complete. Go to action 4.

4 Fan the print media.

Does this solve your problem?

The task is complete. Go to action 5.

5 Wipe the retard roller in the MPF where the multi-feed occurred with a 
cloth moistened with water.

Does this solve your problem?

The task is complete. Contact Dell.

Action Yes No

1 To specify the cause of the noise, perform the Auto Registration 
Adjustment.

Does this solve your problem? 

The task is complete. Go to action 2.

2 Replace the transfer belt unit, the 2nd BTR, and the retard roller.
a Replace the transfer belt unit, the 2nd BTR, and the retard roller. See 

"Replacing the Transfer Belt Unit, the 2nd Belt Transfer Roller (2nd 
BTR), and the Retard Roller."

b After you replace the transfer belt unit, the 2nd BTR, and the retard 
roller, click Chart Print on the Diagnosis tab.

c Click Pitch Configuration Chart.

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 3.

3 Replace the fusing unit.
a Replace the fusing unit. See "Replacing the Fusing Unit."
b After you replace the fusing unit, click Chart Print on the Diagnosis 

tab.
c Click Pitch Configuration Chart. 

The Pitch Configuration Chart is printed.

Does this solve your problem?

The task is complete. Go to action 4.

4 Replace the waste toner box.

Does this solve your problem?

The task is complete. Go to action 5.

5 Replace the drum cartridges.

Does this solve your problem? 

The task is complete. Go to action 6.
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Copy Problem

Fax Problems

6 Replace the toner cartridge (K). See "Replacing the Toner Cartridges." The task is complete. 
(The toner cartridge 
(K) you are using has 
been damaged. Replace 
it with a new one.)

Go to action 7.

7 Replace the toner cartridge (Y). See "Replacing the Toner Cartridges." The task is complete. 
(The toner cartridge 
(Y) you are using has 
been damaged. Replace 
it with a new one.)

Go to action 8.

8 Replace the toner cartridge (M). See "Replacing the Toner Cartridges." The task is complete. 
(The toner cartridge 
(M) you are using has 
been damaged. Replace 
it with a new one.)

Go to action 9.

9 Replace the toner cartridge (C). See "Replacing the Toner Cartridges." The task is complete. 
(The toner cartridge 
(C) you are using has 
been damaged. Replace 
it with a new one.)

Contact Dell.

Problem Action

A document loaded in the DADF cannot be 
copied.

Ensure that the DADF cover is firmly closed.

Ensure that the release lever is properly positioned.

Vertical blanks or streaks appear on the 
output when scanned using the DADF.

Clean the DADF glass.

Clean inside the printer by using the cleaning rod. See "Cleaning the Raster 
Optical Scanner (ROS) Window."

Problem Action

The printer is not working, there is no 
display and the buttons are not working.

Unplug the power cord and plug it in again.

Ensure that there is power to the electrical receptacle.
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No dial tone sounds. Check that the phone line is connected properly. See "Connecting the Telephone 
Line."

Check that the phone socket in the wall is working by plugging in another phone.

Diagnose the fax connection. See "Diagnosing the Fax Connection."

The numbers stored in the memory do not 
dial correctly.

Ensure that the numbers are stored in the memory correctly.

Print a Phone Book list.

The document does not feed into the 
printer.

Ensure that the document is not wrinkled and you are putting it in correctly. 
Check that the document is of the right size, not too thick or thin.

Ensure that the DADF cover is firmly closed.

Faxes are not received automatically. The FAX mode should be selected.

Ensure that there is paper in the paper tray.

Check to see if the display shows MFP Memory Full.

If the time interval specified for the following features is too long, change the time 
interval shorter such as 30 seconds.

• Auto Rec Fax

• Auto Rec TEL/FAX

• Auto Rec Ans/FAX

Diagnose the fax connection. See "Diagnosing the Fax Connection."

The printer does not send faxes. Sending Fax should show up on the display.

Check the other fax machine you are sending to, to see if it can receive your fax.

Check the dialing type for Tone or Pulse.

Ensure that the document is loaded in the DADF or on the document glass.

Diagnose the fax connection. See "Diagnosing the Fax Connection."

The incoming fax has blank spaces or is 
received in poor quality.

Check your printer by making a copy.

The toner cartridge may be empty. Replace the toner cartridge. See "Replacing the 
Toner Cartridges."

A noisy phone line can cause line errors. Set the fax modem speed to a slower 
speed.

The fax machine sending you the fax may be faulty.

Some of the words on an incoming fax are 
stretched.

The fax machine sending you the fax had a temporary document jam.

There are lines on the documents you send. Check the surface of the document glass and DADF glass for marks and clean it. 
See "Cleaning the Scanner."

The printer dials a number, but the 
connection with another fax machine fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming 
calls. Speak with the other machine operator and ask her/him to sort out the 
problem.

Documents are not stored in the memory. There may not be enough memory to store the document. If the display shows a 
MFP Memory Full message, delete any documents you no longer need from 
the memory and then restore the document, or wait for the job in progress (e.g., a 
fax transmission or reception) to complete.

Blank areas appear at the bottom of each 
page or on other pages, with a small strip of 
text at the top.

You may have chosen the wrong paper settings in the user option setting. See 
"Print Media Guidelines."
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Scanning Problems

The printer will not send or receive faxes. Ensure that the country code is set correctly. Press the  (Information) button 
and select the Tools tab→select Admin Settings→
Fax Settings→Fax Line Settings→Country.

Check the dialing type for Tone or Pulse.

Check that the cables are connected properly.

If the telephone line cord is connected to the printer via any device such as an 
answering machine and a computer, remove the device and directly connect the 
telephone line cord to the printer.

Ensure that Junk Fax Setup is set to off.

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed. Press the  (Information) button and select the 
Tools tab→select Admin Settings→Fax Settings→ 
Transmission Defaults→Modem Speed.

The printer receive faxes, but it does not 
print.

Check the toner level.

Ensure that there is paper in the paper tray.

Ensure that Sent Fax Forward is set to off.

Check whether the printer is in the secure receiving mode. If this mode is turned 
on, enter the correct password or turn off this mode to print faxes in memory.

Problem Action

The scanner does not work. Ensure that you place the document to be scanned facing down from the 
document glass, or facing up in the DADF. 

There may not be enough available memory to hold the document you want to 
scan. Lower the scan resolution rate and then try scanning again.

Check that the USB or Ethernet cable is connected properly.

Ensure that the USB or Ethernet cable is not defective. Switch the cable with a 
known good cable. If necessary, replace the cable.

If using the network TWAIN (WIA) driver, check that the Ethernet cable is 
connected properly and the IP address of the printer is set correctly. To check the 
IP address, see "Verifying the IP Settings."

Check that the scanner is configured correctly. Check the application you want to 
use to make certain that the scanner job is being sent to the correct port.

Ensure that the scanner sharing feature is disabled when you use Mac OS X before 
you scan documents via an ICA compatible application such as Image Capture. 
The printer does not support the scanner sharing feature of Mac OS X. Select a 
printer which is directly connected to the computer via USB or wired /wireless 
LAN and scan documents.

The printer scans very slowly. Graphics are scanned more slowly than text when using the E-mail or Scan to 
Network feature.

Communication speed becomes slow in scan mode because of the large amount of 
memory required to analyze and reproduce the scanned image.

Scanning images at a high resolution takes more time than scanning at a low 
resolution.



Troubleshooting Guide 555

Document misfeeds or multiple feeds occur 
in the DADF.

Check whether the DADF roller assembly is installed properly.

Ensure the document’s paper type meets the specifications for the printer. See 
"Supported Paper Types" for more information.

Check whether the document is properly loaded in the DADF.

Ensure that the document guides are adjusted properly.

Ensure that the number of document sheets do not exceed the maximum capacity 
of the DADF.

Ensure that the document is not curled.

Fan the document well before loading it in the DADF.

Vertical blanks or streaks appear on the 
output when scanned using the DADF.

Clean the DADF glass.

Clean inside the printer by using the cleaning rod. See "Cleaning the Raster 
Optical Scanner (ROS) Window."

A smear appears at the same location on the 
output when scanned using the document 
glass.

Clean the document glass.

Images are skewed. Ensure that the document is loaded straight in the DADF or on the document 
glass.

Diagonal lines appear jagged when scanned 
using the DADF.

If the document uses thick media, try scanning it from the document glass.

Message appears on your computer screen: 

• "Device can’t be set to the H/W mode you 
want."

• "Port is being used by another program."

• "Port is Disabled."

• "Scanner is busy receiving or printing data. 
When the current job is completed, try 
again."

• "Invalid handle."

• "Scanning has failed."

There may be a copying or printing job in progress. When the current job is 
complete, try the job again.

The selected port is currently being used. Restart your computer and try again.

The cable may be improperly connected or the printer may be turned off.

The scanner driver is not installed or an operating environment is not set up 
properly.

Ensure that the port is properly connected and the printer is turned on. Then 
restart your computer.

Check that the USB or Ethernet cable is connected properly.

The printer does not properly transfer scan 
data to a specified destination via the E-
mail or Scan to Network feature.

Check if the following settings have been set correctly on the Dell Printer 
Configuration Web Tool.

Scan to Network

Check the following settings under Address Book→ Server Address:

• Server Address

• Share Name

• Server Path

• Login Name

• Login Password

E-mail

Check the following setting under Address Book→ E-Mail Address:

• Address
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Digital Certificate Problem

Cannot scan using WIA on a Microsoft® 
Windows Server® 2003 computer.

Enable WIA on the computer.

To enable WIA:
1 Click Start, point to Administrative Tools, and then click Services.
2 Right-click Windows Image Acquisition (WIA), and then click Start.

Cannot scan using TWAIN or WIA on a 
Windows Server 2008 or Windows Server 
2008 R2 computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Start, point to Administrative Tools, and then click Server Manager.
2 Under Features Summary, click Add Features.
3 Select the Desktop Experience check box, click Next, and then click Install.
4 Restart the computer.

Cannot scan using TWAIN or WIA on a 
Windows Server 2012 computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:
1 Click Server Manager from the Start screen.

The Server Manager screen appears.
2 Under Manage, click Add Roles and Features.

Add Roles and Features Wizard appears.
3 Click Next to skip the Before you begin page.
4 Ensure that Role-based or feature-based installation is selected, and then click 

Next.
5 Ensure that Select a server from the server pool is selected, select the server under 

Server Pool, and then click Next.
6 Click Next to skip the Select server roles page.
7 Select the Desktop Experience check box under User Interfaces and 

Infrastructure, and then click Next.
8 Click Confirmation from the list on the left.
9 Select the Restart the destination server automatically if required check box, and 

then click Install.
10 Restart the computer.

Symptom Cause Action

The LDAP-SSL/TLS 
Communication setting and the 
Upload Signed Certificate button 
are not displayed.

The optional hard disk installed in 
the printer is not encrypted.

Confirm whether the optional hard disk is 
connected correctly, and confirm whether Data 
Encryption is enabled from the operator panel or 
Dell Printer Configuration Web Tool.

The certificate import button is 
disabled.

SSL communication is disabled. Create a self-signed certificate and enable SSL.

The certificate details button is 
disabled.
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The certificate cannot be imported. The time setting is incorrect. Confirm validity period of the certificate as well as 
the time setting of the device.

The certificate file is incorrect. Confirm whether the password is correct.

Confirm whether the file type is PKCS#7/#12 or 
x509CACert (extension: p7b/p12/pfx/cer/crt).

Confirm whether the attribute information (key 
Usage/Extended key usage) of the certificate to be 
imported is set correctly.

The browser is incorrect. Use Internet Explorer.

016-404 is displayed when setting 
the encryption of the optional hard 
disk to Off.

The optional hard disk is formatted 
and the certificate data is deleted 
when setting encryption of the 
optional hard disk to Off. Since a 
certificate is required and the 
security function cannot be enabled 
when restarting the device afterward, 
016-404 is displayed and the security 
setting must be initialized. The 
cause is the same when formatting or 
removing the optional hard disk.

After initializing, import the certificate and enable 
the security settings again. The action is the same 
when formatting the optional hard disk.

016-404 is displayed when 
formatting the optional hard disk.

Security is set to Off when setting 
encryption of the optional hard disk 
to Off.

Security is set to Off when 
formatting the optional hard disk.

A certificate is deleted when setting 
encryption of the optional hard disk 
to Off.

A certificate is deleted when 
formatting the optional hard disk.

A certificate cannot be set with 
"Certificate Details".

The validity period is invalid. The validity period of the certificate is invalid. 
Confirm whether the time setting of the machine is 
correct, and whether the validity period of the 
certificate has expired.

The certificate path is invalid. The certificate chain (path validation) of the 
imported certificate may not be correctly validated. 
Confirm whether all of the high-level certificates

(Trusted/Intermediate) have been imported and are 
not deleted, and whether the validity period has 
expired.

Although a certificate was imported, 
it is not displayed when selecting 
with "Local Device".

The type of the certificate is 
incorrect.

To import a certificate for use with the device (own 
device), import the secret key and a certificate of 
the PKCS#12 (p12/pfx) format as a pair.

Server validation is not operating 
correctly.

The certificate chain is incorrect 
when importing.

Although importing a root certificate (Trusted) to 
use for server authentication, an Intermediate 
certificate may be required when validating the 
path.

When executing a certificate file with the 
certification authority, create the certificate with a 
format including all paths and then import that 
certificate.

Symptom Cause Action
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Problems With Installed Optional Accessories
If an option does not operate correctly following installation or stops working:

• Turn off the printer, wait for 10 seconds, and then turn on the printer. If this does not fix the problem, unplug the 
printer, and check the connection between the option and the printer.

• Print the system settings report to see if the option is listed in the Installed Options list. If the option is not listed, 
re-install it. See "Report / List."

• Ensure the option is selected in the printer driver you are using.

The following table lists printer's option and corrective action for related problem. If the suggested corrective action 
does not correct the problem, call customer service.

Scanner Driver/Printer Utility Problems

Digital Signature cannot be selected 
with the IPsec setting.

The certificate cannot be associated. Either the certificate has not been imported or the 
certificate has not been associated for use with 
Digital Signature of IPsec. Refer to "Setting the 
Certificate in the IPsec Digital Signature Mode" to 
set a certificate of IPsec.

Problem Action

550-sheet feeder • Ensure the 550-sheet feeder is correctly installed on the printer. Re-install the 
feeder. See "Removing the Optional 550-Sheet Feeder" and "Installing the 
Optional 550-Sheet Feeder."

• Ensure the print media is loaded correctly. See "Loading Print Media in Tray1 and 
the Optional 550-Sheet Feeder" for more information.

Memory module • Ensure the memory module is securely connected to the memory connector.

Hard disk • Ensure the hard disk is securely inserted to the correct slot.

Wireless adapter • Ensure the wireless adapter is securely inserted to the correct slot.

Problem Action

Unable to retrieve the Address Book data 
from the printer on the Address Book Editor.

Check that the USB or Ethernet cable is connected properly.

Ensure that the printer is turned on.

Ensure that the scanner driver is installed on your computer. (The Address Book 
Editor retrieves the Address Book data via the scanner driver when the printer is 
connected using a USB cable.)

The TWAIN driver cannot connect to the 
printer.

Check that the USB or Ethernet cable is connected properly.

If using the network connection, check that IP address of the printer is set 
correctly. To check the IP address, see "Scanning Using the TWAIN Driver."

Check whether the printer is turned on. If the printer is turned on, reboot it by 
turning off the printer and then on again.

If a scan application is running, close the application once, restart the application, 
and then try scanning again.

The scanner driver has not been registered 
on your computer and cannot be accessed 
from ScanButton Manager. 

Install the scanner driver. If the scanner driver is installed, uninstall it and then re-
install it again. After the installation of the scanner driver is completed, re-install 
the ScanButton Manager.

Symptom Cause Action
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Other Problems

Contacting Service
When you call for printer service, be prepared to describe the problem you are experiencing or the error message that 
appears.

You need to know the model type and service tag of your printer. See the label located inside the front cover of your 
printer.

Failed to scan your document on the printer 
via ScanButton Manager.

Ensure that your computer and the printer is properly connected with the USB 
cable.

Check whether the printer is turned on. If the printer is turned on, reboot it by 
turning off the printer and then on again.

If a scan application is running, close the application once, restart the application, 
and then try scanning again.

Network connection cannot be used. Connect with the USB cable.

Uninstall ScanButton Manager from Control Panel→ Add or Remove Programs 
(Programs and Features in Windows Vista® and Windows® 7) on your computer and 
then re-install it again.

Failed to create an image file via ScanButton 
Manager.

Ensure there is sufficient space in your hard disk.

Uninstall ScanButton Manager from Control Panel→ Add or Remove Programs on 
your computer and then re-install it again.

Failed to initialize ScanButton Manager. Uninstall ScanButton Manager from Control Panel→ Add or Remove Programs on 
your computer and then re-install it again.

Failed to execute ScanButton Manager. Uninstall ScanButton Manager from Control Panel→ Add or Remove Programs on 
your computer and then re-install it again.

An unexpected error occurred on 
ScanButton Manager.

Uninstall ScanButton Manager from Control Panel→ Add or Remove Programs on 
your computer and then re-install it again.

Problem Action

Condensation has occurred inside the 
printer.

This usually occurs within several hours after you heat the room in winter. This 
also occurs when the printer is operating in a location where relative humidity 
reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment.

Problem Action
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Appendix

Dell™ Technical Support Policy
Technician-assisted technical support requires the cooperation and participation of the customer in the 
troubleshooting process and provides for restoration of the operating system, software program and hardware drivers 
to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of 
the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical 
support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for 
third-party software and peripherals is provided by the original manufacturer, including those purchased and/or 
installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Online Services
You can learn about Dell products and services on the following websites:

www.dell.com

www.dell.com/ap (Asian/Pacific countries only)

www.dell.com/jp (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la (Latin American and Caribbean countries)

www.dell.ca (Canada only)

You can access Dell Support through the following websites and e-mail addresses:

• Dell Support websites

support.dell.com

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Dell Support e-mail addresses

mobile_support@us.dell.com

support@us.dell.com 

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)

• Dell Marketing and Sales e-mail addresses

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your e-mail address as your password.

http://www.dell.com
http://www.dell.com/ap
http://www.dell.com/jp
http://www.euro.dell.com
http://www.dell.com/la
http://www.dell.ca
http://support.dell.com
http://support.jp.dell.com
http://support.euro.dell.com
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Warranty and Return Policy
Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or 
equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your 
printer, see support.dell.com.

Recycling Information
It is recommended that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally 
sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. 

For specific information on Dell’s worldwide recycling programs, see www.dell.com/recyclingworldwide. 

Contacting Dell
You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, 
and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

• World Wide Web

www.dell.com

www.dell.com/ap (Asian/Pacific countries only)

www.dell.com/jp (Japan only)

www.euro.dell.com (Europe only)

www.dell.com/la (Latin American and Caribbean countries)

www.dell.ca (Canada only)

• Anonymous file transfer protocol (FTP)

ftp.dell.com

Log in as user: anonymous, and use your email address as your password.

• Electronic Support Service

mobile_support@us.dell.com

support@us.dell.com

la-techsupport@dell.com (Latin America and Caribbean countries only)

apsupport@dell.com (Asian/Pacific countries only)

support.jp.dell.com (Japan only)

support.euro.dell.com (Europe only)

• Electronic Quote Service

apmarketing@dell.com (Asian/Pacific countries only)

sales_canada@dell.com (Canada only)

http://support.dell.com
http://www.dell.com/recyclingworldwide
http://www.dell.com
http://www.dell.com/ap
http://www.dell.com/jp
http://www.euro.dell.com
http://www.dell.com/la
http://www.dell.ca
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Index

Symbols
(All Clear) button, 130

(Cancel) button, 130

(Delete) button, 129

(Home) button, 129

(Information) button, 130

(Job Status) button, 130

(Power Saver) button, 129

(Redial / Pause) button, 129

(Start) button, 129

Numerics
1000Base-T Full-Duplex, 176

100Base-TX Full-Duplex, 176

100Base-TX Half-Duplex, 176

10Base-T Full-Duplex, 176

10Base-T Half-Duplex, 176

2 Sided, 149

2 Sided Copying, 151, 163, 208, 222

2 Sided Print, 148

2 Sided Printing, 152-153, 164, 209, 225, 227, 
252

2 Sided Scanning, 208-209, 223, 225

2nd BTR, 34, 475

2-Up, 151, 163, 208, 222, 288

4 Colors Configuration Chart, 228

802.1x, 174, 192

A
A4, 305

A4<>Letter Switch, 205, 214, 262

A5, 305

About printer, 33

Access List, 192

Address Book, 139, 141, 156, 194, 399

Address Book Editor, 399

Ad-Hoc, 185

Adjust 2nd BTR, 166

Adjust Altitude, 154, 169, 205, 216

Adjust Fusing Unit, 154, 167, 265

Adjust Transfer Belt Unit, 166, 265

Adjusting color registration, 498

Admin Settings, 233

Administrator Account, 184

AirPrint, 173, 186, 325

Alert Tone, 147, 156, 205, 212

Alignment Chart, 228

All Tones, 148, 157

Altitude, 456

Ans Machine/Fax, 164

Appendix, 563

Apply New Settings, 142

Asset Tag Number, 135, 146

Assigning IP address, 83

Audio Tone, 204, 211

Authenticate Error Trap, 183

Authentication System, 414

Auto Clear Alert Tone, 148, 157, 205, 212

Auto Color To Mono Print, 264

Auto Correct, 168, 215

Auto Exposure, 150, 153, 162, 165, 208, 221, 
224, 286, 291

Auto Exposure Level, 150, 153, 162, 165, 208, 
221, 224

Auto Log Print, 148, 157, 204, 212, 258

Auto Receive Ans/Fax, 209, 226

Auto Receive Answer/Fax, 151, 164
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Auto Receive Fax, 151, 164, 209, 226

Auto Receive Tel/Fax, 151, 164, 209, 226

Auto Reg Adjust, 266

Auto Registration Adjustment, 154, 167, 205

Auto Reset, 148, 157, 205, 213

Avoiding paper jams, 315, 513

B
B5, 305

Banding Detection Chart, 228

Banner Sheet Insert Position, 148, 157, 205, 214

Banner Sheet Specify Tray, 148, 157, 205, 214

Base memory, 455

Basic Information, 175

Basic printer problems, 531

Bitmapped font, 436

Blue plug, 34, 74

Bonjour (mDNS), 173, 176

C
C5, 305

Cable, 456

Canceling a print job, 316

Canceling print job
From your computer, 316

Carbonless copy paper, 302

CCP, 302

Changing printer settings, 142, 327

Changing the Language, 133

Clear Storage, 169

Clearing paper jams, 513
From DADF, 515
From fusing unit, 521
From MPF, 517
From optional 550-sheet feeder, 527
From tray1, 520

Clock Settings, 154

Coated, 153-154, 167, 265-266

Coated Thick, 153-154, 167, 265-266

Collation, 149-150, 162, 207, 209, 220, 226

Color Balance, 208, 221

Color Reg Adjust, 266

Color Regi Chart, 168

Color Registration Adjustments, 167-168, 215

Color registration chart, 498

Color Saturation, 150, 162, 208, 221, 286

Color Test Page, 156, 206, 232

ColorTrack, 413

ColorTrack Error Report, 154, 414

ColorTrack Mode, 154, 414

ColorTrack Settings, 413

Community Name, 183

Completed Jobs, 138, 146

Concurrent Jobs Feature, 134

Configure 802.1x, 192

Configuring wireless adapter, 57

Connecting local printer, 72

Connecting printer, 71

Connecting to the network, 73

Connection specification, 71, 456

Connection Time-Out, 178

Connection type, 71, 456

Conserving supplies, 463

Contact Dell Support at, 139, 141

Contact Person, 140

Contacting service, 559

Contrast, 153, 165, 208, 224, 290

Control board, 34

Control Panel Tone, 156, 204, 211

Copy Color Balance, 151, 162

Copy Completed Tone, 147, 204, 212

Copy Defaults, 150, 207

Copy Printer Settings, 139, 141, 193

Copy Printer Settings Report, 193



Appendix 567

Copy Settings, 151

Country, 151, 163, 209, 226, 248

Cover, 145

Covers, 153-154, 167, 265-266

Covers Thick, 153-154, 167, 265-266

Create Folder, 153, 166, 209, 224, 292

Custom Paper Size - X, 148, 158

Custom Paper Size - Y, 148, 158

Custom Reduce / Enlarge, 162, 221

D
DADF cover, 35

DADF feed roller, 35, 498

DADF glass, 497

Darken / Lighten, 150, 153, 162-163, 165, 
207-209, 221, 223, 225, 284, 290, 294

Data Encryption, 423

Date & Time, 211

Date Format, 154, 204, 211

Default Color, 149, 158, 239

Default Paper Size, 148, 157, 205, 214

Default Setup, 195

Delayed Send, 151, 163, 209, 225, 295

Dell ColorTrack, 154, 193, 413

Dell Printer Configuration Web Tool, 135
Page display format, 140

Dell ScanCenter, 399

Dell Service Tag Number, 146

Dell Supplies Management System, 397

Dell support website, 28

Dell technical support policy, 563

Details, 145

Determining Values, 499

Digital Certificates, 423

Dimensions, 455

DIMM size, 455

Direct connection setup, 92

Direct Fax, 382

Disabling Panel Lock, 299

Discard Size, 152, 164, 210, 227, 252

Display Manual Fax Recipients, 210, 228

Display of Dell Configuration Web Tool, 220

Display problems, 531

DL, 305

DNS, 171, 178

Document feeder tray, 35

Document glass, 35, 497

Document guides, 35

Draft Mode, 149, 158, 239

Driver, 27

DRPD, 164

DRPD Pattern, 151, 164, 209, 226, 249

Drum cartridge, 33, 467

Duplex Automatic Document Feeder 
(DADF), 33, 514-515

Duplex unit, 34

E
ECM, 152, 165, 210, 227, 254

E-mail, 366

E-Mail Address, 195

Email Address Book, 206

E-Mail Alert, 139, 141, 176, 180, 246

E-Mail Alert Settings, 175, 181

E-Mail Alert Setup, 135

E-Mail Alert Setup Page, 174

E-Mail Group, 195-196

E-mail Server Address Book, 204, 213

E-Mail Server Settings, 174, 180

Emulations, 455

Encryption, 185

End Time, 161

Entering Values, 501

Envelope, 154, 167, 265-266, 303
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Envelope #10, 305

Environment, 456

Error codes, 443

Error History, 156, 206, 232

Error messages, 451

Ethernet, 170, 176, 456

Ethernet port, 34, 71, 73

Event Panel, 140

EWS, 246

EWS Settings, 175

Executive, 305

Expiration Mode, 161

Expiration Time, 161

Express Service Code, 146

External Authentication, 413

F
Fast scan, 500

Fault Time-out, 148, 157, 205, 213

Fault Tone, 147, 156, 204, 212

Fax Activity, 152, 156, 165, 206, 210, 228, 254

Fax Broadcast, 165, 210, 228, 255

Fax Cover Page, 152, 165, 210, 227, 253, 295

Fax Defaults, 151, 163, 209, 275

Fax Forwarding Number, 209, 227

FAX Group, 195, 200

Fax Header, 152, 165, 210, 227, 253

Fax Header Name, 151, 163, 209, 226, 248

Fax Line Test, 269

Fax Menu, 293

Fax Number, 151, 163, 209, 226, 248

Fax Pending, 156, 206

Fax printer driver, 92, 95

Fax Protocol, 165, 210, 228

Fax Server Address Book, 204, 213

Fax Settings, 151, 163

FAX Speed Dial, 195, 201

Fax Transmit, 165, 210, 228

File Format, 153, 165, 208, 223, 290

File Naming Mode, 153, 166, 209, 224, 292

Finding information, 27

Firmware Version, 146

Flip on Long Edge, 318

Flip on Short Edge, 318

Folio, 305

Font, 149, 158, 435
PCL 5/PCL 6, 437
Pitch, 435
Point size, 435
PostScript 3, 437
Style, 435
Typefaces and fonts, 435
Weight, 435

Font Pitch, 149, 158, 237

Font Size, 149, 158, 237

Form Line, 149, 158, 238

Forwarding Number, 152, 164

Front cover, 33

Front USB port, 33

FTP Client, 173, 184

Function Enabled, 159, 269

Function Enabled - Copy, 159

Function Enabled - Fax, 159

Fusing unit, 34, 473, 514, 521

G
Gateway Address, 177, 206, 219

Get Environment Sensor Info, 229

Ghost Configuration Chart, 228

Google Cloud Print, 173, 186, 325

Group Dial, 233

H
Hard disk, 64

Hex Dump, 149, 158, 238



Appendix 569

Host I/F, 146-147

Host Name, 146-147, 182, 188

How to install option, 43

How to remove option, 503

How to set up, 28

How to use printer, 27

HTTP, 172, 179

HTTP-SSL/TLS Communication, 425

I
ID, 146

ID Card Copy, 298, 338

Identifying print media, 305

Image Compression, 153, 166, 209, 224

Image Enhance, 149, 158

Impression Number, 147

Infrastructure, 185

Initialize NIC NVRAM Memory and restart 
printer, 187

Initialize Print Meter, 215, 267

Installing optional 550-Sheet Feeder, 48

Installing optional accessories, 43

Installing optional hard disk, 64

Installing optional memory module, 43

Installing optional wireless adapter, 53

Interfaces, 456

Interval of Redial, 152, 165, 210, 227

Invalid Key Tone, 147, 156, 204, 211

IP Address, 83, 135, 138, 140, 171, 177, 183, 188, 
191-192, 206, 219, 417

IP Address Mode, 206, 219

IP Filter (IPv4), 174, 192

IP filter setup, 179

IPP, 172, 176, 178

IPsec, 191, 428

IPsec Settings, 174, 191

IPv4, 183, 191

IPv6, 140, 171, 178, 183, 191

J
Job Completed Tone, 147, 156, 204, 212

Job History, 156, 206, 231

Job List, 138, 146

Job Name, 146

Job Status, 146

Job Submitted Time, 146-147

Job Time-out, 148, 157, 205, 213, 260

Job Type, 146-147

Junk Fax Setup, 151, 164, 209, 227, 251

K
Kerberos Server, 415

L
Label, 153-154, 167, 205, 215, 304

Landscape, 235

Layout, 149

LDAP Authentication, 417

LDAP Server, 188-189, 416-417

LDAP-SSL/TLS Communication, 429-430

Left frame, 141

Left side cover, 34

Legal, 305

Letter, 305

Letterhead 2 Sided, 148, 157, 205, 214

Line Monitor, 151, 163, 209, 226, 249

Line Termination, 149, 158, 239

Line Type, 151, 163, 209, 226, 248

Link Channel, 185

Link Local Address, 206

Link Quality, 185

Loading letterhead, 307

Loading paper, 87
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Loading print media, 307
MPF, 308
Tray1 and optional 550-sheet feeder, 307

Location, 140, 145

Login Error, 161

Low Toner Alert Message, 148, 157, 204, 212

Low Toner Alert Tone, 147, 157, 205, 212

LPD, 172, 176, 178, 246

M
MAC Address, 185

Machine Ready Tone, 147, 156, 204, 211

Maintenance, 463

Manual Address, 206

Margin Left / Right, 151, 153, 163, 165, 208-209, 
222, 224

Margin Middle, 151, 153, 163, 165, 208-209, 
222, 224

Margin Top / Bottom, 151, 153, 163, 165, 208, 
222, 224

Max E-mail Size, 153, 166, 209, 224

Maximum memory, 455

Memory, 455

Memory Capacity, 146

Memory connector, 455

Memory module, 43, 503

Memory speed, 455

Menu item, 142

Menu Settings, 147

MIB compatibility, 456

mm / inch, 147, 156, 204, 211

Modem Speed, 152, 165, 210, 228, 254

Monarch, 305

Monthly Settings, 161

MPF, 514

MPF Custom Paper Size - X, 155, 201

MPF Custom Paper Size - Y, 155, 201

MPF Custom Size - X, 207, 216

MPF Custom Size - Y, 207, 216

MPF Display Tray Prompt, 155, 201, 207, 216

MPF Paper Size, 155, 201, 207, 216

MPF Paper Type, 155, 201, 207, 216

MPF Use Driver Settings for Print Job, 155, 201, 
207, 216

MQ Chart, 228

Multiple Up, 463

Multiple-Up, 153, 209, 225, 297

Multipurpose feeder (MPF), 33, 517

N
NCR, 302

Network, 73

Network connection setup, 95

Network Firmware Version, 146

Network TWAIN, 172, 176, 179

Network Type, 185

New Password, 160

No carbon required paper, 302

No. of Sheets, 147

Non Registered User, 154, 414

Non-Dell Toner, 154, 205, 215, 268

Notification Time-Out, 179

Number pad, 129, 132

O
OCR, 302

OffHook Wake Up, 148, 157, 204, 212

Online Help, 139, 141

Operation, 456

Operator panel, 33, 36

Operator Panel Buttons, 129

Optical character recognition, 302

Optional 550-sheet feeder, 33, 514, 527

Order Supplies at, 139, 141
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Ordering supplies, 37, 463

Orientation, 148, 158, 235

Original Size, 150, 153, 162, 165, 207-208, 221, 
223, 291, 336

Original Type, 162, 207, 221, 285

OS, 456

OS compatibility, 455

Other problems, 559

Out of Paper Alert Tone, 205, 212

Out of Paper Tone, 147, 157

Output Color, 150, 153, 162, 165, 207-209, 220, 
223, 225

Output Result, 147

Output Size, 149

Output Tray, 145

Output tray extension, 33

Owner, 146

P
Page display format, 140

Page orientation, 308

Panel Language, 148, 157, 210, 219, 280

Panel Lock Control, 149, 159, 269

Panel Settings, 155, 206, 231

Panel Settings page, 155, 231

Paper, 301
Characteristics, 301
Curl, 301
Fiber content, 302
Grain direction, 301
Moisture content, 301
Smoothness, 301
Weight, 301

Paper Density, 153, 166, 205, 215, 264

Paper jam location, 514

Paper Size, 148, 158, 234

Paper Tray, 148

Paper Used, 193

Parts name, 33

Password, 179, 184, 187-189, 192, 414, 417, 419

PCL, 233
Font, 236

PCL 5/PCL 6, 437

PCL Fonts List, 155, 206, 231

PCL Macros List, 155, 206, 231

PCL printer driver, 92, 95

PCL Settings, 148, 158

PDF Fonts List, 156, 206

PDL, 455

Peer-to-Peer, 108

Phone Book, 195, 233

Phone connector, 34, 71, 74, 457

Pitch Configuration Chart, 228

Plain, 153-154, 167, 205, 215, 265-266

Plain Thick, 153-154, 167, 265-266

Point and Print, 105

Polling Receive, 295

Port Settings, 175

Port Status, 176

Port9100, 172, 176, 178, 246

Portrait, 235

PostScript 3, 437

Power connector, 34

Power On Wizard, 169

Power Saver Time, 255

Power Saver Time - Deep Sleep, 147, 156

Power Saver Time - Sleep, 147, 156

Power Saver Timer, 211

Power Saver Timer - Deep Sleep, 204

Power Saver Timer - Sleep, 204

Power supply, 455

Power switch, 33

Prefix Dial, 152, 165, 210, 227

Prefix Dial Number, 152, 165, 210, 227

Prefix/Suffix String, 153, 166

Premier, 154
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Print Color Regi Chart, 215

Print Drivers / Remote Client Account, 184

Print ID, 148, 157, 205, 214, 260

Print media, 301, 463
Source, 308

Print Meter, 156, 206

Print Mode, 149

Print quality guarantee, 456

Print Server Reports, 170

Print Server Settings, 138, 141, 170, 175, 220

Print Server Setup Page, 170

Print side, 308

Print Text, 148, 157, 205, 214, 261

Print Volume, 139, 141, 193

Printer driver, 117, 119, 418

Printer Events, 145

Printer Information, 139, 141, 146

Printer Jobs, 138, 141, 146

Printer Maintenance, 166

Printer Page Count, 193

Printer paper, 301

Printer Revision Levels, 146

Printer Serial Number, 146

Printer Settings, 138, 147, 156

Printer software, 397

Printer specification, 455

Printer Status, 138, 141, 145

Printer Status Window, 397

Printer Type, 145

Printer utility software, 398

Printing, 315

Printing problems, 531

Printing Speed, 145

Private Mail Box Print, 280, 319-320

Problems with Optional Accessories, 558

Processor Speed, 146

Product Information Guide, 28

Proof Print, 281, 320

Protocol Monitor, 156, 206, 232

Proxy Server, 173, 186

PS Fonts List, 156, 206

PS printer driver, 92, 95

Public Mail Box Print, 281, 319-320

Q
Quantity, 149, 158, 238

Quick Launch Utility, 398

Quick Reference Guide, 27

R
RAM Disk, 148, 157, 204, 213

Rear cover, 34

Receive Mode, 151, 164, 209, 226, 250

Receive Time-Out, 179

Recommended paper, 302

Recurrence, 161

Recycled, 154, 167, 265-266

Red Hat, 117

Red Hat Enterprise Linux, 117, 455

Redial Attempts, 152, 165, 210, 227

Reduce / Enlarge, 150, 162, 207, 220

Re-enter Password, 160

Refresh, 142

Registration Adjustments, 215

Regular, 154

Relative humidity, 456

Remote Authentication, 414

Remote Receive, 152, 164, 210, 227

Remote Receive Tone, 152, 164, 210, 227

Removing optional 550-sheet feeder, 506

Removing optional hard disk, 511

Removing optional memory module, 503

Removing optional wireless adapter, 509
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Removing options, 503

Report 2 Sided Print, 205, 214

Reports, 155, 233

Resend Delay, 152, 165, 210, 227

Reset Defaults, 169, 215

Reset Print Server, 187

Resident fonts, 437

Resident scalable fonts, 437

Resolution, 151, 153, 163, 165, 208-209, 
223-224, 289, 294

Restore Settings, 142

Retard roller, 475

Return policy, 564

Right frame, 141

Right side cover, 33

Ring Tone Volume, 151, 164, 209, 226, 250

RSA BSAFE, 23

S
Safety information, 28

Scalable fonts, 436

Scan Defaults, 153, 208

Scan Settings Tool, 347

Scan to Application, 343

Scan to Network, 351

Scan to USB Memory, 364

ScanButton Manager, 399

Search Time-Out, 188-189, 417

Secure Print, 281, 319-320

Secure Receive, 251, 392

Secure Receive Set, 160

Secure Settings, 149, 159

Security, 187

Security Settings, 185

Select Reorder URL, 154

Select Tray, 150, 153, 162, 207, 209, 220, 225

Selecting letterhead, 303

Selecting paper, 302

Selecting preprinted form, 303

Selecting pre-punched paper, 303

Sending print job, 315

Sent Fax Forward, 151, 164, 209, 227

Server Address, 156, 195, 198, 206

Server address book, 421

Server phone book, 421

Server Response Time-Out, 415

Service code, 28

Service tag, 28

Set Available Time, 161

Set Date, 154, 204, 211

Set Password, 139, 141, 187

Set Time, 154, 204, 211

Shared printing, 104

Sharpness, 150, 153, 162, 165, 207-208, 221, 
223, 285, 290

Slow scan, 499-500

SMB, 172, 176

SMB Client, 173, 184

SNMP, 173, 176

SNMP Configuration, 182

SNMP UDP, 246

Software and Documentation disc, 27

Software update, 398

Speed Dial, 156, 206

SSID, 185

SSL/TLS, 174, 189, 429

Start Time, 161

Status LED, 129

Status Monitor Console, 397

Status Monitor Console for Linux, 407

Status Monitor Widget for Macintosh, 403

Status of printer supplies, 463

Status Window, 399

Storage, 456
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Storage humidity range, 456

Stored Documents, 156, 206, 232

Storing consumables, 464

Storing print media, 305, 315, 464

Straightest lines, 500

Subnet Mask, 206, 219

Substitute Tray, 148, 157, 205, 214, 261

Supported paper sizes, 305

Supported paper types, 306

SUSE, 455

SUSE Linux Enterprise Desktop 10, 120

SUSE Linux Enterprise Desktop 11, 122

Symbol Set, 149, 158, 236, 441

System Settings, 147, 155-156, 175, 204, 206, 
231

System Settings Report, 155, 231

T
TCP/IP, 176

TCP/IP Settings, 171, 177

Telephone, 164

Telephone/Fax, 164

Telnet, 173, 176, 179

Temperature, 456

TIFF File Format, 153, 165, 209, 224

Time Format, 154, 204, 211

Time Zone, 154, 204, 211

Time Zone Settings, 211

Tone/Pulse, 152, 165, 210, 227, 253

Toner cartridge, 33, 465

Toner cartridge level, 145

Tool Box, 203, 399

Top cover, 33

Top frame, 140

Touch panel, 129

Transfer belt unit, 33

Trap Notification, 183

Tray 1 Custom Paper Size - X, 155, 201

Tray 1 Custom Paper Size - Y, 155, 201

Tray 1 Custom Size - X, 207, 217

Tray 1 Custom Size - Y, 207, 217

Tray 1 Display Tray Prompt, 155, 202, 207, 217

Tray 1 Paper Size, 155, 201, 207, 217

Tray 1 Paper Type, 155, 201, 207, 217

Tray 2 Custom Paper Size - X, 155, 202

Tray 2 Custom Paper Size - Y, 155, 202

Tray 2 Custom Size - X, 207, 218

Tray 2 Custom Size - Y, 207, 218

Tray 2 Display Tray Prompt, 155, 202, 207, 217

Tray 2 Paper Size, 155, 202, 207, 218

Tray 2 Paper Type, 155, 202, 207, 218

Tray Management, 139, 141, 155, 201, 275

Tray Priority, 207, 218

Tray Settings, 207, 216

Tray1, 33, 514, 520

Troubleshooting, 399, 531

Typeface, 435

U
Unacceptable paper, 302

UNITED STATES GOVERNMENT 
RESTRICTED RIGHTS, 23

Update Address Book, 173, 176, 179

Updater, 399

USB, 457

USB Direct Print, 159

USB Direct Print Defaults, 153, 209

USB port, 34, 71-72, 148, 158

USB printing, 92

Use Another Tray, 205, 214

Use Manual Address, 206

User Setup Disk Creating Tool, 397

Using Dell Printer Configuration Web Tool, 138
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V
Verifying IP settings, 85

W
Wall jack connector, 34, 71, 73, 457

Warranty, 564

Warranty information, 28

Waste toner box, 33, 484

Web Link Customization, 154, 170

Web services on devices, 323

Weekly Settings, 161

WEP, 185

White document cover, 497

White sheet, 497

Width guide, 88

WINS, 172, 178

Wired Network
IP Filter, 247
Protocol, 245
Reset LAN, 247

Wireless Adapter, 53

Wireless adapter socket, 34

Wireless Settings, 171, 185

WPA-Enterprise, 430-431

WPA-PSK, 186

WPS-PBC, 61

WPS-PIN, 60

WSD, 172, 179, 323

WSD Scan, 292, 344

X
XPS printer driver, 93, 96

Y
Yellow terminator, 74
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